HP 4971S
LAN Protocol Analyzer

Operating Manual
NOTICE

Hewlett-Packard makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Hewlett-Packard assumes no responsibility for the use or reliability of its software on equipment that is not furnished by Hewlett-Packard.

This document contains proprietary information which is protected by copyright. No part of this document may be photocopied, reproduced, or translated to another language without the prior written consent of Hewlett-Packard Company. The information contained in this document is subject to change without notice.

If your software application or hardware should fail, contact your local Hewlett-Packard Sales Office. A list of offices can be found in the back of this manual.

Copyright © 1987 Hewlett-Packard Company

Hewlett-Packard Company
Colorado Telecommunications Division
5070 Centennial Blvd. P.O. Box 7050
Colorado Springs, Colorado, 80933
U.S.A.
SAFETY SUMMARY

The following general safety precautions must be observed during all phases of operation, service and repair of this instrument. Failure to comply with these precautions or with specific warnings else where in this manual violates safety standards of design, manufacture, and intended use of this instrument. Hewlett-Packard Company assumes no liability for the customer's failure to comply with these requirements.

Safety Classification

This is a Safety Class I instrument (provided with terminal for protective grounding).

Operation.

BEFORE APPLYING POWER, verify that the line voltage select switch is set to match the power transformer primary to the available line voltage, the correct fuse is installed, and safety precautions are taken (see the following warnings).

Ground the Instrument.

To minimize shock hazard, the instrument chassis and cabinet must be connected to an electrical ground. The instrument is equipped with a three-conductor ac power cable. The power cable must either be plugged into an approved three-contact electrical outlet or used with a three-contact to two-contact adapter with the grounding wire (green) firmly connected to an electrical ground (safety ground) at the power outlet. The power jack and mating plug of the power cable must meet International Electrotechnical Commission (IEC) safety standards.

Use correct fuses.

Only fuses with the required rated current, voltage, and specified type (normal blow, time delay, etc.) should be used. Do not use repaired fuses or short circuited fuse holders. To do so could cause a shock or fire hazard.

Do not operate in an explosive atmosphere.

Do not operate the instrument in the presence of flammable gases or fumes. Operation of any electrical instrument in such an environment constitutes a definite safety hazard.
Keep away from live circuits.

Operating personnel must not remove instrument covers. Component replacement and internal adjustments must be made by qualified maintenance personnel. Do not replace components with power cable connected. Under certain conditions, dangerous voltages may exist even with the power cable removed. To avoid injuries, always disconnect power and discharge circuits before touching them. Capacitors inside the instrument may still be charged even if the instrument has been disconnected from its source of supply.

Use caution when exposing or handling the CRT.

Breakage of the Cathode-Ray Tube (CRT) causes a high velocity scattering of glass fragments (implosion). To prevent CRT implosion, avoid rough handling or jarring of the instrument. Handling of the CRT shall be done only by qualified maintenance personnel using approved safety mask and gloves.

Do not service or adjust alone.

Do not attempt internal service or adjustments unless another person, capable of rendering first aid and resuscitation, is present.

Do not substitute parts or modify instrument.

Do not install substitute parts or perform any unauthorized modification to the instrument.
PRINTING HISTORY

Each new edition of this manual incorporates all material updated since the previous edition. Manual change sheets are issued between editions, allowing you to correct or insert information in the current edition.

The part number of the manual changes only when each new edition is published. Minor corrections or additions may be made as the manual is reprinted between editions.

First printing          Feb 1986
Second printing         Mar 1987
                        Update manual to new revision system software.
VOLUME I, Getting Started With Your HP 4971S, includes the following chapters:

GENERAL INFORMATION

CHAPTER 1: USING THIS MANUAL
CHAPTER 2: PRODUCT INFORMATION
CHAPTER 3: SITE PREPARATION
CHAPTER 4: INSTALLING THE HP 4971S
CHAPTER 5: GETTING STARTED
CHAPTER 6: INTRODUCTION TO LANs
CHAPTER 7: INTRODUCTION TO THE HP 4971S
CHAPTER 8: PREVENTATIVE MAINTENANCE
APPENDIX A: ERROR MESSAGES
APPENDIX B: KEYBOARDS AND CHARACTER CODES
APPENDIX C: EXECUTION TIMES
APPENDIX D: BNC OUTPUTS
GLOSSARY OF LAN TERMS
INDEX
Volume II
OPERATING MANUAL FOR THE HP 4971S

GENERAL INFORMATION

Title Page 1
Warranty 2
Copyright 3
Safety Summary 4
Printing History 6
Table of Contents 7

CHAPTER 9: TOP LEVEL MENU

Top Level Menu Display 9-2
Top Level Menu Selections 9-3

CHAPTER 10: <Setup Analyzer> MENU

Introduction 10-2
<Setup Analyzer> Function Descriptions 10-3
### CHAPTER 11: <Edit Nodelist> MENU

- <Edit Nodelist> Softkey Selections 11-2
- Introduction 11-2
- Assigning A Network Name 11-3
- Assigning The Network Type 11-4
- Adding Stations To The Node List 11-5
- Deleting Stations From The Node List 11-7
- Sorting The Node List 11-8
- Searching For A Node 11-9

### CHAPTER 12: <Edit Filters> MENU

- Introduction 12-2
- <Edit Filters> Softkey Selections 12-8
- Add, Delete, And Label Filters 12-10
- Add, Delete, And Label Filter Fields 12-12
- Select Character Type 12-16
- Select Network Protocol Display Format 12-17
- <Edit Filters> Copy Function 12-19
- Select Frame Traits 12-20
- Edit Filter Length 12-22
- Filter Examples 12-24

### CHAPTER 13: <Edit Messages> MENU

- <Edit Messages> Softkey Selections 13-2
- <Edit Messages> Display Description 13-2
- <Edit Messages> Softkey Descriptions 13-4
- Copying The Data Length Field 13-11
- Selecting An FCS Value 13-12
- Example For Editing A Message 13-13
CHAPTER 14: <Edit Programs> MENU

Introduction 14-2
Selecting A Program To Edit 14-4
"Selecting A Program" Softkey Descriptions 14-4
Store Function Softkey Selections 14-6
Store Function Softkey Descriptions 14-6
Name The Log To Disc File 14-15

Program Commands Softkey Selections 14-18
Overview Of Programming 14-24
Conditional Program Statements 14-25

Program Commands Softkey Descriptions 14-26
   Group 1 Softkey Descriptions 14-27
   Group 2 Softkey Descriptions 14-40
   Group 3 Softkey Descriptions 14-42
Display Functions In <Edit Programs> Menus 14-49

Selective Display 14-50
Continuous Display 14-51
Programming Examples 14-54

CHAPTER 15: <I/O Functions> MENU

<I/O Functions> Softkey Selections 15-2
Introduction 15-2
Editing The I/O Configuration 15-4
Saving The I/O Configuration 15-12
Capturing A Slave LAN Protocol Analyzer 15-13
Editing And Sending A Modem String 15-15
Enabling I/O Operation 15-19
I/O Status Messages 15-20
<Terminal Emulator> Description 15-29
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAPTER 16: &lt;Execute Programs&gt; MENU</td>
<td></td>
</tr>
<tr>
<td>&lt;Execute Programs&gt; Softkey Selections</td>
<td>16- 2</td>
</tr>
<tr>
<td>&lt;Execute Programs&gt; Operation Considerations</td>
<td>16- 2</td>
</tr>
<tr>
<td>Running Programs From The Network</td>
<td>16- 3</td>
</tr>
<tr>
<td>Running Programs From The Buffer</td>
<td>16- 4</td>
</tr>
<tr>
<td>Examine Data After Program Run</td>
<td>16- 6</td>
</tr>
<tr>
<td>Edit Functions In &lt;Execute Program&gt; Menu</td>
<td>16- 7</td>
</tr>
<tr>
<td>&lt;Execute Program&gt; Soft LED Indicators</td>
<td>16- 8</td>
</tr>
<tr>
<td>CHAPTER 17: &lt;Monitor Network&gt; MENU</td>
<td></td>
</tr>
<tr>
<td>&lt;Monitor Network&gt; Softkey Selections</td>
<td>17- 2</td>
</tr>
<tr>
<td>&lt;Monitor Network&gt; Softkey Descriptions</td>
<td>17- 3</td>
</tr>
<tr>
<td>&lt;Monitor Network&gt; Soft LED Indicators</td>
<td>17- 6</td>
</tr>
<tr>
<td>&lt;Monitor Network&gt; Anomalies</td>
<td>17- 9</td>
</tr>
<tr>
<td>CHAPTER 18: &lt;Disc Functions&gt; MENU</td>
<td></td>
</tr>
<tr>
<td>&lt;Disc Functions&gt; Softkey Selections</td>
<td>18- 2</td>
</tr>
<tr>
<td>Introduction To Disc Functions</td>
<td>18- 2</td>
</tr>
<tr>
<td>Selecting A Volume</td>
<td>18- 4</td>
</tr>
<tr>
<td>Listing The Directory</td>
<td>18- 5</td>
</tr>
<tr>
<td>Deleting A File</td>
<td>18- 7</td>
</tr>
<tr>
<td>Saving A File</td>
<td>18- 8</td>
</tr>
<tr>
<td>Loading A File</td>
<td>18-15</td>
</tr>
<tr>
<td>&lt;Copy File&gt; Introduction</td>
<td>18-16</td>
</tr>
<tr>
<td>Copying &lt;Analyzer Files&gt;</td>
<td>18-18</td>
</tr>
<tr>
<td>Copying &lt;All Files&gt;</td>
<td>18-20</td>
</tr>
<tr>
<td>Copying &lt;Unique Files&gt;</td>
<td>18-21</td>
</tr>
<tr>
<td>File Name Syntax</td>
<td>18-22</td>
</tr>
<tr>
<td>Wild Cards</td>
<td>18-24</td>
</tr>
<tr>
<td>Formatting A Volume</td>
<td>18-25</td>
</tr>
<tr>
<td>Compressing A Volume</td>
<td>18-27</td>
</tr>
<tr>
<td>&lt;Disc Functions&gt; In Remote Mode</td>
<td>18-28</td>
</tr>
</tbody>
</table>
CHAPTER 19: <Examine Data> MENU

<Examine Data> Display 19-2
<Examine Data> Softkey Selections 19-8
<Examine Data> Softkey Descriptions 19-8
Finding Frames 19-10
Selecting A Frame Display Format 19-17
Selecting Frame Header Formats 19-25
Selecting Datafield Character Formats 19-31
Displaying Data In Filter Formats 19-35
Selecting Timestamp Measurements 19-36
Selecting Timers And Counters 19-41

Displaying Frame Errors 19-42

CHAPTER 20: <Printer Functions> MENU

<Printer Functions> Softkey Selections 20-2
Getting Top Of Forms 20-3
Stopping The Printer 20-4
Selecting The Printer 20-5
Printing The Node List 20-6
Printing Filters 20-7
Printing Messages 20-8
Printing Programs 20-9
Printing Data 20-10
Print The Screen 20-16
<Printer Functions> In Remote Mode 20-17
CHAPTER 21: <Hardware Functions> MENU

HP 4971S Hardware Functions Display 21-2
HP 4971S Hardware Functions Descriptions 21-3
<Test LAN Analyzer> Self Tests 21-9
Running The Self Tests 21-11

CHAPTER 22: <Passwords> MENU

>Passwords> Softkey Selections 22-2
Introduction 22-3
Changing The Password 22-5
Storing The Password 22-8
Securing Receiver Or Transmitter Functions 22-9
Unsecuring Receiver Or Transmitter Functions 22-10
Passwords In Other Analyzer Menus 22-11

CHAPTER 23: <Set Date> AND <Set Time> MENUS

Setting The Date 23-2
Setting The Time 23-3

INDEX
CERTIFICATION

Hewlett-Packard Company certifies that this product met its published specifications at the time of shipment from the factory. Hewlett-Packard further certifies that its calibration measurements are traceable to the United States National Bureau of Standards, to the extent allowed by the Bureau's calibration facility, and to the calibration facilities of other International Standards Organization members.

WARRANTY

This Hewlett-Packard product is warranted against defects in material and workmanship from the date of delivery. The standard warranty requires the product to be returned to a service facility designated by HP and is in effect for one year from the date of shipment. An optional 90-day, on-site repair warranty is also available.

For products returned to HP for warranty service, Buyer shall prepay shipping charges to HP and HP shall pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping charges, duties, and taxes for products returned to HP from another country.

HP warrants that its software and firmware designated by HP for use with an instrument will execute its programming instructions when properly installed on that instrument. HP does not warrant that the operation of the instrument, or software, or firmware will be uninterrupted or error free.

Limitation of Warranty

The foregoing warranty shall not apply to defects resulting from improper or inadequate maintenance by Buyer, Buyer-supplied software or interfacing, unauthorized modification or misuse, operation outside of the environmental specifications for the product, or improper site preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. HP SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Exclusive Remedies

THE REMEDIES PROVIDED HEREIN ARE BUYER'S SOLE AND EXCLUSIVE REMEDIES. HP SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY.

ASSISTANCE

Product maintenance agreements and other customer assistance agreements are available for Hewlett-Packard products.

For any assistance, contact your nearest Hewlett-Packard Sales and Service Office, Addresses are provided at the back of this manual.
HP 4971S
LAN PROTOCOL ANALYZER

Operating Manual

This manual applies directly to the HP 4971S system with software revision 1.0

© COPYRIGHT HEWLETT-PACKARD COMPANY
COLORADO TELECOMMUNICATIONS DIVISION 1986
5070 CENTENNIAL BVLD.
P.O. Box 7050
COLORADO SPRINGS, COLORADO 80933
USA
ALL RIGHTS RESERVED

Manual Part No. 18211-90001
Includes: printed pages 5957-4478
binders (2 ea.) 5080-8562

Microfiche Part No. 18211-90002

Printed in USA
FEB 1986
TABLE OF CONTENTS
VOLUME I
GETTING STARTED WITH YOUR HP 4971S

GENERAL INFORMATION

Certification  i
Warranty ii
Title Page viii
Table of Contents ix
Safety Consideration viii
Safety Symbols x
Printing History x

CHAPTER 1: USING THIS MANUAL

The GETTING STARTED Volume 1-2
Chapter Descriptions 1-2
OPERATING THE HP 4971S Volume 1-4
Chapter Descriptions 1-5

Softkey Conventions 1-8
Editing With The Keyboard Keys 1-11
### CHAPTER 4: INSTALLING YOUR HP 4971S SYSTEM

- Identify The System Parts 4-3
- Position The System 4-4
- Check Line Voltage Select Switches 4-5
- Check Line Fuses 4-7
- Connect The Power Cords 4-11

- Install The Keyboard 4-14
- Install The Display 4-16
- Install The HP-IB Cables 4-18
- Turn On Your System 4-20
- Connect The HP 4971S To Your Network Cable 4-21

- Identify Accessory Slots 4-22
- Optional Memory Boards Address Settings 4-24

### CHAPTER 5: GETTING STARTED

- Introduction 5-2
- Loading The System Software 5-4
- Backing Up Your System Software 5-14
- Using The Top Level Menu 5-16
- Setting The Date And Time 5-18
- Using The TUTORIAL Disc 5-20
## CHAPTER 6: INTRODUCTION TO LANs

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Is A Local Area Network?</td>
<td>6-3</td>
</tr>
<tr>
<td>Advantages of a Local Area Network</td>
<td>6-4</td>
</tr>
<tr>
<td>Where and How are LANs used?</td>
<td>6-6</td>
</tr>
<tr>
<td>Network Topology</td>
<td>6-10</td>
</tr>
<tr>
<td>Transmission Media</td>
<td>6-11</td>
</tr>
<tr>
<td>Network Access Methods</td>
<td>6-15</td>
</tr>
<tr>
<td>The IEEE 802.3 Frame</td>
<td>6-17</td>
</tr>
<tr>
<td>Local Area Network System Differences</td>
<td>6-20</td>
</tr>
<tr>
<td>Local Area Network Performance Measurements</td>
<td>6-23</td>
</tr>
</tbody>
</table>

## CHAPTER 7: INTRODUCTION TO THE HP 4971S

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functional View Of The HP 4971S</td>
<td>7-2</td>
</tr>
<tr>
<td>More Details About HP 4971S Functions</td>
<td>7-16</td>
</tr>
<tr>
<td>The HP 4971S System Devices</td>
<td>7-18</td>
</tr>
</tbody>
</table>
Table of Contents

CHAPTER 8: PREVENTATIVE MAINTENANCE

Cleaning System Devices 8-2
Common Replaceable Parts 8-3

APPENDIX A: GLOSSARY OF LAN TERMS

INDEX
VOLUME II, Operating The HP 4971S, includes the following chapters:

CHAPTER 9: TOP LEVEL MENU
CHAPTER 10: <Setup HP 4971S> MENU
CHAPTER 11: <Edit Nodelist> MENU
CHAPTER 12: <Edit Filters> MENU
CHAPTER 13: <Edit Messages> MENU
CHAPTER 14: <Edit Programs> MENU
CHAPTER 15: <I/O Functions> MENU
CHAPTER 16: <Execute Programs> MENU
CHAPTER 17: <Monitor Network> MENU
CHAPTER 18: <Disc Functions> MENU
CHAPTER 19: <Examine Data> MENU
CHAPTER 20: <Printer Functions> MENU
CHAPTER 21: <Test Hardware> MENU
CHAPTER 22: <Set Date> AND (Set Time> MENUS

APPENDIX B: DATA CODE TABLES

APPENDIX C: ERROR MESSAGES

APPENDIX D: EXECUTION TIME FOR PROGRAM INSTRUCTIONS

APPENDIX E: BNC OUTPUTS

INDEX
SAFETY CONSIDERATIONS

Safety Classification
This is a Safety Class I instrument (provided with terminal for protective grounding).

Operation.
BEFORE APPLYING POWER, verify that the line voltage select switch is set to match the power transformer primary to the available line voltage, the correct fuse is installed, and safety precautions are taken (see the following warnings). In addition, note the instrument's external markings which are described under "Safety Symbols".

Ground the Instrument.
To minimize shock hazard, the instrument chassis and cabinet must be connected to an electrical ground. The instrument is equipped with a three-conductor ac power cable. The power cable must either be plugged into an approved three-contact electrical outlet or used with a three-contact to two-contact adapter with the grounding wire (green) firmly connected to an electrical ground (safety ground) at the power outlet. The power jack and mating plug of the power cable must meet International Electrotechnical Commission (IEC) safety standards.

Do not operate in an explosive atmosphere.
Do not operate the instrument in the presence of flammable gases or fumes. Operation of any electrical instrument in such an environment constitutes a definite safety hazard.

Keep away from live circuits.
Operating personnel must not remove instrument covers. Component replacement and internal adjustments must be made by qualified maintenance personnel. Do not replace components with power cable connected. Under certain conditions, dangerous voltages may exist even with the power cable removed. To avoid injuries, always disconnect power and discharge circuits before touching them. Capacitors inside the instrument may still be charged even if the instrument has been disconnected from its source of supply.

Use caution when exposing or handling the CRT.
Breakage of the Cathode-Ray Tube (CRT) causes a high velocity scattering of glass fragments (implosion). To prevent CRT implosion, avoid rough handling or jarring of the instrument. Handling of the CRT shall be done only by qualified maintenance personnel using approved safety mask and gloves.
Do not service or adjust alone.
Do not attempt internal service or adjustments unless another person, capable of rendering first aid and resuscitation, is present.

Use correct fuses.
Only fuses with the required rated current, voltage, and specified type (normal blow, time delay, etc.) should be used. Do not use repaired fuses or short circuited fuse holders. To do so could cause a shock or fire hazard.

Do not substitute parts or modify instrument.
Do not install substitute parts or perform any unauthorized modification to the instrument.

SAFETY SYMBOLS

Instruction manual symbol: The product will be marked with this symbol when it is necessary for the user to refer to the instruction manual in order to protect against damage to the product.

Indicates hazardous voltages.

Earth terminal (sometimes used in manual to indicate circuit common connected to grounded chassis).

The WARNING sign denotes a hazard. It calls attention to a procedure, practice, or the like, which, if not correctly performed or adhered to, could result in personal injury. Do not proceed beyond a WARNING sign until the indicated conditions are fully understood and met.

The CAUTION sign denotes a hazard. It calls attention to an operating procedure, practice, or the like, which, if not correctly performed or adhered to, could result in damage to or destruction of part or all of the product. Do not proceed beyond a CAUTION sign until the indicated conditions are fully understood and met.
PRINTING HISTORY

Each new edition of this manual incorporates all material updated since the previous edition. Manual change sheets are issued between editions, allowing you to correct or insert information in the current edition.

The part number of the manual changes only when each new edition is published. Minor corrections or additions may be made as the manual is reprinted between editions.

First printing ..... Feb 1986
CHAPTER 1
USING THIS MANUAL

The HP 4971S manual is divided into two volumes: GETTING STARTED and OPERATING THE HP 4971S. GETTING STARTED is an installation and beginning operation guide. Follow the chapters in sequence in GETTING STARTED to learn what accessories and options are available for the protocol analyzer, how to install the different devices making up your system, and finally how to begin operating the system. Also included in GETTING STARTED is an introduction to local area networks (LANs) and to the HP 4971S LAN Protocol Analyzer.

The second volume, OPERATING THE HP 4971S, is a reference section. This volume covers in detail the softkey guided menus used to control the operation of the protocol analyzer. Each major softkey function is covered as a separate chapter.

This chapter includes:

- The GETTING STARTED Volume
  
  Chapter Descriptions

- OPERATING THE HP 4971S Volume
  
  Chapter Descriptions

- Softkey Conventions
  
  Softkey Designation
  Softkey Levels
  Other Choices
  Toggling Softkeys
  Active Softkeys

- Editing With Keyboard Keys

- Repeating Keys

- Text Entry Conventions
The GETTING STARTED Volume

Chapters in this volume describe the HP 4971S system's features and how to install the system. After installation is complete, instructions are given to install the operating system software.

An introduction to LAN's and the HP 4971S LAN Protocol analyzer follows the installation and beginning operation steps. These sections will give helpful background information to you if you are new to LANs or protocol analyzers.

CHAPTER DESCRIPTIONS

The GETTING STARTED volume includes the chapters:

Chapter 1  Using This Manual
This chapter describes the functions of the manual supplied with the HP 4971S. Softkey and keyboard conventions used in the manual are discussed.

Chapter 2  Product Information
This chapter describes the devices that make up an HP 4971S system. Included are operating characteristics of the protocol analyzer system and the specifications for the individual devices. The accessories and options available for the HP 4971S are listed.

Chapter 3  Site Preparation
This chapter describes the requirements of the site where the protocol analyzer is to be installed.

Chapter 4  Installation
This chapter describes how to install each of the devices used in the HP 4971S system.

Chapter 5  Getting Started
This chapter describes how to install the operating system software.
Chapter 6

Introduction to LANs
This chapter provides an introduction to Ethernet Local Area Networks.

Chapter 7

Introduction to HP 4971S
This chapter describes the basic functions of the HP 4971S.

Chapter 8

Preventative Maintenance
This chapter describes the preventative maintenance that may be performed on the HP 4971S devices. A common replaceable parts list is included.

Appendix A

Glossary of LAN Terms

Index
Using This Manual

The OPERATING THE HP 4971S Volume

In the OPERATING THE HP 4971S volume, each chapter describes a major function of the protocol analyzer that may be selected by softkeys shown at the bottom of the display.

Chapter introductions

An introduction is presented in each chapter to help you understand the purpose or application for that function. You may also want to read the Introduction To LANs and Introduction To The HP 4971S chapters in the GETTING STARTED volume to help you understand more about protocol analyzer applications.

Softkey selections

In each chapter, a chart is provided to show the different softkey selections for that function. Softkey levels are indicated by indenting the softkeys on the chart. An indented softkey indicates that the previous level softkey has to be selected before you can access the next lower key.

For example:

```
Setup HP 4971S
  Edit Node List
  Edit Filters
  Edit Programs
  Edit Messages
  Monitor Network
  Execute Program
```

In this example, you must press the <Setup HP 4971S> softkey before <Edit Node List>, <Edit Filters>, etc. can be selected.

Softkey descriptions

In each chapter, the softkeys available for that function are described. The softkey descriptions are presented in the approximate order they appear on the selection charts from top to bottom. In some menus, the descriptions are grouped by the tasks available under that softkey function.
OPERATING THE HP 4971S CHAPTER DESCRIPTIONS

Each chapter in this volume describes a particular softkey function. The chapters are presented in the sequence the softkeys are displayed on the HP 4971S.

Chapter 9  Top Level Menu
This chapter describes the choices available from the top level menu.

Chapter 10  <Setup HP 4971S> Menu
This chapter describes the softkey functions available to configure or setup the HP 4971S to perform its primary functions.

Chapter 11  <Edit Node List> Menu
A node list may be created that identifies the addresses on a network by their function or by their user name.

Chapter 12  <Edit Filters> Menu
Filters may be created to screen or control what network frames are stored into the protocol analyzer. Filters may also be used to control the protocol analyzer programmed operation.

Chapter 13  <Edit Programs> Menu
You can create programs to control the operation of the protocol analyzer.

Chapter 14  <Edit Messages> Menu
You can create messages to simulate operation of other nodes on the network. Messages can simulate a request to another node or they can simulate a response to another nodes inquiry.
Chapter 15  <I/O Functions> Menu
An HP 4971S can be used with another HP 4971S to form a master/slave combination that lets you test a LAN from a remote location.

Chapter 16  <Execute Program> Menu
Programs you have created can be run on frames currently appearing on the network cable or a program can be run to analyze frames already stored in the protocol analyzer.

Chapter 17  <Monitor Network> Menu
A very quick and simple softkey selection lets you immediately begin using a protocol analyzer to let you view frames occurring on your network.

Chapter 18  <Disc Functions> Menu
A floppy disc or hard disc can be used for mass storage of network frames captured in the protocol analyzer. In addition, different protocol analyzer setup or configuration files can be stored on the disc.

Chapter 19  <Examine Data> Menu
After network frames are stored in the protocol analyzer, they may be viewed in different formats for easy recognition of frame patterns and contents.

Chapter 20  <Printer Functions> Menu
Hard copies may be made of the protocol analyzer screen contents, the HP 4971S setup menus, as well as stored data.

Chapter 21  <Test Hardware> Menu
Several hardware self tests for the instrument portion of the protocol analyzer may be chosen by softkey selection.
Chapter 22  <Set Date-Time> Menu
At each power-on cycle, you can set the date and time. This information is used to timestamp when frames are received and when files are stored on the disc.

Appendix B  ASCII, EBCDIC Character Conversion Tables

Appendix C  Error Messages
When incorrect operation is performed with the protocol analyzer an error message is displayed. An explanation and possible causes of the error are described.

Appendix D  Execution Times for Program Instructions
Approximate execution times for program instructions are listed.

Index
Softkey Conventions

The HP 4971S lets you use softkeys shown on the display to control its operation. When you turn the system power on, the instrument portion of the HP 4971S system goes through a self test. After the self test is completed, a "Top Level Menu" is shown. This menu is shown below.

From the Top Level Menu, you can use the softkeys shown at the bottom of the display to select primary functions that control the protocol analyzer. As you press any one of these softkeys, you will cause the display to change to new softkeys used to control the function you have chosen.
SOFTKEY DESIGNATION

Softkeys are indicated in the manual by enclosing the softkey word(s) with the <> characters. The list below shows examples of softkeys displayed in the Top Level Menu:

<Setup HP 4971S>
<Monitor Network>
<Examine Data>

SOFTKEY LEVELS

From the Top Level Menu, when you press any labeled softkey, you branch to new softkeys to control that particular function. Some of the function menus may branch to several levels as you press the different softkeys. To escape from a lower level menu display, press the <EXIT> softkey until you return to the primary menu display for that function. If you press the <EXIT> softkey again, you return to the Top Level Menu. For Example:

<Setup HP 4971S>
  <Edit Node List>
  <Edit Filters>
  <Edit Programs>
  <Edit Messages>

From the Top Level Menu, if you select <Setup HP 4971S> softkey, you will see the choices shown above. If you select one of these choices, you will branch to new softkeys for that function. If you continue to make selections from new softkeys displayed, you can continue branching to even lower levels.

It is easy to escape or return to an upper level menu, just repeat pressing the <EXIT> softkey until you have returned to the level you want.

To go to another HP 4971S function, you have to return to the Top Level Menu and then select the next softkey function you want.
Using This Manual

<OTHER CHOICES> SOFTKEY

Some menus have more softkey selections than can be shown on one display. When this occurs, the softkey <OTHER CHOICES> is displayed. Press <OTHER CHOICES> to display additional softkeys available in that menu.

TOGGLING SOFTKEYS

Some softkeys have an on-off toggle capability.

These keys are marked by an asterisk (*) when they are on. Press the softkey again to turn the function off and the asterisk is removed. Not all keys with an asterisk will toggle.

ACTIVE SOFTKEYS

When the cursor is positioned in some fields, several choices are displayed as softkeys to control that field. An asterisk (*) is automatically displayed in one of the softkeys to show the currently selected choice. When you select another softkey for that field, the asterisk will move to that softkey.

Examples of softkeys marked by an asterisk when they are active include:

<Show Node Names*>  <Show Hex Addresses>

<ASCII 7>  <ASCII 8*>  <EBCDIC>

<Detailed Format *>  <Summary Format>  <Filter Format>
Editing With The Keyboard Keys

Several of the keys on the keyboard may be used to edit the display of the protocol analyzer. In this manual, these keys are denoted by using all capital letters for the key.

**ARROW-DOWN**
- moves the cursor down to the next available field.

**ARROW-HOME**
- is the key with a diagonal arrow symbol. In general, this key causes the cursor to move to the field nearest the upper left corner of the display.

In **<Edit Nodelist>** Menu, this key moves the cursor to the beginning of the node list.

In **<Edit Programs>** Menu, this key moves the cursor to the "Store:" command at the beginning of the program.

In **<Examine Data>** Menu, this key shows the first frame in the buffer at top of the display.

In **<Edit Messages> <Format As Filter>** and **<Edit Filters> <Edit All Fields>**
- In these menus, ARROW-HOME key moves the cursor to the first byte of the Destination Address Field.

In **<Edit Messages> <Edit Datafield>**
- In this menu, ARROW-HOME key moves the cursor to the first byte of the Data Field.

**ARROW-LEFT**
- moves the cursor to the left within a field. After reaching the left end of a field, the arrow key moves the cursor to the next field if another field is available on the same line.

To quickly move the cursor to another field, use the TAB key or the UP-ARROW/DOWN-ARROW keys.
### Using This Manual

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARROW-RIGHT</td>
<td>Moves the cursor to the right within a field. After reaching the right end of a field, the arrow key moves the cursor to the next field if another</td>
</tr>
<tr>
<td></td>
<td>field is available on the same line. To move the cursor to another field, use the TAB key or the UP-ARROW/DOWN-ARROW keys.</td>
</tr>
<tr>
<td>ARROW-UP</td>
<td>Moves the cursor up to the next available field.</td>
</tr>
<tr>
<td>CLEAR LINE</td>
<td>Clears the alphanumeric field currently marked by the cursor. CLEAR LINE resets numeric fields to zero.</td>
</tr>
<tr>
<td>DELETE CHAR</td>
<td>In some fields, this key deletes the character marked by the cursor.</td>
</tr>
<tr>
<td>DELETE LINE</td>
<td>In some menus, this key deletes the current line marked by the cursor. The line immediately below the cursor is moved up to the cursor position.</td>
</tr>
<tr>
<td>INSERT CHAR</td>
<td>In &quot;label&quot; fields, this key provides a space where the cursor is located. You can then enter a new character from the keyboard. INSERT CHAR</td>
</tr>
<tr>
<td></td>
<td>must be pressed each time a character is to be added.</td>
</tr>
<tr>
<td>INSERT LINE</td>
<td>&lt;Edit Node List&gt;</td>
</tr>
<tr>
<td></td>
<td>The INSERT LINE key inserts a new node having the default protocol analyzer values.</td>
</tr>
<tr>
<td></td>
<td>&lt;Edit Programs&gt;</td>
</tr>
<tr>
<td></td>
<td>The INSERT LINE key inserts a blank line before the current cursor position.</td>
</tr>
</tbody>
</table>
NEXT

<Examine Data>
The NEXT keyboard key acts similar to the <Next Frame> softkey in the <Examine Data> Menu. It advances the display to the next frame in the buffer memory.

When the <Scroll Marked> softkey is selected, only marked frames are displayed. After the display stops scrolling, the NEXT key advances the display to the next marked frame. The key skips over any unmarked frames.

<Edit Node List>
<Edit Messages>
<Edit Programs>
<Disc Functions><List Directory>
The NEXT key advances the display to the next page.

PREV

<Examine Data>
The PREVIOUS keyboard key acts similar to the <Previous Frame> softkey in <Examine Data> Menu. It moves the display down with a new frame being displayed at the top of the screen.

When the <Scroll Marked> softkey is selected, only marked frames are displayed. After the display stops scrolling, the PREVIOUS key advances the display to the previous marked frame. The key skips over any unmarked frames.

<Edit Node List>
<Edit Messages>
<Edit Programs>
<Disc Functions><List Directory>
The PREV key moves the display to the previous page.
RETURN is used to complete an entry when the protocol analyzer prompts you to enter information in a field.

After you complete an entry and press the RETURN key, the cursor moves to the next field.

You can also use the RETURN key to perform insertions at the end of messages, filter, and node lists.

TAB moves the cursor to the first character in the next available field.

TAB moves the cursor from the last field to the first field.

Press SHIFT and TAB keys at the same time to move the cursor backwards through the fields. When the cursor is in the first field of a display, you can use the SHIFT and TAB keys to quickly move the cursor to the last field.
Repeating Keys

When keys are held down, the protocol analyzer interprets this as a request to repeat the function.

For example, in the <Edit Node List> Menu, look at the bottom left corner of the display as you hold the <Insert Node> softkey down. The hex code for that key is displayed. If you continue to hold the key down, the character code will stack along the bottom of the display.

To quickly remove the stacked keyboard keys, press CTRL and BACKSPACE keys at the same time until the stacked keys are removed.
Text Entry Conventions

ALPHA AND HEX CHARACTER ENTRY

For entry fields using alpha or hex characters, when you use the TAB key to move the cursor to the field, the cursor is automatically positioned at the left of the field and characters you enter are automatically left justified.

If you position the cursor in a field with one of the ARROW keys, and enter a character, the character is written wherever the cursor is positioned.

NUMERIC ENTRY (OTHER THAN HEX)

When you use any key to move the cursor to an entry field using numeric characters, the cursor is automatically positioned at the right of the field and characters you enter are automatically right justified.

SPACES IN ENTRY FIELDS

You can enter spaces in name fields such as: node names, program names, disc file names, filter names, etc. The spaces are replaced with an underscore character when you exit the field.
CHAPTER 2
PRODUCT INFORMATION

This chapter identifies the HP 4971S operating characteristics, specifications, product structure and accessories.

This chapter includes:

- Product Description
- HP 4971S Operating Specifications
- HP 4971S Specifications
- Accessories Available For The HP 4971S
- Recommended Peripherals For The HP 4971S
- Accessories Supplied With The HP 4971A
- Options Available For The HP 4971A
- Support Services Available
**HP 4971S Product Description**

The HP 4971S is a protocol analyzer for troubleshooting on local area networks employing Ethernet or IEEE 802.3 protocols on a 10 Mbps baseband coaxial medium. It lets you monitor traffic on the network, generate data frames to test other nodes, and write programs to verify network performance. For testing remote LANs, an HP 4971S can download programs via an RS-232C link to another HP 4971S for troubleshooting a LAN in a distant location. The HP 4971S provides a comprehensive, easy-to-use, troubleshooting tool for maintaining a local area network.

**Features:**

- Analysis of IEEE 802.3 and Ethernet data frames
- Generation of data frames
- Softkey-guided programming for user created applications
- High level naming of node addresses
- Flexible display formats
- Up to 20 Mbyte of fixed disc storage
- Full remote operation
- Printer output
- Softkey guided measurements

<table>
<thead>
<tr>
<th>HP 4971S</th>
<th>HP 4971A</th>
</tr>
</thead>
<tbody>
<tr>
<td>VS</td>
<td>LAN Protocol Analyzer</td>
</tr>
<tr>
<td></td>
<td>Disc Drive</td>
</tr>
</tbody>
</table>

In order to be a stand-alone operating system, the HP 4971S must consist of:

- Display
- Keyboard

You may also use a printer to get hard copies of displays and copies of setup functions defined for the HP 4971S.

The HP 4971A term applies directly to the instrument portion of the HP 4971S system. The HP 4971A consists of an instrument package containing a microprocessor board and related hardware measurement boards.
# HP 4971S Operating Specifications

<table>
<thead>
<tr>
<th>Protocols</th>
<th>IEEE 802.3, Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interfaces</td>
<td>IEEE 802.3, Ethernet, and other Ethernet compatible interfaces. The HP 4971S will only support media access units (MAUs) using receive-based collision detection conforming to IEEE 802.3 or Ethernet 2.0 standards.</td>
</tr>
<tr>
<td>Data Transfer Rate</td>
<td>10 Mbps.</td>
</tr>
<tr>
<td>Data Codes</td>
<td>ASCII 7,8 and EBCDIC.</td>
</tr>
<tr>
<td>Data Formats</td>
<td>IEEE 802.2, IEEE 802.3, and Ethernet frame formats.</td>
</tr>
<tr>
<td>Capture Buffer Memory</td>
<td>One Mbyte memory for incoming data that has passed the filtering process. In terms of actual frame capacity, typically storage of 655 frames independent of frame length within the IEEE 802.3 and Ethernet specifications.</td>
</tr>
<tr>
<td>Mass Storage</td>
<td>Two 3 1/2 inch external microfloppy discs (1420 kbytes) or a single 710 Kbyte 3 1/2 inch external floppy disc and up to 20 Mbyte on an external hard disc for storage of programs, data and configurations.</td>
</tr>
<tr>
<td>Node Names</td>
<td>User definable names for up to 500 network addresses.</td>
</tr>
<tr>
<td>Filters</td>
<td>Sixteen filters with 14 trigger bytes defined for addresses and type or length field and 47 non-contiguous user-definable trigger bytes.</td>
</tr>
<tr>
<td>Timers</td>
<td>Maximum 1.5 days for timestamping. For event timing, maximum 3 hours per interval, maximum accumulation to 1.5 days.</td>
</tr>
<tr>
<td>Counters</td>
<td>Sixteen each with a maximum count of 99,999,999.</td>
</tr>
</tbody>
</table>
## Product Information

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Stamping</strong></td>
<td>Timestamp for each incoming frame accurate to 32 microseconds. Displayed as time of day, time from start of monitor, time between frames, time from triggered event, and time from specified captured frame.</td>
</tr>
<tr>
<td><strong>Transmitter Performance</strong></td>
<td>Typically responds to an incoming frame within 10 milliseconds. Define and transmit messages from 5 to 2026 bytes including frame check sequence.</td>
</tr>
<tr>
<td><strong>Receiver Performance</strong></td>
<td>In monitor mode, captures and displays all frames within Ethernet or IEEE 802.3 specifications.</td>
</tr>
<tr>
<td><strong>Traffic Generation</strong></td>
<td>Using maximum legal frame length (1518 bytes), 90% network loading can be achieved.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>A 12 inch external monochromatic display with 80 characters on 25 lines.</td>
</tr>
<tr>
<td><strong>Printer Support</strong></td>
<td>Supports HP 2225A ThinkJet printer via HP-IB interface.</td>
</tr>
<tr>
<td><strong>Remote RS-232C Interface</strong></td>
<td>Supports data rates from 300 bps to 9600 bps.</td>
</tr>
<tr>
<td><strong>Self-Test</strong></td>
<td>Extensive self-test and functional verification routines isolate failures to the field replaceable unit.</td>
</tr>
</tbody>
</table>
HP 4971S Specifications

SAFETY CLASSIFICATION

This is a Safety Class 1 instrument system (provided with terminal for protective grounding).

DIMENSIONS

<table>
<thead>
<tr>
<th>Model</th>
<th>Height</th>
<th>Width</th>
<th>Depth</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument 4971A</td>
<td>19.1 cm</td>
<td>42.6 cm</td>
<td>37.7 cm</td>
<td>9.5 kg</td>
</tr>
<tr>
<td></td>
<td>7.5 in</td>
<td>16.8 in</td>
<td>25.75 in</td>
<td>21. lb</td>
</tr>
<tr>
<td>Display 35731B</td>
<td>33.2 cm</td>
<td>34.0 cm</td>
<td>34.0 cm</td>
<td>10.0 kg</td>
</tr>
<tr>
<td></td>
<td>13.1 in</td>
<td>13.4 in</td>
<td>13.4 in</td>
<td>22.0 lb</td>
</tr>
<tr>
<td>Disc Drive 9122D</td>
<td>76.0 cm</td>
<td>32.5 cm</td>
<td>28.5 cm</td>
<td>4.5 kg</td>
</tr>
<tr>
<td></td>
<td>2.99 in</td>
<td>12.8 in</td>
<td>11.2 in</td>
<td>10.0 lb</td>
</tr>
<tr>
<td>9133H</td>
<td>13.2 cm</td>
<td>32.5 cm</td>
<td>28.5 cm</td>
<td>9.0 kg</td>
</tr>
<tr>
<td></td>
<td>5.2 in</td>
<td>12.8 in</td>
<td>11.2 in</td>
<td>20.0 lb</td>
</tr>
<tr>
<td>9153A</td>
<td>10.6 cm</td>
<td>32.5 cm</td>
<td>28.5 cm</td>
<td>8.2 kg</td>
</tr>
<tr>
<td></td>
<td>4.1 in</td>
<td>12.8 in</td>
<td>11.2 in</td>
<td>18.0 lb</td>
</tr>
<tr>
<td>Printer 2225A</td>
<td>8.9 cm</td>
<td>29.2 cm</td>
<td>20.6 cm</td>
<td>3.4 kg</td>
</tr>
<tr>
<td></td>
<td>3.5 in</td>
<td>11.5 in</td>
<td>8.1 in</td>
<td>7.4 lb</td>
</tr>
</tbody>
</table>
## TEMPERATURE

<table>
<thead>
<tr>
<th>State</th>
<th>Operating Range</th>
<th>Non-operating Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>10° C to +40° C</td>
<td>10° F to +104° F</td>
</tr>
<tr>
<td>Non-operating</td>
<td>-40° C to +60° C</td>
<td>-40° F to +140° F</td>
</tr>
</tbody>
</table>

## HUMIDITY

<table>
<thead>
<tr>
<th>State</th>
<th>Operating Range</th>
<th>Non-operating Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>20% to 80%</td>
<td>(noncondensing 26° C max. wet bulb temperature)</td>
</tr>
<tr>
<td>Non-operating</td>
<td>8% to 80%</td>
<td>(noncondensing)</td>
</tr>
</tbody>
</table>

## ALTITUDE

<table>
<thead>
<tr>
<th>State</th>
<th>Operating Range</th>
<th>Non-operating Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>0 to 4572 m</td>
<td>(0 to 15,000 ft)</td>
</tr>
<tr>
<td>Non-operating</td>
<td>0 to 15,240 m</td>
<td>(0 to 50,000 ft)</td>
</tr>
</tbody>
</table>
### POWER REQUIREMENTS

<table>
<thead>
<tr>
<th>Model</th>
<th>Line Volts (Vac)</th>
<th>Line Freq (Hz) (Single Phase)</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Instrument</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4971A</td>
<td>90-125</td>
<td>48-66 hz</td>
<td>200 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35731B</td>
<td>90-125</td>
<td>48-66</td>
<td>50 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disc Drive</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9122D</td>
<td>90-125</td>
<td>48-66</td>
<td>67 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9133H</td>
<td>90-125</td>
<td>48-66</td>
<td>125 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9153A</td>
<td>90-125</td>
<td>48-66</td>
<td>100 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Printer</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2225A</td>
<td>90-125</td>
<td>48-66 (max non-print)</td>
<td>2 W</td>
</tr>
<tr>
<td></td>
<td>195-250</td>
<td>(max printing)</td>
<td>17 W</td>
</tr>
</tbody>
</table>

**Note**

The HP 4971S system is designed to run at the voltage ranges of either 90-125 Vac or 195-250 Vac. Some devices used in the HP 4971S system have wider operating ranges than 90-125 Vac or 195-250 Vac. However, these ranges are the maximum for the system.
# Accessories Available For The HP 4971S

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>92254A</td>
<td>6 meter AUI cable</td>
</tr>
<tr>
<td>92254B</td>
<td>12 meter AUI cable</td>
</tr>
<tr>
<td>92254C</td>
<td>24 meter AUI cable</td>
</tr>
<tr>
<td>92254D</td>
<td>48 meter AUI cable</td>
</tr>
<tr>
<td>30241A</td>
<td>Media Access Unit &amp; Cable Tap</td>
</tr>
<tr>
<td>92256C</td>
<td>MAU Tap Installation Kit</td>
</tr>
<tr>
<td>10833A</td>
<td>1 meter HP-IB cable</td>
</tr>
<tr>
<td>10833B</td>
<td>2 meter HP-IB cable</td>
</tr>
<tr>
<td>10833C</td>
<td>4 meter HP-IB cable</td>
</tr>
<tr>
<td>92192A</td>
<td>Double sided Microfloppy Discs</td>
</tr>
<tr>
<td></td>
<td>Box of 10</td>
</tr>
<tr>
<td>92261A</td>
<td>ThinkJet print head ink cartridge</td>
</tr>
<tr>
<td>92261L</td>
<td>ThinkJet paper, 1000 sheets</td>
</tr>
<tr>
<td>92261S</td>
<td>ThinkJet printer stand</td>
</tr>
<tr>
<td>18213A</td>
<td>HP 4971A Carrying Case</td>
</tr>
<tr>
<td>18214A</td>
<td>Carrying case for CRT, keyboard and HP 9122D</td>
</tr>
<tr>
<td>1008A Opt.006</td>
<td>Cart</td>
</tr>
<tr>
<td>19500B</td>
<td>Disc Drive Rack Mount Adapter Kit</td>
</tr>
<tr>
<td></td>
<td>HP 9122D, 9133H/9153A</td>
</tr>
</tbody>
</table>
Recommended Peripherals For The HP 4971S

**DISPLAY**

For local operation, an HP 4971S must have a display. All displays have 12 inch monochrome CRTs with built-in tilt and swivel. The different display models provide the appropriate power cord for the country indicated.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Description</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>35731BB</td>
<td>Display with power cord</td>
<td>-European Continent</td>
</tr>
<tr>
<td>35731BM</td>
<td>Display with power cord</td>
<td>-U.S./Canada</td>
</tr>
<tr>
<td>35731BQ</td>
<td>Display with power cord</td>
<td>-Switzerland</td>
</tr>
<tr>
<td>35731BU</td>
<td>Display with power cord</td>
<td>-United Kingdom</td>
</tr>
<tr>
<td>35731BY</td>
<td>Display with power cord</td>
<td>-Denmark</td>
</tr>
<tr>
<td>35731BK</td>
<td>Display without power cord</td>
<td></td>
</tr>
</tbody>
</table>

**KEYBOARD**

For local operation, a station must have a keyboard.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>46021A</td>
<td>U.S. keyboard</td>
</tr>
</tbody>
</table>

**DISC DRIVE**

The HP 4971S must have a disc drive to operate. Software is only distributed on 3 1/2 inch, double sided, floppy discs. A disc can also be used to store data collected from the network as well as programs and other configuration information.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9122D</td>
<td>Dual double sided 3 1/2 inch floppy disc drive</td>
</tr>
<tr>
<td>9153A</td>
<td>10 Mb Winchester and 3 1/2 inch floppy drive</td>
</tr>
<tr>
<td>9133H</td>
<td>20 Mb Winchester and 3 1/2 inch floppy drive</td>
</tr>
</tbody>
</table>

**PRINTER**

A printer may be selected for output purposes on the HP 4971S. The HP 4971S supports printing of selected data from the its buffer, programs and other configuration information.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2225A</td>
<td>150 cps, ThinkJet Printer</td>
</tr>
</tbody>
</table>
Product Information

**Accessories Supplied With The HP 4971A**

For a HP 4971S to be a stand-alone operating system, a keyboard, display monitor, and disc drive are needed in addition to the HP 4971A instrument.

The standard HP 4971A consists of the components listed below.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4971A    | 1        | LAN Protocol Analyzer Instrument  
                        | also includes: 2 meter HP-IB cable  
                        | Keyboard cable  
                        | Audio cable  
                        | Power cord  
                        | System software discs  
                        | Tutorial disc  
                        | Operating Manual |
| 92192A   | 1        | Box of ten 3 1/2 inch floppy discs |
Options Available For The HP 4971A

Several options are available that apply directly to the HP 4971A instrument. These options are listed below:

<table>
<thead>
<tr>
<th>Option Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Video Interface Card &amp; Cable. (Must be ordered if monitor is to be used.)</td>
</tr>
<tr>
<td>002</td>
<td>RS-232C Remote Communications Interface Includes DTE (male) cable (Requires 1 each for each master and slave station)</td>
</tr>
<tr>
<td>200</td>
<td>Additional 256 kbyte of system memory</td>
</tr>
<tr>
<td>210</td>
<td>Additional 1 Mbyte of system memory (Maximum of two additional memory cards per system.)</td>
</tr>
<tr>
<td>908</td>
<td>HP 4971A Rack Mount Kit</td>
</tr>
<tr>
<td>915</td>
<td>Hardware Support Manual</td>
</tr>
<tr>
<td>916</td>
<td>Additional Operating Manual</td>
</tr>
<tr>
<td>W03</td>
<td>Convert 1 year return-to-HP warranty to 90 day on-site repair</td>
</tr>
</tbody>
</table>
Support Services Available

SOFTWARE SUPPORT

<table>
<thead>
<tr>
<th>HP Part No.</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4971A +N00  | Software Notification Service (SNS)  
Includes periodic distribution of applications and update/upgrade information. |

HARDWARE SUPPORT

On-site hardware support is available for the HP 4971A, the specified disc drives, the specified displays, and the printer. The following list shows the types of hardware support service available.

<table>
<thead>
<tr>
<th>Category</th>
<th>Place of Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSMS</td>
<td>Basic System Maintenance Service</td>
</tr>
<tr>
<td></td>
<td>Next day, on site.</td>
</tr>
<tr>
<td>SMMS</td>
<td>Standard Monthly Maintenance Service</td>
</tr>
<tr>
<td></td>
<td>Four hours, on site.</td>
</tr>
<tr>
<td>FMMC</td>
<td>Field Monthly Maintenance Charge</td>
</tr>
<tr>
<td></td>
<td>Return to HP.</td>
</tr>
</tbody>
</table>
You can install the HP 4971S LAN Protocol Analyzer yourself or, if assistance is needed, contact your local HP Sales and Service office.

This section contains information about site requirements and preparation needed to install the HP 4971S LAN Protocol Analyzer.

This chapter includes:

- Operating Environment Requirements
  - Temperature
  - Humidity
  - Altitude
  - Space
  - Power
- Initial Inspection
  - Claims for Damage
  - Storage and Shipment
  - Repackaging for Shipment
### Operating Environment Requirements

#### TEMPERATURE REQUIREMENTS

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>10°C to +40°C</td>
<td>-40°C to +60°C</td>
</tr>
<tr>
<td>Non-operating</td>
<td>(+50°F to +104°F)</td>
<td>(-40°F to +140°F)</td>
</tr>
</tbody>
</table>

#### HUMIDITY REQUIREMENTS

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>20% to 80%</td>
<td>8% to 80%</td>
</tr>
<tr>
<td>Non-operating</td>
<td>(non-condensing)</td>
<td>(non-condensing)</td>
</tr>
</tbody>
</table>

#### ALTITUDE REQUIREMENTS

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>0 to 4572 m</td>
<td>0 to 15,240 m</td>
</tr>
<tr>
<td>Non-operating</td>
<td>(0 to 15,000 ft)</td>
<td>(0 to 50,000 ft)</td>
</tr>
</tbody>
</table>
SPACE REQUIREMENTS

HP 4971A Instrument
Position your HP 4971A instrument so there is at least 6 cm (2.5 in) of clearance on the left side. The fan draws cooling air into the left side near the back and exhausts the air at the left side near the front. Ensure that there is an unrestricted supply of cool air to the intake holes.

Allow at least 15 cm (6 inches) of clearance beyond the back cover of the HP 4971A for cable connections. If pressure is exerted against the instrument-end of these cables, the connectors could be damaged. No top, bottom, or right side clearance is required for the mainframe.

Disc Drive
Position your disc drive so there is at least 6 cm (2.5 inches) of clearance at the front and back. The fan for the disc drives draws cooling air in from the front and exhausts the air at the back. Ensure that there is an unrestricted supply of cool air to the intake holes.

Printer
The ThinkJet printer is designed to print on single sheet or fanfold paper. If fanfold paper is used, provide space below or behind the printer for the paper supply. Also, provide space behind the printer for the printed paper output.
POWER REQUIREMENTS

The total power requirement for your HP 4971S system will vary depending on what components your system has. The following list shows what power is required for each of the primary components.

<table>
<thead>
<tr>
<th>HP Model</th>
<th>Line Volts (Vac)</th>
<th>Line Freq (Hz) (Single Phase)</th>
<th>Power max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument</td>
<td>4971A</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>35731B</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td></td>
</tr>
<tr>
<td>Disc Drive</td>
<td>9122D</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9133H</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9153A</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td></td>
</tr>
<tr>
<td>Printer</td>
<td>2225A</td>
<td>90-125</td>
<td>48-66</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195-250</td>
<td>(max non-print)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(max printing)</td>
</tr>
</tbody>
</table>
Initial Inspection

To avoid hazardous electrical shock, do not perform electrical tests when there are signs of shipping damage to any portion of the instrument.

Inspect the shipping containers for damage. If the shipping containers or packaging materials are damaged, they should be kept until the contents of the shipment have been checked for completeness and the instruments have been checked mechanically and electrically. The contents of the shipment should be as listed in the Accessories Supplied and Accessories Available portions of Section 1. If the contents are incomplete, or if there is mechanical damage or defect, notify the nearest Hewlett-Packard office. If either the shipping containers are damaged or the packaging materials show signs of stress, notify the carrier as well as the Hewlett-Packard office. Keep the shipping materials for the carrier’s inspection. The HP office will arrange for repair or replacement without waiting for claim settlement.

CLAIMS FOR DAMAGE

If physical damage is evident or if the instrument does not meet specifications when received, notify the carrier and replace the nearest Hewlett-Packard Sales/Service Office. The sales/service office will arrange for repair or replacement of the unit without waiting for settlement of the claim against the carrier.

STORAGE AND SHIPMENT

The HP 4971S LAN Protocol Analyzer may be stored and shipped in environments that do not exceed the following limits:

- Temperature: -40°C to +60°C (-40°F to +140°F)
- Humidity: <8% or >80% (non-condensing, 26°C max. wet bulb temperature)
- Altitude: 15,240 meters (50,000 ft)

The instrument should be protected from temperature extremes that would cause condensation in the instrument.
REPACKAGING FOR SHIPMENT

Original packaging i.e., the containers and materials identical to those used in factory packaging are available from Hewlett-Packard. If the unit is being returned to Hewlett-Packard for servicing, attach a tag indicating the type of servicing required, return address, model number, and full serial number. Mark the container FRAGILE. In any correspondence, refer to the instrument by model number and full serial number.

If other packaging is to be used, the following general instructions for repackaging with commercially available materials should be followed:

a. Wrap the instrument in heavy paper or plastic. If you are shipping the unit to a Hewlett-Packard office or service center be sure to attach a tag to the instrument indicating the type of service required, return address, model number and full serial number.

b. Use a strong shipping container. A double wall carton made of 2.4 MPa (350 psi) test material is adequate.

c. Use a layer of shock absorbing material 75 to 100 mm (3 to 4 in.) thick around all sides of the instrument to provide firm cushioning and prevent movement inside the container. Protect the control panel with cardboard.

d. Seal the shipping container securely.

e. Mark the shipping container FRAGILE to insure careful handling.

f. In any correspondence, refer to instrument by model number and full serial number.
This chapter tells you how to install your HP 4971S LAN Protocol Analyzer system. Instructions are given for each of the standard and optional devices that may be used. Where additional specific details are available for the different devices, directions are given to let you know where to find the more detailed information in each of the system device manuals.

This chapter includes:

- Identify The System Parts
- Position The System
- Check Line Voltage Select Switches
- Check Line Fuses
- Connect Power Cords
- Install The Keyboard
- Install The Display
- Install The HP-IB Cables
- Turn On Your System
- Connect The HP 4971S To Your Network Cable
- Identify Accessory Slots
- Optional Memory Board Address Switches
Figure 4-1. HP 4971S System Devices.
Identify The System Parts

The HP 4971S LAN Protocol Analyzer consists of several separate devices. Fold out the previous page and familiarize yourself with the system parts. Find each part in your system as you look over the following list.

**Power Switches**
These are the switches you use to turn power on and off. Power indicators on the display and HP 4971A instrument light when power is on. Never plug or unplug a device with the power on.

**Voltage Select Switches**
The HP 4971S system is designed to run at the voltage ranges of either 90-125 Vac or 195-250 Vac. The line frequency range is 48-66 Hz.

**Note**
Some devices used in the HP 4971S system have wider operating voltage ranges than 90-125 Vac or 195-250 Vac. These ranges are the maximum for the system.

**Power Sockets**
The power sockets are especially designed for an HP power cord. Table 4-2 shows the power cord configurations and part numbers.

**Display Interface**
This interface provides the connection for the display.

**Keyboard/HP-IB Interface**
This interface provides connections for the keyboard and for HP-IB peripherals.

**Fuses**
A properly rated fuse must be installed in each device for your system to operate safely. The correct fuse rating depends on the input voltage.

**Fans**
The mainframe and disc drive each have small built-in fans to keep the devices cool. These fans should always be running when the power is on.
Installing The HP 4971S System

**Position the System**

Several of the devices in the HP 4971S system require consideration for air flow for cooling or for operation. This section describes how to position the devices in your system.

| **HP 4971A Instrument** | Place the mainframe of your system on a flat level surface. Position it so there is at least 6 cm (2.5 inches) of clearance on the left side. The fan draws cooling air into the left side near the back and exhausts the air at the left side near the front. Ensure that there is an unrestricted supply of cool air to the intake holes. Allow at least 15 cm (6 inches) of clearance beyond the back cover of the HP 4971A instrument for cable connections. If pressure is exerted against the instrument-end of these cables, the connectors could be damaged. No top, bottom, or right side clearance is required. |
| **Disc Drive** | Position your disc drive so there is at least 6 cm (2.5 inches) of clearance at the front and back. The fan for the disc drive draws cooling air in from the front and exhausts the air at the back. Ensure that there is an unrestricted supply of cool air to the intake holes. |
| **Display** | The display should be placed so the ventilation holes at the top, bottom, and sides are not obstructed. To avoid obstructing the air vents in the bottom of the display housing, do not locate the monitor on a felt pad or other soft surface. |
| **Printer** | The HP 2225A ThinkJet printer prints on single sheet or fan fold paper. If fan fold paper is used, the paper supply feeds in from the rear. You should provide space behind or below the printer for the paper supply. The printer outputs pages to the rear. |
Check Line Voltage Select Switches

Each device in your system has its own line voltage select switch. Check each device as described below to verify that the switch is in the correct position. Always disconnect the power cord from the device before setting the power select switch.

Detailed instructions and illustrations are available in each of the separate device manuals for the HP 4971S system. Refer to the installation section in each separate manual if additional details are needed.

CAUTION

DEVICES IN YOUR SYSTEM CAN BE DAMAGED IF SET FOR THE LOWER VOLTAGE RANGE AND PLUGGED INTO A HIGHER VOLTAGE.

**HP 4971A**

The instrument line voltage select switch is at the upper left corner of the rear panel.

**Disc Drive**

The line voltage select switches for the 9122D, 9133H, and 9153A Disc Drives, recommended for use with the HP 4971S, are located on the rear panel of each disc drive near the power socket.

**Display**

The HP 35731Bx* Display line voltage select switch is at the lower center of the rear panel.

Bx* Bx refers to displays in the HP 35731B family: BB, BM, BQ, BU, or BY.
The power receptacle box on the rear panel of the 2225A Printer contains a voltage selector drum for selecting one of four line voltages. The line voltage selections are:

- 100 VAC 50-60 Hz
- 120 VAC 50-60 Hz
- 220 VAC 50-60 Hz
- 240 VAC 50-60 Hz

To select a line voltage:

1. Remove the power cord from the printer.
2. Open the cover of the fuse box with a small screwdriver. The cover closes tightly but will yield to firm pressure.
3. Pull out the voltage selector drum.
4. Rotate the voltage selector drum until the setting that corresponds to the line voltage in your area faces out, and insert the drum back into its slot. Do not force the voltage selector drum into the slot. If it is turned upside down, it will not fit.

Additional information and figures are available in Appendix C, 'Changing the Fuse or Line Voltage', of the HP 2225A ThinkJet Printer Reference Manual.
Check Line Fuses

Each of the devices in the HP 4971S system that have a separate power cord also have a line fuse. Check each of the devices as described below to ensure you have the correct fuse installed.

Table 4-1 lists the line fuses required for all the devices recommended for use with the HP 4971S system.

WARNING

DO NOT CHECK OR CHANGE ANY FUSE UNLESS POWER IS DISCONNECTED FROM THAT DEVICE.
Installing The HP 4971S System

<table>
<thead>
<tr>
<th>MODEL</th>
<th>VOLTAGE SETTING</th>
<th>VOLTAGE RANGE (Vac)</th>
<th>REQUIRED FUSE</th>
<th>FUSE PART NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4971A</td>
<td>115</td>
<td>90-125</td>
<td>5.0 Amp/250</td>
<td>2110-0010</td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>195-250</td>
<td>2.5 Amp/250</td>
<td>2110-0083</td>
</tr>
<tr>
<td>Display</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35731Bx</td>
<td>115</td>
<td>90-125</td>
<td>Internal, not replaceable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>195-250</td>
<td>Internal, not replaceable</td>
<td></td>
</tr>
<tr>
<td>Disc Drive</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9122D</td>
<td>115</td>
<td>90-125</td>
<td>1.0 Amp/250</td>
<td>2110-0001</td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>195-250</td>
<td>0.5 Amp/250</td>
<td>2110-0012</td>
</tr>
<tr>
<td>9133H</td>
<td>115</td>
<td>90-125</td>
<td>3.0 Amp/250</td>
<td>2110-0003</td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>195-250</td>
<td>3.0 Amp/250</td>
<td>2110-0003</td>
</tr>
<tr>
<td>9153A</td>
<td>115</td>
<td>90-125</td>
<td>2.0 Amp/250</td>
<td>2110-0002</td>
</tr>
<tr>
<td></td>
<td>230</td>
<td>195-250</td>
<td>1.0 Amp/250</td>
<td>2110-0001</td>
</tr>
<tr>
<td>Printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2225A</td>
<td>100</td>
<td>100</td>
<td>0.5 Amp TD</td>
<td>2110-0621</td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>120</td>
<td>0.4 Amp TD</td>
<td>2110-0340</td>
</tr>
<tr>
<td></td>
<td>220</td>
<td>220</td>
<td>0.25 Amp TD</td>
<td>2110-0489</td>
</tr>
<tr>
<td></td>
<td>240</td>
<td>240</td>
<td>0.2 Amp TD</td>
<td>2110-0588</td>
</tr>
</tbody>
</table>

Table 4-1.Fuse Cross Reference For HP 4971S System.

4-8
FUSE LOCATIONS

HP 4971A
The HP 4971A instrument fuse holder is located at the lower left corner of the rear panel. To remove the fuse holder, press in on it and turn counterclockwise.

Additional fuse figures are available in Chapter 2, "Installing Your Computer," of the Model 220 Installation Guide.

Disc Drive Fuse

9122D
The HP 9122D Disc Drive fuseholder is located at the lower right corner of the rear panel. To remove the fuseholder, press in and turn counterclockwise. Check that you have the correct fuse installed.


9133 H
The fuse holder for the HP 9133H Disc Drive is located at the lower right corner of the rear panel. To remove the fuse holder, press in and turn counterclockwise.

Additional fuse information is available in Chapter 1, "Essentials," of the HP 9133H Operator’s Manual.

9153A
The fuse holder for the HP 9153A Disc Drive is located at the lower right corner of the rear panel. To remove the fuseholder, press in and turn counterclockwise. Check that you have the correct fuse installed.

A figure for fuse location is available in Chapter 1, "Essentials," of the HP 9153A Operator’s Manual.
Installing The HP 4971S System

Display

The display has no external line fuse. The line voltage select switch selects between two fuses mounted internally in the 35731B. The fuses are soldered in the circuitry and are not field replaceable.

Bx Bx refers to any display monitor in the HP 35731B family: BB, BM, BQ, BU or BY.

Printer

The line fuse for the HP 2225A ThinkJet printer is located inside the power socket assembly. The fuse is behind the cover of the power socket. The fuse is in a carrier which slides into a cavity in the fuse box. There are two cavities for fuse carriers; one above the other. The fuse to be connected into the line circuit must be mounted in the upper cavity. The fuse size depends on the line voltage selected.

Additional fuse information is available in Appendix C, "Changing the Fuse or Line Voltage," in the HP 2225A Reference Manual.
Connect The Power Cords

This section describes how to connect the power cord from your HP 4971S system devices to a power outlet.

On each device, connect the power cord to that device and then connect the other end to the power outlet.

---

**WARNING**

IF A REPLACEMENT POWER CORD IS NEEDED, MAKE SURE YOU ORDER AN HP POWER CORD THAT IS IDENTICAL TO THE ORIGINAL. OTHERWISE, ELECTRICAL SHOCK OR EQUIPMENT DAMAGE MAY RESULT.

---

**WARNING**

Before applying power to an instrument, you must ensure that the chassis is properly grounded. This precaution is necessary to avoid the possibility of injury or death which may result if the protective ground is defeated. The devices used in an HP 4971S system are provided with a 3-wire power cord. When this cord is connected to an appropriate AC power receptacle, it provides a ground for the instrument cabinet.

---

The type of power cord shipped with each instrument depends on the country of destination. Table 4-2 describes the power cords and their applications. Figure 4-2 illustrates the location of each power cord socket on the HP 4971S.
## Installing The HP 4971S System

<table>
<thead>
<tr>
<th>Plug Type</th>
<th>Cable HP Part Number</th>
<th>C/D</th>
<th>Plug Description</th>
<th>Cable Length (inches)</th>
<th>Cable Color</th>
<th>For Use In Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>250V</td>
<td>8120-1351 8120-1703</td>
<td>0</td>
<td>Straight *BS1363A 90°</td>
<td>90</td>
<td>Mint Gray Mint Gray</td>
<td>United Kingdom, Cyprus, Nigeria, Rhodesia, Singapore</td>
</tr>
<tr>
<td></td>
<td>8120-1369 8120-0696</td>
<td>0</td>
<td>Straight *NZS1900/AS5112 90°</td>
<td>79</td>
<td>Gray Gray</td>
<td>Australia, New Zealand</td>
</tr>
<tr>
<td>250V</td>
<td>8120-1689 8120-1692</td>
<td>7</td>
<td>Straight *CEE7-Y11 90°</td>
<td>79</td>
<td>Mint Gray Mint Gray</td>
<td>East and West Europe, Saudi Arabia, Egypt, So. Africa, India (unpolarized in many nations)</td>
</tr>
<tr>
<td></td>
<td>8120-1348 8120-1398</td>
<td>5</td>
<td>Straight *NEMA5-15P 90°</td>
<td>80</td>
<td>Black Black</td>
<td>United States, Canada, Japan 100V or 200V, Mexico, Philippines, Taiwan</td>
</tr>
<tr>
<td></td>
<td>8120-1278 8120-1521</td>
<td>6</td>
<td>Straight *NEMA5-15P 90°</td>
<td>80</td>
<td>Jade Gray Jade Gray</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8120-1676</td>
<td>2</td>
<td>Straight *NEMA5-15P 90°</td>
<td>36</td>
<td>Jade Gray Jade Gray</td>
<td></td>
</tr>
<tr>
<td>250V</td>
<td>8120-2104</td>
<td>3</td>
<td>Straight *SEV1011 1959-24507 Type 12</td>
<td>79</td>
<td>Gray Gray</td>
<td>Switzerland</td>
</tr>
<tr>
<td></td>
<td>8120-0698</td>
<td>6</td>
<td>Straight *NEMA6-15P</td>
<td></td>
<td></td>
<td>United States, Canada</td>
</tr>
<tr>
<td>220V</td>
<td>8120-1957 8120-2956</td>
<td>2</td>
<td>Straight *DHCK 107 90°</td>
<td>79</td>
<td>Gray Gray</td>
<td>Denmark</td>
</tr>
<tr>
<td></td>
<td>8120-1860</td>
<td>6</td>
<td>Straight *CEE22 VI</td>
<td></td>
<td></td>
<td>Systems Cabinet use</td>
</tr>
<tr>
<td>250V</td>
<td>8120-4600 8120-4211</td>
<td>8</td>
<td>Straight BS 546/SABS 164 90°</td>
<td>98</td>
<td>Black Black</td>
<td>So. Africa, India</td>
</tr>
</tbody>
</table>

*Part number shown for plug is industry identifier for plug only. Number shown for cable is HP Part Number for complete cable including plug.

E = Earth Ground, L = Line, N = Neutral.

Table 4-2. Hewlett-Packard Power Cords.
Figure 4-2. Connecting HP 4971S Power Cords.
Installing The HP 4971S System

Install The Keyboard

Use the following procedure to connect the keyboard to the Keyboard/HP-IB Interface card.

Procedure:

1. Turn off all system power switches.

2. Connect the keyboard cable end with one dot to the back of the keyboard in the slot with one dot.

   \begin{center}
   \textbf{CAUTION}
   \end{center}

   The coiled cable connecting the keyboard to the Keyboard/HP-IB Interface card has polarized connectors at both ends. Do not use excessive force to plug the cable into the sockets.

3. Connect the end of the keyboard cable with two dots to the the back of the Keyboard/HP-IB Interface card.
Figure 4-3. Connecting The Keyboard Cable.
Installing The HP 4971S System

Install The Display

The HP 35731Bx Display connects to the Composite Video Interface connector on the rear panel of the HP 4971A instrument. A speaker can also be connected to the Keyboard/HP-IB Interface card.

Use the following procedure to connect the video cable and audio cable to the display.

Procedure:

**VIDEO CABLE**

1. Check that the HP 4971A instrument power switch is set to the off position.
2. Connect one end of the video cable to the HP 35731Bx Display.
3. Connect the other end of the video cable to the Composite Video Interface.

**AUDIO CABLE**

4. Connect one end of the audio cable to the SPEAKER connector on the back of the Keyboard/HP-IB Interface card.
5. Connect the other end of the audio cable to the audio connector on the back of the display.
Figure 4-4. Connecting the Monitor Cables.
Installing The HP 4971S System

Install The HP-IB Cables

Some of the HP 4971S system devices are connected to the HP 4971A instrument via HP-IB cables. Figure 4-5 shows the HP-IB cable connections.

DISC DRIVE

1. Connect an HP-IB cable from the HP 4971A instrument connector to the disc drive connector.

PRINTER

1. If your system has a printer, connect an HP-IB cable from the HP 4971A instrument connector to the printer HP-IB connector.
Figure 4-5. Installing The HP-IB Cable(s).
Installing The HP 4971S System

Turn On Your System

Turn on each of your system devices with it’s separate power switch. Verify that the power indicator lights are ON and the fans on the disc drive and HP 4971A are operating. If the fans run and the indicator lights are on, you have successfully installed your HP 4971S system.

Problems?

If all or part of your system does not turn on, check the following:

1. Is the power switch to each device set to the ON position?
2. Is the power cord firmly plugged into each device of the system?
3. Is power present at the power outlet?

If your answered "yes" to all three questions, replace the fuse in the component(s) that fail(s) to power on and try again to turn on the system. If it still does not turn on, contact your HP Service Representative.

Note

Loading the system software into the HP 4971S is described in the "Getting Started" section. Before getting to that point however, the HP 4971S should be connected to your Local Area Network (LAN). This procedure is described on the next page, "Connect The HP 4971S To Your Network Cable".
Connect The HP 4971S To Your Network Cable

In order to interface the system with your local area network, the HP 4971S must be connected to your network cable. The method for this connection varies depending on what network type you are using. With IEEE 802.3 and Ethernet systems, the connection is made through an Access Unit Interface (AUI) cable to a Media Access Unit (MAU). The MAU provides a physical connection to the local area network cable. With a Cheapernet system, connection can be made directly from the HP 4971S to a MAU adapter on the Cheapernet local area network cable.

There are two kits recommended to help you connect your HP 4971S to your network: HP 30241A MAU & Cable Tap and HP 92256C MAU & Tap Installation Kit.

Follow the instructions included with each of the kits. Remember to observe the following guidelines:

1. The cable must be properly terminated with N-series terminators.

2. The minimum distance between MAUs is 2.5 meters.

3. These environmental specifications must be met:
   - temperature 0 - 50°C
   - humidity 5 - 95% relative humidity

4. The power dissipation is 15.75 Vdc max, .5 Amp max, 6 Watts max.

5. Do not connect the HP 4971S or the above mentioned installation kits to an ungrounded network coaxial cable.

6. Cover all N-series connectors with a rubber boot. Inadvertent grounding to building grounds such as an exposed metal building structure or metal cable tray can damage the network components or cause the network to fail (except the grounded end of the coaxial cable).
Identify Accessory Slots

The HP 4971A instrument has 16 accessory slots as shown in Figure 4-6. The following list shows the assigned locations for boards used in the HP 4971A.

Slot 1  -  Restricted
Slot 2  -  Restricted
Slot 3  -  Dual Port Memory.
Slot 4  -  Deep Trap
Slot 5  -  Shallow Trap
Slot 6  -  LAN Receiver
Slot 7  -  LAN Transmitter
Slot 8  -  Restricted

Slot 9  -  Memory Card (Standard, 1 Mbyte)
Slot 10 -  RS-232 Remote Communication Interface (Option 002)  
           (Select Code 20)
Slot 11 -  Memory Card (Standard, 256 kbyte)
Slot 12 -  Memory Card [Opt. 200 (256 kbyte) or Opt. 210 (1 mbyte)]
Slot 13 -  HP 98204A Video I/O
Slot 14 -  HP 98204A Video I/O
Slot 15 -  Memory Card [Opt. 200 (256 kbyte) or Opt. 210 (1 mbyte)]
Slot 16 -  Keyboard/HP-IB (Select Code 7)
Figure 4-6. HP 4971A Card Cage Configuration.
Installing the HP 4971S System

Optional Memory Board Address Switches

You can have up to four memory cards in your HP 4971A instrument. The standard memory of 1.256 Mbytes is composed of one HP 98257A board (1Mbyte) and one HP 98256A board (256 kbyte).

Optional memory may be added to the protocol analyzer by Option 200 (additional 256 kbytes) and/or Option 210 (additional 1 mbyte).

If you ordered your HP 4971S with Options 200 and/or 210, the address switch configuration is set at the factory.

If you add memory to a system you already have, Table 4-3 shows the address switch settings for different memory combinations.

Figure 4-7. HP 98257A and 98256A Address Switch Locations
<table>
<thead>
<tr>
<th>STAND</th>
<th>98257A BOARD</th>
<th>98256A BOARD</th>
</tr>
</thead>
<tbody>
<tr>
<td>MEMORY</td>
<td>std board</td>
<td>std board</td>
</tr>
<tr>
<td></td>
<td>std board</td>
<td>std board</td>
</tr>
<tr>
<td>ADDITIONAL MEMORY</td>
<td>std board</td>
<td>std board</td>
</tr>
<tr>
<td>Opt. 200</td>
<td>opt. 200</td>
<td>opt. 200</td>
</tr>
<tr>
<td>(256 kbyte)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDITIONAL MEMORY</td>
<td>std board</td>
<td>std board</td>
</tr>
<tr>
<td>Opt. 210</td>
<td>opt. 210</td>
<td>opt. 210</td>
</tr>
<tr>
<td>(1 Mbyte)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADDITIONAL MEMORY</td>
<td>std board</td>
<td>std board</td>
</tr>
<tr>
<td>(1.256 Mbyte)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4-3. Memory Boards Address Switch Settings.
Installing the HP 4971S System
CHAPTER 5
GETTING STARTED

This chapter explains some of the first things you should do to begin operating the HP 4971S.

In addition, a tutorial disc is supplied to introduce you to the protocol analyzer functions.

This chapter includes:

- Introduction
- Loading The System Software
  - 9122D Dual Disc Drive
  - 9133H, 9153A Winchester Drive
- Backing Up Your System Software
- Using the Top Level Menu
- Setting the Date and Time
- Using the Tutorial Disc
Getting Started

Introduction

The operating system for the HP 4971S LAN Protocol Analyzer is delivered on floppy discs. These discs must be loaded into RAM memory in the protocol analyzer before the system can function.

If your system has the HP 91220 Dual Disc Drive, go to page 5-4 for instructions to load the operating system software.

If your system has a Winchester disc drive, go to page 5-6 for instructions to load the operating system software.

SOFTWARE SUPPLIED

The HP 4971S system is delivered with several system floppy discs. The discs are labeled:

<table>
<thead>
<tr>
<th>LABEL</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>LANSYS</td>
<td>(For LAN SYStem) contains the system software.</td>
</tr>
<tr>
<td>LANCOD</td>
<td>(For LAN CODe) contains the operating code for the HP 4971S system.</td>
</tr>
<tr>
<td>HP 4971S TUTORIAL</td>
<td>is a self-paced tutorial supplied to introduce you to the basic functions of the protocol analyzer.</td>
</tr>
</tbody>
</table>
## DISC DRIVES AVAILABLE

Three models of disc drives are supported for use with your protocol analyzer. The power-up sequence depends on what model disc drive your system has. The following instructions describe the turn-on procedure for the different disc drives.

<table>
<thead>
<tr>
<th>MODEL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual Disc Drive</td>
<td></td>
</tr>
<tr>
<td>9122D</td>
<td>Dual 3 1/2&quot; floppy disc drive, 710 kbyte</td>
</tr>
<tr>
<td>Winchester Disc Drives</td>
<td></td>
</tr>
<tr>
<td>9153A</td>
<td>10 Mb Winchester and 3 1/2&quot; floppy drive</td>
</tr>
<tr>
<td>9133H</td>
<td>20 Mb Winchester and 3 1/2&quot; floppy drive</td>
</tr>
</tbody>
</table>
Loading The System Software

USING THE HP 9122D

If the disc drive with your system is the HP 9122D Dual Disc Drive, the floppy discs containing the system software must be manually loaded into the protocol analyzer memory each time the power is turned on.

The system software is contained on the floppy discs: LANSYS, and LANCOD.

The figure below shows the disc slot identification for protocol analyzer systems using the 9122D Disc Drive.

![Disc Drive Identification](image-url)

Use the following procedure to load system software into the HP 4971S Protocol Analyzer.

You should back up your operating system software. The section, Backing Up Your System Software, in this chapter, describes how to perform this operation.
Note

If the TUTORIAL disc is to be used, do not load the LANSYS and LANCOD floppy discs. Skip ahead to the "Using The Tutorial Disc" in this section.

1. Before starting, set the HP 4971S and HP 9122D Disc Drive power switches to OFF.

2. Insert the LANCOD and LANSYS floppy discs into the two disc drive slots. The discs may go into either slot.

3. Set the HP 9122D disc drive power switch to ON and then set the HP 4971S power switch to ON.

Note

If you hit a key during the self test portion of the power on cycle, the boot up process halts. To proceed, press the 1 key and then press the P key.

4. The protocol analyzer performs a self test of the mainframe at power on. After the two discs are loaded into the analyzer and the self test is complete, the Top Level Menu is displayed.

If self test passes, a status message is displayed:

    4971S power-on self-test PASSED

If the self-test fails, an error message is displayed. Refer to the <Test Hardware> section.

5. Skip ahead to Using the Top Level Menu or the TUTORIAL sections in this chapter.
Getting Started

**USING HP 9133H, 9153A WINCHESTER DISC DRIVES**

If your system uses the HP Winchester disc drives, the floppy discs containing the system software can be stored onto the hard disc, and then, the protocol analyzer will automatically boot up each time the power is turned on.

The Winchester disc drive requires more initial effort to get the system software stored than the HP 91220 Dual Disc Drive. However, after the system software is stored in the Winchester disc drive, you will have a faster power up cycle and greatly increased file storage space.

**Is the Winchester disc drive initialized?**

**WARNING**

If you reinitialize a Winchester disc that has been previously used, any existing files will be lost.

**No**
If the Winchester disc drive is being turned on for the first time, continue in this section.

**Yes**
If the Winchester disc drive has previously been turned on with your system, the hard disc has been initialized, and the operating software stored on the disc, the system should boot up automatically.

However, if for some reason, the operating system software files become corrupted, the protocol analyzer will not boot up at power on.

If you detect that the operating system files on the hard disc have become corrupted, you can easily restore the files, if the power has not been turned off. Use the "Restoring System Software" procedure in the <Disc Functions> Menu section of your Operating Manual.

If you detect that the operating system files on the hard disc have become corrupted and the power has been turned off, continue in this section to repeat the first time power on procedure.
Winchester disc drives (cont.)

The following figure shows the disc drive identification for the Winchester disc drives.

![Diagram of Winchester Disc Drive Identification]

Figure 5-2. Winchester Disc Drive Identification.

Use the following procedure to load the system software into the Winchester disc drives for the first time. Three operations are needed to permanently store the operating system software onto the hard disc:

A. Loading the operating system software for the first time.
B. Initializing the Winchester disc drive.
C. Storing the system software.
A. Loading The Operating System

The first part of this procedure loads the system software for the protocol analyzer into the HP 4971S. This is necessary before the hard disc can be initialized.

**Note**

The following procedure needs to be performed only for the first time the disc drive and HP 4971S are being turned on. It is not necessary to load the system software, initialize the hard disc, and save the system software onto hard disc each time the system is turned on.

1. Before starting to load your system software into the Winchester disc drive, set the following switches:
   A. Power switches for the disc drive and HP 4971A instrument are OFF.
   B. HP-IB switch on back of disc drive is set to 9.

2. Insert the floppy disc, LANSYS, in the disc drive slot.

3. Set the disc drive power switch to ON and then set the HP 4971A instrument power switch to ON.

   The disc drive access light should begin blinking.

**Note**

At power on, the The HP 4971A instrument performs an initial processor circuits check followed by a self test of the hardware. If you hit a key during the initial test processor portion of the power-on cycle, the boot up process halts. To proceed, press the 1 key and then press the P key.
After displaying several other status messages, the protocol analyzer displays the message:

`Loading 'LANSYS.Library.Code'`

After a few seconds, the display shows the message:

`Loading 'LANCOD: HP4971S.CODE'
cannot open 'LANCOD.HP4971S.CODE'
Logical volume not found.`

4. Remove the LANSYS floppy disc from the disc drive.
5. Insert the LANCOD floppy disc in the disc drive.
6. Enter the character `x` from the keyboard.
   The message `Load what file?` is displayed.
7. Type the characters: LANCOD:HP4971S (use all capital letters) from the keyboard and press the RETURN key.
   The message `Loading 'LANCOD.4971S.CODE'` is displayed.
8. After the LANCOD floppy disc is loaded, the Top Level Menu is displayed.
B. Initializing The Hard Disc

The following steps initialize the hard disc inside the Winchester disc drive.

The following initialization procedure creates three blank logical volumes on the hard disc. Two, 1 Mbyte volumes are used to store LANSYS and LANCOD. The remaining volume is numbered #13: (or HARDSC) and is used as storage space for Network and Data files you create.

<table>
<thead>
<tr>
<th>MODEL</th>
<th>NETWORK &amp; DATA FILE STORAGE SIZE</th>
</tr>
</thead>
<tbody>
<tr>
<td>9153A</td>
<td>8 Mbytes</td>
</tr>
<tr>
<td>9133H</td>
<td>18 Mbytes</td>
</tr>
</tbody>
</table>

9. From the Top Level Menu, press the <Disc Functions> softkey.


11. Press <Format Disc> softkey,

   The message Drive number? :__ is displayed.

12. Enter the number 11 from the keyboard and press RETURN key.

   The following message is displayed:

   (9133H)   Device: HP 9133 fixed disc, xxx,x,x
             Logical unit #11 - < no directory >

   (9153A)   Device: HP 9153 fixed disc, xxx,x,x
             Logical unit #11 - < no directory >

   Are you sure you want to proceed?

13. Press the <YES> softkey.
14. The disc drive requires several minutes to complete the initialization.

<table>
<thead>
<tr>
<th>MODEL</th>
<th>APPROXIMATE INITIALIZATION TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>9153A</td>
<td>7 minutes</td>
</tr>
<tr>
<td>9133H</td>
<td>33 minutes</td>
</tr>
</tbody>
</table>

During initialization, the protocol analyzer displays the message:

Disc formatting in progress

15. When initialization is complete, the <Disc Functions> Menu is displayed.

16. Press <List Directory> softkey to verify initialization. The figure below shows the directory headings:

```
DIRECTORY OF -- VOLUME : HARDSC
FILE #  NAME  TYPE  SEQUENCE  DATE  TIME
---------  -------  -------  ----------  --------  --------

Selected disc is now : HARDSC:
```

Figure 5-3. Disc Drive Directory List
C. Storing The Operating System To Hard Disc

After the hard disc is initialized, you need to store the HP 4971S system software from the floppy discs, LANSYS and LANCOD, onto the hard disc.

After the system software is saved onto the hard disc, the system power switches can be turned off and then back on and you will not have to repeat the preceding steps. The HP 4971S system will automatically power up to the Top Level Menu.

SAVING LANSYS TO HARD DISC

If you make an error in the following steps, 17 through 20 or 21 through 24, just start the "Storing The Operating System" process over at step 17 or 21. There is no need to completely reinitialize the hard disc.

17. Install the LANSYS floppy disc in the disc drive slot.

18. Press the <Copy Files> softkey to display the message:

   Copy from: _____    Copy to: _____

19. Enter #3: in the Copy from: field and press the RETURN key.

20. Enter #11: in the Copy to: field and press the RETURN key.

   Message  File copy in process  is displayed.

   After the file is copied,  Copy function complete  is displayed.
SAVING LANCOD TO HARD DISC

20. Install the LANCOD floppy disc in the disc drive slot.

21. Press the <Copy Files> softkey to display the message:

   Copy from: ___  Copy to: ___

23. Enter #3: in the copy from: field and press the RETURN key.

24. Enter #12: in the copy to: field and press the RETURN key.

   Message  File copy in process  is displayed.

   After the file is copied, Copy function complete is displayed.

The operating software you have stored to the hard disc now becomes your working copy of the software. You should keep the master floppy discs in a safe environment.
Back Up Your System Software

If you have an HP 4971S system with an HP 9122D Dual Disc Drive, you should make working copies of your LANSYS and LANCOD system software floppy discs and store the master copies in a safe environment.

If you have a Winchester disc drive, when you store the operating software to the hard disc, you should use the hard disc as your working copy and store the original discs as your master copies.

Follow the procedure below to make a working copy of your system software discs using the HP 9122D disc drive.

**FORMAT TWO FLOPPY DISCS**

You need to copy your master system software discs to two formatted floppy discs.

1. Check that the write protect tab on the floppy disc is in the write enable position. (Slide tab toward center of disc.)

2. Install the floppy disc to be formatted in a disc drive slot.

3. Press the <Format Disc> softkey.

   Message *Drive number? 3* is displayed.

4. Enter the disc drive number where the floppy disc is installed and press the RETURN key.

   Message *Are you sure you want to proceed?* is displayed.

5. Press the <Yes> softkey.

   Message *Disc formatting in progress.* is displayed.
6. After the floppy disc is formatted, message

Select a disc name, default is "LANSAV": _______ is displayed.

We suggest you name the disc LANSYS.

7. Repeat the steps 1 through 6 to format the second floppy disc.

   Name the second disc LANCOD.

COPY THE SYSTEM SOFTWARE DISCS

8. Install the new formatted disc, LANSYS, in disc drive slot #4.

9. Install the master LANSYS system software disc in disc slot #3.

10. From the <Disc Functions> Menu, press the <Copy Files> softkey. The following prompt is displayed:

       Copy from: _______    Copy to: _______

11. In the Copy from: field, enter #3: and press the RETURN key.

12. In the Copy to: field, enter #4: and press the RETURN key.

   The copy function begins and the protocol analyzer displays the status messages:

   File copy in progress.

   Copy function complete.

Use the second formatted blank disc and LANCOD disc and repeat steps 8 through 12 to back up LANCOD software floppy disc.

After you have copied both LANSYS and LANCOD system software discs, install the new working disc copies in the disc drive and cycle the protocol analyzer power to verify the discs let the protocol analyzer power up correctly. Store the original system software floppy discs in a protected environment.
Getting Started

Using The Top Level Menu

The Top Level Menu is very important because it allows you to gain access to all the functions of the protocol analyzer.

The Top Level Menu appears after power-on self-test is complete. Also, you can return to the Top Level Menu from lower level menus by pressing the <EXIT> softkey. You will use this menu often, so briefly experiment going to lower levels of softkeys and returning to the Top Level Menu.
Chapter 1, Using This Manual, describes the selections that you can make from the Top Level Menu. Chapter 1 also describes conventions used in the HP 4971S and this operator's manual.
Setting The Date And Time

At power up, or any time the power to the HP 4971S system has been interrupted, the date and time should be set. When frames are captured and stored in the protocol analyzer, they are time stamped with the date and time the event occurred. Also, when network or data files are stored on a disc, the time of the event is noted. It is important to set date and time so that disc functions and time measurement functions will be accurate.

SETTING THE DATE

1. From the Top Level Menu, press the <OTHER CHOICES> softkey to display softkeys for setting the date and time.

2. Press <Set Date> softkey.

Entry format

The date entry must follow the format:

day month year
(separate each entry with a space)
(use three letters for month)

For example:

28 oct 85 - October 28, 1985

Entry values

The values you can enter for the day and year must be within the range listed below:

years - => 0 => 1
" 99 <= 31

3. Press the RETURN key to complete the entry.
SETTING THE TIME

1. From the Top Level Menu, press the <Set Time> softkey.

Entry format

2. The time entry must follow the format:

   hour:minute:second
   (separate each entry with a colon :)
   (use 24 hour entry to denote AM and PM)

For example:

   9:30:00    =    9:30 AM
   21:30:00   =    9:30 PM

Entry values

   The values you enter for the hours, minutes, and seconds must be within the ranges listed below:

   hours -   =>  0
              <=  23

   minutes - =>  0
              <=  59

   seconds - =>  0
              <=  59

3. Press the RETURN key to complete the entry.
Using The TUTORIAL Disc

The HP 4971S TUTORIAL floppy disc supplied with the HP 4971S LAN Protocol Analyzer provides an introduction to the features of the protocol analyzer. To use the HP 4971S TUTORIAL disc, perform the following procedure:

LOADING THE HP 4971S TUTORIAL FLOPPY DISC

1. The HP 4971S system software on LANSYS and LANCOD floppy discs does not have to be loaded in the HP 4971S before using the TUTORIAL disc.

   Remove the LANSYS and LANSYS floppy discs from the disc drive.

2. Insert the TUTORIAL floppy disc in any disc drive slot.

3. Set the HP 4971A instrument power switch to OFF and then back to the ON position. The floppy disc contents will load into the HP 4971A instrument.

4. After the disc is loaded, a display similar to the Top Level Menu is shown.

   Figure 5-5. Tutorial Disc Power-on Display.
5. Press the keyboard SPACE bar to display the following tutorial topics:

0  Introduction to HP 4971S
1  Introduction to Local Area Networks
2  Monitor Network / Examine Data
3  Node List
4  Filters
5  Messages
6  Programming
7  Disc Functions
8  I/O Functions
9  Conclusion

CHOOSING A TUTORIAL TOPIC

Press a number key on the keyboard to choose the tutorial topic you want to view and that tutorial topic will begin.

Instructions to move through the tutorial are displayed in the status message line immediately above the softkeys.

EXITING FROM A TUTORIAL TOPIC

To exit from a module before reaching the end of that topic discussion, press either the <ESC>, <STOP>, or <BREAK> key on the keyboard.

No key is provided to page backwards in the tutorial.
Getting Started
CHAPTER 6

INTRODUCTION TO LANs

This section describes the HP 4971S Protocol Analyzer and the Local Area Network (LAN) environment it is to be used in.

This chapter includes:

- Introduction
- What is a Local Area Network?
- Advantages of a Local Area Network.
- Where and How are LANs used.
- Network Topology.
- Transmission Media.
- Network Access Methods
- The IEEE 802.3 Frame
- Local Area Network System Differences
- Local Area Network Performance Measurements
If you are unsure of what a (LAN) is and feel intimidated by having to use a LAN analyzer instrument, read the following chapter.

If you feel comfortable about LANs and their details, you may want to skip to the next chapter. The next chapter describes the basic functions available in the HP 4971S protocol analyzer.

The next few pages describe basic concepts of a LAN and put you more at ease in understanding its performance measurements.

A LAN is simply a method of connecting together a number of independent computers so they can share peripherals and other resources and communicate between themselves and other terminals. You now have the benefit of operating your computer independently and still enjoy the reduced cost of shared peripherals and resources.

Connecting a group of computers and peripherals together requires some form of traffic control for the data communication between the stations. Data communication is not new, perhaps you are already familiar with RS-232C and its relatively slow speed modems and dial-up telephone lines. Network systems available today not only support data rates several hundred times faster than dial-up phone lines with modems, they allow simultaneous connection of many devices and much improved data transmission error rates.

For simplicity, the following discussion is focused on the IEEE 802.3 standard. Ethernet and 10BASE2 standards are similar to the IEEE 802.3 and they are described in a summary table at the end of this section. This table shows the primary differences between the IEEE 802.3, Ethernet, and 10BASE2 standards.
What Is A Local Area Network?

A LAN is a way of connecting multiple systems together in a limited geographical area. A LAN usually spans a distance of five kilometers or less. LANs can provide network communications in a building or a group of buildings in close proximity such as in a university, a hospital, or a cluster of manufacturing buildings on a site.

A LAN is usually owned by one organization and can be configured by that organization to satisfy its unique needs. LANs are user controlled and are not subject to government regulations.

The following diagram shows a simplified Local Area Network.

![Figure 6-1. Simplified Local Area Network](image-url)
Advantages Of A Local Area Network

HIGH DATA RATE

With the IEEE 802.3 standard, LANs generally can transmit data at a rate of 10 million bits per second. In comparison, systems depending on data transmission through telephone lines are limited to several thousand bits per second.

LOW TRANSMISSION ERROR RATE

Due to the limited geographic range of the LAN, there is less opportunity for electrical interference on data transmission. Electrical signals typically weaken when transmitted over long distances; this is not as much a problem with LANs.

FLEXIBLE TOPOLOGY

Reliable hardware and good design can provide a flexible topology for a LAN, which means you can readily modify and reconfigure a network as your organization changes. Easy attachment or removal of devices means that computers, terminals and other peripherals can be added or moved around easily. Organizations can choose their own cable layouts for their special needs.

RESOURCE SHARING

Sharing of resources such as computers, peripherals and software, saves expenses and provides for more efficient usage of equipment. A LAN can allow several departments to share resources without having systems duplicated in each area.

LANs can help distribute system work loads evenly. For example, say there's one database that everyone in the building uses. Without a LAN, everyone would have to use the one system that held the database for all their computing needs. With a LAN, everyone could use a different computer for most of their daily work, but still be able to access the database computer when necessary. This reduces the overall load on one system and improves response time and productivity.
Efficient Wiring

The IEEE 802.3, Ethernet, and 10BASE2 networks all offer extremely simplified wiring; each computer, terminal or other peripheral only needs to connect to one main LAN cable. For example, suppose you want to connect four computers to each other. Rather than connect each computer to all the other computers, you can simply connect all four computers to one LAN cable. In this case, the number of physical communication cables is reduced and each computer requires only one point of connection.

Traditional wiring methods have led to serious crowding of cable ducts and raceways in buildings with large amounts of computer equipment. LANs are expected to be more cost effective for initial wiring of new buildings and for managing changes of wiring in existing buildings.
Where And How Are LANs Used?

It is becoming very common to have your own personal computer in many work applications. While the cost for personal computers is becoming more favorable for the user, the cost of peripherals such as high speed printers, graphic plotters and large memory storage devices still make it expensive for each user to have their own complete system. Many applications exist that make it attractive to group individual workstations into networks.

Some of these application environments include:

- Personal computer networks
- Office equipment
- Data Processing
- Manufacturing
- Engineering
- Integrated work environments

PERSONAL COMPUTER NETWORKS.

PC networks need special consideration since their growing importance and role has not yet been fully realized. They can be used in any computer environment. A PC takes advantage of the low cost of microprocessors to allow a single user environment for computing. The PC network reduces the overall cost of peripherals by permitting a multi-user environment for device sharing. Applications processing is done at the PC work station, while the network provides peripheral sharing. Sometimes, access to peripherals is controlled by a dedicated PC.

PC LANs are based on two types of devices:

- The network user: a PC that uses the resources of the network.
- The network server: a PC or other device that provides the resources for the network.

The network server may be dedicated to a service such as providing hard disc memory for the network. Or a PC can serve as a work station as well as a network server.
OFFICE ENVIRONMENT

The office environment ranges from mainframe computers to minis to personal computers, with peripherals serving these computers. In the office, many users need to be connected at the same time, but generally don't need constant access to the computer system. The data traffic tends to be in bursts. That is, data is sent in sporadic, but often large, transmissions.

The main characteristic of computer usage in the office environment is the sending and receiving of messages and data between the users. A simple single cable LAN can connect this environment.

An office environment is an ideal place for a PC LAN to operate. PCs combine local processing power with a host computer's ability to share information, peripherals, and communications facilities. Printing, text processing, electronic mail, spreadsheet information, and data bases can be shared. Other functions like file transfer and remote file access are also available. When many users need to be connected to each other at the same time, but constant interaction is not necessary, a PC LAN can provide good computer response time.

DATA PROCESSING ENVIRONMENT

The data processing area has its own requirements that make LAN capabilities very attractive. A mixture of computer systems exists here. Mainframes do production jobs and manage large data bases while minicomputers do distributed processing. A large network of terminals may be used for interactive data entry, as well as being controlled by applications programs. LANs provide a solution for sharing data whenever updated information is important, and for notifying everyone on the network of the most current information.

PC LANs are also found in this environment. Sometimes the data processing environment is broken up into small branch offices that need to do their own thing before sending information over a wide area network.

The data processing environment often includes equipment from different vendors. A multi-vendor LAN requires multi-vendor compatibility, that is, a network containing equipment from many different vendors communicating with each other.
MANUFACTURING ENVIRONMENT

Simple robots, programmable controllers, and controlled machinery can be brought together to form automated production lines. The functions performed on the factory floor include automated production, testing and process control. An automated production assembly line could be linked to an automated warehouse. Supervising computers decide if a sub-assembly is needed. If so, the parts could be retrieved from the warehouse bins by automatic devices.

In some environments such as the chemical industry, the factory can be hazardous to humans, so automation becomes essential. Some processes are time sensitive and require real-time automated controls, especially where measurements are involved. Often, a production line needs real-time monitoring and control of a process.

A high speed LAN is ideal for these purposes. The need to link order entry systems, production control systems, inventory systems, sales data and the production database makes the manufacturing environment especially well suited for LANs.

ENGINEERING ENVIRONMENT

Within the engineering application area, workstations are the machines mainly used by engineers for computer aided design (CAD). These engineering workstations can now have the power of a minicomputer. Engineers using these workstations often utilize the local processor power only, since their primary function is designing. Typically, data exchange with larger minicomputers or mainframes occurs infrequently.

A LAN provides interaction for shared resource functions like disc access, printer and plotter output, and file transfer between workstations or to a mainframe. Applications and databases are kept on a shared network disc and loaded via the network onto the individual workstations when needed. This makes updating applications easier since only one copy of the data exists.
INTEGRATED ENVIRONMENT

Putting together the office, the data processing environment, and the engineering environment creates an integrated environment where the user can communicate with any of the other environments. For example, an engineering LAN linked to automated test equipment can allow a manufacturer’s engineering section to directly transmit its performance criteria to the factory. The factory, in turn, can communicate its requirements and process constraints to the engineering design team. Input from the marketing department (customer preferences and order forecasts) is transmitted to both engineering and manufacturing areas.

An integrated environment allows different LAN technologies to communicate. PBX networks and PC LANs can be connected together or connected to other LANs. When users in the office, the manufacturing environment, and the data processing environment have access to common data bases and have the ability to exchange data, the result will be a powerful network capable of being a corporate data network, handling many environments and a diverse combination of data traffic.

The key to an integrated environment is the compatibility between individual LANs.
Introduction To LANs

**Network Topology**

The computers, printers, memory devices, plotters, and other peripherals that are connected to a LAN are called "nodes". The physical layout of the network, that is, the way in which nodes are interconnected is the network topology.

The goal of a topological design is to achieve a specified performance at a minimal cost or, in other words, deliver the right information at the right time and at the right price.

**BUS TOPOLOGY**

The simplest technology used to connect the nodes of a LAN is the Bus Topology. It is a linear run of single conductor coaxial cable with nodes connected along the cables entire length. Nodes can be connected to the cable with regular coaxial cable connectors or by piercing the cable with a tap to connect to the center conductor.

Transmissions from a node flow in both directions towards the ends of the bus cable. The destined receiver must recognize data intended for it and read the message as it passes by. Bus cables over 1500 feet or one half kilometer require a device called a repeater to regenerate the data signals.

The bus topology offers several advantages:

- If one node fails, it does not affect the transmissions between the remaining nodes.
- Bus topologies are flexible enough to be configured in most physical environments and also allow for easy expansion.
- Relatively simple transmission hardware can be used to access the bus.
Transmission Media

The transmission medium is the physical connection over which communication between nodes takes place. It is sometimes called the link, line, channel, or coaxial cable.

COAXIAL CABLE

Coaxial cable is the most common physical medium for LANs. It combines strong construction, light weight, and low cost with good electrical isolation for high data transmission rates.

The transmission media used to connect the various devices is specified by IEEE 802.3 as a 50 ohm coaxial cable. The center conductor is a 0.0855-inch diameter, tinned, solid copper wire. The center conductor is insulated by foam polyethylene or foam Teflon. A wire mesh cable shielding is protected by a polyvinyl chloride (PVC) or Teflon fluorinated ethylene propylene (FEP) cover. The outside cable diameter should be 0.405 inch.

A transmission cable may consist of a single segment with a maximum length of 500 meters, or, segments of cable may be connected by using repeating amplifiers. The longest coaxial cable length between any two work stations may not exceed 2500 meters and any work station signal must not pass through more than four repeaters. An additional 400 meters may be added to the 2500 meters maximum length by the AUI cables connecting the repeaters to the cable segments. Up to 100 work stations separated by a minimum distance of 2.5 meters may be connected to a network cable segment.
Introduction To LANs

Figure 6-2. Local Area Network With Single Segment

Figure 6-3. Local Area Network With Joined Segments
MEDIA ACCESS UNITS (MAUs)

The MAU is a transmitter and receiver unit which sits on the coaxial bus cable of the network. MAUs perform the function of transmitting and receiving data, and of detecting collisions, thus earning the name "transceivers." MAUs must adhere to strict specifications regarding input impedance and capacitance.

Connection to the coaxial cable may be made by a tap used to pierce through the cable to the center conductor. This type of "vampire" connection has the advantage of having a connection made or removed without disturbing any communications occurring on the line. Another method of connecting to the transmission cable is to cut the cable and install coaxial cable connectors.
ACCESS UNIT INTERFACE CABLE (AUI Cable)

The AUI cable is used to connect the MAU to the node device. It lets the coaxial cable and the MAU be located in the ceiling, while the work station sits on your desk. The AUI cable consists of four shielded wire pairs. One pair of wires is reserved for transmit data, another for receive data, and the third is reserved for the collision detection signal. The fourth wire pair provides power (+/- 12V) to the MAU. Because of the susceptibility to electrical interference, the transceiver cable must be less than 50 meters long. The ends of the cable are terminated into D-series 15 pin connectors with one male and one female connector at either end.

BASEBAND SIGNALING

The method that the IEEE 802.3 standard uses to transmit signals over the coaxial cable is called baseband. In baseband signaling, the available band width is allocated to a single data transmission channel. This means that simultaneous transmissions cannot coexist on a channel.

Baseband typically has high data transmission rates of about 10 million bits per second. Most baseband networks are typically used for data transmission only.

Because of the lower bandwidth used with baseband, it has an advantage over other signaling methods of easy reconfiguration and addition of equipment. Baseband taps can quickly connect to or disconnect from the cable without disturbing network transmissions in process.

IEEE 802.3 is often referred to as a 10BASE5 network. In breaking up the term 10BASE5, the 10 refers to the data rate. Data is transmitted at 10 Mbits or 10 million bits per second. The word base denotes that the network is baseband. The 5 in the term refers to the allowable length of a segment of coaxial cable. A 10BASE5 system allows each contiguous segment of coaxial bus cable to be a maximum of 500 meters in length.
Network Access Methods

Transmitted messages simultaneously interconnect to all nodes in a bus network topology. However, for proper communication between nodes, data must be able to travel along the coaxial cable without interfering with other data transmissions. Network access methods are the techniques by which nodes gain use of the physical network medium to send a message across the network. These methods ensure that only one node transmits at a time, or, if more than one transmits, the proper recovery action is taken to provide correct data transmission.

CARRIER SENSE MULTIPLE ACCESS WITH COLLISION DETECT (CSMA/CD)

IEEE 802.3 standard uses Carrier Sense Multiple Access with Collision Detect (CSMA/CD) as an access method in which each node has equal access to the network. There is no central node that controls transmission. CSMA/CD is an access method used predominately with bus topologies.

Carrier Sense means that the sending node has the responsibility to discern that there is no other node transmitting before it attempts transmission.

Multiple Access means that all the nodes have equal access to the network.

Collision Detect means that while transmitting, the sending node must continue monitoring the network for evidence of a message collision from another node.

When two or more nodes attempt to transmit at the same time, the signals interfere with each other, causing a collision. If a collision is detected, each colliding node initiates a jam signal to warn the other nodes on the network. The collision is remedied by having the colliding nodes cease transmitting, and then wait. Stopping transmission and waiting a while before transmitting again is called "backing off".

CSMA/CD protocol involves two basic rules:

First, when the bus is busy; that is, a message is being sent, all other nodes must wait until the channel clears before trying to send their own messages.

Second, if multiple nodes try to transmit messages simultaneously, which would cause a collision, these nodes must stop transmitting and wait for randomly varying delay times before transmitting again.
Introduction To LANs

**MAU COLLISION DETECTION**

Collisions on the network can be detected using two different methods. The characteristics of the different methods are listed below:

**Received Based Detection**

MAUs using Received Based Detection have the following characteristics:

1. The average DC level of the network cable is used to determine if a collision has occurred.

2. Non-transmitting stations can detect collisions.

3. Received Based Detection is dependent on the DC resistance of the network cable.

**Transmit Based Detection**

MAUs using Transmit Based Detection have the following characteristics:

1. The transmitted signal is subtracted from the received signal, leaving only the interference signal.

2. Transmit Based Detection can be used over greater distances than Received Based Detection. It is less susceptible to DC resistance losses.
The IEEE 802.3 Frame

The word frame is used to describe the format of a node's transmissions on the network. The frame format specifies the location of routing information and the check for data integrity. The frame format is vital to proper function of the network. You must be well acquainted with the frame structure because it is the level at which the HP 4971S is most effective as a diagnostic tool. In order of transmission, the fields are Preamble, Destination Address, Source Address, Length Field, Data Field, and FCS Field.

![Frame Format Diagram]

Figure 6-5. Frame Format.
THE PREAMBLE (8 bytes)

The Preamble is an eight byte field used for informing all the receivers on a network that a frame is coming. It is eight bytes long to provide ample time for the synchronization of clocks. The first seven bytes of the Preamble are AA hex, the last byte is an AB hex. It is important to note that MAUs and repeaters sometimes lose several bits from the front of the Preamble while synchronizing their clocks. (The HP 4971S does not display the Preamble Field of frames.)

THE DESTINATION ADDRESS (6 bytes)

The Destination Address Field contains the unique six byte address of the unit for which the frame is intended. The important fact about the Destination Address is that every unit manufactured to be connected to an Ethernet LAN has a unique 6 byte address. Thus, when any new device is added to a LAN, it is already equipped with an address different from those of the devices which have already been installed on the LAN. As a result, any and all of the LANs in the world could be connected without any conflicting addresses.

THE SOURCE ADDRESS (6 bytes)

The Source Address Field identifies the origin of a frame. When nodes transmit a message, they identify themselves by placing their unique six byte address in this field.

THE LENGTH FIELD (2 bytes)

The Length Field is used in IEEE 802.3 frames to indicate how many valid bytes are contained in the frame’s Data Field. This count includes only valid data bytes, it does not include any padding characters added to make the Data Field long enough or the four bytes of the FCS Field.

On Ethernet networks only, this two byte field is not used for describing the byte count, but for describing the type of data contained in the Data Field.
THE DATA FIELD (46-1500 bytes)

The Data Field is reserved for information exchange. It is limited to 1500 bytes to prevent one node from consuming too much of the network capability with one transmission. The Data Field is required to be at least 46 bytes so that collisions can be detected before the transmitting node finishes its transmission. The minimum 46 byte Data Field length is sufficient even on very large networks where propagation delay is significant. Any type of data is permitted in the Data Field.

THE FCS FIELD (4 bytes)

The FCS or Frame Check Sequence Field is used to verify that the frame was received intact. As a frame is received from the network, every byte of it (except the Preamble) is used in calculation of the frame check value. Most nodes discard frames which have incorrect FCS values. The HP 4971S indicates Frame Check Sequence errors in the displayed frame header.
Local Area Network System Differences

IEEE 802.3, Ethernet, and 10BASE2 networks share many characteristics. However, some differences do exist. The following text describes the primary differences.

**ETHERNET DIFFERENCES**

The primary difference between Ethernet and IEEE 802.3 networks is in the protocol frame structure. The two bytes between the Source Address field and the Data field are used to indicate message type in Ethernet. In IEEE 802.3, this two byte field is used to indicate length of significant bytes in the Data Field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Ethernet</th>
<th>IEEE 802.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type Field</td>
<td>2 bytes</td>
<td>2 bytes</td>
</tr>
<tr>
<td>Data Field</td>
<td>variable</td>
<td>46-1500 bytes</td>
</tr>
<tr>
<td>Frame Check Sequence</td>
<td>4 bytes</td>
<td>4 bytes</td>
</tr>
</tbody>
</table>

*Figure 6-6. IEEE 802.3 Frame Format.*
10BASE2 DIFFERENCES

10BASE2 is very similar to IEEE 802.3. The primary difference is: smaller coaxial cable, shorter segment lengths and fewer work stations. Its advantages are lower cost and easier installation.

The 10 Mbit/sec data rate is maintained similar to IEEE 802.3. A cost advantage gained by using regular RG-58 coaxial cable to connect the nodes via BNC connectors is offset by having the maximum cable segment length reduced to 200 meters with 1000 meters maximum overall network length. 10BASE2 networks support only 30 work stations on a segment; however, they must be separated by a minimum distance of only 0.5 meters.

In contrast to IEEE 802.3, the 10BASE2 networks do not use a MAU and transceiver cable but connect directly to the network’s primary cable via a simple BNC connector. The MAU function is usually built into the work stations’s interface board.

The protocol of the 10BASE2 messages is the same as IEEE 802.3.
Introduction To LANs

Some of the IEEE 802.3, Ethernet, and 10BASE2 differences and similarities are summarized below.

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>IEEE 802.3 (10BASE5)</th>
<th>ETHERNET</th>
<th>10BASE2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Rate</td>
<td>10 Mbits/sec</td>
<td>10 Mbits/sec</td>
<td>10 Mbits/sec</td>
</tr>
<tr>
<td>Max Segment Length</td>
<td>500 meters</td>
<td>500 meters</td>
<td>200 meters</td>
</tr>
<tr>
<td>Max Network Span</td>
<td>2500 meters</td>
<td>2500 meters</td>
<td>1000 meters</td>
</tr>
<tr>
<td>Max nodes per segment</td>
<td>100</td>
<td>100</td>
<td>30</td>
</tr>
<tr>
<td>Max nodes per network</td>
<td>1024</td>
<td>1024</td>
<td>1024</td>
</tr>
<tr>
<td>Minimum Spacing Between Nodes</td>
<td>2.5 meters</td>
<td>2.5 meters</td>
<td>0.5 meters</td>
</tr>
</tbody>
</table>

**LAN CABLE**

<table>
<thead>
<tr>
<th></th>
<th>Type</th>
<th>Connectors</th>
<th>Impedance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RG-225</td>
<td>N series</td>
<td>50 ohm</td>
</tr>
</tbody>
</table>

**TRANSCEIVER CABLE**

<table>
<thead>
<tr>
<th></th>
<th>Diameter</th>
<th>Construction</th>
<th>Connectors</th>
<th>Max length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.38-in</td>
<td>4 twisted-pair wires</td>
<td>15 pin D-series</td>
<td>50 meters</td>
</tr>
<tr>
<td></td>
<td>not used</td>
<td>(Additional twisted pair optional)</td>
<td>not used</td>
<td>not used</td>
</tr>
</tbody>
</table>
Local Area Network Performance Measurements

The preceding section described the fundamentals of a LAN. Several measurements can be made that show the performance of the network. Examples of these measurements include:

- What stations are transmitting on the network?
- Are messages with frame errors being sent?
- Do stations respond correctly to some number of frames/second?
- Do stations respond to an average packet size?
- What is the length of messages?
- What time are messages transmitted/received?
- How much time occurs between messages?
- What station(s) is(are) talking to another station?

The HP 4971S can help you to answer these system questions. The following chapter summarizes the functions of the protocol analyzer that capture, display, and measure the operation of your LAN.
CHAPTER 7
INTRODUCTION TO THE HP 4971S

This chapter provides an introduction to the functions and capabilities of the HP 4971S.

This chapter includes:

- Functional View Of The HP 4971S
- More Details About HP 4971S Functions
- The HP 4971S System Devices
What will a protocol analyzer do for you?

In Chapter 6, you learned about Local Area Networks (LANs) and in particular about CSMA/CD LANs. You should recall that there are some rigid rules regarding accessing the network, backing off, frame lengths, and frame formats. You should also recall that the data transmission on the network occurs at a rate of 10 million bits per second.

What do you do when something goes wrong with a LAN? If you need to verify frames transmitted by a particular device on a busy network, how do you do it? If you only have an oscilloscope and a logic analyzer, it would require very complicated triggering to capture specific frames on the network. In addition, you would have to be able to decode the frame information from its binary state. The obvious solution to your network problem is a specialized tool, a LAN protocol analyzer.

In the most simple monitor form, a LAN protocol analyzer will let you view on a display, the frames which are occurring on the LAN. Figure 7-1 shows a simple monitor function.
Figure 7-1. Simple Monitor Block Diagram.
Introduction To The HP 4971S

BUFFER MEMORY

With frame information being transmitted at 10 million bits per second, it is obvious that you cannot view the frames in real time. The HP 4971S uses a Receive Buffer to capture and hold the frames so you can view the details of each frame. You are not viewing the frames as they occur on the network in real time. However, you do see the frames in the actual sequence they occurred on the network.

Management of this memory buffer can be difficult. Considering the data rates on the LAN, the buffer should be large, but it should also be small enough to allow something less than a mainframe computer to operate on it in a reasonable amount of time. There are two primary ways to manage this buffer: in a non-stop mode, or in a stop-when-full mode.

In non-stop mode, the oldest frame in the buffer is destroyed to make room for the next frame to be stored. Non-stop mode allows you to have a buffer full of the newest frames at all times. On a busy network, non-stop mode may not permit you to view every frame before it is overwritten. Instead, the analyzer displays the newest complete frame each time.

In the stop-when-full mode, every frame from the LAN is stored sequentially in the buffer memory. When the memory is full, the analyzer quits collecting frames and returns control to you. You can then view or examine the data at a slower rate that is convenient for you.

NODE LIST

LANs can have several hundred work stations or nodes installed. While each transmitted frame identifies the sending and receiving stations with a six byte address, recognizing six byte addresses for several hundred nodes would be difficult. It would be helpful to be able to identify nodes by a descriptive name that identifies the user or the node function.
Figure 7-2. Buffer Memory And Node List.
DATA FILTERING

Stop to consider for a moment that even a buffer memory of several million bits would be filled in just seconds with a transmission rate of 10 Mbits/second. Thus it is important for your protocol analyzer to be able to filter incoming frames, that is, to discard unwanted frames and prevent them from wasting the buffer memory available.
Figure 7-3. Data Filtering.
TIMESTAMPING

The primary reason for a LAN is to allow different machines to talk to one another. Of course, they must be able to respond to each other's requests in a reasonable amount of time. At some point, when you are troubleshooting a LAN, you will need to know when different frames are transmitted on the network. In most cases, you need to see the time between related frames.

The HP 4971S solution to this problem is a timestamp feature which tags each incoming frame with the time the frame arrived.
Figure 7-4. Timestamping The Frames.
SIMULATING MESSAGES

Just for a moment, think about what happens when computers exchange messages. The example messages below have been paraphrased to illustrate computer transmissions:

Hey mainframe, this is Bill's PC, will you send me record 1234?

Sure Bill's PC, this is the mainframe, here's record 1234.
"The quick brown fox jumped over the lazy dog's back!"

Hey mainframe, this is Bill's PC, thanks for record 1234. I received it OK.

At some time, you may want to start a transmission like the one above by asking a question of another LAN device. The HP 4971S lets you impersonate or simulate another LAN device which normally talks to the device you are testing.

To accomplish this simulation capability, the HP 4971S has transmitting hardware and a buffer to store the messages you wish to send.
Figure 7-5. Simulating Messages.
PROGRAMMING

With the addition of the transmit hardware, you have a reasonably complete LAN protocol analyzer. You can store selected data in a buffer, analyze it at your leisure, observe exactly when the frame came in, and you only have to look at the frames you are interested in.

You can even start a transaction by sending a message, but what if you need to respond to another device's query? It would be hard for you to always be available when a message came in that requested a response from you. Clearly, a need exists for programming capability in your LAN protocol analyzer.

The HP 4971S has the programming capability to watch the incoming frames and make decisions based on their contents. It can control the display, transmit messages, make timing measurements as well as count events on the LAN.
Figure 7-6. Programming Function.
Introduction To The HP 4971S

MASS STORE

As mentioned earlier, it would be difficult to create a buffer storage large enough to hold network traffic for long periods of time. What if you needed to save network data, protocol analyzer setup configuration or programs for future reference? A LAN protocol analyzer should have the quick reference to information that a disc drive can provide.

PRINTER OUTPUT

What if you wanted a hard copy of a program you have written or you want a printer output of the display? The HP 4971S supports a printer to let you have these functions.

SUMMARY

In summary, the HP 4971S provides the following primary functions:

1. Monitoring a network in a transparent or unobtrusive manner.
2. Simulating a node on the network.

In addition these functions can be performed in a master-slave combination using two HP 4971S stations. One station must be connected directly to the local area network while the second station can be positioned anywhere that an RS-232C link can be established.

These primary functions are enhanced by having the following features available as softkey operations:

- Filtering
- Programming
- Friendly node identification
- Mass storage of programs and data to a disc drive
- Printed copies of received frames and system setup information
Figure 7-7. Mass Storage And Printer Output Functions.
More Details About HP 4971S Functions

MONITOR FUNCTIONS

Monitoring can be performed in two modes. One of the modes uses simple softkey selections while the second mode uses programming statements created by the user.

Simple monitor - The simplest mode is available with only a few softkey selections. In this mode, all messages occurring on the network are stored in a Receive Buffer, no filtering can be done.

Programmed monitor - The more complex monitor function can be done by using the programming capability of the protocol analyzer. In this mode, you can filter only the data that is important to you. Programs can also perform more complex triggering to start and stop the display or increment counters and timers.

In either monitoring mode, the activity on a Local Area Network is viewed in a transparent mode that does not disturb the activity of the system. Both monitor modes store frames in a buffer; however, in the programmed mode, up to 16 different traps or filters can be used to specify frames to be stored. The captured frames can be displayed in several formats. In addition, analysis on the stored frames can be performed in a variety of ways.

Storage capacity - Depending on the length of the data message in each frame, different amounts of frames can be stored. The HP 4971S memory will hold several hundred frames.

SIMULATE FUNCTION

In the simulate mode, programs can be written to allow messages to be transmitted in response to specific received frames. Sequences of different messages can be sent and specific messages can be repeated a selected number of times. The messages can be created with any address, data field content, and good or bad FCS.

Messages can be sent that vary in length from one to 2022 bytes. This lets you observe how stations respond to messages that are too short or too long.

Similar to the monitor function, simulate mode can store received frames. The same storage capacity is available in simulate mode as in monitor mode.
MASTER/SLAVE OPERATION

Monitor and simulate functions can be performed on your LAN from a remote location by using two HP 4971S's connected by an RS-232C data link.

The **slave unit** or measurement device is the unit connected to the LAN under test.

The **master unit** or controlling device is the unit from which the measurements are controlled. The master or controlling device must be a HP 4971S.

Both the master and slave units must have an HP 98628A Datacomm Interface for the RS-232C data link. The slave or measurement device must contain HP 4971A hardware but does not need a keyboard, a display monitor, or mass storage (disc drive). The controlling unit can provide all display and control functions for the remote unit as well as all disc operations such as system software and file storage.
The HP 4971S System Devices

Look over the figure below. Keep in mind that the parts shown below perform all the functions described on the previous pages. The display, mass store and printer functions are performed by the peripheral devices shown. The HP 4971A instrument performs the LAN interfacing, buffering and programming functions.

As you read more about this instrument system, it is important that you remember the product number HP 4971S refers to the LAN Protocol Analyzer system which includes an HP 4971A instrument, a disc drive, and possibly a display, keyboard and printer. (Systems operated only from a remote location need only the HP 4971A instrument and a disc drive.) The product number HP 4971A refers to the processor unit only.

Figure 7-8. HP 4971S System Devices.
Introduction To The HP 4971S

The HP 4971A

The HP 4971A processor is the heart of the HP 4971S LAN Protocol Analyzer system. It contains the hardware which interfaces to the LAN and collects data. It contains the processor which runs the system software and controls the LAN interface hardware.

The Disc Drive

A double sided, double density 3.5 inch floppy disc drive is required for each HP 4971S system. The disc drive is used to load the instrument code, and to store instrument data and setup configurations. You have a choice of what disc drive to order with the system. Your decision will be based upon the intended application of your system.

The HP 9122D Dual Disc Drive should be ordered with any system that will be moved regularly. It is the most "portable" disc drive option for the HP 4971S and will perform all the system functions.

The Winchester disc drives are recommended for any application where large amounts of network data need to be stored. The hard discs offer a large storage capacity and faster storage and retrieval than the HP 9122D. The hard discs are more delicate and require special precautions whenever they are moved or shipped.

The Video Display

A video display is required at any time the system will be used as a master in master-slave operation or in stand-alone operation. The Video Interface and cable (Option 001) must be ordered with every HP 4971S that must support a video display.

The Keyboard

A keyboard is also required for master and stand-alone operation. The keyboard interface is included in every HP 4971S.

The Printer

The HP ThinkJet Printer is supported by the HP 4971S. You will find printouts of particular displays, data and programs is a convenient feature.
Introduction To The HP 4971S
CHAPTER 8
PREVENTATIVE MAINTENANCE

In general, the devices in the HP 4971S do not require periodic maintenance. Suggestions are given for general cleaning. Also included is a list of common replaceable parts.

This chapter includes:

- Cleaning System Devices
- Common Replaceable Parts
Preventative Maintenance

Cleaning System Devices

WARNING

ALWAYS UNPLUG THE SYSTEM DEVICES BEFORE CLEANING THEM WITH A LIQUID SOLUTION.

To remove dirt and smudges from your system devices, use a mild solution of dish washing detergent and water. Never use harsh chemicals to clean the devices.

PRINTER

Periodically clean paper dust out of the printer.

See Chapter 4 of the HP 2225A ThinkJet Printer manual for details about maintenance of the print head cartridge.

DISC DRIVE

Make sure the shutter on the floppy disc is closed when any discs are not in use.

Store the discs in a clean environment.

Protect the discs from dust, fingerprints, and scratches.
Common Replaceable Parts

Fuses

Fuses for the HP 4971S are listed in Table 4-1 of Chapter 4.

Floppy Discs, double-sided, (box of 10) 92192A
HP-IB Cable, 1/2 meter 10833D
HP-IB Cable, 1 meter 10833A
HP-IB Cable, 2 meters 10833B
HP-IB Cable, 4 meters 10833C

Ink Jet Paper, 2000 sheets, single sheets 92261M
Ink Jet Paper, 2500 sheets, fan fold 92261N

Print Head Cartridge 92261A
Preventative Maintenance
APPENDIX A
GLOSSARY OF LAN TERMS

Amplifier
An analog device designed to boost the strength of an electronic signal. It compensates for the signal loss in a section of transmission medium.

AUI (Attachment Unit Interface) cable
Cable that attaches the MAU (Media Access Unit) to the interface at the computer.

Bandwidth
The range (band) of frequencies capable of being carried by a channel. The difference between the highest and the lowest frequencies of a band expressed in hertz.

Baseband
A transmission channel which carries only one communication channel. The transmission rate is typically 10 megabits/second.

Baseband networks are sometimes referred to in the format, 10BASE5. In this example, the 10 refers to the data rate. Data is transmitted at 10 Mbits per second or 10 million bits per second. The word BASE denotes the network is baseband. The 5 in the term refers to the allowable length of a segment of coaxial cable. A 10BASE5 system allows each contiguous segment of coaxial bus cable to be a maximum of 500 meters in length.

IEEE 802.3 and Ethernet are examples of 10BASE5 networks.

Cheapernet and ThinLAN are examples of 10BASE2 networks.

Bits per second (bps)
Measurement of rate at which data is transmitted over a channel.

Bridge
A device that provides an interconnection between LANs using similar protocols.
Glossary of LAN Terms

**Broadband**
A transmission channel with a wide frequency range that is multiplexed into separate communication channels.

**Broadcast**
The act of one station transmitting a signal on a LAN to all the other stations capable of receiving signals.

**Bus**
A topology in which nodes are attached to a linear cable segment.

**Carrier Sense Multiple Access with Collision Detection (CSMA/CD)**
An access protocol in which devices contend for a shared communication line.

**Channel**
Path on which signals travel.

**Cheapernet**
A de facto Local Area Network standard. Similar to IEEE 802.3 standard.

**Coaxial cable**
An insulated conducting wire surrounded by a fine copper braid or an extruded aluminum sleeve. It has the capability to carry transmissions with high data rates with high immunity to noise.

**Collision**
The name for when two nodes on a network contend for the network at the same time.

**Collision Detection (CD)**
The ability of a transmitting node to detect simultaneous transmission attempts on a shared medium.

**Common carrier**
Companies which provide communication networks.
Contention
The condition when two or more stations attempt to use the channel at the same time.

CRC (Cyclic Redundancy Check)
An error checking algorithm which is included in a frame before transmission. The receiving station generates its own CRC and checks it against the received CRC. If the results are different, the system can either discard the frame or request a new transmission.

CSMA (Carrier Sense Multiple Access)
A medium access control technique for multiple access transmission media. A station wanting to transmit, senses the medium and transmits only if the medium is idle.

CSMA/CD (Carrier Sense Multiple Access / Collision Detect)
A refinement of CSMA in which a station ceases transmission if it detects a collision.

Ethernet
A Local Area Network standard. Similar to IEEE 802.3 standard.

Fiber optics
Thin, transparent fibers of glass or plastic that transmit light. Data is transferred through light pulses.

Gateway
A device that allows routing from one network to various other dissimilar networks. It provides protocol translation between the networks.

Hertz
A unit of frequency equal to one cycle per second.
Glossary of LAN Terms

IEEE 802
An IEEE standard for the interconnection of local area networking computer equipment. The IEEE 802 standard describes the Physical and Link Layers of the ISO Reference Model for OSI.

Internetworking
Communication between two or more different networks.

Jam
A short encoded sequence emitted by a node to ensure that all other nodes have detected a collision.

Local Area Network (LAN)
A network of limited size (building or campus) with a high data rate, low delay and low error rate.

Long Haul Network
Network which spans areas as large as the entire world. Associated with Wide Area Networks rather than Local Area Networks.

Manchester Encoding
A digital signaling technique in which there is a transition in the middle of each bit time. A 1 is encoded with a high level during the first half of the bit time. A 0 is encoded with a low level during the first half of the bit time.

MAU (Media Attachment Unit)
Component which connects directly to the coaxial cable of the LAN system. This component is connected through the AUI to the computer interface circuit.

MAN (Metropolitan Area Network)
A network of large geographic area (a city) with a high data rate, moderate delay and moderate error rate.

Modem
Device which converts digital signals into analog signals and vice versa; also called "data set".
**Multicast**
The ability to broadcast messages to one node or a select group of nodes.

**Network**
A mixture of hardware and software components that allow the transfer of data locally as well as over great distances.

**Node**
A computer or a device on a network.

**Noise**
Undesirable electrical signals on a communication channel that can interfere or distort data signals.

**OSI Reference Model**
Open Systems Interconnection reference model defined by the International Standards Organization (ISO), which establishes a data communication architectural model for networks.

**Packet**
A group of bits that includes data plus destination and source addresses. Control information is carried in the packet, along with the data, to provide for such functions as addressing, sequencing, flow control, and error control at different protocol levels. Packet length can be fixed or variable, but it commonly has a specified maximum length.

**Polling**
An access method involving a central node asking each node in a predetermined order if it has data to send.

**Private Branch Exchange (PBX)**
A telephone system used to connect calls between offices in the same complex, and to switch calls between the site and the outside world.

**Protocol**
A formalized set of rules by which computers communicate.
Packet Switching Network (PSN)
Network which uses packet switching for digital transmission of data.

Repeater
A device which continues signals from one segment of coaxial cable to another.

Ring
A topology in which nodes are connected in a circular pattern.

RS-232-C
A standard developed by the Electronic Industries Association for interfacing data communications equipment and data terminal equipment.

Server
Dedicated processor to perform a function such as print server or file server.

Star
A topology in which all nodes join at a central node.

Store and Forward
A computer system capability in which messages are received at specific points and held there until they can be forwarded to their destination.

Time division Multiplexing (TDM)
A method using specific time slots to access a communication link. This is done by combining data from several devices into one transmission.

Topology
Layout of a network, the way in which the nodes in a network are interconnected.
Glossary of LAN Terms

Twisted Pair
Pairs of wires twisted together, commonly used in telephone communications.

Wide Area Network (WAN)
A network with the capability of covering an area as large as the entire world.

Work station
An intelligent terminal.

X.25
International standard from CCITT for interfacing computer equipment to Packet Switching Networks.
This index references both volumes of the HP 4971S Operating Manual.

Volume I contains Chapters 1 through 8 and Appendix A.
Volume II contains Chapters 9 through 22 and Appendixes B through E.
### Index

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10BASE2</td>
<td>6-21, 6-22</td>
</tr>
<tr>
<td>10BASE5</td>
<td>6-14, 6-22</td>
</tr>
<tr>
<td>&lt;802.2 Format&gt;</td>
<td>12-18</td>
</tr>
<tr>
<td>&lt;802.2 Header&gt;</td>
<td>19-28</td>
</tr>
<tr>
<td>&lt;802.3 Format&gt;</td>
<td>12-17</td>
</tr>
<tr>
<td>&lt;802.3 Header&gt;</td>
<td>19-27</td>
</tr>
<tr>
<td>802.3 Frame Protocol</td>
<td>6-17, 9-4</td>
</tr>
<tr>
<td>&lt;Abort Operation&gt;</td>
<td>20-4</td>
</tr>
<tr>
<td>Accessories for the HP 4971A</td>
<td>2-10</td>
</tr>
<tr>
<td>Accessories for the HP 4971S</td>
<td>2-8</td>
</tr>
<tr>
<td>Accessory boards, locations</td>
<td>4-22</td>
</tr>
<tr>
<td>Access Unit Interface (AUI)</td>
<td>6-14</td>
</tr>
<tr>
<td>Active softkeys</td>
<td>1-10</td>
</tr>
<tr>
<td>&lt;Add Filter&gt;</td>
<td>12-10</td>
</tr>
<tr>
<td>&lt;Add Message&gt;</td>
<td>13-4</td>
</tr>
<tr>
<td>Address switches, memory boards</td>
<td>4-24</td>
</tr>
<tr>
<td>&lt;All Frames&gt;</td>
<td>14-6</td>
</tr>
<tr>
<td>Altitude</td>
<td>2-6, 3-2</td>
</tr>
<tr>
<td>&lt;And&gt;</td>
<td>14-36</td>
</tr>
<tr>
<td>&lt;And Frame Traits&gt;</td>
<td>14-10, 14-37</td>
</tr>
<tr>
<td>&lt;And Then&gt;</td>
<td>14-24</td>
</tr>
<tr>
<td>ARROW-DOWN key</td>
<td>1-11</td>
</tr>
<tr>
<td>ARROW-HOME key</td>
<td>1-11</td>
</tr>
<tr>
<td>ARROW-LEFT key</td>
<td>1-12</td>
</tr>
<tr>
<td>ARROW-RIGHT key</td>
<td>1-12</td>
</tr>
<tr>
<td>ARROW-UP key</td>
<td>1-11</td>
</tr>
<tr>
<td>&lt;ASCII 7&gt;</td>
<td>19-33</td>
</tr>
<tr>
<td>&lt;ASCII 8&gt;</td>
<td>19-33</td>
</tr>
<tr>
<td>&lt;ASCII 8 Data&gt;</td>
<td>13-6</td>
</tr>
<tr>
<td>ASCII code table</td>
<td>Appendix B</td>
</tr>
<tr>
<td>&lt;ASCII Entry&gt;</td>
<td>12-16</td>
</tr>
</tbody>
</table>

---

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.

I-2
Assigning A Printer 15-12
Assigning The Mass Storage Device: 15-13

B

Backing up system software 5-14
BACKSPACE key 1-15
Bad FCS 19-6, 19-48
Baseband 6-14
Baud Rate: 15-17
<BEEP> 14-28

<Binary LSB Left> 11-11
<Binary LSB Right> 11-10
<Bin LSB Left> 12-16
<Bin LSB Right> 12-16

Bits/Character: 15-18
<Block l> 14-11
Block structure 14-18
Buffer Memory 7-4

Bus position 11-6
Bus Topology 6-10
Byte position in <Examine Data> Menu 19-8

C

<Capture Slave> 15-5
Carrier Sense 6-15
<Centered About> 14-8
<Change Datafield> 19-31

<Change Headers> 19-25
<Change Timestamp> 19-35
Chapter introductions 1-2, 1-5
<Character Data> 19-32
Character entry 1-16
CLEAR LINE key 1-12
Coaxial Cable 6-11
Index

Collision 12-21
<Collision Counter> 14-24, 14-34, 14-40
Collision Detect 6-15
Collision LED 16-6, 17-7
Control field (IEEE 802.2) 19-28

<Copy Block> 14-31
<Copy Files> 18-15
Copy Files Syntax 18-15
<Copy Filter> 12-19
<Copy Frame> 13-8
Copying an Entire Disc 18-20

<Copy Message> 13-8
<Copy Program> 14-32
Copy system software 5-14
Corrupt Data 19-6, 19-47
<Counters & Timers> 19-39

<Create New File> 18-9, 18-13
CSMA 6-15, A-3
CSMA/CD 6-15, A-3

<Datafield = 0000...> 13-7
<Datafield = 0101...> 13-7
<Datafield = 1010...> 13-7
<Datafield = 1111...> 13-7
Data Field, IEEE 802.3, Ethernet 6-19, 19-8

<Data File> 18-10
Date (Setting The Date) 5-18, 22-2
<Date/Time> 19-36
DDCMP: 15-15, 15-21
<Delete Block> 14-32

<Delete Bytes> 12-15, 13-5
DELETE CHAR key 1-12

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.
Index

**<Delete Field>**  12-15
**<Delete File>**  18-8
**<Delete Filter>**  12-10
DELET E LINE key  1-12
**<Delete Message>**  13-4

**<Delete Node>**  11-7
**<Delete Program>**  14-5
**Destination Address, IEEE 802.3**  6-18, 19-7
**<Detailed Format>**  19-17
**Disabled hand shaking**  15-19

Disc Designations  18-3
Disc Drive Numbers  18-3
Disc Drives  5-3
Disc file syntax  18-15
Disc File Type  18-17

**<Disc Functions> Menu**  18-1
**Disc Number or Name**  5-4, 5-7, 18-16
**Disc Sequence Number**  18-17
**Discs Supplied With System**  18-4
**<Display>**  14-21, 14-44

**<Display Frame>**  14-26, 14-43
**Display, installation**  4-16
**DSAP**  19-28

**<EBCDIC>**  19-33
**EBCDIC code table**  Appendix B
**<EBCDIC Data>**  13-6, 13-10
**<EBCDIC Entry>**  12-16
**<Edit All Fields>**  12-12

**<Edit Config.>**  15-4
**<Edit Datafield>**  13-5
**<Edit Filters>**  12-1, 12-9, 14-36

---

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.

I-5
Index

Editing programs 14-18
Editing With Keyboard Keys 1-11
Edit Message example 13-12
<Edit Messages> 13-1
<Edit Modem Str> 15-7
<Edit New Program?> 14-4

<Edit Nodelist> 11-1
  adding stations to list 11-5
  deleting stations from list 11-7
  searching the node list 11-9
  sorting the node list 11-8
<Edit Programs> 14-1

Edit Which Program? 14-4
<Else If> 14-34
<Else When> 14-34, 14-41
<Enable I/O> 15-9

Encoded DDCMP: 15-15, 15-22
<End Edit> 14-10, 14-24, 14-34
<Ending With> 14-9
End of Frame 19-34
<Enter Node Name> 12-11, 13-4
Environment, operating 3-2

Error, I/O 15-23
Error Messages Appendix C
<Ethernet> 11-4
<Ethernet Format> 12-17
Ethernet, frame 6-20
<Ethernet Header> 19-27

<Examine Data> 19-1

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.
Examine Data Display 19-2
  Byte Position 19-8
  Data 19-8
  Destination Address 19-7
  Error 19-5
  Filters 19-4
  Frame Number 19-2
  Message Length 19-3
  Source Address 19-7
  Time Stamp 19-3
  Type 19-7

<Execute Program> 16-1
<EXIT> 20-14

F

FCS, Bad, Good 12-21
FCS, choosing an FCS value 13-11
FCS Field, IEEE 802.3 6-19
Files, disc syntax 18-15
Filter examples 12-24

<Filter Format> 19-20
Filter, introduction 7-6, 12-2
Filter length 12-22
<Find Block> 14-31
Finding Frames 19-12

<Floppy 0 (#3:)> 18-6
<Floppy 1 (#4:)> 18-6
<Followed By> 14-30
<Format As Filter #> 13-9
<Format Disc> 18-18

Formatting (Initializing) a Floppy Disc 5-14, 18-18
Formatting (Initializing) a hard disc 5-10

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.
Frame Acquisition vs Display Speed 16-2
<Frame Counter> 14-23, 14-34, 14-39
Frame Errors 19-41
<Frame Matches> 14-34, 14-36
Frame match hierarchy 14-37
Frame Number 19-2
<Frames Matching> 14-11
Fuses 4-7

<Go To Byte> 13-6
<Go To Frame #> 19-14

<Hard Disc (#13)> 5-7, 18-6
Hardware Handshake:
<Hex> 15-19
<Hex> 11-10
<Hex Data> 19-32
<Hex/Char Data> 19-32
<Hex Entry> 12-16
HP 4971S Files On Disc:
HP-IB Cables, installation 15-15
HP-IB Cables, part numbers 4-18
Humidity 8-3

IEEE 802.3 Frame 2-6, 3-2,
If commands 6-17, 19-41
<If Counter> 14-19
<Increment Counter> 14-25, 14-33
Initializing (formatting) floppy disc 14-25
Initializing (formatting) hard disc 5-14, 18-18

<Insert Block> 5-10
<Insert Bytes> 14-32
INSERT CHAR key 12-15, 13-5
<Insert Field> 1-12
<Insert Line> 12-14
INSERT LINE key 11-5
<Insert Node> 11-2
<Internal Loopback> 21-6
Index

I/O Functions 15-1
I/O Mode of Operation 15-11
I/O Status Messages 15-23

J
Jabber Frames 19-6, 19-45

K
Keyboard, installation 4-14
Keyboard keys 1-11

L
LAN (Local Area Network), introduction 6-1
LAN terms, glossary Appendix A
LANCOD 18-4
<LANSAV: Disc> 18-5
LANSYS 18-4
Length Field, IEEE 802.3 6-18

Line voltage select switches 4-5
<List Directory> 18-7
<Load File> 18-14
Loading The System Software 5-4

M
Manual conventions 1-1
<Mark Frame> 14-27
<Marked Frames> 18-13, 20-13
<Marking Frames> 14-23
<Mark/Unmark> Frame 19-15

Mass Store Assigned To: 15-13
Master/Slave 7-18, 15-5
Media Access Units (MAUs) 6-13
Memory Bytes Available 21-3
Message Length 19-3

Misaligned Frame 12-21, 19-6, 19-46
Modem Fl-Duplex 15-19
Modem Hf-Duplex 15-19
Monitor Function 7-17

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.
I-9
<Monitor Network> 17-1, 17-3
Multiple Access 6-15

Network Access Methods 6-15
<Network File> 18-9
<Network Loop Test> 21-5
Network Name, assigning a name 11-3
Network Topology 6-10

Network Type, assigning a type 11-4
<New String> 15-7
<Next Block> 14-24, 14-34
<Next Frame> 19-13
NEXT key 1-13
<Next Marked> 19-14
<NO> 11-7
Node address 11-6

Node List 7-4
Node list, adding stations to the list 11-5
Node name 11-6
Node number 11-6
<No Frames> 14-11
<Nonstop> 14-10
<Nonstop Mode> 17-3

<Not> 14-36
<'Not' Byte> 12-16
Numeric entry 1-16

Options for the HP 4971A 2-11
<Or> 14-11, 14-37

Parity Bit 15-18
Peripherals for the HP 4971S 2-9
<Physical Header> 19-26
Power cords 4-11
Index

Power Requirements 2-7, 3-4
Preamble, IEEE 802.3 6-18
Preventative maintenance 8-1
<Previous Frame> 19-13
<Previous Marked> 19-15
PREV key 1-13

<Print Data> 20-10
Printer Assigned To: 15-11
<Printer Functions>
  Getting Top Of Forms 20-3
  Stopping The Printer 20-4
<Print Filters> 20-7
<Print Messages> 20-8
<Print Nodes> 20-6
<Print Programs> 20-9
<Print The List> 20-14
Print The Screen 20-15

Product Description, HP 4971S 2-2
Product Information 2-1

Programming examples 14-48
Programming with softkeys 14-18
Program structure 14-18
Protocol 15-15
Protocol Buffer Size: 15-16
Protocol timeout: 15-16
<Purge Node List> 11-7

Range of Frames 18-10, 18-12, 20-11
Received Based Detection 6-16
Receive LED 16-6, 17-7
<Rename Counters & Timers> 14-32
<Rename Programs> 14-5
<Repeated ___ Times> 14-29
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeating Displays</td>
<td>17-10</td>
</tr>
<tr>
<td>Repeating keys</td>
<td>1-15</td>
</tr>
<tr>
<td>Replacement Parts</td>
<td>8-3</td>
</tr>
<tr>
<td>&lt;Reset&gt;</td>
<td>14-30</td>
</tr>
<tr>
<td>&lt;Reset MAU&gt;</td>
<td>21-5</td>
</tr>
<tr>
<td>Restoring System Software</td>
<td>18-22</td>
</tr>
<tr>
<td>RETURN key</td>
<td>1-14</td>
</tr>
<tr>
<td>&lt;Re-write Existing&gt;</td>
<td>18-9, 18-13</td>
</tr>
<tr>
<td>&lt;Run From Buffer&gt;</td>
<td>16-4</td>
</tr>
<tr>
<td>&lt;Run From Network&gt;</td>
<td>16-3</td>
</tr>
<tr>
<td>Running Programs</td>
<td>14-18</td>
</tr>
<tr>
<td>Runt Frames</td>
<td>12-21, 19-5, 19-44</td>
</tr>
<tr>
<td>Safety Classification</td>
<td>viii</td>
</tr>
<tr>
<td>Safety Considerations</td>
<td>viii</td>
</tr>
<tr>
<td>Safety Symbols</td>
<td>ix</td>
</tr>
<tr>
<td>&lt;Save Config.</td>
<td>15-4</td>
</tr>
<tr>
<td>&lt;Save File&gt;</td>
<td>18-9</td>
</tr>
<tr>
<td>&lt;Save The List&gt;</td>
<td>18-13</td>
</tr>
<tr>
<td>&lt;Scroll Frames&gt;</td>
<td>19-13</td>
</tr>
<tr>
<td>&lt;Scroll Marked&gt;</td>
<td>19-15</td>
</tr>
<tr>
<td>&lt;Search For Addr&gt;</td>
<td>11-10</td>
</tr>
<tr>
<td>&lt;Search For Name&gt;</td>
<td>11-9</td>
</tr>
<tr>
<td>&lt;Search For Node #&gt;</td>
<td>11-9</td>
</tr>
<tr>
<td>&lt;Search For Pos’n&gt;</td>
<td>11-11</td>
</tr>
<tr>
<td>&lt;Select Bad FCS&gt;</td>
<td>13-11</td>
</tr>
<tr>
<td>&lt;Select Data Code&gt;</td>
<td>19-33</td>
</tr>
<tr>
<td>&lt;Select Disc&gt;</td>
<td>18-5</td>
</tr>
<tr>
<td>&lt;Select Format&gt;</td>
<td>17-5, 19-17</td>
</tr>
<tr>
<td>&lt;Select Good FCS&gt;</td>
<td>13-11</td>
</tr>
<tr>
<td>&lt;Select Hex FCS&gt;</td>
<td>13-11</td>
</tr>
<tr>
<td>&lt;Select Printer&gt;</td>
<td>15-11, 20-5</td>
</tr>
</tbody>
</table>

*Volume I contains Chapters 1 through 8 and Appendix A*

*Volume II contains Chapters 9 through 22 and Appendixes B through E.*
<Select Traits> 12-20
Selecting Datafield Character Formats 19-30
Selecting Frame Display Format 19-16

Selecting Frame Header Format 19-24
Selecting Timers and Counters 19-39
Selecting Timestamp Measurements 19-35
Self Tests 21-1
<Send At Power On> 15-8

<Send Message> 14-29
<Send Modem Str> 15-8
Sequence Number 18-17
Service support: hardware, software 2-12
Setting the Date and Time 5-18, 22-1
<Set Date> 5-18, 22-2

<Set Time> 5-19, 22-3
<Setup HP 4971S> 10-1
>Show Hex Address> 12-10, 13-4, 17-6
>Show Hex Name> 19-23
>Show Node Name> 12-10, 13-4, 17-6, 19-23

Simulate Function 7-17
<Single Frame> 18-12, 20-12
Site Preparation 3-1
Softkey conventions 1-8
Softkey descriptions 1-4
Softkey Levels 1-4, 1-9
Softkey programming 14-18
Softkey selections 1-4

Soft LED indicators 16-6, 17-7
Software Handshake: 15-20
Software, loading into the system 5-4
Software, system 5-2
Index

<Sort By Address> 11-8
<Sort By Bus Pos'n> 11-8
<Sort By Name> 11-8
<Sort Nodes> 11-8

Source Address, IEEE 802.3 6-18, 19-7
Spaces in entry fields 1-16
Specifications, HP 4971S Operating 2-3
Specifications, physical 2-5
SSAP field (IEEE 802.2) 19-28

<Start> 14-21, 14-44
<Start Display> 17-4
<Starting With> 14-7
<Start Monitor> 17-4
Start of Frame 19-34

<Stop> 14-24
Stop Bits: 15-17
<Stop Display> 14-44, 17-4
<Stop Monitor> 17-5
Store: command 14-6
<Summary Format> 19-17
<Suppress Data> 19-31
<Suppress Headers> 19-25

System Software
  Backing up system software 5-14
  Loading system software 5-4
  Software supplied with the HP 4971S 5-2

TAB key 1-14
Temperature 2-6, 3-2
<Test> 14-24
<Test All Hardware> 21-4
<Test Deep Trapmach.> 21-6
<Test Dual Port RAM> 21-5

Volume I contains Chapters 1 through 8 and Appendix A
Volume II contains Chapters 9 through 22 and Appendixes B through E.

I-14
<Test Hardware> 21-1, 21-4
<Test LAN Receiver> 21-5
<Test LAN Xmitter> 21-5
<Test Sha. Trapmach.> 21-6

Text Entry Conventions 1-16
<Then Go To Block> 14-26, 14-33, 14-41
<Time btwn Frames> 19-38
Time (Setting The Time) 5-19, 22-3

<Time From Frame #> 19-37
<Time From Start> 19-36
<Time From Trigger> 19-37
<Timer> 14-23, 14-34, 14-38
Time Stamp 19-3

Timestamping 7-8
Toggling Softkeys 1-10
Top Level Menu 5-16, 9-1
Transmission Media 6-11
Transmit Based Detection 6-16
Transmit LED 16-6, 17-7

Tutorial Disc 5-20
Type Field, Ethernet 19-7

<Unmark> 19-15
<Until Buffer Full> 14-7
<Until Full> 17-3

Viewing data during a program run 14-42

<Wait> 14-31
When commands 14-19
<When Event> 14-26, 14-35

<YES> 11-7
Index
CERTIFICATION

Hewlett-Packard Company certifies that this product met its published specifications at the time of shipment from the factory. Hewlett-Packard further certifies that its calibration measurements are traceable to the United States National Bureau of Standards, to the extent allowed by the Bureau's calibration facility, and to the calibration facilities of other International Standards Organization members.

WARRANTY

This Hewlett-Packard product is warranted against defects in material and workmanship from the date of delivery. The standard warranty requires the product to be returned to a service facility designated by HP and is in effect for one year from the date of shipment. An optional 90-day, on-site repair warranty is also available.

For products returned to HP for warranty service, Buyer shall prepay shipping charges to HP and HP shall pay shipping charges to return the product to Buyer. However, Buyer shall pay all shipping charges, duties, and taxes for products returned to HP from another country.

HP warrants that its software and firmware designated by HP for use with an instrument will execute its programming instructions when properly installed on that instrument. HP does not warrant that the operation of the instrument, or software, or firmware will be uninterrupted or error free.

Limitation of Warranty

The foregoing warranty shall not apply to defects resulting from improper or inadequate maintenance by Buyer, Buyer-supplied software or interfacing, unauthorized modification or misuse, operation outside of the environmental specifications for the product, or improper site preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. HP SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Exclusive Remedies

THE REMEDIES PROVIDED HEREIN ARE BUYER'S SOLE AND EXCLUSIVE REMEDIES. HP SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY.

ASSISTANCE

Product maintenance agreements and other customer assistance agreements are available for Hewlett-Packard products.

For any assistance, contact your nearest Hewlett-Packard Sales and Service Office, Addresses are provided at the back of this manual.
This section contains a summary table of contents for Volume I and a detailed table of contents for Volume II.
Table Of Contents

Volume I

VOLUME I, Getting Started With Your HP 4971S, includes the following chapters:

GENERAL INFORMATION

CHAPTER 1: USING THIS MANUAL
CHAPTER 2: PRODUCT INFORMATION
CHAPTER 3: SITE PREPARATION
CHAPTER 4: INSTALLING YOUR HP 4971S SYSTEM
CHAPTER 5: GETTING STARTED
CHAPTER 6: INTRODUCTION TO LANs
CHAPTER 7: INTRODUCTION TO THE HP 4971S
CHAPTER 8: PREVENTATIVE MAINTENANCE
APPENDIX A: GLOSSARY OF LAN TERMS
INDEX
Volume II

CHAPTER 9: THE TOP LEVEL MENU

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Level Menu Display</td>
<td>9-2</td>
</tr>
<tr>
<td>Top Level Menu Selections</td>
<td>9-3</td>
</tr>
</tbody>
</table>

CHAPTER 10: <Setup HP 4971S> MENU

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>10-2</td>
</tr>
<tr>
<td>&lt;Setup HP 4971S&gt; Function Descriptions</td>
<td>10-3</td>
</tr>
</tbody>
</table>
### CHAPTER 11: <Edit Nodelist> MENU

- <Edit Nodelist> Softkey Selections 11-2
- Introduction 11-2

- <Edit Nodelist> Softkey Descriptions 11-3
  - Assigning A Network Name 11-3
  - Assigning The Network Type 11-4
  - Adding Stations To The Node List 11-5
  - Deleting Stations From The Node List 11-7
  - Sorting The Node List 11-8
  - Searching For A Node 11-9

### CHAPTER 12: <Edit Filters> MENU

- Introduction 12-2
- <Edit Filters> Softkey Selections 12-8
- <Edit Filters> Softkey Descriptions 12-9
  - <Edit Filters> Softkey 12-9
  - Adding Or Deleting Filters 12-10
  - Editing Filter Fields 12-12

- Selecting Frame Traits 12-20
- Editing Filter Length 12-22
- Filter Examples 12-24
### CHAPTER 13: <Edit Messages> MENU

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Edit Messages&gt; Softkey Selections</td>
<td>13-2</td>
</tr>
<tr>
<td>&lt;Edit Messages&gt; Display Description</td>
<td>13-2</td>
</tr>
<tr>
<td>&lt;Edit Messages&gt; Softkey Descriptions</td>
<td>13-4</td>
</tr>
<tr>
<td>Choosing An FCS Value</td>
<td>13-11</td>
</tr>
<tr>
<td>Example For Editing A Message</td>
<td>13-12</td>
</tr>
</tbody>
</table>

### CHAPTER 14: <Edit Programs> MENU

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>14-2</td>
</tr>
<tr>
<td>Selecting A Program To Edit</td>
<td>14-4</td>
</tr>
<tr>
<td>&quot;Selecting A Program&quot; Softkey Descriptions</td>
<td>14-4</td>
</tr>
<tr>
<td>Store Function Softkey Selections</td>
<td>14-6</td>
</tr>
<tr>
<td>Store Function Softkey Descriptions</td>
<td>14-6</td>
</tr>
<tr>
<td>Program Commands Softkey Selections</td>
<td>14-12</td>
</tr>
<tr>
<td>Overview Of Programming</td>
<td>14-18</td>
</tr>
<tr>
<td>Conditional Program Statements</td>
<td>14-19</td>
</tr>
<tr>
<td>Program Commands Softkey Descriptions</td>
<td>14-20</td>
</tr>
<tr>
<td>Group 1 Softkey Descriptions</td>
<td>14-21</td>
</tr>
<tr>
<td>Group 2 Softkey Descriptions</td>
<td>14-33</td>
</tr>
<tr>
<td>Group 3 Softkey Descriptions</td>
<td>14-35</td>
</tr>
<tr>
<td>Display Functions In &lt;Edit Programs&gt; Menus</td>
<td>14-42</td>
</tr>
<tr>
<td>Selective Display</td>
<td>14-43</td>
</tr>
<tr>
<td>Continuous Display</td>
<td>14-44</td>
</tr>
<tr>
<td>Programming Examples</td>
<td>14-48</td>
</tr>
</tbody>
</table>
Table of Contents

CHAPTER 15: <I/O Functions> MENU

Introduction 15-2
<I/O Functions> Softkey Selections 15-4
<I/O Functions> Softkey Descriptions 15-4
<I/O Functions> Configuration Description 15-10
IO Status Messages 15-23

CHAPTER 16: <Execute Programs> MENU

<Execute Programs> Softkey Selections 16-2
<Execute Programs> Operation Considerations 16-2
<Execute Programs> Softkey Descriptions 16-3
<Execute Program> Soft LED Indicators 16-6
TOP LEVEL MENU

The softkey functions available in the protocol analyzer can be selected from the Top Level Menu.

This chapter includes:

- Top Level Menu Display
- Top Level Menu Selections
Top Level Menu Display

The Top Level Menu is very important because it allows you to gain access to all the features of the protocol analyzer.

The Top Level Menu appears whenever you complete the power on for the protocol analyzer. Also, from lower level displays, you can return to the Top Level Menu by pressing the <EXIT> softkey. You will need to use this menu often, so briefly experiment going to lower levels of softkeys and returning to the Top Level Menu.

HEWLETT PACKARD

4971S

LAN PROTOCOL ANALYZER

Revision: ___.___
Copyright 1987 Hewlett-Packard Company

day month year 00:00:00

4971S power-on self-test PASSED

<table>
<thead>
<tr>
<th>Setup</th>
<th>Execute</th>
<th>Monitor</th>
<th>Load</th>
<th>Disc</th>
<th>Examine</th>
<th>OTHER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzer</td>
<td>Program</td>
<td>Network</td>
<td>Applic.</td>
<td>Functions</td>
<td>Data</td>
<td>CHOICES</td>
</tr>
<tr>
<td>KEY 1</td>
<td>KEY 2</td>
<td>KEY 3</td>
<td>KEY 4</td>
<td>KEY 5</td>
<td>KEY 6</td>
<td>KEY 7</td>
</tr>
</tbody>
</table>

<OTHER CHOICES>

Printer Hardware Functions Functions Passwords Date Set Set OTHER

Figure 9-1. Top Level Menu Selections.
Top Level Menu Selections

The HP 4971S is a softkey driven protocol analyzer. The softkeys shown at the bottom of the display allow you to select the different protocol analyzer functions and then to edit or control the functions.

Softkey conventions are discussed in Chapter 1, "Using This Manual." Chapter 1 also describes conventions used by the HP 4971S and this operator's manual.
< SETUP Analyzer > MENU

This chapter describes the softkeys used to set up or configure the different HP 4971S LAN Protocol Analyzer functions.

This chapter includes:

- Introduction

- <Setup Analyzer> Function Descriptions
Introduction

The HP 4971S can be setup or configured to perform several functions. A block diagram discussion of these functions is presented in Chapter 7, Introduction To The HP 4971S.

The primary functions of the HP 4971S are integrated so that the functions can be viewed and referenced from several positions. For example, specific messages and filters you create can be referenced in programs you also create.

After you have configured or "set up" the HP 4971S for a particular application, you can save the setup information to a disc drive. This setup can later be recalled from the disc drive and quickly loaded into the HP 4971S. This feature makes it very convenient for you to have several setups stored for different applications and then quickly load the file for your current application.
<Setup Analyzer> Function Descriptions

From the Top Level Menu, press the <Setup Analyzer> softkey to display softkeys used to configure the protocol analyzer. Each of the setup softkeys are discussed separately in the following chapters.

Setup functions include:

<Edit Node List> softkey lets you assign functional names for stations in place of having to use 6 byte hex numbers for the Destination and Source Addresses.

<Edit Filters> softkey lets you create filters that will be used to qualify the information stored in memory and trigger other functions.

<Edit Messages> lets you create messages to simulate stations on your LAN.

<Edit Programs> lets you create programs to control operation of the protocol analyzer in both monitor and simulate operation.

<Disc Functions> lets you access the mass storage functions from the <Setup HP 4971S> softkey. You can create different types of files, store them in your disc drive, and any time later, load them into the protocol analyzer. This lets you quickly change your protocol analyzer to a setup you have previously established.

<I/O Functions> lets you control another HP 4971S remotely by setting up a serial data link between the two protocol analyzers.

<EXIT> softkey returns the protocol analyzer to the Top Level Menu.
This chapter describes the softkeys used to create a list of the nodes connected to your LAN. Labels can be created that identify nodes on the network by a user's name or by the device's function.

Chapter 1, Using This Manual, describes the format used to explain the HP 4971S menus. It also describes conventions used for softkeys and keyboard keys.

This chapter includes:

- <Edit Node List> Softkey Selections
- Introduction
- Assigning A Network Name
- Assigning The Network Type
- Adding Stations To The Node List
- Deleting Stations From The Node List
- Sorting The Node List
- Searching For A Node
Introduction

<Edit Node List> Menu softkeys let you create a node list that displays all the stations on your Local Area Network. Nodes on the network are properly identified by 6 byte hexadecimal numbers. This menu lets you assign a more readable name to each node. The names can be grouped by descriptive names such as:

- Functional description
  - print server
  - main_CPU

- User name
  - GaryR
  - BillM

- Group/Area identity
  - finance123
  - EngLab1

The node names feature offers a real convenience in recognizing a node's identification in the <Examine Data> Menu or while you are viewing frames while monitoring the network. Station identities are much easier to recognize in filter summary or message summary displays where many nodes are presented on one display. It is much easier to recognize a station by a name than by 6 byte Hex numbers.

Descriptions of <Edit Node List> softkeys are grouped by the following functions:

- Assigning a network name
- Assigning the network type
- Adding stations to the node list
- Deleting stations from the node list
- Sorting the node list
- Searching for a node
Assigning A Network Name

Since a Local Area Network can communicate with other Local Area Networks, it may be convenient for you to show the station names with the network name they are grouped under.

At the top of the <Edit Node List> Menu, a label field is displayed for "NETWORK NAME". The name can be any functional name that you want to assign. The default network name is Network_0.

The protocol analyzer cannot access or store files by the network name. It is displayed for documentation purposes only.

```
NETWORK NAME : NETWORK_0          NETWORK TYPE : ETHERNET

<table>
<thead>
<tr>
<th>NODE #</th>
<th>NODE NAME</th>
<th>NODE ADDRESS</th>
<th>BUS POSITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>....</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

To change the network name, use the following procedure:

1. Use the UP-ARROW cursor key to move the cursor to the "NETWORK NAME" name field.

2. Use the keyboard keys to enter the network name you want.

   Network names may be up to 17 keyboard characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_).

3. Press the RETURN key or the TAB key to move the cursor to the "NETWORK TYPE" field or press the cursor down-arrow key to move the cursor to the first node name.
Assigning The Network Type

The NETWORK TYPE field displayed at the top of the <Edit Node List> Menu is for documentation purposes only.

<table>
<thead>
<tr>
<th>NETWORK NAME : NETWORK_0</th>
<th>NETWORK TYPE : ETHERNET</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE #</td>
<td>NODE NAME</td>
</tr>
<tr>
<td>....</td>
<td>..............</td>
</tr>
</tbody>
</table>

ETHERNET   
IEEE  
802.3

Figure 11-1. Network Type Selection.

To select the protocol type, use the following procedure:

1. From the <Edit Node List> Menu, use the cursor up-arrow key to move the cursor to the Network Type field.

If the cursor is in the Network Name field, use the TAB or RETURN key to move the cursor to the Network Type field.

2. Use the softkeys to select either <ETHERNET> or <IEEE 802.3> protocol.

Select <ETHERNET> softkey for 10BASE2 networks.
Adding Stations To The Node List

Up to 1000 stations can be added to the Node List by using the <Insert Node> softkey. The following softkeys and definitions are used to add stations.

The figure below shows the display generated from the <Edit Node List> softkey. The default display shows the protocol analyzer and its Ethernet address. Each HP 4971S LAN Protocol Analyzer has a unique address, only the first three bytes are similar.

<table>
<thead>
<tr>
<th>NETWORK NAME : NETWORK 0</th>
<th>NETWORK TYPE : ETHERNET</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE #   NODE NAME       NODE ADDRESS     BUS POSITION</td>
<td></td>
</tr>
<tr>
<td>----  ---------------  ---------------  ---------------</td>
<td></td>
</tr>
<tr>
<td>0001  HP LAN Analyzer  08-00-09- -  0000</td>
<td></td>
</tr>
</tbody>
</table>

Figure 11.2. <Edit Node List> Menu Display

<Insert Node>   Pressing this softkey adds another field to the node table list. Additional nodes may be inserted at any point in the Node List. Each inserted node is added immediately above the line containing the cursor.

Each node contains the following fields:

- Node number
- Node name
- Node address
- Bus position
Node number is a number generated by the protocol analyzer to provide an easy reference when viewing the node name list and is not used otherwise.

Node Name The Node Name field enables you to enter a name that allows easier recognition of a specific station.

The Node Name field may have up to 17 keyboard characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press TAB or RETURN key to complete the entry.

Node Address The Node Address field entry must be in Hexadecimal characters. Six bytes are used for the address entry.

Bus Position The Bus Position field can be up to 4 numeric characters. The Bus Position is similar to the Node Name in that it is user defined.

The Bus Position Field is for documentation purposes only and is not used by the protocol analyzer. You can use this field in any way that helps you identify your network to yourself.

Duplicate entries

When you press the <EXIT> softkey to leave the <Edit Node List> Menu, duplicate entries are deleted from the list. The default node name, HP_LAN_Analyzer, and the Source Address unique to the analyzer can be duplicated while you are editing the node list. However, when you press <EXIT> softkey to leave the menu, all duplicate names and addresses are deleted. The first entry for duplicate names or addresses remain on the list.

When duplicate names other than HP_LAN_Analyzer and the Source Address unique to the analyzer are entered and you try to leave the name or address field, the analyzer returns the previously entered name or address.

<Edit Node List> Menu  11-6
Deleting Stations From The Node List

Stations can be removed from the node list one at a time or the entire list can be deleted at once.

<Delete Node>  
This softkey is used to remove work stations one station at a time from the Node List. Stations may be deleted from the node list by positioning the cursor to either the Node Name, Node Address, or Bus Position field of the station you want to delete. When the station has been identified by the cursor, press <Delete Node> softkey to remove the station.

Stations remaining on the node list below the deleted station are moved up one line to fill the deleted space. The Node # field updates to fill in where the node was deleted so that the numbers are always contiguous.

<Purge Node List>  
The <Purge Node List> softkey removes all the stations from the node list at one time. When this softkey is pressed, message, Reinitialize the node list?, and softkey choices <YES> and <NO> are displayed.

<YES>  
If you press the <YES> softkey, the entire node list is deleted. The node name list starts again at default node (HP_LAN_Analyzer).

<NO>  
If the <NO> softkey is pressed, the existing node list is not deleted and the display returns to the previous softkey choices.
Sorting The Node List

The node list can be displayed in a variety of sequences to help you easily find stations in the list.

**<Sort Nodes>**
Pressing the <Sort Nodes> softkey changes the softkey display to:

- **<Sort By Name>**
- **<Sort By Address>**
- **<Sort By Bus Pos’n>**

**<Sort By Name>**
The node list is sorted using the names in the Node Name field. Sorting is generally done in the standard ASCII collating sequence. For example, CTRL-X characters are followed by alphabet characters and then by numbers. Alphabet characters are not upper/lower case sensitive.

**<Sort By Address>**
sorts the node list using entries in the Node Address field. The sorting is done in the order of 0 through F and then with Xs (don’t cares) sorted last.

\[
0 < 9 < F < X
\]

**<Sort By Bus Pos’n>**
The node list is sorted using the entries in the Bus Position field. The sorting arranges the node list in an increasing bus position sequence.
Searching For A Node

Softkeys on the protocol analyzer make it easy to look through the Node List to find stations by using their assigned identities: node number, node name, node address, or position on the bus.

<Search for Node #>

The <Search For Node Number> softkey lets you search the node list for the node number you specify.

Press <Search For Node Number> softkey and enter a node number in the displayed field. The node number entry must be in numeric characters.

Press RETURN key to execute the search.

When the specified node number is found, that station is displayed at the top of the node list.

<Search For Name>

This softkey lets you search the node list for a node name you specify.

Press the <Search For Name> softkey to display a field for the Node Name entry. The node name entry must be exactly as displayed in the node list. Letter case is significant.

Press RETURN key to execute the search.

When the node name you are searching for is found, that node is displayed at the top of the node list.
SEARCHING FOR A NODE (cont.)

<Search for Addr> This softkey lets you search the node list for a node address
that you enter.

When that node address is found, the node is displayed at the
top of the node display.

Pressing <Search For Addr> softkey prompts you for the node
address. The address may be entered in one of three formats
selected by softkeys:

<Hex> Enter the address in hex characters 0 - F or X (don’t care).

You can use don’t cares to view all nodes with a common
prefix. For example:

08-09-00-0A-XX-XX

Press RETURN key to execute the search.

<Binary LSB Right> softkey lets you enter each address character byte in
binary with the least significant bit on the right side. Only
the byte marked by the cursor is displayed in binary.

The address entry must be in binary 1’s and 0’s or X (don’t
care).

After the address is entered, press RETURN key to
execute the search.

When you complete a binary entry using a don’t care, the
part of the byte having the don’t care is displayed as ◄.

For example:

1010001X = A ◄

XX111010 = ◄A

<Edit Node List> Menu 11-10
SEARCHING FOR A NODE (cont.)

<Binary LSB Left> softkey lets you enter each address character byte in binary with the least significant bit on the left side. Only the byte marked by the cursor is displayed in binary.

The address entry must be in binary 1’s and 0’s or X (don’t care).

After the address is entered, press RETURN key to execute the search.

See the preceding description in <Binary LSB Right> for don’t care operation.

<Search For Pos’n> The node list can be searched via the Bus Position column.

Press <Search For Pos’n> and enter the bus position in the displayed field. Press the Return key to execute the search.
This section describes softkeys used to control filter functions in the HP 4971S LAN Protocol Analyzer.

This chapter includes:

- Introduction
- <Edit Filters> Softkey Selections
- Add, Delete, And Label Filters
- Add, Delete, And Label Filter Fields
- Select Character Types
- Select Network Protocol Display Format
- <Edit Filters> Copy Functions
- Select Frame Traits
- Edit Filter Length
- Filter Examples
Introduction

Filtering capability greatly enhances the power of the HP 4971S LAN Protocol Analyzer. The <Edit Filters> Menu lets you easily use this capability. Filtering frames on a Local Area Network (LAN) provides the following benefits:

- More effectively use buffer memory

  store only frames matching "xxxx" condition

- Make decisions in program flow

  "wait until" ... filter condition X is true, then goto...

  "if" ... filter condition X is true, goto...

- Interact with network in real-time program execution.

  when station ABC transmits XX message, reply with message_1

- Filter on higher level protocol formats

Filters can be used to qualify what frames are stored in the protocol analyzer memory. The HP 4971S has a large storage capacity; however, at a Local Area Network's transmission rate of 10 Mbits/second, the buffer memory would be filled in only a few seconds of heavy traffic. Filters allow you to store only the information that is of interest to you. In effect, this expands the time the protocol analyzer can monitor the network.

Filtering the frames you store offers more convenience to you than just providing more effective memory capacity. Without filters, you would have to scroll through the equivalent of many typewritten pages of information to find the specific messages you are interested in each time you fill the memory buffer.

Filters can be used with WAIT and IF commands to control the program flow in programs you can create. These commands allow you to make branching decisions depending on filters matching or not matching conditions occurring in frames on the network.
Filters let you control the functions of timers and counters available in programs you create. You can start, stop, and reset counters and timers by decisions made on filter conditions.

While filters allow you to choose what messages to store from a specific station(s), you can also use filters to choose what response message to transmit in reply to a specific station(s).

Frames received from an IEEE 802.3 or Ethernet LAN conform to a protocol standard. The standard assigns elements in the message to a particular byte or octet location. The elements and their assigned position within a frame are shown below.

<table>
<thead>
<tr>
<th>Frame Element</th>
<th>Byte Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Address</td>
<td>1-6</td>
</tr>
<tr>
<td>Source Address</td>
<td>7-12</td>
</tr>
<tr>
<td>Type or Length Field</td>
<td>13-14</td>
</tr>
<tr>
<td>Data field</td>
<td>15-1515</td>
</tr>
<tr>
<td>802.2 Header (optional)</td>
<td>15 - DSAP field</td>
</tr>
<tr>
<td></td>
<td>16 - SSAP field</td>
</tr>
<tr>
<td></td>
<td>17 - 17-18 for Control field</td>
</tr>
<tr>
<td>FCS (CRC error check)</td>
<td>Last four byte locations in frame.</td>
</tr>
</tbody>
</table>

```
Bytes -->
6  6  2  46-1500  4
```

```
Dest  Source  Type/ Addr  Addr  Length  .
      Addr  802.2. info
```

<Edit Filters> Menu  12-3
The HP 4971S Protocol Analyzer can identify bytes in frames from any station using Ethernet, IEEE 802.2, and IEEE 802.3 protocols and test them for some particular content. Depending on whether the contents of a byte pass or fail a comparison test in the protocol analyzer, you can decide to keep or ignore the frame.

The protocol analyzer filter function may be viewed as a set of 62 individual byte comparators. Each comparator can be assigned to a byte position within a frame. Each comparator can examine the contents of its assigned byte position within any frame received from the network.

Fourteen of the available 62 filter comparators are permanently reserved to the Destination Address, Source Address, and Type/Length fields. Two additional comparators are reserved; one for byte 15, the first byte in the Data Field and one to detect when the maximum frame length exceeds 2022 bytes.

Byte 15 can be a single byte filter field or it may be included as part of a larger filter field. In contrast, the length of the Addresses and Type/Length filter fields can not be changed.

<table>
<thead>
<tr>
<th></th>
<th>Trapmachine bytes available</th>
</tr>
</thead>
<tbody>
<tr>
<td>62</td>
<td>Reserved filter bytes</td>
</tr>
<tr>
<td>16</td>
<td>Destination Address</td>
</tr>
<tr>
<td>6</td>
<td>Source Address</td>
</tr>
<tr>
<td>2</td>
<td>Type/Length</td>
</tr>
<tr>
<td>1</td>
<td>Data Byte 15</td>
</tr>
<tr>
<td>1</td>
<td>Max length (byte 2023)</td>
</tr>
<tr>
<td>16</td>
<td>Total</td>
</tr>
<tr>
<td>46</td>
<td>Trapmachine bytes available for user assignment</td>
</tr>
</tbody>
</table>

<Edit Filters> Menu  12-4
Things to know about filter construction.

I. Filter Definitions.

A. Up to 16 filters can be defined.

B. Each filter includes both Address Fields, the Type/Length field and at least one Data Field byte.

C. A filter can include 32 separate filter fields; and up to 29 of the 32 separate fields can be defined in the Data Field.

\[
\begin{array}{c|c}
   & \text{Location} \\
\hline
   1 & \text{Destination Address Field} \\
   1 & \text{Source Address Field} \\
   1 & \text{Type/Length Field} \\
   29 & \text{Data Field} \\
\end{array}
\]

\[32\text{ separate filter fields}\]

II. Filter Field Definitions.

A. Filter field length in bytes Location

\[
\begin{array}{c|c}
   & \text{Location} \\
\hline
   6 & \text{Destination Address} \\
   6 & \text{Source Address} \\
   2 & \text{Type/Length field} \\
   1-15 & \text{Anywhere in Data Field or in byte locations 1515--2022.} \\
\end{array}
\]

B. Filter fields within a filter cannot share or overlap bytes.

C. Filter fields in different filters can share a byte comparator location.

1. When different filters share a byte comparator location, a "Filter bytes available" counter is reduced by one only for the first filter declaring the byte location.

2. As additional filters share the same byte comparator location, the "Filter bytes available" count is not reduced again.
If only the default 15 filter bytes are being used, then only 3 filter bytes are new locations.

**FILTER_3**

If **FILTER_3** uses the same filter byte locations as defined in **FILTER_2** except that the 5 Data Field bytes are at locations 54-58, then only 3 filter bytes are new locations.

38 "Trapmachine Bytes Are Available"

**Figure 12-1. Example for "Filter Bytes Available".**
<Edit Filters> Softkey Selections

Edit Filters
Add Filter
Delete Filter
Show Node Names
Show Hex Addresses

Enter Node Name (displayed only when cursor is in ADDRESS fields)

Edit all Fields

Cursor in Addr Fields
'NOT' Byte
Copy From Filter HW
Bin LSB Right
Hex
ASCII
Roman 8
EBCDIC
OTHER CHOICES
80.3 Format
Ethernet Format
Copy Filter
Copy Frame

Cursor in Length/Type Field
Insert Field
'NOT' Byte
Copy From Filter HW
Bin LSB Right
Hex
ASCII
Roman 8
EBCDIC
OTHER CHOICES
80.3 Format
Ethernet Format
Copy Filter
Copy Frame

Cursor in Data Field
MIN, MAX Fields
Insert Field
'NOT' Byte
Delete Field
'NOT' Byte
Copy Filter HW
Bin LSB Right
Hex
ASCII
Roman 8
EBCDIC
OTHER CHOICES
80.2 Format
Ethernet Format
Copy Filter
Copy Frame

OTHER CHOICES
Select Traits
Accept/Reject Frame with GOOD FCS
Accept/Reject Frame with BAD FCS
Accept/Reject MISALIGNED Frame
Accept/Reject RUNT Frame

Enter Node Name (displayed only when cursor is in ADDRESS Fields)

EXIT

Optional keyboard can be used with the HP 4971S to display other character code sets. See appendix B.
The <Edit Filters> softkey displays an overview of the filters defined and available for programming the protocol analyzer. A given filter can test or compare only on messages received from the Source Address specified for that filter and/or messages transmitted to the Destination Address specified for that filter.

To get to the <Edit Filters> softkey functions, use the following steps:

From the Top Level Menu:

1. Press <Setup 4971S> softkey.
2. Press <Edit Filters> softkey.

The figure below shows the default display is a summary of filters that have been defined. Line 4 shows the default display for an undefined filter. Line 5 contains a filter with addresses displayed in Hexadecimal code. Line 6 is an example of a filter with user defined filter label and equivalent names displayed for the addresses.

Frames can also be filtered by their length. Minimum and maximum frame lengths can be specified.

<table>
<thead>
<tr>
<th>FILTER</th>
<th>FILTER</th>
<th>DESTINATION ADDRESS</th>
<th>SOURCE ADDRESS</th>
<th>LENGTH OF FRAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FILTER_0</td>
<td>XX·XX·XX·XX·XX·XX</td>
<td>XX·XX·XX·XX·XX·XX</td>
<td>15</td>
</tr>
<tr>
<td>1</td>
<td>FILTER_1</td>
<td>08·00·71·AB·CD·EF</td>
<td>08·11·34·A1·23·10</td>
<td>15</td>
</tr>
<tr>
<td>2</td>
<td>printer filter</td>
<td>printer_4</td>
<td>cpu_1</td>
<td>15</td>
</tr>
</tbody>
</table>

Figure 12·2. <Edit Filters> Softkey Display.
Add, Delete, And Label Filters

Softkeys are provided to let you quickly add or delete filters to the summary filter display. Up to 16 filters can be created.

<Add Filter> adds filters to the displayed filter list. Sixteen filters can be defined. The Filter #’s are labeled in Hexadecimal sequence, 0..9, A..F.

If all the filter #’s displayed are in sequence, the <Add Filter> softkey will add the next available Filter # to the bottom of the list.

If any Filter #’s are missing in the list, the <Add Filter> softkey inserts filters by the algorithm:

1. Insert closest missing Frame # above the cursor location.
2. If there is no room above the cursor location, then, insert closest missing Frame # below the cursor location.

FILTER NAMES
You can change the filter name to a descriptive label that identifies the filter function.

Filter names can have up to 17 keyboard characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press RETURN or TAB keys to complete the name entry.

<Delete Filter> removes filters from the displayed filter list. Use the keyboard Tab key or cursor keys to position the cursor to the filter to be removed.

Filters below the deleted field will move up to fill the deleted position. Remaining filters retain their Filter # and Filter Label.
<Show Node Name> causes the Destination and Source addresses to be converted from Hexadecimal code to the equivalent node name defined in the <Edit Node List> Menu.

<Show Hex Addresses> causes the Destination and Source Address fields to be displayed in Hexadecimal code.

NOTE

In the <Edit Filters> Menu, the softkey selections change when the cursor is moved from the FILTER LABEL Field to an address field. Use the keyboard TAB key or the cursor keys to move the cursor to a Destination or Source Address field. Notice the softkey fields change.

<Enter Node Name> softkey lets you define the Destination and Source Address fields using node names.

This softkey is displayed only when the cursor is in an ADDRESS FIELD.

Node names that have been assigned in the <Edit Node List> menu will be displayed as softkeys when you press <Enter Node Name> softkey. You may use a softkey to enter a valid node name for its equivalent Destination or Source address. If more than 6 node names have been defined, use the <OTHER CHOICES> softkey to see additional node names. You can also type the node name from the keyboard.
Add, Delete, And Label Filter Fields

Details of the filter fields are displayed and are available for editing when the <Edit all Fields> softkey is selected.

After you press <Edit all Fields>, the softkey selections change as the cursor is moved between address fields, Type/Length Field, or Data Field. The foldout softkey selection chart for this chapter shows the choices available as you move the cursor. Fold out the selection chart and observe which softkeys are displayed as the cursor is moved between different fields.

**<Edit all Fields>** softkey causes the protocol analyzer to display details of filter fields for the filter presently marked by the cursor.

The following frame fields can be edited by choosing the <Edit all Fields> softkey:

Address Fields  Type Field  Data Field

<table>
<thead>
<tr>
<th>FIELDS of FILTER #0</th>
<th>Label: Filter_0</th>
<th>MINIMUM Frame Length = 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>46 Filter bytes available</td>
<td></td>
<td>MAXIMUM Frame Length = 2022</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>DATA</td>
<td>XX</td>
</tr>
</tbody>
</table>

Hexadecimal (0..9, A..F or X) field data entry

<table>
<thead>
<tr>
<th>Bin LSB</th>
<th>Bin LSB</th>
<th>Hex</th>
<th>ASCII 8</th>
<th>EBCDIC</th>
<th>OTHER</th>
<th>CHOICES</th>
<th>EXIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Right</td>
<td>Entry*</td>
<td>Entry</td>
<td>Entry</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 12-3. <Edit all Fields> Softkey Selected.
The softkey selection chart shows all the softkey choices available when the <Edit All Fields> softkey is pressed with the cursor in the different frame filter fields.

Softkey descriptions are provided for the softkeys seen when the cursor is in a filter’s Data Field. Since the same softkeys are used in the address and Type/Length Fields, the descriptions are given only once.

<Edit all Fields> softkey selections are grouped into the following three primary functions:

Add, delete, and edit filter fields.
- Insert Field
- Delete Field
- Insert Byte(s)
- Delete Byte(s)

Select character type
- 'NOT' Byte
- Bin LSB Left
- Bin LSB Right
- ASCII 7
- ASCII 8 Roman 8
- EBCDIC

Select network protocol
- 802.3 Format
- Ethernet Format
- 802.2 Format

Utility softkeys
- Copy Filter
- Copy Frame
<Insert Field> adds an additional filter field in the Data field.

When the <Insert Field> softkey is pressed, a new filter field is inserted immediately below the cursor.

The newly inserted BYTE field is automatically loaded with the next byte location available after the previous filter field. If you want to assign the new filter field to a different byte location, enter the new location number from the keyboard.

Guidelines for inserting filter fields:

1. You can not insert fields between consecutive numbered bytes.

   Filter fields can not overlap. If you need to insert a data field filter that would overlap existing filter fields, you must change the length and position of existing filter fields before the new filter field may be inserted.

2. Up to 32 filter fields can be defined for each filter.

   **WITH IEEE 802.2 FORMAT**
   In addition to DSAP, SSAP, and CONTROL filters, up to 26 additional data filter fields can be defined.

   **NOT IEEE 802.2 FORMAT**
   Up to 29 data filter fields can be defined.

The FIELD LABEL for each data field filter can be identified by up to 17 alphanumeric characters. Spaces or underscore (_) may be used between characters in the FIELD LABEL.
<Delete Field> removes the filter field currently marked by the cursor.

The cursor can be positioned in any part of the filter field being deleted.

<Insert Bytes> adds or inserts bytes in the filter field currently marked by the cursor.

Up to 15 byte locations can be defined in a filter field.

If the cursor is in the FIELD DATA field, new bytes are inserted immediately before the byte marked by the cursor.

If the cursor is in the BYTE Field, FIELD LABEL Field, or at the last character position of a field displayed in hex, new bytes are added at the end of the FIELD DATA Field.

<Delete Bytes> removes bytes from the filter field currently marked by the cursor.

At least one byte must be left in each filter field. If you want to delete all bytes in a filter field, use the <Delete Field> softkey.

If the cursor is in the FIELD DATA Field, deleted bytes include the byte marked by the cursor and the bytes following the cursor.

If you enter more bytes to be deleted than follow the cursor, remaining bytes will be removed from in front of the cursor.

If the cursor is not in the FIELD DATA Field, the rightmost bytes will be deleted.
Select Character Type

Characters in the Addresses, Type/Length, and Data Fields can be displayed in several formats by simple softkey selections. This enables you to change the character display for easier bit or byte pattern entry as you edit the filter contents.

Optional keyboards may be used with the HP 4971S to display additional character code sets. See appendix B in the Getting Started volume.

Undefined characters are displayed as _. Appendix B shows keys that may be used to enter control characters such as $f and $g.

Don’t Care "Don’t Care" characters or bits are displayed as " X " in hex or binary character types and as " $ $ " in other character types.

<’NOT’ Byte> enables a filter to match any character except the character entered. ‘NOT’ Byte characters as shown as blinking characters.

<Bin LSB Left> lets you enter characters in binary with the least significant bit at the left for each character. Only the byte marked by the cursor is displayed in the binary format.

<Bin LSB Right> lets you enter characters in binary with the least significant bit at the right for each character. Only the byte marked by the cursor is displayed in the binary format.

<Hex Entry> lets you enter characters in Hexadecimal.

<ASCII 7> lets you enter characters in ASCII 7. Different parity checking softkeys are displayed for your choice.

<ASCII 8 <Roman 8> lets you enter characters in ASCII 8 or Roman 8, depending on what keyboard is used.

<EBCDIC Entry> lets you enter characters in EBCDIC.
Select Network Protocol Display Format

The network protocol for the displayed frame may be changed by softkey selection.

**<802.3 Format>**

causes the protocol header for the displayed filter to be shown in IEEE 802.3 protocol. This choice will display the third filter field as a Length Field.

<table>
<thead>
<tr>
<th>FIELDS of FILTER #0</th>
<th>Label: Filter_0</th>
<th>MINIMUM Frame Length = 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>46 Filter bytes available</td>
<td>MAXIMUM Frame Length = 2022</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>LENGTH (TYPE)</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>DATA</td>
<td>XX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>DATA</td>
<td>XX</td>
</tr>
</tbody>
</table>

**<Ethernet Format>**

causes the protocol header for the displayed filter to be shown in Ethernet protocol. This choice will display the third filter field as a Type Field.

<table>
<thead>
<tr>
<th>FIELDS of FILTER #0</th>
<th>Label: Filter_0</th>
<th>MINIMUM Frame Length = 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>46 Filter bytes available</td>
<td>MAXIMUM Frame Length = 2022</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>DATA</td>
<td>XX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>DATA</td>
<td>XX</td>
</tr>
</tbody>
</table>
inserts the 802.2 fields; DSAP, SSAP, and CONTROL below the Length/Type Field.

A one-byte CONTROL field is inserted. The CONTROL field can be expanded to 2 bytes by using the <Insert Byte> softkey.

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
<th>COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX-XX-XX-XX-XX-XX</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX-XX-XX-XX-XX-XX</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>13</td>
<td>LENGTH (TYPE)</td>
<td>XX-XX</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>DSAP</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>SSAP</td>
<td>XX</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>CONTROL</td>
<td>XX</td>
<td></td>
</tr>
</tbody>
</table>
<Edit Filters > Copy Functions

<Copy Filter> copies the contents of a specified filter to the currently displayed filter.

Press <Copy Filter#> softkey to display:

Select softkey OR enter valid name: ________

Select a filter to copy by using the displayed softkeys or you can enter a filter name with the keyboard keys. Press RETURN key to execute the copy function.

<Copy Frame> copies an existing frame from the Receive Buffer to load the fields of a filter. Bytes locations specified by the filter are filled by the contents from the same byte locations of the frame in the Receive Buffer.
Select Frame Traits

In addition to filtering on specific byte comparator locations in a frame and minimum and maximum frame lengths, the HP 4971S LAN Protocol Analyzer can filter on different types of frame errors.

<Select Traits> allows you to choose to view good frames and/or frames with different types of errors.

The "RUNT FRAME FILTER" paragraph shown below is displayed only if "Runt Frame Filter" is enabled in the <Hardware Functions> Menu.

<table>
<thead>
<tr>
<th>Accept/Reject</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept/Reject</td>
<td>Frame with GOOD FCS</td>
</tr>
<tr>
<td>Accept/Reject</td>
<td>Frame with BAD FCS</td>
</tr>
<tr>
<td>Accept/Reject</td>
<td>Misaligned Frame</td>
</tr>
<tr>
<td>Accept/Reject</td>
<td>RUNT Frame</td>
</tr>
</tbody>
</table>

(A frame with a bad FCS and with 1 to 7 residual bits following the final byte of the FCS.)

(A frame which contains fewer than 60 bytes, not including the FCS.)

The frame traits selected in this menu will apply to all filters.

The RUNT FRAME FILTER is installed, therefore Frames containing less than 512 bits including the preamble and FCS (equivalent to a length of approximately 53 bytes), will not be recognized.

Accept Reject EXIT

Figure 12-4. <Frame Traits> Softkey Display.
Frame with GOOD FCS  
Frame with BAD FCS  
These fields let you choose to accept or reject frames that you receive with good or bad FCS values.

The majority of frames would normally be received with good FCS values. To filter out unwanted frames, you may want to capture only the frames with FCS errors. This lets you view only the frames having problems and greatly reduces the number of frames you have to view.

Misaligned Frame  
A misaligned Frame has a total number of bits that is not divisible by eight and also has an FCS error.

RUNT Frame  
Runt frames are defined as frames having less than 60 bytes in the address, Type/Length and data fields. Runt frames may occur as a result of frame collisions on the network.

Figure 12-4 shows the display with "Runt Frame Filter: Enabled" in the <Hardware Functions> Menu. With the Runt Frame Filter: Enabled, the analyzer discards frames with less than 512 bits.

If the Runt Frame Filter: is "Disabled" in the <Hardware Functions> Menu, frames with as few as one byte in the data field are stored in the HP 4971S.

Frame errors are also discussed in "Displaying Frame Errors" section in Chapter 19, <Examine Data> Menu.
Edit Filter Length

In addition to filtering on particular bytes in a frame, you can filter on frame lengths.

In order to conserve buffer memory, you may want to exclude frames exceeding some maximum length, or, you may want to view only jabbering frames (frames with more than 1514 bytes).

You can control the frame length for particular filters by positioning the cursor in the MINIMUM or MAXIMUM Frame Length Fields. The default values are:

MINIMUM Frame Length = 15

MAXIMUM Frame Length = 2022

You can manually set these values to what your filter needs are. The protocol analyzer will only let you enter numbers so that the minimum value is always less than the maximum value.
**Minimum Filter Length**

The MINIMUM Filter Length Field uses the following rules:

1. The minimum entry for the MINIMUM Filter Length Field is 15 bytes.

2. The MINIMUM Filter Length Field entry must be an odd number.

3. When you specify additional filter fields in the DATA Field which occupy byte positions greater than the minimum value, the MINIMUM Frame Length Field automatically increases to be the largest odd numbered byte occurring in the filter field.

**Maximum Filter Length**

The MAXIMUM Filter Length Field uses the following rules:

1. The maximum entry for the MAXIMUM Filter Length Field is 2022 bytes.

2. The MAXIMUM Filter Length Field entry must be an even number.

3. You can specify a maximum filter length less than 2022 bytes. However, if you then add a filter field which occupies byte positions greater than the new maximum filter length, the MAXIMUM Frame Length Field automatically increases to be the next largest even value which will contain all the bytes in the filter.
Filter Examples

This section contains several examples to illustrate filter applications for high level protocols.

The first three FIELD LABEL Fields are automatically entered by the HP 4971S Protocol Analyzer. The following FIELD LABELS can be labels you choose to identify that fields function.

The examples do not show specific bytes in the filter fields. Instead, only the number of bytes in the field is shown. You can enter any specific byte you need to filter on.

FILTER EXAMPLE 1.

REQUIREMENT: Define a filter to decode level 3 Internal Protocol (IP) for ARPANET implementation.

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>IP_Ver_Hdr_length</td>
<td>XX·XX</td>
</tr>
<tr>
<td>16</td>
<td>IP_Type_of_servic</td>
<td>XX</td>
</tr>
<tr>
<td>17</td>
<td>IP_Total_Length</td>
<td>XX·XX</td>
</tr>
<tr>
<td>19</td>
<td>IP_Identification</td>
<td>XX·XX</td>
</tr>
<tr>
<td>21</td>
<td>IP_Flg_Frgmt_Ofst</td>
<td>XX·XX</td>
</tr>
<tr>
<td>23</td>
<td>IP_Time_to_live</td>
<td>XX</td>
</tr>
<tr>
<td>24</td>
<td>IP_Protocol</td>
<td>XX</td>
</tr>
<tr>
<td>25</td>
<td>IP_Checksum</td>
<td>XX·XX</td>
</tr>
<tr>
<td>27</td>
<td>IP_Source_address</td>
<td>XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>31</td>
<td>IP_Dest_address</td>
<td>XX·XX·XX·XX</td>
</tr>
</tbody>
</table>

MINIMUM Frame Length = 33
MAXIMUM Frame Length = 2022

<Edit Filters> Menu   12-24
FILTER EXAMPLE 2.

REQUIREMENT: Define a filter to decode level 4 Transmission Control Protocol (TCP) commonly found in local area network implementation.

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX-XX-XX-XX-XX-XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX-XX-XX-XX-XX-XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX-XX</td>
</tr>
<tr>
<td>35</td>
<td>TCP_Source_port</td>
<td>XX-XX</td>
</tr>
<tr>
<td>37</td>
<td>TCP_Dest_port</td>
<td>XX-XX</td>
</tr>
<tr>
<td>39</td>
<td>TCP_Seq_number</td>
<td>XX-XX-XX-XX-XX</td>
</tr>
<tr>
<td>43</td>
<td>TCP_Dest_addr</td>
<td>XX-XX-XX-XX-XX</td>
</tr>
<tr>
<td>47</td>
<td>TCP_Flg_Ofst_Cflg</td>
<td>XX-XX</td>
</tr>
<tr>
<td>49</td>
<td>TCP_Window</td>
<td>XX-XX</td>
</tr>
<tr>
<td>51</td>
<td>TCP_CHECKSUM</td>
<td>XX-XX</td>
</tr>
<tr>
<td>53</td>
<td>TCP_Urg_pointer</td>
<td>XX-XX</td>
</tr>
</tbody>
</table>
FILTER EXAMPLE 3.

REQUIREMENT: Define a filter format to decode a combined level 4 Transmission Control Protocol (TCP) and level 3 Internal Protocol (IP).

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td></td>
<td>Node Name: -- Not Defined --</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td></td>
<td>Node Name: -- Not Defined --</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>IP_Ver_Hdrlg_Type</td>
<td>XX·XX</td>
</tr>
<tr>
<td>17</td>
<td>IP_Total_Length</td>
<td>XX·XX</td>
</tr>
<tr>
<td>19</td>
<td>IP_Identification</td>
<td>XX·XX</td>
</tr>
<tr>
<td>21</td>
<td>IP_Flgs_Ofst</td>
<td>XX·XX</td>
</tr>
<tr>
<td>23</td>
<td>IP_T_live</td>
<td>XX·XX</td>
</tr>
<tr>
<td>25</td>
<td>IP_Checksum</td>
<td>XX·XX</td>
</tr>
<tr>
<td>27</td>
<td>IP_Srce_Dest_addr</td>
<td>XX·XX·XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>35</td>
<td>TCP_Srce_Dest_addr</td>
<td>XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>39</td>
<td>TCP_Seq_number</td>
<td>XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>43</td>
<td>TCP_Dest_addr</td>
<td>XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>47</td>
<td>TCP_Data_Ofst_Cfg</td>
<td>XX·XX</td>
</tr>
<tr>
<td>49</td>
<td>TCP_Window_chksum</td>
<td>XX·XX·XX·XX</td>
</tr>
<tr>
<td>53</td>
<td>TCP_Urg_pointer</td>
<td>XX·XX</td>
</tr>
</tbody>
</table>
FILTER EXAMPLE 4.

REQUIREMENT: Define a filter to decode level 3 protocol for Xerox Network System (XNS).

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>06-00</td>
</tr>
<tr>
<td>15</td>
<td>IDP_Checksum</td>
<td>XX·XX</td>
</tr>
<tr>
<td>17</td>
<td>IDP_Length</td>
<td>XX·XX</td>
</tr>
<tr>
<td>19</td>
<td>IDP_Transport_Cnt</td>
<td>XX</td>
</tr>
<tr>
<td>20</td>
<td>IDP_Packet_Type</td>
<td>XX</td>
</tr>
<tr>
<td>21</td>
<td>IDP_Dest_Net</td>
<td>XX·XX·XX</td>
</tr>
<tr>
<td>25</td>
<td>IDP_Dest_Host</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>31</td>
<td>IDP_Dest_Socket</td>
<td>XX·XX</td>
</tr>
<tr>
<td>33</td>
<td>IDP_Source_Net</td>
<td>XX·XX·XX</td>
</tr>
<tr>
<td>37</td>
<td>IDP_Source_Host</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>43</td>
<td>IDP_Source_Socket</td>
<td>XX·XX</td>
</tr>
</tbody>
</table>
FILTER EXAMPLE 5:

REQUIREMENT: Create a filter to decode a combined level 3 and level 4 protocol for Xerox Network System (XNS).

### Fields of Filter #0: Sequenced_Packet

**MINIMUM Frame Length = 55**

<table>
<thead>
<tr>
<th>BYTE</th>
<th>FIELD LABEL</th>
<th>FIELD DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>13</td>
<td>LENGTH (TYPE)</td>
<td>06·00</td>
</tr>
<tr>
<td>15</td>
<td>Seq_Packet_Chksum</td>
<td>XX·XX</td>
</tr>
<tr>
<td>17</td>
<td>IDP_Length</td>
<td>XX·XX</td>
</tr>
<tr>
<td>19</td>
<td>IDP_Transport_Cnt</td>
<td>XX</td>
</tr>
<tr>
<td>20</td>
<td>IDP_Packet_Type</td>
<td>05</td>
</tr>
<tr>
<td>21</td>
<td>IDP_Destination</td>
<td>XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>33</td>
<td>IDP_Source</td>
<td>XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td>45</td>
<td>SP_Connection_Cnt</td>
<td>XX</td>
</tr>
<tr>
<td>46</td>
<td>SP_Datastream_Type</td>
<td>XX</td>
</tr>
<tr>
<td>47</td>
<td>SP_Source_Conn_ID</td>
<td>XX·XX</td>
</tr>
<tr>
<td>49</td>
<td>SP_Dest_Conn_ID</td>
<td>XX·XX</td>
</tr>
<tr>
<td>51</td>
<td>SP_Sequence_Numb</td>
<td>XX·XX</td>
</tr>
<tr>
<td>53</td>
<td>SP_Ack_Number</td>
<td>XX·XX</td>
</tr>
<tr>
<td>55</td>
<td>SP_Allocation_Num</td>
<td>XX·XX</td>
</tr>
</tbody>
</table>
This chapter describes the <Edit Messages> Menu functions.

Messages that you create can be used with the <Edit Programs> Menu to simulate stations on the Local Area Network.

Messages can be used to simulate a request or to initiate a transfer of information. The messages can also be used as an acknowledgment for transmissions from other stations.

This chapter includes:

- <Edit Messages> Softkey Selections
- <Edit Messages> Display Description
- <Edit Messages> Softkey Descriptions
- Copying The Data Length Field
- Selecting An FCS Value
- Example For Editing A Message
<Edit Messages > Softkey Selections

Add Message
Delete Message
Show Node Names
Show Hex Addresses
Enter Node Name (shown when cursor is in address fields)
Edit Datafield

Insert Byte(s)
Delete Byte(s)
ASCII 7

Par = 0 Par = 1 Odd Par Even Par
ASCII B Roman 8
EBCDIC
Go To Byte #
OTHER CHOICES

Copy Frame
Copy Message

Datafield= 00000.. (0)
Datafield= 01010.. (5)
Datafield= 10101.. (A)
Datafield= 11111.. (F)
Random Datafield

OTHER CHOICES
Format as Filter #

Copy Data Length (Cursor in FRAME TYPE field)
Select Good FCS (Cursor in FCS Value field)
Select Bad FCS
Select Hex FCS
EXIT

<Edit Messages > Display Description

The menu for <Edit Messages> is shown below. This menu shows a directory of the messages you have created. Elements included in this display are:

- Message number
- Message label
- Destination address
- Source address
- Frame Type
- Frame Length
- FCS value

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>MESSAGE</th>
<th>DESTINATION</th>
<th>SOURCE</th>
<th>FRAME</th>
<th>FRAME</th>
<th>FCS</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>LABEL</td>
<td>ADDRESS</td>
<td>ADDRESS</td>
<td>TYPE</td>
<td>LENGTH</td>
<td>VALUE</td>
</tr>
<tr>
<td>0</td>
<td>MESSAGE_0</td>
<td>00-00-00-00-00-00</td>
<td>00-00-00-00-00-00</td>
<td>00-00</td>
<td>60</td>
<td>Good</td>
</tr>
<tr>
<td>1</td>
<td>MESSAGE_1</td>
<td>00-00-00-00-00-00</td>
<td>00-00-00-00-00-00</td>
<td>00-00</td>
<td>60</td>
<td>Good</td>
</tr>
<tr>
<td>2</td>
<td>POLL_CPU</td>
<td>COMPUTER_1</td>
<td>HP_LAN_Analyzer</td>
<td>00-00</td>
<td>60</td>
<td>Good</td>
</tr>
<tr>
<td>3</td>
<td>PRINT_TEST</td>
<td>PRINT_SERVER</td>
<td>HP_LAN_Analyzer</td>
<td>00-00</td>
<td>60</td>
<td>Good</td>
</tr>
</tbody>
</table>

Add Delete Show Node Show Hex Enter Edit OTHER EXIT
Message Message Names Addresses Node Names Datafield OTHER EXIT

Figure 13-1. <Edit Messages> Menu.
The MESSAGE # is generated by the protocol analyzer. Up to 16 messages can be created and stored in the protocol analyzer. The messages are numbered in hex characters 0 through F. Your created messages can be stored in the system disc drive along with the other <Setup HP 4971S> functions. When you need them, you can quickly load your own created messages along with the other setup functions back into the protocol analyzer to solve a particular application.

The default MESSAGE LABEL field is in the format, MESSAGE_0. For your convenience, you can assign functional labels that describe the message function. Figure 13-1 shows the sample message labels POLL_CPU and PRINT_TEST.

The DESTINATION and SOURCE ADDRESS fields are both the same six byte address fields seen in <Edit Node List> and <Edit Filters> Menus. These address fields can also be described with functional name labels in place of the six byte hex code. Remember that equivalent node names must first be defined in the <Edit Node List> Menu before they can be used in other menus.

The FRAME TYPE field contains the contents of bytes 13 and 14 of each frame.

The default FRAME LENGTH field for each message is 60 bytes. This includes the Destination and Source addresses, the Type field, and Data Field. Frame length does not include the preamble field or FCS characters.

FCS VALUE field lets you generate either good or bad FCS characters when the message is transmitted. For example, you may want to transmit a frame with bad FCS characters to see if the receiving station will detect the error. Also, you can enter an FCS value in HEX characters.
<Edit Messages > Softkey Descriptions

<Add Message>  softkey causes a new message to be added to the message table.

The new message is added first at the closest available position above the cursor and then to the closest available position below the cursor.

The cursor may be in any field of a message when the <Add Message> softkey is pressed.

Naming The Message
Message names may be assigned that identify the function of the message. The name field may have up to 17 characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press RETURN or TAB keys to complete the entry.

<Delete Message>  softkey deletes the message that contains the cursor. The cursor may be in any field of the message.

>Show Node Names>  softkey causes the Destination and Source Address fields to be displayed as the equivalent Node Names assigned in the <Edit Node List> Menu.

>Show Hex Addresses>  softkey causes the Destination and Source Address fields to be displayed in the hexadecimal code format.

<Enter Node Name>  softkey is displayed only when the cursor is in an address field.

This softkey causes names of nodes defined in <Edit Nodes> Menu to be displayed as softkeys. Press the softkey whose node name you want to assign to either the Destination Address Field or the Source Address Field.

Type a node name from the keyboard and press the RETURN key to complete the command.
<Edit Datafield> shows a default display containing a 60 byte data field for editing messages.

<table>
<thead>
<tr>
<th>Data Field of MESSAGE 1</th>
<th>MESSAGE Label: MESSAGE 1</th>
<th>FRAME Length: 60 Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>LINE</td>
<td>BYTES</td>
<td>HEX DATA</td>
</tr>
<tr>
<td>1</td>
<td>15...29</td>
<td>00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00</td>
</tr>
<tr>
<td>2</td>
<td>30...44</td>
<td>00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00</td>
</tr>
<tr>
<td>3</td>
<td>45...59</td>
<td>00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00</td>
</tr>
<tr>
<td>4</td>
<td>60...60</td>
<td>00</td>
</tr>
</tbody>
</table>

* = N

Figure 13-2. <Edit Datafield> Menu display

<Insert Byte(s)> prompts you to enter how many bytes you want to enter. Enter the number of new bytes you want and press the RETURN key. The new bytes are inserted before the position marked by the cursor.

<Delete Byte(s)> prompts you to enter how many bytes to delete. Enter the number of bytes to delete and press the RETURN key. The byte marked by the cursor and following bytes are deleted.

Changing Message Length
You can change the message field by inserting or deleting bytes.

Another method to change the length of the message data field is to move the cursor to the "FRAME Length:" Field in the upper right corner. Enter how many bytes you want the field length to be and press the RETURN key to complete the entry.
A third method to change the length of the data field is to just keep typing characters at the end of the data field. New byte locations are added as new characters are typed. Up to 2022 byte positions may be entered.

Depending on which of these softkeys you select, the protocol analyzer converts characters in the HEX DATA Field into the equivalent ASCII, Roman or EBCDIC characters for the CHARACTER DATA Field.

Optional keyboards can be used with the HP 4971S. See appendix B for the different keyboards and character code sets available.

**Unknown character** -- When a character is entered in hex code that does not have an equivalent character, the character is displayed as ~ in the CHARACTER DATA Field.

You can move the cursor to the CHARACTER DATA Field and enter characters directly from the keyboard. The equivalent hex code for each character is automatically entered in the HEX DATA Field.

- **ASCII 7**
  - Par = 0> creates messages in ASCII 7 with the parity bit always set to zero.
  - Par = 1> creates messages in ASCII 7 with the parity bit always set to one.
  - Odd Par> creates messages in ASCII 7 so that the character byte always has an odd number of bits.
  - Even Par> creates messages in ASCII 7 so that the character byte always has an even number of bits.
<Go To Byte #> causes the protocol analyzer to move the cursor and the message so the selected byte is at the top of the display. This lets you quickly move through large messages.

Press <Go To Byte #> to display the following message:

Go to which byte number? __

Enter the byte number you want to view and press RETURN key to execute the command.

<Copy Frame > creates a message using a frame stored in the Receive Buffer. All of the contents of the frame in Receive Buffer are copied. This includes: Address fields, Type/Length Field, Data field, and Frame Check Sequence. The length of the frame is also updated.

All frames are copied into your message with a good FCS value assigned.

Press the softkey, to display the following message:

Copy which frame number? __0

Enter the frame number you wish to copy from the Receive Buffer. Press RETURN key to execute the command.

Frame number 0 is the default value. Since no frame 0 exists in the protocol analyzer memory, you have to enter a valid frame number for a copy to occur. This prevents you from unintentionally overwriting a message which could happen if the default value was a real frame number.
<Copy Message>
copies a previously defined message. The entire message is copied, including: Address fields, Type/Length field, Data field, and FCS field.

The FCS value for the copied frame is automatically reset to a good value.

Press the <Copy Message #> softkey to display the following message:

    Select softkey OR enter valid name: ______

Enter the message number to be copied and press RETURN key to execute the command.

<Datafield = 00000..> fills the entire data field with all 0s.

<Datafield = 01010..> fills the entire data field with all 5s.
(Alternating 0s and 1s.)

<Datafield = 10101..> fills the entire data field with all A's.
(Alternating 1s and 0s.)

<Datafield = 11111..> fills the entire data field with all Fs.
(All 1s.)

<Random Datafield> uses an HP 4971S internal random generator to fill the entire data field with random characters.
softkey causes the message marked by the cursor to be formatted according to a specific protocol. This lets you more easily recognize if control or protocol characters are correctly placed in specific byte locations in the data field.

The following frame header information is included in the display:

- Message Label
- Frame Length
- Destination Address
- Source Address
- Equivalent Node Names
- Type/Length Field

In addition, the <Format as Filter #> softkey displays byte locations in the data field that have been declared as filter bytes. The data field characters are displayed in hex code with the equivalent characters displayed on the right side of the screen in the selected character format.

The "FIELD LABEL" Field lets you can assign names to filter fields you create in the data field. The name can reflect byte position or a protocol function.

<table>
<thead>
<tr>
<th>FIELD LABEL</th>
<th>HEX DATA</th>
<th>CHARACTER DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESTINATION</td>
<td>00-00-00-00-00-00</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>SOURCE</td>
<td>00-00-00-00-00-00</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>TYPE</td>
<td>00-00</td>
<td></td>
</tr>
<tr>
<td>DATA</td>
<td>00</td>
<td>N</td>
</tr>
</tbody>
</table>

Figure 13-3. <Format as Filter #> Display.
The data field displays only the data bytes defined in the filter you chose for your pattern.

Press the <Format As Filter #> softkey to display:

select softkey or enter valid name

Press a displayed softkey or type the filter name whose format you want to copy and press RETURN key to execute the command.
Copying The Data Length Field

Some protocols require that the "FRAME TYPE" Field show the length of the data field.

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>MESSAGE DESTINATION</th>
<th>SOURCE ADDRESS</th>
<th>FRAME TYPE LENGTH VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>LABEL</td>
<td>ADDRESS</td>
<td>TYPE</td>
</tr>
<tr>
<td>1</td>
<td>Message_0</td>
<td>00-00-00-00-00-00 HP_LAN_Analyzer</td>
<td>00-2E 60 GOOD</td>
</tr>
</tbody>
</table>

In the <Edit Messages> Menu, when you position the cursor to the "FRAME TYPE" Field, the softkey, <Copy Data Length>, is displayed.

**<Copy Data Length>**

causes the protocol analyzer to enter the length of the data field, for the current message, in the "FRAME TYPE" Field. The data field length is displayed in Hex code.

For example:

If the data field contains 46 bytes, the "FRAME TYPE" Field would display 00-2E

00-2E = Hex code for 46₁₀

Don’t confuse data field length with frame length. Frame length contains the Destination and Source Address fields, the Type/Length field, and the Data field.
Selecting An FCS Value

When a frame is transmitted on the network, IEEE 802.3 uses a Cyclic Redundancy Check (CRC) technique to generate Frame Check Sequence (FCS) characters for determining if a message is received correctly. The receiving station generates its own FCS value and compares it to the received FCS value. If the values are the same, the receiving station knows it has a good frame. The algorithm used for the error checking sequence is CRC-32.

The HP 4971S displays the FCS Field in the <Edit Messages> Menu display:

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>MESSAGE</th>
<th>DESTINATION</th>
<th>SOURCE</th>
<th>FRAME</th>
<th>FRAME</th>
<th>FCS</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>LABEL</td>
<td>ADDRESS</td>
<td>ADDRESS</td>
<td>TYPE</td>
<td>LENGTH</td>
<td>VALUE</td>
</tr>
</tbody>
</table>

To view the softkey functions available for FCS values, use the TAB key to move the cursor to the "FCS VALUE" Field. The following softkeys are displayed:

**<Select Good FCS>** is the default selection. This causes the protocol analyzer to transmit a good FCS sequence with the message you have created.

**<Select Bad FCS>** softkey causes the protocol analyzer to create and purposely send a bad FCS value with the message.

You may occasionally want to send a message with a bad FCS sequence in order to check if another station detects bad FCS values and how it responds to the bad value.

**<Select Hex FCS>** softkey lets you type an FCS value in hex format from the keyboard. This lets you have complete control of generating an FCS test value.
Example For Editing A Message

The simplest way to send a message with the HP 4971S is to use all default menus and send Message_0.

Creating a message may require coordination with other edit function menus. Node names and a filter may need to be defined before you complete your message.

The following example creates a message for a station named "CPU1" to send to another station named "PRINT_SERVER".

The outline below shows the steps that may be used for creating a message. Each step below is discussed in detail on the following pages.

1. <Edit Node List> Menu. (Optional)

   This menu is used to assign user labels to the stations assigned HEX code address.

2. <Edit Messages> Menu.

   In this menu, you do two functions.

   A. Name the message and identify the Destination and Source Addresses.
   B. Enter the data field contents.

3. <Edit Filters> Menu. (Optional)

   This menu is optional for editing a message if you want to edit in a particular filter format. In some messages, you may want the data field to contain specific information at specific byte locations. By defining a filter to conveniently display the byte locations you are interested in, you can easily verify if your message meets your protocol.

4. <Edit Messages> Menu. (Optional)

   Now you can use the filter format from step 3 to verify if your new message meets your filter specifications.
EXAMPLE (cont.)

1. **<Edit Nodes>** (Optional)

   If node names are to be used, they should be declared in the **<Edit Nodes>** Menu.

   In the example below, network names "CPU1" and "PRINT_SERVER", are assigned to network addresses 08-00-09-0A-11-04 and 08-00-09-B1-00-12 respectively.

   If your node names are already declared, go ahead to step 2.

Example for **<Edit Node List>**:

<table>
<thead>
<tr>
<th>NETWORK NAME : NETWORK_0</th>
<th>NETWORK TYPE : ETHERNET</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE #</td>
<td>NODE NAME</td>
</tr>
<tr>
<td>1</td>
<td>CPU1</td>
</tr>
<tr>
<td>2</td>
<td>PRINT_SERVER</td>
</tr>
</tbody>
</table>

Using labels for the message name, Destination, and Source addresses makes the message much easier to recognize when a large list of messages have been created.
EXAMPLE (cont.)

2A. Assigning The Message Labels

Select the <Edit Messages> softkey to assign the following elements of the message:

MESSAGE LABEL is a functional label you can assign to describe the contents or purpose of your message.

DESTINATION ADDRESS is the network address of the station that you want to receive your message. You can assign a functional label to this field in the <Edit Nodelist> Menu.

SOURCE ADDRESS is the network address you want to simulate as the transmitter of the message. You can assign a functional label to this field in the <Edit Nodelist> Menu.

Example for assigning a message:

Press the <Show Node Names> softkey and the Destination and Source Addresses are converted to their equivalent labels as shown below. Remember that node name labels must be defined in the <Edit Node List> Menu.

Example for <Show Node Names>

<table>
<thead>
<tr>
<th>MESSAGE</th>
<th>MESSAGE</th>
<th>DESTINATION</th>
<th>SOURCE</th>
<th>FRAME</th>
<th>FRAME</th>
<th>FCS</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>LABEL</td>
<td>ADDRESS</td>
<td>ADDRESS</td>
<td>TYPE</td>
<td>LENGTH</td>
<td>VALUE</td>
</tr>
<tr>
<td>0</td>
<td>ALPHABET</td>
<td>PRINT_SERVER</td>
<td>CPU1</td>
<td>00-00</td>
<td>60</td>
<td>Good</td>
</tr>
</tbody>
</table>
EXAMPLE (cont.)

2B. Creating the Message Data Field

In the <Edit Messages> Menu, press the <Edit Datafield> softkey to create your frame's data field.

When you create a message, be aware that it is easier to move the cursor to the equivalent "CHARACTER DATA" Field and type your message from the keyboard. However, if you have memorized the hex values for ASCII or EBCDIC characters, you can enter your text directly in hex code in the "HEX DATA" Field.

When you enter characters in the "CHARACTER DATA" Field, the equivalent "HEX DATA" Field display is updated after you press the RETURN or TAB keys.

Example message for <Edit Datafield>

```
DATA FIELD of MESSAGE 0

MESSAGE label: hello
FRAME Length: 60 Bytes

<table>
<thead>
<tr>
<th>LINE</th>
<th>BYTES</th>
<th>HEX DATA</th>
<th>CHARACTER DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>15</td>
<td>61-62-63-64-65-66-67-78-79-6A-6B-6C-6D-6E-6F</td>
<td>abcdefghijklmno</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>70-71-72-73-74-75-76-77-78-79-7A-30-31-32-33</td>
<td>pqrstuvwxy0123</td>
</tr>
<tr>
<td>4</td>
<td>60</td>
<td>4A</td>
<td>J</td>
</tr>
</tbody>
</table>
```

Notice that the default data field length is 60 bytes. You can increase or decrease the data field to meet your message length by using the "Frame Length:" Field or, the <Insert Bytes> or <Delete Bytes> softkeys.
3. <Edit Filters> (Optional)

This operation is optional, you do not have to do this step to get your message transmitted. However, the filters function does provide a convenient feature for you.

In some messages, you may want the data field to contain control or protocol information at specific byte locations. By specifying a filter to contain the byte locations you are interested in, you can easily verify if your message meets your protocol.

In the filter example that has been presented, a message is being sent from a computer on the network to a print server. Usually some protocol or formatting control information has to accompany messages to a print server. This protocol or control information has to occur at specific locations in the data field.

In the example below, specific byte locations are to be checked at byte locations 15, 25, and 50 in the data field. An example for <Edit Filters> is shown below.

<table>
<thead>
<tr>
<th>FIELDS of FILTER #0</th>
<th>Label: Filter 0</th>
<th>MINIMUM Frame length = 53</th>
</tr>
</thead>
<tbody>
<tr>
<td>46 Filter hardware</td>
<td></td>
<td>MAXIMUM Frame Length = 2022</td>
</tr>
<tr>
<td>bytes available</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BYTE</td>
<td>FIELD LABEL</td>
<td>FIELD DATA</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td></td>
<td>Node Name:</td>
<td>Not Defined</td>
</tr>
<tr>
<td>7</td>
<td>SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
</tr>
<tr>
<td></td>
<td>Node Name:</td>
<td>Not Defined</td>
</tr>
<tr>
<td>13</td>
<td>TYPE</td>
<td>XX·XX</td>
</tr>
<tr>
<td>15</td>
<td>first data</td>
<td>XX</td>
</tr>
<tr>
<td>25</td>
<td>second data</td>
<td>XX</td>
</tr>
<tr>
<td>50</td>
<td>third data</td>
<td>XX</td>
</tr>
</tbody>
</table>

For now, the contents of this filter's bytes do not have to match your specific message, you are primarily interested the data field byte locations being identified.
4. Compare Message Data Field To Filter Format.  (Optional)

This step compares the message you have created to your filter pattern. You can easily verify the header labels of the message and also see if your protocol and format characters are correct in the data field.


b. Position the cursor in any field of the message you have just created.

c. Press <OTHER CHOICES> softkey.

d. Press <Format As Filter> softkey.

e. Select the softkey that identifies the filter you are using for your message pattern. In this case, Filter_0.

Example of Message in <Format as Filter> mode:

<table>
<thead>
<tr>
<th>FIELD LABEL</th>
<th>HEX DATA</th>
<th>CHARACTER DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESTINATION</td>
<td>22·22·22·22·22·22</td>
<td>Node Name: LASER PRINTER</td>
</tr>
<tr>
<td>SOURCE</td>
<td>11·11·11·11·11·11</td>
<td>Node Name: CPU1</td>
</tr>
<tr>
<td>TYPE</td>
<td>00·00</td>
<td></td>
</tr>
<tr>
<td>first data</td>
<td>61</td>
<td>a</td>
</tr>
<tr>
<td>second data</td>
<td>68</td>
<td>k</td>
</tr>
<tr>
<td>third data</td>
<td>39</td>
<td>9</td>
</tr>
</tbody>
</table>

The filter pattern should be defined with a "FRAME Length" long enough to be able to show all the characters in the message data field.
This chapter describes the softkeys you can use to program the HP 4971S Protocol Analyzer. Programs can be written to control the operation of the protocol analyzer in both monitor and simulate operation.

This chapter includes:

- Introduction
- Selecting A Program To Edit
- "Selecting A Program" Softkey Descriptions
- "Store" Function Softkey Selections
- "Store" Function Softkey Descriptions
- Select The Log To Disc File
- Program Commands Softkey Selections
- Overview Of Programming
- Conditional Program Statements
- Program Commands Softkey Descriptions
- Display Functions In <Edit Programs> Menu
- Program Examples
**Introduction**

The HP 4971S Protocol Analyzer can be programmed to perform monitor and simulate operations.

While you can have up to five programs created in the HP 4971S at a time, the programs can be executed one at a time. This lets you have programs for different applications quickly available in the protocol analyzer.

**PROGRAMMING A MONITOR OPERATION**

The monitor function can be used to capture and view frames as they are occurring on the network or to display frames previously stored in the Receive Buffer.

The HP 4971S Protocol Analyzer provides a monitoring function using only a few simple softkey selections in the <Monitor Network> Menu. However, by using programming functions, you can use much more of the power of the protocol analyzer. Additional functions available when monitoring with programming include:

- Filters
- Timers
- Counters
  - Conditional actions for data collection
  - Logging to a disc for mass storage

When monitoring messages on the network, the filter function can be used to control what messages are stored by the protocol analyzer. When monitoring frames previously stored in the Receive Buffer, the filter function can be used to display on the screen only messages that meet conditions you specify.

You can also use timers to measure time intervals between events you specify. Similarly, counters are provided to count how many times certain events occur. Conditional statements let you display, time, and count only the messages that meet filter conditions you specify.

Monitored network messages may be saved from the Receive Buffer onto a floppy disc and later recalled back into the Receive Buffer for viewing or processing in a programmed monitor mode.

You can also use the increased storage capacity of disc drives to log messages directly to disc as they occur on the network.
PROGRAMMING A SIMULATE OPERATION

In simulate mode, the protocol analyzer has the same filter, timer, counter, and conditional action functions as in monitor mode. However, in simulate mode, the protocol analyzer can also transmit messages onto the Local Area Network.

The protocol analyzer can be programmed to simulate a station or stations on the network. The protocol analyzer can start transmitting messages onto the Local Area Network on your command. Also, the protocol analyzer can transmit in response to a particular transmission received from another station on the network. This provides the capability to artificially increase network loading to test performance under higher traffic conditions.
Selecting A Program To Edit

Edit Which Program? Program 0

Rename Programs

Delete Program

OTHER CHOICES

EXIT MENU

"Selecting A Program" Softkey Descriptions

Edit Which Program?

lets you choose one of five programs to edit.

If any programs have been created, the names of the programs are displayed as softkey selections.

Press the softkey for the program you want to edit or enter the name from the keyboard and press RETURN key.

A default program, Program 0, is in the protocol analyzer at power-on and consists of a "Store" command. This program lets the protocol analyzer perform simple monitor functions with only a few softkey entries.

New Program Name?

softkey lets you create a new program. If you press this softkey, the protocol analyzer displays:

New Program Name?

Enter the new program name from the keyboard. Up to nine keyboard characters may be entered. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press RETURN or TAB keys to complete the entry.

This softkey is displayed until five programs are created. After five programs are created, the <Edit New Program?> softkey is not displayed again until an existing program is deleted.
softkey lets you assign new names for programs that already exist. Press <Rename Programs> softkey to display the message:

 Rename which program? ________

If any programs exist, their names are displayed as softkeys. Press the softkey that identifies a program you want to rename.

 Rename program xxxxxxxxxx to ________

Up to nine keyboard characters may be entered for the program name. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press RETURN key to complete the entry.

softkey deletes programs from the protocol analyzer.

Press the <Delete Program> softkey to display the message:

 Delete which program? ________

Press a softkey label for the program you want deleted or enter the program name from the keyboard and press the RETURN key.

The protocol analyzer prompt asks if you really want to delete the program. Press <YES> to delete the program or <NO> to exit the menu.

If you try to delete all programs, a default program remains as Program_0. This program contains only the "Store: all frames until full" command which lets the protocol analyzer acquire frames in monitor modes.

The default Program_0 stores all frames in the Receive Buffer until the buffer is filled.
The command, \textit{Store: all frames until buffer full}, is automatically presented at the top of each program. The "Store" command is not executed as part of the program; it is used to set up internal circuitry to store frames in the Receive Buffer when the program run starts.

The program sees only those frames which meet the requirements of the store statement. It is important to remember that the frame counter function counts only the frames going into the Receive Buffer. Frames not stored in the Receive Buffer are not counted by the frame counter.

The store function sets up the hardware when you execute a program using \textless Run From Network\textgreater{} softkey.

\textbf{Log to disc.}

If the "Log file" command beneath the "Store" command is used, frames can be stored to a disc drive. Files can be created on a disc drive that are much larger than the Receive Buffer.

Only frames that pass filter and trigger conditions are stored to the Receive Buffer. In "Log file" mode, frames are first stored to the Receive Buffer and then to the disc file. Interactions between the Receive Buffer and log-data disc files are described in the following store command descriptions.

To view softkey selections for the store command, position the cursor in the "Store" command line.
Choosing what frames to store.
In the store field, you first have to choose what frames to store and then how you want the frames stored.

<All Frames> softkey stores all incoming frames into the Receive Buffer that pass the "Runt Frame Filter:" selected in the <Hardware Functions> Menu.

<Frames Matching> lets the protocol analyzer store only the frames matching the filter or frame traits you specify.

Frames to be stored by the protocol analyzer can be further qualified by ANDing or ORing frames with frame traits. Before a frame will be stored, it has to match the filters you specify AND/OR it has to meet the frame traits you specified in <Edit Filters> Menu.

<Not Matching> softkey lets you store only frames that do not match filters or frame traits you specify. You can also use the AND or OR functions to make combinations of filters and frame traits that you want.

The not condition applies to all the filter and frame trait elements that follow the <Not Matching> command in the store field.

<No Frames> softkey lets the protocol analyzer ignore incoming frames.

This function can be used when trying to transmit a group of messages at the fastest rate. Not having to look for frames to be stored allows faster transmission of messages when trying to load a network.
EXAMPLES OF "Store:" COMMANDS

Store: frames matching Filter_0 until full
      Stores only frames that do match Filter_0.

Store: frames not matching Filter_0 until full
      Stores only frames that do not match Filter_0.

Store: frames matching Filter_0 or Filter_1 until full
      Stores any frame that matches either Filter_0 or Filter_1.

Store: frames not matching Filter_0 or Filter_1 until full
      Stores only frames that do not match either Filter_0 or Filter_1.

Store: frames matching Filter_0 as well as Frame Traits until full
      Stores only frames that match both Filter_0 and Frame Traits.

Store: frames not matching Filter_0 as well as Frame Traits until full.
      Stores only frames that do not match both Filter_0 and Frame Traits.

Store: frame matching Filter_0 or Filter_1 as well as Frame Traits until full
      Stores only frames that match either Filter_0 or Filter_1
      and also match Frame Traits.

Store: frame matching Filter_0 or Filter_1 or Frame Traits until full
      Stores only frames that match at least one of either
      Filter_0 or Filter_1 or Frame Traits.
Choosing how to fill memory.
After you have chosen which frames to store, you have to choose how you want the frames organized in memory. The selections are:

- Until Full
- Starting With
- Centered About
- Ending With
- Nonstop

**<Until Full>**

**Storing to Receive Buffer.**
If the program does not log data to disc, the analyzer initializes the Receive Buffer and starts storing frames until the buffer is full.

**Storing to log-data file.**
If the program logs data to a disc, data is stored until the designated disc file is full. Since the log-data file is normally much larger than the Receive Buffer, data is overwritten in the Receive Buffer until the log-data file is filled.
softkey lets you begin filling the Receive Buffer or log-data file only when a particular filter or combination of filters has been found. After the starting event is found, all frames matching filter conditions are stored.

Example: Store: all frames starting with FILTER_0

...........
••••••••••• first frame matching FILTER_0
••••••••••• frame 2
••••••••••• frame 3
...........
...........

After Filter_0 occurs, the protocol analyzer starts to store frames into memory. All frames occurring on the network are stored until the memory is filled.

When you view the frames in <Examine Data>, the frame "starting with FILTER_0" is displayed with a blinking frame number.
softkey causes the protocol analyzer to start filling the Receive Buffer or log-data disc file in a circular manner. If the buffer is filled before the trigger event occurs, new frames are written over previously stored frames.

This process of writing over previously stored frames continues until the filter condition you specify is found. At that time, the protocol analyzer calculates the approximate center of the circular memory; notes where the starting frame would be; and then allows more incoming frames to be stored until the buffer is filled from the calculated starting point. For example:

---frame 1--- Store: all frames
---frame 2--- centered about FILTER_0

------frame matching FILTER_0

-----last frame

The <Centered About> softkey is more closely related to the number of bytes of data in the buffer than the number of frames in the buffer. For example, if long frames precede the filter and short frames follow the filter, there are more frames stored after the filter than before the filter. However, the frame matching your filter condition is approximately at the center of the total quantity of bytes stored.

If the program logs data to disc, the trigger is still centered in the Receive Buffer. Frames are stored after the trigger event to fill the remainder of the Receive Buffer. Since the log-data file is typically much larger than the Receive buffer, the trigger event may not occur at the center of the log-data file.

In <Examine Data> Menu, use the <Go to Trigger> softkey to display the trigger event with a blinking frame number.
<Ending With> softkey causes the protocol analyzer to begin storing frames into the Receive Buffer or log-data file and stop when a filter condition you specify occurs.

Similar to <Centered About> softkey, <Ending With> softkey uses a circular mode to fill the buffer and log-data file. Only frames matching the specified filter conditions are stored to the Receive Buffer and log-data file. Once the buffer is filled, new frames are written over existing frames. This function of repeatedly writing over frames continues until the trigger you specify is found.

Example: Store: all frames

ending with FILTER_0

--- frame 1 ---
--- frame 2 ---
--- frame 3 ---

--- frame matching FILTER_0

* ---

When you view the stored frames in <Examine Data>, the "frame matching FILTER_X" is displayed with the frame number in blinking, half-bright, inverse video. If the same frame is also "marked" by the program, the frame number is displayed in blinking full-bright inverse video.

* Due to the fast speed of the data acquisition circuits, some additional frames may be stored after the protocol analyzer matches a filter and initiates stopping frame acquisition.
<Nonstop> softkey lets the protocol analyzer store frames in the Receive Buffer or log-data file in a circular buffer mode.

Similar to <Centered About> and <Ending With> softkeys, after <Nonstop> softkey fills the memory, it continues to write new frames over the oldest previously stored frames.

Example:

```
Store: all frames
nonstop

---- frame 1 ----
---- frame 2 ----
------------- after the buffer is filled once, new frames will be written over
------------- previously stored frames
------------- frames
```
<End Edit>  softkey lets you exit the current program you are editing. After you press <End Edit>, you can select a new program to edit, or, you can press <EXIT> to return to the Top Level Menu.

<And Frame Traits>  softkey enables the frame error traits you selected in <Edit Filters> Menu. The selection includes:

- Accept/Reject Frame with GOOD FCS
- Accept/Reject Frame with BAD FCS
- Accept/Reject MISALIGNED Frame
- Accept/Reject RUNT Frame

<And Frame Traits> softkey ANDs the selected frame traits with all the filters in store command line.

Frame errors are discussed in more detail in the section, "Displaying Frame Errors," in <Examine Data> Menu chapter.

<Or>  softkey lets you combine filters used to specify the store operation.

Example:  Store: all frames
          starting with FILTER_0
          or FILTER_1

This example starts storing frames into memory when either FILTER_0 or FILTER_1 has been found.

<Block 1>  This softkey moves the cursor to the program starting position in program block 1. This is a program editing key, it is not a program step.
Select The Log To Disc File

Log file:

New File -------> | ...( select )...( select )...( select )...>
    | (volume number) (file name) (file size) | 1

Existing File --> |

Not Used --------------------------------------------------------------->

Disc functions

When you want to store frames occurring on the network to a disc drive, you must supply the following information:

- Volume number
- Volume file name
- File size (in bytes)

<New File> lets you assign a name to a new file.

Select Volume

After you select <New File>, the protocol analyzer displays a choice of disc volumes available for logging. You must enter the volume number from softkeys. Press a softkey for a volume to be used for logging.
Name File

Enter a file name. The name may be up to seven keyboard characters. Leading spaces are deleted. Spaces between names are replaced with an underscore (_). The following reserved characters may not be used in log-data file names:

@ : . (period)
# " CTRL-x (control characters)
$ /

Press RETURN key to complete the file name entry.

Choose File Size

You can control how much disc space you want to allocate to the file. Use the <Maximum Size> softkey to show the maximum continuous file space available for the chosen volume.

If you need less than the maximum available space, enter the file size you want. The minimum file size is 32,768 bytes.

Press <EXIT> to return to the Log File menu. Enter the file size you want.

Default File Size

If you do not enter a file size, the protocol analyzer automatically assigns the maximum contiguous space available on the selected volume.
<Existing File> displays the names of files already existing on the volume you have selected to logging.

Logging to an existing file overwrites information previously stored on the disc.

<Not Used> When a program does not use the log to disc function, you do not have to enter a disc volume and file name.

However, if you do enter a log to disc command in the following program, when you try to <Execute Program>, the protocol analyzer stops and displays the message:

LOG FILE NOT DECLARED FOR "Log frame" STATEMENT IN BLOCK X.

Press <Continue Compiling> softkey and the protocol analyzer ignores the log statement and continues compiling, however, the program won't run.

<Disk Functions> provides quick access to the <Disc Functions> Menu. When you go to the <Disc Functions> Menu, you can press <EXIT> softkey to return to the <Edit Programs> Menu.
Program Commands Softkey Selections

1

...Start--------| Display -----------| --------------------------| And Then --------|
          |
          |
          | Marking Frames --->|
          |
          |
          | Timer -----------| _0 -->|--------------------------|
          |               | _1 -->|
          |
          | Frame Counter--| _2 -->|
          |               | _: -->|
          |
          | Collision Counter--> _F -->|

          |
          |
          | Logging To Disc --------------------------|

Stop-->| Test -----------|--------------------------|

...Increment Counter--> _0 -->|--------------------------|
          | _1 -->|
          | _2 -->|
          | _: -->|
          | _F -->|

...If Counter--------> 2

...Go to Block--> (Keyboard entry ____) --------------------------| <Next Block>-->| 1

...When (event) ------> 3

END EDIT

<Edit Programs> Menu 14-18
Program Commands Softkey Selections

1 (cont.)

- Display Frame

- Mark Frame

- Log Frame To Disc

- Send

- Log Frame To Disc

- Send

- Reset

- Wait

- Beep

And Then

| 0 |

| 1 |

<Next Block>

Repeated __ Times

Followed By

Followed By

Followed By

| 0 |

| 1 |

| 2 |

| 3 |

| F |

Counter

| 2 |

| 3 |

| F |

<Keyboard entry __> Ms

" Seconds

" Minutes

" Hours

Reset

Timer

Counter

Wait

Beep

Wait (Keyboard entry __) Ms

" Seconds

" Minutes

" Hours

<Edit Programs> Menu 14-20
Program Commands Softkey Selections

1 (cont.)

---<Find Block> ---------·>I (Keyboard entry ___ )--------->-·> 1

D

---<Copy Block> ---------·>I (Keyboard entry ___ )--------->-·> D

---<Insert Block>  

---<Delete Block>  

---Copy Program--------| _0---->|  
| _1---->|  
| _2---->|  
| _3---->|  
| _4---->|  
| _5---->|  

---Rename Ctr/Tmrs------| --Counter_0--| Timer_0---|  
| _1  _1 |  
| _2  _2 |  
| _3  _3 |  
| _4  _4 |  
| :  : |  
| :  : |  
| _F  _F |  

<Edit Programs> Menu    14-22
Overview of Programming

When you press a softkey in the <Edit Programs> Menu, other softkeys are displayed to lead you through a program step. For example, when you press the <Start> softkey, only the program functions that can be "started" are displayed as your new softkey choices.

Block 1:

| Start |

EDITING PROGRAMS

When you need to edit a program, editing softkeys such as <Insert Block>, <Delete Block>, and <Copy Block> are provided. In addition, you can use the TAB key, cursor keys and other keyboard keys described in the chapter, "Using This Manual", to edit programs.

RUNNING PROGRAMS

After your program is developed, return to the Top Level Menu and press <Execute Program>. Select the data source you want to test with the program. Select either <Run From Network> or <Run From Buffer>.
Conditional Program Statements

The HP 4971S Protocol Analyzer uses the conditional programming statements:

If
When

The differences between these two commands allow more flexible programs to be written.

If

The "If" command causes the contents of a counter to be compared to a Boolean condition to see if the condition is true or false. Regardless of whether the comparison is true or false, the program moves to another program step.

A true <If Counter> comparison lets you branch to another program block. When the <If Counter> comparison is false, the program increments to the next program step even if the next step is in another program block.

When

The "When" command also compares events in the protocol analyzer to see if particular Boolean conditions are true or false. Unlike the "If" command, the "When" command waits at a program step until it is true.

If the protocol analyzer finds a <When (event)> condition to be false, the protocol analyzer waits at that program step until the condition becomes true.

Fortunately, it is possible to escape from a 'When' command by using an <Else When> command immediately after the <When (event)> step. The program uses the following logic:

1. If an <Else When> command immediately follows a false <When (event)> condition, the program continues to the <Else When> command.

2. If the <Else When> condition is true, the program observes the <Else When> command.

3. If the <Else When> condition is false, the program loops back to the preceding <When (events)> step.
Program Commands Softkey Descriptions

The <Edit Programs> softkey selections are organized in three groups. The groups are indicated by the bold numbers; 1, 2, or 3 at the top of each softkey selection chart on the previous foldout pages.

The softkey descriptions are also described under the same group numbers.

PROGRAM BLOCK COMMENT FIELD

When you move the cursor to a block label, a field opens for you to make descriptive comments about the block's function or purpose. Up to 66 keyboard characters may be entered in the block comment field.

Block 1: Example of a program block comment field

<End Comment> Press the <End Comment> softkey, cursor keys, or the RETURN key to exit the block label field.
<Start> softkey can cause six functions to begin. The functions that can be started are:

- Display
- Marking Frames
- Timer
- Frame Counter
- Collision Counter
- Logging To Disc

<Display>
The default program mode for the HP 4971S is to start a program run with the display blank.

The command <Start> <Display> causes the HP 4971S to display timers and counters while the program is executing.

While timers and counters are shown, the softkey <Display Frames> is displayed. Press the softkey during program execution to cause the protocol analyzer to display frames. While frames are being displayed, the same softkey changes to <Timers & Counters>. Press <Timers & Counters> to return to displaying the contents of the timers and counters.

For more details about the command <Start><Display>, see the section, Display Functions In <Edit Programs> Menu, in this chapter.

(Continued)
NOTE

Be aware that displaying frames or counters/timers slows the operation of the protocol analyzer. In circular mode (Nonstop, Centered About, or Ending With), if frames are stored in the Receive Buffer faster than they are displayed, the Receive Buffer may be completely filled before the contents are displayed. The protocol analyzer cannot begin to write over previously stored data that has not been displayed. If this happens, the protocol analyzer stops the program and displays the message:

Program_X aborted by buffer overflow
PROGRAM TOO COMPLEX FOR CURRENT TRAFFIC LEVEL

A suggestion is to not display frames, counters/timers, or use the beeper when storing frames in circular modes.

]<Marking Frames> softkey causes the protocol analyzer to add a frame marker to frames that match your specified conditions.

In <Run From Buffer> mode, the frame marker is added to the frames currently in the Receive Buffer that match your filter and these frames are then displayed on the screen as marked frames.

In <Run From Network> mode, the frame mark is added to frames as they are stored in the Receive Buffer. The frame mark is also displayed on the screen.

Marked frames are displayed with the Frame Number Field in inverse video.
Group 1 (cont.)

<Timer> softkey lets one of up to sixteen available timers be selected to be clocked when the program is executed.

At the beginning of the program execution, all timers are reset to zero. If you halt the timer during the program and then <Start> the timer again, the timer continues from its previous count.

Use the <Reset> softkey command if you want to reset the timer to zero during the program.

<Frame Counter> softkey is incremented differently in <Run From Buffer> mode than in <Run From Network> mode. In <Run From Buffer> mode, the frame counter is incremented sequentially by frames existing in the buffer.

In <Run From Network> mode, the frame counter is incremented only by the frames that pass the filter and are stored in the Receive Buffer, not by all frames occurring on the network.

<Collision Counter> softkey lets you assign a specific counter to count when collisions occur on the network.

The counter you assign to count collisions cannot be incremented by the program command <Increment Counter>. The counter designated as the collision counter is not displayed as a softkey choice when <Increment Counter> softkey is pressed.

When you view counters and timers, the counter you designate for collision counting has the display:

counter_x = nnn collisions

Remember that you can rename the collision counter to a functional name.
Group 1 (cont.)

(Logging To Disc)

This program command causes the protocol analyzer to begin logging frames from the network to the disc drive and file name you assigned in the "Log File:" field above Block 1.

The logging to disc function follows the operation of the "Store:" command. Store commands used to control logging to disc include: Until Full, Starting With, Centered About, Ending With, and Nonstop.

Filters used to control or limit the frames stored in the protocol analyzer also control which frames are logged to disc.

NOTE

Since frames are first stored in the Receive Buffer and then transferred to the disc file, if new frames are stored in the Receive Buffer faster than the analyzer can transfer them to the disc file, the analyzer skips storing frames to the disc file and displays the error message:

Receive buffer overflow detected. Frames skipped!

Skipped frames are indicated by a dashed line in the <Examine Data> Menu.

<Stop> softkey can be used to end any of the functions began by the <Start> softkey. In addition, the <Stop> softkey can end the program by using the <Test> softkey.

<Test> softkey stops the program execution. All counter, timer and data acquisition is halted.
Group 1 (cont.)

<And Then> softkey lets multiple program actions occur within a single block of program. After the first program step is completed, the second program step is executed.

<Next Block> softkey ends the current program block and moves the cursor to the first position in the next block.

Up to 999 blocks may be generated in a program.

<END EDIT> ends programming for the current program. The softkey selection returns to the previous level to select either a new program to edit or to exit this menu to the next higher level.

<Increment Counter> causes a particular counter to be incremented. This is an unconditional command and does not depend on other events. When this key is pressed, the softkeys change to display counter labels. You select a counter by using a softkey or by entering a counter label from the keyboard. If the name is entered from the keyboard, press RETURN key to complete the program step.

You can assign names to the counters to more easily identify the counter function. Press the <Rename Counters> softkey to assign a counter name that identifies its function.

NOTE

Be careful not to confuse event counters with frame counters. Frame counters are incremented automatically by frames as they are stored in the Receive Buffer. Frame counters can not be incremented manually by your program since this would cause its count to differ from the actual number of frames it has seen.
Group 1 (cont.)

<If Counter> See description under Group 2.

<Go To Block> softkey lets you jump to another program block. This is an unconditional command. It does not use a preceding If or When command. When the program steps to that line, the command is executed.

Press the softkey to display a prompt for entering the block number you wish the program to go to. Press RETURN key to complete the program command.

<When (event)> see description under Group 3.

<Display Frame> If <Display Frame> is used to begin the display, only one frame is displayed.

When the program executes a <Start> <Display> command, timers and counters are displayed. When <Display Frame> command follows a <Start><Display> command, the analyzer display changes to show incrementing frames.

NOTE

Similar to the <Start> <Display> commands, <Display Frame> can cause the protocol analyzer to halt if the display process is too much slower than the rate at which frames are being acquired. This condition only happens in circular modes of frame acquisition (Nonstop, Centered About, and Ending With). A recommendation to prevent halting the run is to not display frames, counters/timers, or use the beeper while frames are being stored.
Group 1 (cont.)

<Mark Frame>

softkey will cause the frame currently being processed in the Receive Buffer to have a mark condition. This softkey is normally used with filters to indicate when a frame matched a filter condition.

The <Examine data> Menu displays marked frames with the frame number in inverse video.

In the following example, the protocol analyzer marks all frames matching Filter_0.

Example:

Block 1:
   When frame matches FILTER_0 then go to Block 2

Block 2:
   Mark Frame

Block 3:
   Go to Block 1
<Log Frame To Disc>

This command logs one frame to the log-data file.

When a filter condition you specify occurs, the <Log Frame To Disc> command stores that particular frame to the log-data file.

Do not confuse <Log Frame To Disc> command with the <Start> <Logging To Disc> commands. The <Start> <Logging To Disc> commands let you store frames continuously.
Group 1 (cont.)

<Send Message> softkey lets the protocol analyzer transmit messages to the local area network. Messages created in the <Edit Messages> Menu may be transmitted on program command.

Up to 16 messages can be created in the <Edit Messages> Menu and then transmitted under your program control.

You can use If, When, and Else commands to determine what message to transmit and when it should be sent.

Also, messages may be transmitted repeatedly or they may be sent in combination with other messages by using the commands:

<Repeated ___ Times>

<Followed by >

<Repeated ___ Times> softkey lets you repeat a message up to 9999 times without interruption.

No repeat - causes the message to be sent only once.

Repeat 1 time - causes the message to be sent once and then repeated once.

Repeat 2 times - causes the message to be sent once and then repeated twice.
command lets a series of different messages be transmitted in a particular sequence. By assigning different Destination and Source Addresses to each message, you can simulate transmitting to and from different stations.

The following example sends message_0 ten times and then send message_1 one time followed by message_2 one time.

Block 1:
Send message MESSAGE_0 repeated 9 times followed by MESSAGE_1 followed by MESSAGE_2

command causes either a specific timer or counter to be reset to it's zero state.

Press the <Reset> softkey to display a choice of <Timers> and <Counters> softkeys. Press the softkey for the function you need to reset and the counters or timers you have defined are displayed. Press the softkey for the counter or timer you want to reset.

Counters or timers may be started and stopped in the program. If you <Start> them again, they continue from their previous count. Use the <Reset> softkey command when you wish the function to be reset to zero before beginning to count again. In the example below, whenever Filter_0 occurs, Timer_1 is reset to zero and immediately started again.

Block 8:
When frame matches FILTER_0 then go to block 9
Block 9:
Reset timer Timer_1
and then
Start timer Timer_1
Group 1 (cont.)

<Walt>
softkey lets you create waits or pauses in your program using the following units of time:

\[
\begin{array}{ll}
\text{Ms} & \text{Minutes} \\
\text{Seconds} & \text{Hours}
\end{array}
\]

The minimum time for a wait period is 1.0 Ms. The maximum time for a wait period is 9999 hours.

<Beep>
softkey causes the protocol analyzer to produce an audible beep. The <Beep> softkey would be used to note a condition or status point has occurred. An example would be when a filter has been matched, or, a timer or counter has reached a particular event.

Block 2:
- When timer Timer_1 exceeds 10 Ms then go to Block 3

Block 3:
- Beep
  - and then
  - Go to block 4

NOTE

Using the Beeper slows the operation of the protocol analyzer. In circular mode, Nonstop, Centered About, or Ending With, if frames are stored in the Receive Buffer faster than the Beeper command can be executed, the buffer may be filled before the Beeper is executed. The protocol analyzer cannot begin to write over previously stored data if it is still waiting for the Beeper command. If this happens, the protocol analyzer stops the program and displays the message:

Program_X aborted by buffer overflow.
PROGRAM TOO COMPLEX FOR CURRENT TRAFFIC LEVEL.

If this message occurs, delete the beep command from the program.
Group 1 (cont.)

**<Find Block>**

softkey is a program edit key; it is not a program command. This softkey is used to move quickly to another program block in the program.

When you press the <Find Block> softkey, enter a program block number, and then press the RETURN key; the cursor moves to the program block entered.

**<Copy Block>**

softkey is also a program edit softkey, not a program command. This softkey lets you quickly duplicate an existing program block and insert it anywhere in the program.

The <Copy Block> softkey copies a specified block immediately below the block currently containing the cursor. The protocol analyzer automatically renumbers the program blocks and all block references in the program.

To copy an existing block, use the following procedure.

1. Position the cursor to the program block you want the new block to follow.

2. Press the <Copy Block> softkey.

3. Enter the program block number to be copied.

4. Press the RETURN key to execute the copy.
Group 1 (cont.)

<Insert Block> lets you add a new program block between existing program blocks and automatically renumber the blocks including all block location references.

The new block is inserted immediately above the block currently containing the cursor.

When the <Insert Block> softkey is pressed, the protocol analyzer immediately creates the new block.

<Delete Block> deletes the block currently marked by the cursor. The remaining program blocks and block location references are automatically renumbered.

When the <Delete Block> softkey is pressed, the protocol analyzer immediately deletes the block containing the cursor.

<Copy Program> lets you copy another program already existing in the protocol analyzer.

This softkey sounds the beeper and displays a warning message to alert you that the program you copy will overwrite your existing program.

<Rename Ctr/Tmrs> lets you change the name of a counter or timer. The name can be changed to describe the event or function you are monitoring.

Counter and timer names can be up to nine keyboard characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press TAB or RETURN keys to complete the entry.
GROUP 2 PROGRAM COMMAND DESCRIPTIONS

<If Counter> is a conditional statement using the 'If' construct.

This softkey causes the content of a counter to be compared to Boolean conditions using relational comparator combinations of equal to, greater than, or less than.

If the comparison is true, the program can be jumped to another program block.

If the comparison is false, the program increments to the following program step.

Comparison states that may be used include:

```
=   >   <=
<>  <   >=
```

<> comparison is true when the counter is not equal to the entered count.

Example: If counter Counter_1 <> 10 Then Go To Block 4

If Counter_1 is any number except 10, the program goes to program block 4. If the counter is at 10, the program goes to the following program step.

Sixteen counters are available in the protocol analyzer. You can assign labels to the counters to more easily identify their function. Use <Rename Counters> softkey to label the counters.

<Then Go To Block> lets you specify the block to branch to when the 'If' comparison is true.

Enter a block number and press RETURN key to finish that program step.
Group 2 (cont.)

<Else If> lets you select an alternative 'IF' statement.

<Else When> lets you select an alternative "When (events)" statement.

See group 3 command descriptions.

<Next Block> ends the current program block and moves the cursor to the first position in the next block.

<END EDIT> ends programming for the current program. The softkey selection returns to the previous softkey level to select either a new program to edit or to exit this menu to the next higher level.
GROUP 3 PROGRAM COMMANDS DESCRIPTIONS

<When (event)> is a conditional statement using the 'when' construct.

<When (event)> softkey causes the program to wait at that point until the test condition is true. Conditions that may be tested by this command include:

- Frame Matches
- Time Of Day
- Timer
- Frame Counter
- Collision Counter

When a comparison is true for the function you specify, the program branches to the program block you select.

Example:

Block 6:
  When frame matches FILTER_0 then go to Block 7

Block 7:
  Start timer TIMER_1

Block 8:
  When frame matches FILTER_1 then go to Block 9

Block 9:
  Stop timer TIMER_1

In this example, TIMER_1 is measuring the time between filter events, FILTER_0 and FILTER_1. The program waits at Block 6 until FILTER_0 occurs. After the timer is started, the program waits at Block 8 until FILTER_1 occurs.
<Frame Matches>

compares a filter you created in <Edit Filters> Menu to incoming frames. When an incoming frame matches the filter you specify, the following "Then Go To Block ___" instruction is executed. The program waits at a <When (Frame Matches)> command until a true condition occurs.

Events to describe <Frame Matches> can be grouped in logical combinations to make even more powerful filtering choices. The combinations can be grouped with the following commands:

- Not filter
- And Frame Traits

<Not>
The "when" program step is satisfied when any frame occurs that does not match the specified filter or specified frame traits.

<Edit Filters>
softkey branches to the summary of filters display. This lets you review the filters available for selection. Press <EXIT> to return to <Edit Programs>.

<Frame Traits>
checks if incoming frames match frame traits selected in the <Edit Filters> Menu.

<And>
command can be used to require more than one filter match to occur before the program can continue.

The following example requires a single frame to match both FILTER_0 AND FILTER_1 before the program will move to Block 2.

Block 1:
When frame matches FILTER_0
and FILTER_1 then go to block 2
softkey requires the protocol analyzer to find a frame matching the <Frame Matches> conditions AND the frame traits identified in the <Edit Filters> Menu. Frame Traits selections include:

- Accept / Reject Frame with GOOD FCS
- Accept / Reject Frame with BAD FCS
- Accept / Reject MISALIGNED Frame
- Accept / Reject Runt Frame

command lets one or more of several filters to cause a program step to be executed.

The following example requires a frame to match one or more of FILTERS_0, 1, or 2 before the program moves to Block 2. For example:

Block 1:
When frame matches FILTER_0
  or FILTER_1
  or FILTER_2 then go to Block 2

<Frame Match> Operation Precedence

The <Frame Match> operation precedence for the Not, And, Or, and And Frame Traits commands is:

1. <Not>
2. <And>
3. <Or>
4. <And Frame Traits>
<Time Of Day>

The protocol analyzer detects when the system clock exceeds a time-of-day value that you entered. The time clock you set in the <Set Time> Menu at power on is used for this comparison.

<Timer>

compares the state of a specific timer to a number you have entered. When the timer exceeds the time you have entered, the program goes to the program block you specify. The program waits at this command until a true condition is found.

Sixteen timers are available to be used for this command. Labels that relate to the function being checked may be assigned to each timer. Use the <Rename Timer> softkey to enter the menu for naming timers.

In <Run From Network> mode, the timer completes the time interval you enter even if no frames are detected on the network. In <Run From Buffer> mode, the protocol analyzer automatically halts the timer when an empty buffer is detected.

The following example program counts how many frames are stored in one second:

Store: all frames
    until buffer full

Block 1:
    Start timer Timer_1

Block 2:
    Start frame counter Counter_1
    and then
    When timer Timer_1 exceeds 1 Seconds then go to block 3

Block 3:
    Stop frame counter Counter_1
Group 3 (cont.)

<Frame Counter>

The <When> <Frame Counter> softkeys are used to detect when the number of frames meeting your criteria has exceeded some quantity.

An example follows for <When> <Frame Counter> being used to measure the time while the protocol analyzer waits for 100 frames to be stored in memory.

The example performs the following functions:

- Frames are loaded into the protocol analyzer until the Receive Buffer is full or the program stops operation.
- A timer is started.
- A frame counter is enabled to start counting frames.
- Frames are stored in the Receive Buffer until the counter reaches 100 and the timer is stopped.

```
Store: all frames
  until buffer full

Block 1:
  Start timer Timer_1

Block 2:
  Start frame counter Counter_1
    and then
  When frame counter Counter_1 exceeds 99 then go to block 3

Block 3:
  Stop timer Timer_1
    and then
  Stop Test
```
<Collision Counter>

softkey is used to assign the task of counting collisions to one of the 16 available counters.

The collision counter is exclusively assigned to count collisions. You cannot increment that counter by another program command. The collision counter is not displayed as a softkey choice for <Increment Counter> softkey.

The <When> <Collision Counter> softkeys can be used in combination to detect when the number of collisions has exceeded some quantity.

The example below detects how many collisions occurred in 10 seconds.

Store: all frames
   nonstop

Block 1:
   Start timer Timer_0

Block 2:
   Start collision counter counter_3

Block 3:
   When timer Timer_0 exceeds 10 seconds then go to Block 4

Block 4:
   Stop timer Timer_0
   and then
   Stop Test
<Then Go To Block>

lets you specify the block to branch to when the 'When' comparison is true.

Enter a block number from the keyboard and press RETURN key to complete the program step.

<Else When>

lets you select an alternative 'when' statement.

The <Else When> command follows a <When (event)> command.

The program first checks the status of the <When (event)> line. If the <When (event)> statement is false and if an <Else When> command follows, the program then checks the status of the <Else When> command.

If the <Else When> condition is true, the program branches to wherever the <Else When> command directs.

If the <Else When> condition is false, the program goes back to the <When (event)

Example:

Block 6:

When frame counter Count_Frames exceeds 100 then go to Block 7
else When timer TIMER_0 > 5 Seconds then go to Block 10

In this example, the program first checks to see if the frame counter has exceeded 100. If the counter has exceeded 100, the program jumps to Block 7.

If the counter has not exceeded 100, the program looks at the <Else When> command on the following line. If the timer is greater than 5 seconds, the program goes to Block 10. If the counter has not exceeded 5 seconds, the program returns to the previous program line.
Display Functions In <Edit Programs> Menu

This section provides a summary for viewing data during a program run. Each of the program commands discussed in the following text have been described in the previous section, Program Command Descriptions. See the appendix section for the execution time for program instructions.

During a program run, the default mode for the HP 4971S is to not display data. This lets the protocol analyzer more easily keep up with traffic on the network during heavy network loads.

As described earlier in this chapter, displaying frames or timers and counters slows the processor operation and may cause it to get behind in its task of capturing frames occurring on the network. When the processor gets behind, it halts the program run.

See the appendix section, "Execution Time." This section lists the time to execute different program instructions.

There are two modes of display available in programs:

Selective Display

Continuous.

The selective display mode can be used to selectively display frames under program control, whereas the continuous display mode updates the display continuously under program control.
SELECTIVE DISPLAY MODE

The selective display mode is activated by the <Display Frames> program command. This command causes a single frame (the last frame processed by the program) to be displayed in the format chosen in the <Examine Data> Menu.

This selective display mode should be used when it is desirable to display rarely occurring frames while storing more frequently occurring ones.

When the selective display mode is used, a dashed line will appear between frames to indicate they are not necessarily contiguous in the buffer.

Example to:

Display Selected Frames

Problem: You are running a protocol in which a certain frame type is an acknowledgment frame. You suspect that occasionally an acknowledgment is getting lost because it has a bad FCS or alignment error. To test this, use <Edit Filters> Menu to define an acknowledgment frame filter. Name the filter "ack_frame" and select <Frame Traits> softkey. Frame Traits should be selected to Accept bad FCS and Alignment errors. You will Reject Good FCS and RUNT frames. With these frame traits selected, write the following program.

Program:

Store: frames matching ack_frame nonstop

Block 1:
When frame matches ack_frame as well as Frame Traits then go to Block 2

Block 2:
Display frame and then Go to Block 1

Summary: This program stores all "ack_frames" but only displays the frames also containing a frame error.
CONTINUOUS DISPLAY MODE

The continuous display mode has two formats:

Counters & Timers

Frames

Counters & Timers

Counters & Timers is the recommended display mode since their values can be updated much faster than frames can be displayed. The continuous mode is accessed by using the <Start>< Display> program command. The command remains in effect until a <Stop> <Display> command is encountered. This mode should only be used for viewing data on a lightly loaded or heavily filtered network.

The continuous display form defaults (at the start of a run) to the Counters & Timers display. Thus the first <Start> <Display> executed (with the exception described below) will begin displaying Counter & Timer data and keep updating this display until it is either stopped or changed. When this display format is active, the softkey <Display Frames> will appear and can be used to switch the display to Frames.

Frames

The continuous frame display will display all frames stored in the "Store" line as they are received. Since these will be contiguous in the buffer, no dashed lines appear between them. This form can be accessed in one of two ways: either by pressing the <Display Frames> softkey in the Counters & Timers display or by using the <Display Frame> command described in the selective display mode description. When a <Display Frame> command is executed in between a <Start> <Display> and a <Stop> <Display>, the display will start off in the Counters & Timers format and then switch to the frames display format. When operating in the continuous frames display, a softkey <Counters & Timers> is displayed and can be used to return to the continuous Counter & Timers display.

The <Stop> <Display> command automatically switches the continuous display form back to Counters & Timers. Therefore, to switch back from the frame display mode to the Counters & Timers mode, you need only stop the display and then start it again.
Example to:

Count Frames And Display Counters And Timers Continuously.

Program:

Store: all frames
nonstop

Block 1:
Start display
and then
Start frame counter all_frame

Example to:

Display All Frames Continuously

Program:

Store: all frames
nonstop

Block 1:
Display frame
and then
Start Display

<Edit Programs> Menu  14-52
Example to:

Alternate Displaying Counters & Timers With Frames

Problem:
To count frames, display counters & timers for five seconds, switch to displaying frames for five seconds, and then switch back to counters & timers.

Program:

\textbf{Store: all frames nonstop}

\textbf{Block 1:}
Start timer 5\_secs
and then
Start frame counter all\_frames

\textbf{Block 2:}
Start display (begins Counter & Timer display)
and then
When timer 5\_secs exceeds 5 seconds then go to Block 3

\textbf{Block 3:}
Reset timer 5\_secs
and then
Display frame (switches display to frames)
and then
When timer 5\_secs exceeds 5 seconds then go to Block 4

\textbf{Block 4:}
Stop display
and then
Reset timer 5\_secs
and then
Go to Block 2
Programming Examples

This section lists several example programs. These are simple programs that illustrate using timers, counters, messages and filters in programs.

PROGRAM EXAMPLE 1.

REQUIREMENT: You want to know how many network collisions and frames with bad FCS occur in a five minute period.

You also want to mark all frames occurring with a bad FCS.

CONDITIONS: You need to define the following items:

- A timer named DURATION
- A counter named CNT_FCS
- A filter named BAD_FCS

When the program is completed, the protocol analyzer will display the Timers & Counters Menu.
PROGRAM 1:

Store: all frames
nonstop

Block 1:
Start timer DURATION
and then
Start collision cntr COLLISION

Block 2:
When timer DURATION exceeds 300 seconds then go to block 4
else when frame matches BAD_FCS then go to block 3

Block 3:
Increment counter CNT_FCS
and then
Mark frame
and then
Go to block 2

Block 4:
Start display
and then
Stop test
PROGRAM EXAMPLE 2.

REQUIREMENT: You want to view your network for 60 seconds. During that time, you want to count how many times three different types of addresses occur in the frames seen.

In addition, you will count the total number of frames received during the 60 second period.

CONDITIONS: You need to define the following items:

A timer named DURATION
A counter named TOT_FRAME
A counter named CT_GLOBAL
A counter named CT_LOCAL
A counter named CT_BROAD
A filter named GLOBAL
A filter named LOCAL
A filter named BROADCAST

The three filters test the address fields in each frame to see how they are administered. The address tests are: Local, Global, and Broadcast.

The filters you define will use the Destination and Source Address Fields to determine what type of frame is being received.
PROGRAM 2:

Store: all frames
    nonstop

Block 1:
    Start timer DURATION
    and then
    Start frame counter TOT_FRAME

Block 2:
    When timer DURATION exceeds 60 seconds then go to block 6
    else when frame matches GLOBAL then go to block 3
    else when frame matches LOCAL then go to block 4
    else when frame matches BROADCAST then go to block 5

Block 3:
    Increment counter CT_GLOBAL
    and then
    Go to block 2

Block 4:
    Increment counter CT_LOCAL
    and then
    Go to block 2

Block 5:
    Increment counter CT_BROADCAST
    and then
    Go to block 2

Block 6:
    Start Display
    and then
    Stop test
PROGRAM EXAMPLE 3.

REQUIREMENT: You want to know how often a particular frame with Ethernet Type 06-00 occurs. You also want to know when a frame with a length or 500 bytes occurs. When either of these frames occur, you want to mark the frame. You need to know how many times these two events occur in a 60 second period.

CONDITIONS: You need to define the following items:

- A timer named DURATION
- A counter named CT_TYPE
- A counter named CT_LENGTH
- A filter named TYPE_06_00
- A filter named LENGTH_500

This program is testing for two different conditions. Both events are detected by filters.
PROGRAM 3:

Store: all frames
   nonstop

Block 1:
   Start timer DURATION
   and then
   Start frame counter TOT_FRAME

Block 2:
   When timer DURATION exceeds 60 seconds then go to block 6
   else when frame matches TYPE_06_00
      and LENGTH_500 then go to block 3
   else when frame matches TYPE_06_00 then go to block 4
   else when frame matches LENGTH_500 then go to block 5

Block 3:
   Increment counter CT_TYPE
   and then
   Increment counter CT_LENGTH
   and then
   Mark Frame
   and then
   Go to Block 2

Block 4:
   Increment counter CT_TYPE
   and then
   Mark frame
   and then
   Go to block 2

Block 5:

   Increment counter CT_LENGTH
   and then
   Mark frame
   and then
   Go to block 2
PROGRAM EXAMPLE 4.

REQUIREMENT: You want to know the length of frames that are occurring on the network. You need to know how frames are distributed within several ranges of frame length.

The ranges you wish to use are:

- 51-100 bytes
- 101-500 bytes
- 501-2022 bytes

CONDITIONS: You need to define the following items:

- A timer named DURATION
- A frame counter named TOT_FRAME
- A counter named 51_100
- A counter named 101-500
- A counter named 501_2022
- A filter named FILTER_51_100
- A filter named FILTER_101_500
- A filter named FILTER_501_2022

The filters will look for frame lengths within certain ranges. As each filter is matched, a corresponding counter will be incremented.
PROGRAM 4:

Store: all frames  
nonstop

Block 1:  
Start frame counter TOT_FRAME  
and then  
Start timer DURATION

Block 2:  
When timer DURATION exceeds 30 seconds then go to block 6  
else when frame matches FILTER_51_100 then go to block 3  
else when frame matches FILTER_101_500 then go to block 4  
else when frame matches FILTER_501_2022 then go to block 5

Block 3:  
Increment counter 51_100  
and then  
Go to block 2

Block 4:  
Increment counter 101_500  
and then  
Go to block 2

Block 5:  
Increment counter 501_2022  
and then  
Go to block 2

Block 6:  
Stop timer DURATION  
and then  
Start display  
and then  
Stop test
This section describes the <I/O Functions> softkey control of the HP 4971S LAN Protocol Analyzer in master/slave (remote/local) applications.

This section includes:

- <I/O Functions> Softkey Selections
- Introduction
- Editing The I/O Configuration
- Saving the I/O Configuration
- Capturing A Slave LAN Protocol Analyzer
- Editing And Sending A Modem String
- Enabling I/O Operation
- I/O Status Messages
- <Terminal Emulator> Description
< I/O Functions > Softkey Selections

Edit Config.

Save Config.

Capture Slave

Edit Modem Str

Send At Power On

ASCII 7

ASCII 8 Roman 8

EBCDIC

EXIT

Send Modem Str

Enable I/O

OTHER CHOICES

Terminal Emulator

Local Echo

Auto Linefeed

Show Non-printing

ASCII 7    ASCII 8 Roman 8    EBCDIC

EXIT

<I/O Functions> Menu  15-2
Introduction

The master/slave feature lets you view the operation of a Local Area Network (LAN) or LAN segment from a site not directly adjacent to the LAN. For example, you could view all the LANs in your company from one remote location.

Performing HP 4971S logic analyzer operations on a LAN from a remote location requires two HP 4971S instruments.

Primary capabilities or features offered by using two HP 4971S's in master/slave operation are:

- Testing a LAN from a remote location.
- Selecting a printer located at the master or slave location.
- Selecting a mass storage located at the master or slave location.

Your two HP 4971S systems must be connected by an RS-232C link. Option 002 provides a RS-232C Remote Communications Interface package which includes an interface board and cables. Each station requires an Opt. 002 to be installed in the 4971A instrument.

In remote operation, the master protocol analyzer shows the same screen display that the slave protocol analyzer would display if it were under local control.

The keyboard of the master unit is the controlling keyboard. Local keyboard control may be regained at either the master or slave location by pressing the BREAK key on the keyboard. The BREAK key disconnects the RS-232 link and returns both units to local operation.

When an HP 4971S is linked for remote operation it communicates with another station with the protocol, DDCMP. This protocol allows stations to send and receive data or command information with the protocol handling the problems of framing, error control, sequence control, and message transparency.

The protocol makes sure that one station is ready to receive information and another station is ready to transmit information at the right time. The protocol automatically handles retransmission in case of errors.
The I/O Configuration table shown below is stored on the LANSYS volume. The menu shown below is displayed when you press the <I/O Functions> <Edit Config> softkeys.

---

**RS-232 Configuration**

- **Baud Rate:** 1200
- **Stop Bits:** 1
- **Parity Bit:** None (Defaulted by protocol selection)
- **Bits/character:** 8 (Defaulted by protocol selection)
- **Hardware handshake:** Disabled (Defaulted by protocol selection)
- **Software handshake:** Disabled (Defaulted by protocol selection)

**Remote protocol:** DDCMP

**DDCMP timeout:** 3 seconds

**DDCMP buffer size:** 512 bytes

---

**Figure 15-1. <I/O Functions> Configuration Display.**

---

**Editing The I/O Configuration**

Communication between the master and the slave protocol analyzers occurs over an RS-232 link.

At power on, the protocol analyzer automatically loads your configuration. The power-on configuration can be changed by using <Edit Config> to define a new configuration and then using <Save Config> to rewrite the configuration to the disc volume currently selected in <Disc Functions> Menu.

The <Edit Config> softkey lets you edit the HP 4971S I/O configuration table to meet your system configuration. The fields that can be changed are shown in inverse video. To change a field, use the TAB key or the cursor keys to move the cursor to the field you want changed.

When the cursor is placed in a highlighted field, the softkey choices for that field are displayed. Press the softkey for the choice you want. The menu field is changed immediately.

**Baud rate:**

This line displays the selected transmission rate.

This line is used to select how fast the transmission occurs on the RS-232 link between the protocol analyzers.

The default transmission rate is 1200. To select a different baud rate, move the cursor to the 'Baud Rate' field. Press one of the displayed softkeys to choose a new transmission speed. The choices are:

- 300, 600, 1200, 2400, 4800, 9600
Stop bits:

This line shows the selection for stop bits.

Stop bits are supplied after each transmitted character as part of the system for maintaining synchronization between transmitting and receiving stations.

The default stop bit length is 1.

To choose a different stop bit length, move the cursor to the "Stop Bits" field. Press one of the displayed softkeys to choose a new stop bit length. The choices are:

1, 1.5, 2

Parity bit:

This field may be edited only when Encoded DDCMP protocol has been selected.

The "Parity Bit:" field lets you choose what parity format is used with each transmitted character. The HP 4971S transmits the parity bit(s) with each character for error checking by other computer systems. The HP 4971S does not use the parity bit(s) itself; it uses CRC error checking.

In standard DDCMP, the parity bit is not selectable and the default state is None.

In Encoded DDCMP, the parity bit is used and the default selection is odd. To choose a different parity bit condition, move the cursor to the "Parity bit:" field. Press a displayed softkey to choose a new parity bit format. The choices are:

None  Odd  Even

Parity  Parity
Bits/character: This field enables the RS-232 link to group the transmission in character lengths of 7 bits or 8 bits.

Bits/character field can be edited only when Encoded DDCMP is selected.

In DDCMP mode, the default Bits/character selection is 8.

Encoded DDCMP mode lets you choose bits/character. To choose a different character length, move the cursor to the "Bits/character:" field. Press a displayed softkey to choose a new character bit length. The choices are:

7 8

Bits/char Bits/char

Hardware handshake:

This field lets you choose how your modem handles messages between the modem and the protocol analyzer. Hardware hand shaking involves the control lines between the protocol analyzer and the modem such as: Request To Send (CTS), Clear To Send (CTS), and Carrier Detect (CD).

To choose a different hand shaking method, move the cursor to the "Hardware Handshake:" field. Press a displayed softkey selection to enable the new hand shake function. The softkey choices are:

Disabled Modem Modem
________ Hf-Duplex Fl-Duplex

DISABLED

Hand shaking can be disabled when two HP 4971S protocol analyzers are hard wired together. In this application, modems are not used and hand shaking is not required.

Select the hand shaking required for the modems used in your system.
MODEM HF-DUPLEX
hand shaking is selected when either modem transmits or receives but not both directions simultaneously.

MODEM FL-DUPLEX
hand shaking is selected when either modem transmits or receives simultaneously in both directions.

Software Handshake:
This field lets you choose different methods of hand shaking between protocol analyzers and other computers to control message flow.

Software hand shaking may be selected only in the Encoded DDCMP mode. With standard DDCMP, only hardware hand shaking may be used.

Some systems using Encoded DDCMP may use a combination of hardware and software hand shaking.

To choose a software hand shaking function, move the cursor to the Software Handshake Field. Press a displayed softkey to choose the mode you want. The choices are:

<table>
<thead>
<tr>
<th>Disabled</th>
<th>ENQ/ACK</th>
<th>ENQ/ACK</th>
<th>DC1/DC3</th>
<th>DC1/DC3</th>
<th>DC1/DC3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Terminal</td>
<td>Host</td>
<td>Terminal</td>
<td>Both</td>
<td></td>
</tr>
</tbody>
</table>
Remote protocol: field shows your selection for the RS-232 link protocol.

To choose a different protocol, move the cursor to the Protocol Field. Press one of the displayed softkeys to choose a new protocol. The choices are:

<table>
<thead>
<tr>
<th>DDCMP</th>
<th>Encoded DDCMP</th>
</tr>
</thead>
</table>

**DDCMP**

DDCMP is the default choice.

DDCMP is a byte count oriented protocol that breaks its messages into two parts: a header containing control information and a text body that contains the data portion of the message.

**Encoded DDCMP**

Encoded DDCMP groups the DDCMP frames of the protocol analyzer communications into printable ASCII characters. This allows characters in the protocol analyzer’s communications to pass through data communication equipment or a host computer with none of the characters recognized as control, transparent, or escape characters.

Figures 15-2 and 15-3 show the differences in the configuration fields that may be selected between DDCMP and Encoded DDCMP.
DDCMP timeout: field lets you select how long the protocol analyzers wait for responses to queries or commands. If the response does not come in the required time, the protocol analyzer goes to its next decision point to decide what action to take.

The default timeout is 3 seconds.

The timeout period may be selected from softkeys by moving the cursor to the protocol time out field and pressing one of the displayed softkeys:

<table>
<thead>
<tr>
<th>Seconds</th>
<th>Seconds</th>
<th>Seconds</th>
<th>Seconds</th>
<th>Seconds</th>
<th>Seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>10</td>
<td>30</td>
<td>60</td>
</tr>
</tbody>
</table>

When using two HP 4971As in half duplex, it may be helpful to enter different times for the timeout. In half duplex, if a fault occurs and both units back off, they may wait the same time and then try to establish contact again at the same time. It may be better to have the master station slightly faster than the slave station.

DDCMP Buffer Size: field lets you vary the size of the messages being sent between stations.

If you are sending messages to some station other than an HP 4971S, the receiving station’s buffer may not be able to receive 512 bytes at a time. If longer message lengths are transmitted than the receiver can handle, a buffer overrun may occur.

The default choice for buffer size is 512 bytes. Softkey choices for buffer size are:

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Bytes</th>
<th>Bytes</th>
<th>Bytes</th>
<th>Bytes</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>64</td>
<td>80</td>
<td>128</td>
<td>256</td>
<td>512</td>
</tr>
</tbody>
</table>
## RS-232 Configuration:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>300, 600, 1200, 2400, 4800, 9600</td>
</tr>
<tr>
<td>Stop bits</td>
<td>1, 1.5, 2</td>
</tr>
<tr>
<td>Parity bits:</td>
<td>None, *</td>
</tr>
<tr>
<td>Bits/character:</td>
<td>8, *</td>
</tr>
<tr>
<td>Hardware handshake:</td>
<td>Disabled, Modem Hf-Duplex,</td>
</tr>
<tr>
<td></td>
<td>Modem Fl-Duplex</td>
</tr>
<tr>
<td>Software Handshake:</td>
<td>Disabled, *</td>
</tr>
</tbody>
</table>

Remote protocol: DDCMP

- Protocol timeout: 3 seconds, 1, 2, 3, 10, 30, 60
- DDCMP buffer size: 512 bytes, 32, 64, 80, 128, 256, 512

* (Defaulted by protocol selection.)

---

**Figure 15-2. Configuration Choices With DDCMP Selected.**
RS-232 Configuration:

- Baud rate: 1200
- Stop bits: 1
- Parity bits: None
- Bits/character: 8
- Hardware handshake: Disabled
- Software Handshake: Disabled

Remote protocol: DDCMP

- Protocol timeout: 3 seconds
- DDCMP buffer size: 512 bytes

Figure 15-3. Configuration Choices With Encoded DDCMP Selected.
Saving The I/O Configuration

<Save Config.> softkey saves a copy of the configuration table to the Configuration File, CNFG.

The Configuration file is located on the LANCOD system disc. When you save the configuration, the protocol analyzer looks for the LANCOD volume. The analyzer prompts you to install LANCOD if it is not found.

In systems using only the HP 9122D Dual disc Drive, you must install the LANCOD disc in a disc drive slot. In systems with system software loaded on a Winchester disc drive, the analyzer will find LANCOD on one of the hard disc volumes.

If two LANCOD volumes are found in the system, the protocol analyzer saves the Configuration File, CNFG, to the lowest volume unit number.
Capturing A Slave LAN Protocol Analyzer

<Capture Slave> softkey starts the process of combining two HP 4971S systems into a master/slave operation. The protocol analyzer where you press <Capture Slave> softkey becomes the master or controlling device. The other HP 4971S then becomes the slave or measuring device.

After the <Capture Slave> softkey is pressed, the master analyzer displays:

To terminate Master - Slave mode, hit the "BREAK" key.

Waiting for permission to take control. IO: :

The master analyzer then establishes contact with the slave. After contact is established, the slave displays the message:

A request to take over control has been received over the I/O. Do you wish to relinquish control? If you do not respond in 10 seconds, control will be given to the requesting device.

Allow
Takeover

Block
Takeover

If you do not want to loose control at the slave unit, you must press the <Block Takeover> softkey within 10 seconds. If you do not, the slave defers control to the master device.

After the master captures control of the slave protocol analyzer, the master displays the Top Level Menu and the message:

You are now controlling the remote analyzer. IO: :

(continued)
Also after capture, the slave displays the message:

*This instrument is being remotely controlled. Hit "BREAK" key and wait to regain control.*

If no RS-232 link up occurs, the master cannot capture control of the slave protocol analyzer and the master displays:

SLAVE IS NOT RESPONDING

Troubleshooting <Capture Slave> softkey

If the master HP 4971S is not able to capture control of the slave HP 4971S, several steps are listed below that may help you resolve the problem.

1. Press <I/O Functions> softkey at each device.
   
   Verify the configuration table is the same for each device.

2. Verify <Enable I/O*> softkey is active at each protocol analyzer.
   
   * is displayed in the <Enable I/O> softkey when it is enabled.
   
   If an IO message is displayed in the lower right corner of the screen, see the IO STATUS tables in this section for how to read the status message.

3. Verify the connections from the protocol analyzers to each modem.
Editing And Sending A Modem String

<Edit Modem Str> softkey may be used with modems whose functions can be programmed via a message string from the device the modem supports.

The modem string can consist of up to 80 characters. When you perform a <Save Config.> operation, you also save the modem string. In default mode, a modem string is not defined. If you want to define a modem string, press <Edit Modem Str> softkey.

If the string needs a return character, use CONTROL M or press RETURN key to enter a return character.

Modem Substrings
The modem string can be divided into segments with a user defined amount of delay between sending each segment.

The character sequence "/N" (N = 0..9) can be used to divide the modem string. If "/N" is used, characters to the left of the "/N" will be sent first followed by a delay of "N" seconds, then followed by the characters to the right of the "/N". More than one "/N" may appear in the Modem String.

Example: /2+++/2ATZ_c^c_R/1ATD404_c^c_R

/2+++ After the string is enabled to be sent, the analyzer waits 2 seconds and sends " +++ ".

/2ATZ_c^c_R The analyzer waits 2 seconds and sends " ATZ " and a carriage return.

/1ATD404_c^c_R The analyzer waits 1 second and sends " ATD404 " and a carriage return.

The sequence "/" or a single "/" followed by any character other than "0..9" is treated as a "/" character in an undivided string.
**<Send At Power On>**

softkey lets the message automatically be sent to your modem each time the power switch is cycled on. To do this, you must first define a string, enable the <Send At Power On> softkey, and then use <Save Config.> softkey to save the modem string in the configuration file.

You must save the configuration file before you turn power off or it is lost.

<Send At Power On> acts as a toggle switch. When the softkey is active, an asterisk (*) is displayed in the softkey field and the modem string is sent at power on. Press the softkey again; the asterisk is removed from the softkey field and the modem string is not sent at power on.

**<ASCII 7>**
**<ASCII 8 Roman 8>**
**<EBCDIC>**

These softkeys let you choose the character code used in the modem string. Choose the character code required by your modem.

Other character codes are displayed if optional keyboards are used. See Appendix B.

**<Send Modem Str>**

softkey manually sends a modem string without having to cycle the protocol analyzer power. Check that you have created the string you want and then press <Send Modem Str> softkey.

The <Enable I/O> softkey must be off in order to send the modem string.
PROCEDURE

1. Set the HP 4971S Configuration Menu parameters as follows:
   - Baud Rate: 1200
   - Stop Bits: 1
   - Parity Bit: None
   - Bits/Char: 8
   - Hardware Handshake: Full Duplex; modem connection
   - Software handshake: Disabled

2. Use the following modem strings: (ASCII 7-bit or 8-bit data code).
   - **Caller:**
     \[
     <CTRL\cdot E>^{C_R/1}C_R/10C_R/11C_R/13C_R/1C_R/10C_R/1<\text{number}>^{C_R/1}C_R/1
     \]
     - letter '0'
   - **Unit to be called:**
     \[
     <CTRL\cdot E>^{C_R/1}C_R/10C_R/13C_R/1C_R/1C_R/1
     \]
     - letter '0'
     - letter '1'
   - \(<CTRL\cdot E> = 'CTRL' \text{ key plus letter 'E' key.}\)
   - \(C_R = \text{RETURN key}\)
   - \(<\text{number}> = \text{Telephone number (1 or more digits)}\)

3. Before pressing the \(<\text{Save Config}>\) softkey to save the configuration, check that the following softkeys are enabled:
   - \(<\text{Send At Power On}*>\)
   - \(<\text{l/O Enabled}>\)
EXAMPLE FOR USING THE HP 4971S WITH THE HAYES "Smartmodem 1200"

PROCEDURE

1. Set the configuration switches for the Hayes "Smartmodem 1200" as follows:
   (Switches are behind the front panel.)

   S1  Down  S5  Up  
   S2  Up    S6  Up  
   S3  Down  S7  Up  
   S4  Up    S8  Down

2. Set the HP 4971S configuration menu parameters as follows:

   Baud Rate: 1200
   Stop bits: 1
   Parity Bit: None
   Bits/Char: 8
   Hardware Handshake: Full duplex; modem connection
   Software Handshake: Disabled

3. Use the following modem strings:

   Caller: /2+++/2ATZ^C_R/1ATD<number>^C_R/1

   Unit to be called: /2+++/2ATZ^C_R/1

   ^C_R  = RETURN key
   <number> = telephone number (1 or more digits)

4. Before pressing the <Save Config.> softkey to save the configuration, check that
   the following softkeys are enabled:

   <Send At Power On*>
   <I/O Enabled*>
Enabling I/O Operation

<Enable I/O> softkey enables the HP 4971S LAN Protocol Analyzer to communicate with another HP 4971S.

The <Enable I/O*> softkey must be off in order to <Send Modem Str*> manually or to <Edit Config>.

<Enable I/O> acts as a toggle switch. An asterisk (*) is displayed when the function is on. Press the softkey again to remove the (*) and disable the function.

Status Messages
<Enable I/O*> softkey also enables a status message field to help you know what activity is occurring on the master/slave link.

This status field is located at the lower right corner of the display, just above the <EXIT> softkey.

I/O status messages are discussed on the following pages.
I/O Status Messages

The HP 4971S shows I/O status messages at the lower right corner of the display, just above the <EXIT> softkey.

Each protocol analyzer displays what it is doing or seeing. For example, if Station 1 is transmitting a message to Station 2, the display on each terminal would be:

Station 1

I/O: _ t _____:_____

This unit is transferring a frame to the RS-232 card's buffer.

Station 2

I/O: _ _____:r_____ 

This unit is receiving a frame.
I/O status messages can be grouped in the following functions:

NORMAL STATUS

This group of status characters reports the normal operation of your master/slave systems in remote operation.

PERSISTENT ERRORS

This group of status words and characters reports persistent problems that are occurring.

MODEM NOT READY ERRORS

The modem attached to your protocol analyzer is not ready for establishing communications between the stations.

RUN TIME ERRORS

This group of error messages reports hardware failures.
NORMAL STATUS

The two following tables describe status characters that may be displayed in the Normal Status fields. These fields report the activity of your systems remote communications.

```
I/O: _ _ : ___
     |   |   
Protocol State _ |   |   Receive Information
Transmit Information _
```

Transmit Information Field

<table>
<thead>
<tr>
<th>CHARACTER(S) DISPLAYED</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROTOCOL STATE</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>This unit is attempting to acknowledge the start of communication by other unit.</td>
</tr>
<tr>
<td>H</td>
<td>This unit is halted.</td>
</tr>
<tr>
<td>I</td>
<td>This unit is attempting to start communication with other unit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FRAME TRANSMISSION INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>O</td>
</tr>
<tr>
<td>t</td>
</tr>
<tr>
<td>w</td>
</tr>
</tbody>
</table>
NORMAL STATUS (cont.)

I/O: ____

<table>
<thead>
<tr>
<th>Protocol State</th>
<th>Receive Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmit Information</td>
<td></td>
</tr>
</tbody>
</table>

Receive Information Field

<table>
<thead>
<tr>
<th>CHARACTER(S)</th>
<th>DISPLAYED</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td></td>
<td>This unit has received a good data frame but was unable to accept it because there was no message buffer available.</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>This unit has received a frame with an FCS error.</td>
</tr>
<tr>
<td>O</td>
<td></td>
<td>This unit has had a receiver overrun error.</td>
</tr>
<tr>
<td>p</td>
<td></td>
<td>This unit is processing a received message.</td>
</tr>
<tr>
<td>r</td>
<td></td>
<td>This unit is receiving a frame.</td>
</tr>
</tbody>
</table>
PERSISTENT ERRORS

If persistent errors occur on the I/O interface, each protocol analyzer displays, in inverse video, one of the following messages.

Persistent error messages are displayed in the following groups:

- START
- START ACK
- ACK __
- RCV __

IO: START

This unit is having difficulty starting communication.

IO: START ACK

This unit is having difficulty acknowledging the start of communication.
**PERSISTENT ERRORS (cont.)**

**IO: ACK**

- This unit is having difficulty sending a frame to the other unit.

---

<table>
<thead>
<tr>
<th>CHARACTER(S)</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Other unit received a good data frame one or more times but was unable to accept it because there was no message buffer available.</td>
</tr>
<tr>
<td>D</td>
<td>Other unit received one or more frames with an FCS error in the Data Field.</td>
</tr>
<tr>
<td>F</td>
<td>Other unit has received one or more frame headers with a format error.</td>
</tr>
<tr>
<td>H</td>
<td>Other unit received one or more frame headers with an FCS error.</td>
</tr>
<tr>
<td>L</td>
<td>Other unit has received one or more data frames that are too long.</td>
</tr>
<tr>
<td>O</td>
<td>Other unit has had one or more receiver overrun errors.</td>
</tr>
<tr>
<td>T</td>
<td>Other unit has failed to respond for some period of time.</td>
</tr>
</tbody>
</table>
PERSISTENT ERRORS (cont.)

10: RCV __ This unit is having difficulty receiving a frame from the other unit.

| Status Character(s) |

CHARACTER(S) DISPLAYED DESCRIPTION

B This unit received a good data frame one or more times but was unable to accept it because there was no message buffer available.

D This unit received one or more frames with an FCS error in the data field.

F This unit has received one or more frame headers with a format error.

H This unit received one or more frame headers with an FCS error.

L This unit has received one or more data frames that are too long.

O This unit has had one or more receiver overrun errors.
MODEM NOT READY ERRORS

MODEM NOT READY  The modem at the station displaying this message is not ready. Possible causes are listed below:

HALF DUPLEX MODE
Data Set Ready line is false.

FULL DUPLEX MODE
Data Set Ready or Carrier Detect lines are false.
RUN TIME ERRORS

IO: Error

"ESCAPECODE" FIELD   "IOE_RESULT" or "IORESULT" FIELD

Example:

IO: Error  12   CPU bus error.
           26  12   No driver for this card.
           26  17   A time out has occurred.
           26  19   Bad status or control.
           26  21   Interface card is not operating.
           26  306  Datacomm interface failure.

If other Run Time Errors occur, contact your HP Response Center.
Terminal Emulator Description

The Terminal Emulator softkey provides access to configuration menus of intelligent modems. It lets you interactively configure modem parameters.

Using convenient keyboard entry, you can send and receive on a character basis to the modem. The terminal transmits each character as it is typed. Modem responses are shown on the terminal display.

Using the HP 4971S in terminal emulator mode requires detailed knowledge about your modem's operation. Refer to your modem's manual for guidelines to follow when sending commands to the modem and decoding modem responses.

Configuring The Terminal

Use the I/O Functions Edit Config softkeys to configure the terminal to be compatible with your modem. The I/O configuration menu is described earlier in this chapter.

Choosing Terminal Functions

<Local Echo> causes each key selection to be shown on the display.

When the receiving modem does not provide echo printing back to the display, this softkey lets you see your entry as you type each character.

If you select <Local Echo> and the receiving modem also provides echo printing, double characters are displayed.

<Auto Linefeed> causes the terminal to automatically send a line feed character to the display after a carriage return character is sent to the display.
<Show Non-printing> shows non-printing characters on the display. Characters are displayed if they are entered from the keyboard or received from the modem.

For example: in ASCII-7 character code, pressing the keys, CTRL and D, displays the character \( \text{ET} \) only when <Show Non-printing> softkey is enabled.

<ASCII 7> <ASCII 8 Roman 8> <EBCDIC> softkeys let you select the character code set for the displayed and transmitted characters.

Optional keyboards let other character codes be displayed. See appendix B for keyboard and character code descriptions.
This chapter describes the softkeys used for the <Execute Program> Menu.

From this menu, you select the source of frames for the program you want to execute. The frames may be already stored in the Receive Buffer, or, the source may be frames that are occurring on your Local Area Network.

In addition, this menu allows access to the <Edit Programs> Menu and to the <Examine Data> Menu.

This chapter includes:

- <Execute Program> Softkey Selection
- <Execute Program> Operation Considerations
- Running Programs From The Network
- Running Programs From The Buffer
- Examine Data After Program Run
- Edit Functions In <Execute Program> Menu
- <Execute Program> Soft LED Indicators
<Execute Program> Menu 16-2

<Execute Program > Softkey Selections

Execute Program

Run From Network

Run which program?
Program-0
Program-1
Program-2
Program-5
EXIT

Run From Buffer

Run which program from buffer?
Program-0
Program-1
Program-2
Program-5
EXIT

Edit Program

Edit which program?
Program-0
Program-1
Program-2
Program-5
Edit New Program
Rename Program
OTHER CHOICES
Delete Program
EXIT

Examine Data

(See <Examine data> Menu section)
EXIT

<Execute Program > Operating Considerations

See the appendix section for a list of program execution times. The following paragraphs give general considerations for program execution.

Frame Acquisition Versus Display Speed.
The protocol analyzer operating software performs two functions. First, it must look for frames matching filter conditions and store all qualified frames in the Receive Buffer. Second, it must run the <Edit Program> routines that you have programmed.

The task of looking at all frames for filter matches and then storing the selected frames in the Receive Buffer is happening in realtime at 10 Mbits/sec. The frames cannot be displayed in real time. As the display is updated, the last frame stored in the receive buffer is displayed next.

At the same time the protocol analyzer is storing frames in realtime, your <Edit Program> softkey program is also being executed. Routines such as updating the display, controlling the counters and timers, and beeping are performed relatively slowly compared to the realtime data acquisition rate.

In any circular mode of memory storage (Nonstop, Centered About, and Ending With), if the Receive Buffer is filled before the display, counter, timer, and beeper routines are completed, the protocol analyzer cannot begin writing new frames over the oldest frames previously stored in memory.

If network traffic loading is heavy, the program may cause the protocol analyzer to stop acquiring frames and display a message stating that a buffer overflow has occurred.

Recommendation
In order to reduce processor time spent displaying frames, counters, timers, and controlling the beeper, try to minimize using these programmable functions while storing frames.

An alternative is to capture the frames first, without displaying information, and then run your program in <Run From Buffer> mode.

In <Run From Buffer> mode, no conflict occurs between storing frames and displaying information since the frames are already captured.
Running Programs From The Network

NOTE

If you have not created a program, the protocol analyzer goes to a default PROGRAM_0. This program contains the default "Store" command:

Store: all frames
       until buffer full

This lets the protocol analyzer monitor the network or Receive Buffer in the absence of a user created program in <Run From Network> or <Run From Buffer> modes.

<Run From Network> causes the protocol analyzer to execute a selected program using frames presently occurring on the Local Area Network.

Press the <Run From Network> softkey to display:

Run which program? __________

Press the softkey whose label contains the program you wish to execute. The softkey causes the program to begin executing immediately.

If only 1 program is defined, it is run automatically without going through the "Run which program?" question.

Up to five programs can be created and displayed as softkey selections.
Running Programs From The Buffer

<Run From Buffer> causes the protocol analyzer to execute a selected program using data previously stored in the Receive Buffer or in log-data disc files.

Choose the data source.

RECEIVE BUFFER
To execute a program from the Receive Buffer, load the buffer with frames directly from the network.

LOG-DATA DISC FILE
To execute a program from a log-data file, use the <Disc Functions> Menu to load a log-data file to the Receive Buffer. The analyzer then automatically uses the log-data file as the frame source while executing the program.

Choose the program to execute.

Press the <Run From Buffer> softkey to display:

Run Which Program From Buffer? __

Press the softkey whose label contains the program you wish to execute. The softkey causes the program to immediately begin execution.

If only one program is defined, it is run automatically without going through the "Run which program?" question.

Up to five programs can be created and displayed as softkey selections.
**Run from Receive Buffer.**

When the Receive Buffer is the source of frames used for executing a program, the "Store" command shown in the top line of your program display is ignored in <Run From Buffer> operation since the frames you are using are already stored in the Receive Buffer.

The frames in the receive buffer are not changed by executing the program.

<Execute Program> updates the "Filters" field to show what filters are matched in each frame. Trigger events specified by the program's "Store:" statement are updated. Trigger events are frames that match the statements: Starting With, Centered About and Ending With.

Executing <Run From Buffer> automatically clears the "Mark Frame" condition from frames in the Receive Buffer. Timers and counters are reset. The timestamp for when each frame occurred on the network is retained.

**Run from Log-data disc file.**

If the Receive Buffer has been filled from a log-data file, the <Run From Buffer> command executes using frames in the log-data disc file.

Only frames from the log-data file that match the selected program's "Store:" command, filters and trigger events are written to the Receive Buffer or output file. The original timestamp for when each frame occurred on the network is kept.

The contents of the log-data file on the disc are not disturbed.
## Examine Data After Program Run

After a program run is completed, the protocol analyzer automatically goes to <Examine Data> Menu. The list below shows what information is displayed.

<table>
<thead>
<tr>
<th>Program Data Source</th>
<th>&quot;Log File:&quot; command used?</th>
<th>&lt;Examine Data&gt; Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run from Network</td>
<td>NO</td>
<td>Receive Buffer data</td>
</tr>
<tr>
<td>Run from Network</td>
<td>YES</td>
<td>Log-data file on disc</td>
</tr>
<tr>
<td>Run from Buffer</td>
<td>NO</td>
<td>Receive Buffer data</td>
</tr>
<tr>
<td>(Buffer filled from network)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run from Buffer</td>
<td>YES</td>
<td>Receive Buffer data</td>
</tr>
<tr>
<td>(Buffer filled from network)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run from Buffer</td>
<td>NO</td>
<td>Original log-data file on disc</td>
</tr>
<tr>
<td>(Buffer filled from log-data file)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run from Buffer</td>
<td>YES</td>
<td>New log-data file on disc</td>
</tr>
<tr>
<td>(Buffer filled from log-data file)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To fill the Receive Buffer from a log-data file, use <Disc Functions> <Load File> menu and select a log-data file existing on the selected volume.
Edit Functions In <Execute Programs> Menu

<Edit Program> softkey provides a convenient branch to the <Edit Programs> Menu.

You can choose to edit the following programming functions:

<Edit New Programs>

<Rename Programs>

<Delete Program>

Detailed descriptions of these softkey functions are given in the <Edit Programs> Softkey Descriptions section in Chapter 14.

When you branch to the <Edit Programs> Menu and finish editing a program, press the <EXIT> softkey to return to the <Execute Program> Menu.

<Examine Data> softkey lets you view data stored in the Receive Buffer.

See the <Examine Data> Menu section for a description of the softkeys available.

When you press the <Examine Data> softkey, the protocol analyzer branches to the <Examine Data> Menu. All the normal <Examine Data> Menu softkeys are available for you to view the frames. However, when you press the <EXIT> softkey in <Examine Data> mode, you return to this <Execute Program> Menu.
< Execute Program > Soft LED Indicators

In <Execute Program> operation, characters are provided to indicate the following activities:

- The protocol analyzer is transmitting a frame.
- The protocol analyzer has detected a collision.
- The protocol analyzer is receiving a frame.

These activities are indicated by the characters shown below the softkeys at the lower right corner of the display.

T  C  R

Each character is displayed in normal video when there is no activity, that is, the function is "Off". Characters are displayed inverse video when their function is active or "On".

T indicates the protocol analyzer is transmitting on the network.

C indicates collisions are occurring on the network. Hardware for the collision counter detection circuit has detected a collision.

R indicates the protocol analyzer is receiving a frame. This soft LED turns on when a frame passes through the Runt frame filter.
WHEN ARE THE SOFT LEDs DISPLAYED?

The soft LEDs are displayed during the following program execution:

1. When a <Run From Network> program specifies any "Store:" operation that stores frames in the Receive Buffer.

2. Only the "T" soft LED appears when a <Run From Network> program specifies storing no frames and also specifies sending messages.

The "T" does not appear until the first message is sent in this program's execution.

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDs?

Short display

Since the frames on a LAN are being transmitted at 10 Mbits/sec, there are times when the soft LEDs will be on too briefly to notice.

This is most likely to happen when the network traffic load is very light.

Long Display

In contrast, there are times when the soft LEDs will be on longer than the duration of an event.

For the Collision and Receive soft LEDs, the "On" duration can be from five milliseconds to one second. The time depends on the amount of traffic on the network and the contents of the program for the Collision and Receive soft LEDs.

For the Transmit soft LED, the duration depends on the length of the message to be transmitted, the frequency of transmission, and how often other traffic on the network permits the frame to be transmitted.
**WHAT DISTORTS THE SOFT LEDS DISPLAY?**

| Transmit   | Because frames are transmitted at 10 Mbits/sec, the duration of frames is very short. This soft LED appears to not be on if your program uses "Store: no frames" and short frames are sent in small groupings. |
| Collision  | These two soft LEDs do not display in real time. When a collision or received frame happens, the soft LED indication occurs some time later. |
| Receive    | |

This time lag can vary from one millisecond to one second. Maximum time lag occurs when:

- The network is lightly loaded
  (less than 64 frames/second)

- AND

- A `<When>` statement is not being executed in the program.
This chapter describes the softkeys used to monitor network message traffic.

<Monitor Network> softkey lets you quickly begin looking at frames on your Local Area Network with only a few simple softkey selections.

This chapter includes:

- <Monitor Network> Softkey Selections.
- <Monitor Network> Softkey Descriptions.
- <Monitor Network> Soft LED Indicators
- <Monitor Network> Anomalies
<Monitor Network> Softkey Selections

Monitor Network

Nonstop Mode

Until Full

Start Monitor

Stop Display/Start Display

Stop Monitor

(Examine Data selections) A

Next Frame

EXIT

/

/

Continue Monitor

Select Format B

EXIT (to Monitor Network Menu)

Examine Data A (see Examine Data Selections)

EXIT (to Top Level Menu)

A, B Functions from <Examine Data> Menu

See <Examine Data> Menu section for details.

A Examine Data

1 Next Frame

2 Previous Frame

3 Scroll Frames

4 Go To Frame #

5 Timers & Counters

B 6 Select Format

Detailed Format

Summary Format

Filter Format

Change Headers

Change Datafield

Change Timestamps

EXIT

7 Other Choices

8 Next Marked

9 Previous Marked

10 Scroll Marked

11 Mark/Unmark

12 Show Node Names

13 Show Hex Addresses

14 EXIT
<Monitor Network> provides an easy-to-use method for capturing and viewing network messages with the protocol analyzer.

In <Monitor Network> mode, you capture all messages appearing on a local area network. The messages are captured exactly as they appear on the network. The display updates with the most recently stored frame in the Receive Buffer. Monitoring is done in a transparent or unobtrusive mode with the protocol analyzer generating no signals back to the network.

<Monitor Network> uses the Store command: Store: all frames to capture frames occurring on the Local Area Network. Softkeys <Nonstop Mode> or <Until Full> mode determine how the protocol analyzer fills its Receive Buffer.

<Nonstop Mode> causes the receive buffer to be filled continuously.

The <Nonstop Mode> is sometimes referred to as a circular memory. The captured information increments from the beginning of the buffer to the end of the buffer. As information continues to be received, the protocol analyzer moves back to the beginning of the memory buffer and starts writing over information previously stored. This process of writing over previously stored information continues until the <Stop Monitor> softkey is pressed.

<Until Full> stores network information in the receive buffer until it is full and the protocol analyzer stops acquiring data.

The <Until Full> mode is sometimes referred to as a linear memory. The captured information increments from the beginning of the buffer to the end of the buffer. In contrast to the <Nonstop Mode>, the <Until Full> mode does not continuously write over previously stored information. When the Receive Buffer is filled, the protocol analyzer halts the monitor function and automatically goes to the <Examine Data> Menu.
initializes the Receive Buffer and causes the protocol analyzer to start storing information in the same order that it appears on the local area network.

Several messages are displayed at the beginning of <Start Monitor> to show the status of the protocol analyzer during the acquisition cycle:

- Loading filter hardware
- Initializing Receive Buffers
- Acquiring data. Waiting for incoming frames

The task of storing the frames in the Receive buffer is happening in realtime at 10 Mbits/sec. The frames cannot be displayed in real time. As the display is updated, the last frame stored in the Receive Buffer is displayed next.

When the monitor operation is ended, frames are displayed in the consecutive sequence they occurred on the network.

stops displaying new frames as they are stored into the Receive Buffer. Although the protocol analyzer stops displaying new frames, additional frames continue to be stored in the <Nonstop Mode> or until the memory is full in <Until Full> Mode.

A reason to stop the display might be when acquisition is occurring slowly, you can examine some frame in detail without having to wait until the buffer is full or not having to disrupt the frame acquisition.

Changing the format at this point allows you to display the frame in another format.

restarts the protocol analyzer displaying new frames as they are being loaded into the Receive Buffer.
<Stop Monitor> stops loading new frames into the Receive Buffer and displays the frames in the <Examine Data> mode.

In the <Nonstop Mode>, the following status message is momentarily displayed: Run Suspended; then the protocol analyzer goes to <Examine Data> mode to display frames in the Receive Buffer.

Press the <EXIT> softkey to display the choice to either <Start Monitor> which reinitializes the Receive Buffer and throws away the contents previously stored, or, to <Continue Monitor> which retains previously stored information, and starts filling memory from where it left off.

<Continue Monitor> lets the protocol analyzer resume loading new frames into the Receive Buffer and displaying frames in the <Examine Data> Mode.

<Examine Data> is a softkey that also may be selected from the Top Level Menu. The function of the <Examine Data> softkey is to provide an easy method of viewing the network frames stored in the Receive Buffer.

<Examine Data> softkeys are explained in detail in the <Examine Data> Menu chapter.

<Select Format> is a softkey from the <Examine Data> Menu.

In this monitor mode, <Select Format> softkey lets you change the display format of information stored in the Receive Buffer. By changing the display format, you can exclude unwanted information and identify more easily information that is important to you.

Choices available from the <Select Format> softkey are explained in detail in the <Examine Data> Menu section.
Monitor Network > Soft LED Indicators

In <Monitor Network> operation, characters are provided to indicate the following activities:

- The protocol analyzer has detected a collision.
- The protocol analyzer is receiving a frame.

These activities are indicated by characters shown below the softkeys at the lower right corner of the display.

T .. C·

Each character is displayed in normal video when there is no activity, that is, the function is "Off". Characters are displayed in inverse video when their function is active or "On".

T  indicates the protocol analyzer is transmitting on the network.

NOTE

Monitor operation is a unobtrusive or passive operation; the protocol analyzer will never be transmitting during monitor operation. The "T" LED is only used during <Execute Programs> operation.

C  indicates collisions are occurring on the network. Hardware for the collision counter detection circuit has detected a collision.

R  indicates the protocol analyzer is receiving a frame. The LED turns on when ever a frame passes through the Runt frame filter. Only frames greater than 512 bits will turn this soft LED on if the Runt Frame Filter is enabled in the <Hardware Functions> Menu.
WHEN ARE THE SOFT LEDS DISPLAYED IN MONITOR OPERATION?

The soft LEDs are displayed during the following monitor operations:

1. <Monitor Network> mode is running.

2. <Monitor Network> mode has run and has been manually stopped with no frames received after the monitor has stopped.

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDS?

Short Display

Since the frames on a LAN are being transmitted at 10 Mbits/sec, there are times when the soft LEDs will be on too briefly to notice.

Long Display

In contrast, there are times when the soft LEDs will be on longer than the duration of an event.

For the Collision and Receive LEDs, the duration depends on the amount of traffic on the network.

**LED on continuously**

occurs when the network load is receiving more than one frame/second and less than 64 frames/second.

**LED on continuously with low blink rate**

occurs when the network load is greater than 64 frames/second and some inter-frame spacing is greater than 200 ms.

**LED on continuously with occasional flicker**

Occurs when the network load is greater than 64 frames/second and all inter-frame spacing is less than 200 ms.

**LED always off or blinks at one second rate**

occurs when the network load is less than one frame/second.
WHAT DISTORTS THE LED DISPLAY?

Transmit
(Not active in monitor mode.)

Collision & Receive
The soft LEDs do not operate in real time; a collision can occur or a frame can be received but the indication is not displayed until some time later.

The time lag can range from one millisecond to one second. The maximum time lag occurs when the network is very lightly loaded (less than 64 frames/second).
<Monitor Network> Anomalies

Repeating Displays

The HP 4971S does not display all frames while monitoring the network. Since frames are transmitted at 10 Mbits/sec, the display skips some frames and updates with the most recently stored frame in the Receive Buffer.

In <Monitor Network> <Nonstop Mode>, if you are monitoring a repeating group of frames on the network, the protocol analyzer may appear to be displaying only a few of the frames. This may happen when the display cycle of the protocol analyzer synchronizes with the frames appearing on the network.

To assure yourself that all the frames are being received, you may want to stop the monitor function and use <Examine Data> softkey to verify that other frames are indeed being captured.

No Frame Number Displayed

Frame numbers are not displayed when you monitor the network in <Nonstop> mode. After you stop the monitor, the frames will be numbered with the oldest frame in the buffer starting as number 1.
This chapter describes the disc functions and the softkeys used to control the mass storage operations.

The <Disc Functions> softkey functions provide mass storage capability for the HP 4971S Protocol Analyzer.

This chapter includes:

- <Disc Functions> Softkey Selections
- Introduction To Disc Functions
- Selecting A Volume
- Listing The Directory
- Deleting A File
- Saving A File
- Loading A File
- Copying A File
- <Copy Files> Introduction
- Copying <Analyzer Files>
- Copying <All Files>
- Copying <Unique Files>
- Formatting A Volume
- Compressing A Volume
- <Disc Functions> In Remote Mode
Introduction To Disc Functions

<Disc Functions> softkey provides many conveniences for analyzing a Local Area Network. Programs, messages, node lists and filters can be created for application on your particular system and saved to a disc drive.

The <Log Frames To Disc> program command in <Edit Programs> Menu lets the HP 4971S log frames directly to the disc drive as the frames are occurring on the network. This lets you take advantage of the larger storage capacity of the disc drives.

In non-logging modes, after the HP 4971S Protocol Analyzer captures frames occurring on the Local Area Network, you can manually transfer the frames to the larger storage capacity of a disc drive.

Equally as important as the increased data storage is the easy storage and recall of previously defined setup information that you can create to control the HP 4971S operation. Examples of functions desirable to store on a disc are:

- User defined node name list
- User defined filters
- User created programs
- User created messages

The <Disc Functions> menu lets the HP 4971S Protocol Analyzer perform the following data storage and transfer functions.

- Initialize discs or volumes.
- Save files from the protocol analyzer onto discs or volumes.
- Load files from volumes into the protocol analyzer.
- Copy files from one volume to another disc volume.
- Delete files from volumes.
Discs supplied with system.

Several discs are provided with the HP 4971S protocol analyzer system. These disc are:

<table>
<thead>
<tr>
<th>DISC LABEL</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>LANSYS</td>
<td>Includes the operating system software and some operating tables.</td>
</tr>
<tr>
<td>LANCOD</td>
<td>Includes code unique to protocol analyzer functions.</td>
</tr>
<tr>
<td>HP 4971S TUTORIAL</td>
<td>is a self-paced tutorial supplied to introduce you to the basic functions of the protocol analyzer.</td>
</tr>
<tr>
<td>92192A</td>
<td>Box of ten 3 1/2 inch floppy discs</td>
</tr>
</tbody>
</table>

With HP 9122D Dual Disc drives, LANSYS and LANCOD must be installed in the disc drive each time the protocol analyzer is powered on.

With Winchester drives, you permanently store LANSYS and LANCOD on the hard disc after the initial power up procedure.
Selecting A Volume

<Select Volume> lets you to select the disc volume to use for your mass storage operations.

Up to three disc drives can be supported by the HP 4971S. The HP-IB switch address settings on a disc drive determines the volume unit numbers displayed by the analyzer when you press the <Select Volume> softkey.

In the chapter "Installing The HP 4971S," the section "Set The HP-IB Address Switches" describes the options for setting the address switches for system disc drive(s).
Listing The Directory

<List Directory> displays a directory list of files contained in the selected volume.

The <List Directory> function recognizes and displays Pascal TEXT and CODE files. If another type of file is found, the file is labeled as OTHER in the type field.

<table>
<thead>
<tr>
<th>FILE #</th>
<th>NAME</th>
<th>TYPE</th>
<th>SEQUENCE</th>
<th>DATE SAVED</th>
<th>TIME SAVED</th>
<th>SIZE (BYTES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CNFG</td>
<td>Config</td>
<td>0</td>
<td>15-Apr-85</td>
<td>10:01:01</td>
<td>1024</td>
</tr>
<tr>
<td>2</td>
<td>new</td>
<td>Data</td>
<td>0</td>
<td>16-Jun-85</td>
<td>01:03:39</td>
<td>56780</td>
</tr>
<tr>
<td>3</td>
<td>sys71</td>
<td>OTHER</td>
<td>*</td>
<td>09-Mar-86</td>
<td>12:15:22</td>
<td>237954</td>
</tr>
<tr>
<td>4</td>
<td>Netwrk1</td>
<td>Network</td>
<td>0</td>
<td>17-Jun-86</td>
<td>13:01:55</td>
<td>2283</td>
</tr>
<tr>
<td>5</td>
<td>NList</td>
<td>Nodes</td>
<td>0</td>
<td>17-Jun-86</td>
<td>09:30:02</td>
<td>743961</td>
</tr>
</tbody>
</table>

Printing The Directory
If your system has an HP ThinkJet printer, press SHIFT and PRINT keys to print the complete directory.

VOLUME SIZE displays the total size in bytes of the selected volume.

LARGEST AVAILABLE SPACE is the largest contiguous space available. This may be space between existing files or space at the end of the files. The HP 4971S does not fragment files when performing a save file or copy file operation.

You can use this number to see if you have enough room to save or copy an additional file to the current volume.

If files have been deleted, use the <Compress Volume> softkey to move all free file space to the end of the volume.
**TYPE** field indicates the type of file. Protocol analyzer files include:

- Application
- Configuration
- Data (frames)
- Data (log-to-disc)
- Filter
- Message
- Network
- Node

TEXT, CODE, or OTHER files are not HP 4971S user defined protocol analyzer files.

**SEQUENCE** number is used only for files saved from the protocol analyzer.

OTHER, TEXT, and CODE files have an asterisk (*) in the sequence column.

When large files are saved to a disc, there may not be enough room to save all of a file on one disc. The HP 4971S prompts you to insert a new disc when the current disc capacity has been filled. The HP 4971S automatically assigns sequence number one to the first disc and then increments the sequence number for the remainder of the file created on the next disc(s).

**DATE** is the day, month, and year the file was saved in the protocol analyzer.

If the date is not set in the <Set Date> Menu when the protocol analyzer power is turned on, the "DATE" field defaults to the HP 4971S software revision date.

**TIME** is the hour, minute, and second the file was saved in the protocol analyzer.

If the time is not set in the <Set Time> Menu when the protocol analyzer power is turned on, the "TIME" clock starts from zero and <List Directory> TIME is not relevant to the actual time of day the file was stored on disc.
Deleting A File

<Delete File> softkey lets you remove an unwanted file from a selected volume.

Press the <Delete File> softkey to display a list of the types of files on the selected volume.

After the type of file softkey is pressed, a prompt is displayed to enter the file name to be deleted. All of the files that match the file type you selected are displayed as softkey choices. Press a softkey type the file name from the keyboard. If you enter the file name from the keyboard, press RETURN key to complete the entry.

Are You Sure?
After you enter a file name you want to delete, a prompt is displayed to be sure that you have identified the correct file and really want to delete the information. Press the <YES> softkey to execute the delete command.

One File At A Time
For safety, only one file may be deleted at a time. A wild card can not be used to delete multiple files in one operation.
Saving A File

<Save File> lets you copy a file from the protocol analyzer to a selected volume. The original information is left intact in the protocol analyzer.

After you press the <Save File> softkey, the softkeys change to display a choice of the type of file to be saved. Types of files that can be saved from the protocol analyzer include:

- Network File
- Data File
- Node File
- Filter File
- Message File
- Program File
- OTHER CHOICES
- EXIT

<OTHER CHOICES>

- Config. File

<Config File> softkey lets you copy the current HP 4971S configuration into a file. The configuration file contains data rate, hand shaking and protocol information for communicating over the RS-232 port as well as set-up information for several menus.

Set-up items included in the configuration file include:
- Passwords
- Autostart file
- Default volume
- <Examine Data> Menu data formats

<Disc Functions> Menu  18-8
<Save File> (cont.)

<Network File> softkey copies the following information from the protocol analyzer onto the disc.

- User defined node name list
- User defined filters
- User defined messages
- User defined programs

If no Network file exists on the selected volume, the display prompts you to enter a file name. If network files already exist, the <Network File> softkey requires you to choose between creating a new file or re-writing the file to an existing file name.

<Re-write Existing>
softkey displays the names of network files existing on the selected volume.

Press a displayed softkey representing the file to be replaced to immediately execute storing the current network files in the protocol analyzer to that disc file, or, enter the name of an existing disc file from the keyboard and press RETURN to execute saving the network file.

<Create New File>
softkey prompts you to enter a new file name. Volume file names can be up to seven keyboard characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Characters not valid for volume file names are:

- @ = . (period)
- # / CTRL-x (control characters)
- $ :

After a name is entered for <Create New File>, press RETURN key to execute storing the network setups from the protocol analyzer to the new file.
softkey lets you copy Data Files from the protocol analyzer's Receive Buffer onto a selected volume.

If no data file exists on the selected volume, the display prompts you to enter a file name. If data files already exist, the <Data File> softkey requires you to choose between creating a new file and re-writing the file to an existing file name.

<Create New File> writes the file to a new file name. <Re-write Existing> removes information from an existing file and writes the new information in its place.

To save network frames from the Receiver Buffer to a data file on the volume, you have to decide what portion of the Receive Buffer you want to copy.

Up to 15 combinations of network message frame groups can be stored in one volume file. Softkey choices let you select frames to copy.

<Range Of Frames>
<Single Frame>
<Marked Frame>
<All Frames>
<Save The List>
<Save File> (cont.)

NOTE

Frames are saved with the same frame number they have in the Receive Buffer. If a frame is saved more than one time, it is shown with the same frame number each time it is displayed.

An example is shown below of <Save File> softkey with all 15 available elements defined with frames to be saved from the Receive Buffer Data File. Notice that several frames are copied in more than one element.

FRAMES IN THE LIST (15 elements maximum):

1. RANGE OF FRAMES FROM # ______ 4 TO # ______ 9
2. SINGLE FRAME # ______ 2
3. RANGE OF FRAMES FROM # ______ 14 TO # ______ 20
4. RANGE OF FRAMES FROM # ______ 31 TO # ______ 40
5. SINGLE FRAME # ______ 23
6. MARKED FRAMES
7. RANGE OF FRAMES FROM # ______ 234 TO # ______ 300
8. RANGE OF FRAMES FROM # ______ 400 TO # ______ 500
9. RANGE OF FRAMES FROM # ______ 500 TO # ______ 600
10. SINGLE FRAME # ______ 450
11. SINGLE FRAME # ______ 1
12. SINGLE FRAME # ______ 250
13. RANGE OF FRAMES FROM # ______ 500 TO # ______ 600
14. RANGE OF FRAMES FROM # ______ 10 TO # ______ 35
15. SINGLE FRAME # ______ 625
<Save File> (cont.)

<Range Of Frames>
lets you choose a group of consecutive frames to be copied from the Receive Buffer Data File to a selected disc. The prompt for choosing the range of frames is:

RANGE OF FRAMES FROM #  TO #

The frame numbers refer to the numbers assigned to each frame as it is viewed in <Examine Data> Menu. To specify a number range, use numeric keys from the keyboard in the prompt, From # _____ , and then press the RETURN key. Enter the To # _____ frame number and press the RETURN key.

If you want to know the last frame number, enter a number you know is greater than the last stored frame number such as 999999 and press the RETURN key. The last frame number available in the Receive Buffer is displayed in the field.

Frame numbers can overlap or be duplicated in different combinations or data files.

<Single Frame>
lets you choose one specific frame number to be copied from the Receive Buffer Data File.

A <Single Frame> choice may be duplicated in other frame selections to be saved to the disc.

Enter the single frame number and then press the RETURN key to complete the entry.

If no additional frames need to be saved, press <Save The List> softkey.

<Disc Functions> Menu 18-12
<Save File> (cont.)

<Marked Frames>
stores all frames from the Receive Buffer that have been identified by the <Mark Frame> softkey in <Examine Data> operation.

>All Frames>
lets you save all frames in the Receive Buffer. <All Frames> can be used by itself to save the entire group of frames in the Receive Buffer or it may be used in combination with the other softkeys for saving frames.

<Save The List>
immediately executes saving the frames identified in the list by <Range Of Frames>, <Single Frame>, <All Frames>, and <Marked Frames> softkeys.

If you press <Save The List> softkey and no frames have been identified to be stored, an empty file is generated.

Save Timers And Counters?

After you press <Save The List>, the protocol analyzer asks if you want to also save the Timers and Counters with the current data file to be saved. Press <YES> to begin saving the data list and the counters/timers information. Press <NO> softkey, to save only the previously defined data list.
<SAVE FILE> (cont.)

<Node File>
<Filter File>
<Message File>
<Program File>

You can save each of these individual files that you have created in <Setup Analyzer> Menu to a volume you select.

After one of the above menus is created, go to <Disc Functions> menu.

Press the <Save File> <xxxxxxx File> softkey and the protocol analyzer prompts you to choose between saving the file to a new file name or re-writing an existing file.

Press <Create New File> to save the <xxxxxxx File> to a new file name.

Press <Re-write Existing> to save the menu or information to an existing file name. Re-write removes the old file information and then writes the new information.


**Loading A File**

<Load File> lets you copy an HP 4971S file from a selected volume into the HP 4971S protocol analyzer.

Press the <Load File> softkey to display the selection of files available on the selected disc. Depending on which file type you select, softkeys display names for that type from the selected volume directory.

Press the softkey name of the file you want loaded into the protocol analyzer to immediately start loading the file.

Append Or Overwrite Current Node List?
When you load a network or node file into the protocol analyzer and the node list already has nodes defined, the display prompts you to choose whether to append or overwrite the current node list.

<Append Nodes> softkey adds the new names to the current node list.

<Overwrite Nodes> softkey deletes the current node list and writes the file into the node list.

Status Messages
Status messages are displayed in the upper left corner during the load operation. For example:

```
Loading Nodes

Loading Frame # _____ in to Buffer # _____
```

When the file is loaded, a status message is displayed above the softkeys:

'(<your file name)') loaded.
<Copy File> Introduction

The HP 4971S can copy a file from one volume into another volume. The copy function is softkey controlled.

Softkey selections copy a single file or all files from one volume to another. You can use a wild card to copy files with common characters from one volume to another. You can copy non HP 4971S files.

In any of the copy file modes, when a file to be copied already exists on the TO volume, the file is overwritten.

NOTE

Floppy discs must be initialized by the HP 4971S system before you can copy to the disc.

After you press <Copy Files> and select a volume to copy FROM, the protocol analyzer displays the following softkeys:

<Analyzer Files> <All Files> <Unique Files>

Files types that may be in each of these file groups include:

<table>
<thead>
<tr>
<th>&lt;Analyzer Files&gt;</th>
<th>&lt;All Files&gt;</th>
<th>&lt;Unique Files&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config file</td>
<td>Includes all files stored on the FROM volume.</td>
<td>May be any file.</td>
</tr>
<tr>
<td>Network file</td>
<td></td>
<td>This includes analyzer files or other system files.</td>
</tr>
<tr>
<td>Data file</td>
<td></td>
<td>Wild card (@) can be used.</td>
</tr>
<tr>
<td>Node file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log-to-disc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<Disc Functions> Menu 18-16
softkey lets you copy any of the protocol analyzer file types listed on the previous page.

In <Analyzer Files> copy operations, only one file may be copied at a time. Softkey operation is provided for quick file copy operation.

softkey lets you copy all files (analyzer files and unique files) from one volume to another volume in one operation.

softkey lets copy protocol analyzer files as well as files other than user defined protocol analyzer files. Other file types may be system files.

A "wild card" feature in the <Unique Files> operation lets you copy more than one file at a time.

Each of these copy file groups is discussed in detail on the following pages.
COPYING < ANALYZER FILES >

<Analyzer Files> lets you copy any of the files you use for protocol analyzer operation. Using <Copy Files> <Analyzer Files> lets you copy one file at a time. Softkeys are provided to let you quickly move through the copy operation.

The different types of files used for protocol analyzer operation include:

- Configuration File
- Network File
- Data File
- Node File
- Filter File
- Message File
- Program File
- Log-to-disc File
- Application File

PROCEDURE

1. Press <Copy Files> softkey.
2. HP 4971S prompts: Copy file FROM which volume?
3. Press a softkey for the number of the FROM volume.
4. HP 4971S displays: FROM: #(volume number:),(name of volume) TO:
   For example: FROM: #3, SAVE1 TO:
   Copies a file from volume #3: Volume #3: is named SAVE1.
5. The protocol analyzer reads the directory of the FROM volume and displays softkeys:
   - <Analyzer Files>
   - <All Files>
   - <Unique Files>
6. Press <Analyzer Files> softkey.
7. HP 4971S displays only the analyzer type files that are currently on the selected volume.
8. HP 4971S prompts: Choose a file type to copy.
PROCEDURE: Copy <Analyzer Files> (cont.)

9. Press a softkey for the file type you want to copy.

10. HP 4971S displays softkey choices for the files currently existing on the selected volume.

11. HP 4971S prompts: Select softkey or enter valid name:

12. Press a softkey for the file you want to copy.

13. HP 4971S lists the file name and file type you just selected and prompts: Copy file TO which volume?

14. HP 4971S displays softkey choices for the volumes available on your system.

15. Press a softkey for the volume destination you want.

16. HP 4971S displays the name, type, and size of the file you have selected.

17. HP 4971S displays softkeys to let you rename the file on the TO volume or to begin copying to the current file name.

<!--Begin Copy-->

<!--Begin Copy--> causes the protocol analyzer to begin the copy operation.

<!--Change Name-->

<!--Change Name--> lets you change the name of the file in the TO volume. Press the softkey, <Change Name>, and enter the new name.

Volume file names can be up to seven characters. Leading spaces are deleted. Spaces between characters are replaced with an underscore (_). Press RETURN key to complete the entry. Characters not valid for volume file names are:

@ = . (period)
# / CTRL-x (CONTROL characters)
$ :

Press <Begin Copy> to start the copy function.

<!--Disc Functions> Menu 18-19-->
Copying < All Files >

In some applications, you may need to copy the entire contents of a volume. This can be done in one operation and is easier than copying a volume file by file.

When you need to copy all the files from a hard disc to floppy disc(s), you may not have enough room on the floppy disc. The protocol analyzer prompts you when to install a new floppy disc.

PROCEDURE:

1. Press the <Copy Files> softkey.
2. HP 4971S prompts: Copy file FROM which volume?
3. HP 4971S displays softkeys for you to select which group of files to copy
4. Press <All Files> softkey.
5. HP 4971S prompts: Copy file TO which volume?
6. Press a softkey for the volume you want to copy files TO.
7. The protocol analyzer displays the copy FROM volume, the copy TO volume, and a list of the files to be copied.

You can scroll the file list with the cursor arrow UP and DOWN keys.

8. HP 4971S displays softkeys to execute the copy function, <Begin Copy> or to quit the copy function, <Abort Copy>.
9. Press <Begin Copy> softkey to start the copy function.
Copying <Unique Files>

<Unique Files> lets you copy files used for protocol analyzer operation as well as other system files. System files are labeled OTHER, TEXT, or CODE in the TYPE field of directory listings.

You can copy one file at a time, or, you can use a wild card to copy multiple files.

PROCEDURE Copy <Unique Files> (cont.)

1. Press <Copy Files> softkey.
2. HP 4971S prompts: Copy file FROM which volume?
3. Press a softkey for the FROM volume you want to copy from.
4. HP 4971S displays: FROM: #(volume number:),(volume name) TO:
   
   For example: FROM: #3, SAVE1 TO:

   Copies a file from volume number 3. Volume #3 is named SAVE1.
5. The protocol analyzer reads the directory of the FROM volume and displays:
   
   <Analyzer Files> <All Files> <Unique Files>
6. Press <Unique Files> softkey.
7. HP 4971S displays a data entry field and the prompt:

   Enter the file name you wish to copy.
8. Enter a file name and press the RETURN key.

File name syntax and wild cards are described on the following pages.
"ANALYZER" FILE NAME SYNTAX

```
n n n n n n n n s . t
```

```
^   ^   ^   field type
|   |     D (Receive Buffer data) F (Filter)
|   |     d (Log-to-disc data) M (Message)
|   |     N (Network) C (Configuration)
|   |     n (Node) A (Application)
|   |__ separate with (.)
|   |__ disc sequence number
|   |__ (Needed only with Analyzer files)
|__ file name ( 7 char max )
```

"UNIQUE" FILE NAME SYNTAX

```
n n n n n n n n n n n n . TYPE
```

```
^   ^   ^   field type
|   |     CODE or TEXT
|   |__ separate with (.)
|   |__ (TEXT and CODE files only)
|   |__ (TYPE entry not needed for OTHER file types.)
|__ file name ( 10 char max )
```

COPY FILE SYNTAX

```
COPY FILE SYNTAX   FILE NAME     SEQUENCE   FILE TYPE
msgAl.M = msgA     1           M (Message)
setup10.C = setupl 0           C (Config)
Rona0.n = Rona     0           n (node)
BADDAT0.D = BADDAT 0           D (Data)
Rectangle.TEXT = Rectangle * TEXT
JOB_SUMRY = JOB_SUMRY * OTHER
```

<Disc Functions> Menu 18-22
File Names

ANALYZER files -- names are limited to 7 keyboard characters and must be followed by the disc sequence number and TYPE character.

UNIQUE files -- names are limited to 15 characters. If file is TEXT or CODE, enter file name and .TEXT or .CODE.

If file is OTHER type, enter just the file name and press RETURN key.

Leading spaces in file names are deleted. Spaces between characters are replaced with an underscore (_). Characters not valid for volume file names are:

@ = . (period)
# / CTRL-x (control characters)
$

WILD CARD -- can be used to copy more than one file at a time. See wild card description on next page.

Sequence number

When large files are copied to discs, there may not be enough room to save all the file on one disc. The HP 4971S prompts you to insert a new disc when the current disc capacity has been filled.

Type

ANALYZER files use the letter cases shown below to indicate the type of file:

D (Data saved from Receive Buffer)
F (Filter)
M (Message)
d (log-to-disc data)
C (Configuration)
N (Network)
A (Application)
n (node)

UNIQUE files use the following names to show type of file: TEXT, CODE.
WILD CARDS

The wild card character, (@), lets you copy more than one file at a time. If several files have names that share common characters in sequence, you can copy all the files in one operation.

Wild cards can be used with Analyzer Files or with Unique Files. The file is copied with the same sequence and type information as the original file.

Examples:

- **DAT@** copies all files beginning with DAT
- **@CODE** copies all .CODE files.
- **@DEF@** copies all files with the consecutive letters DEF anywhere in the name.
- **@0.D** copies all Data files with sequence number 0.
Formatting A Volume

<Format Volume> softkey lets you format (or initialize) a volume on a Winchester disc or a 3 1/2 inch floppy disc to the HP 4971S system.

To format a volume, use the following procedure.

**WARNING**

Formatting a used volume erases the current files. Back up files you need to keep.

**PROCEDURE:**

1. If the volume you want to format is a floppy disc, check that the write protect tab on the floppy disc is in the write enable position. (Slide tab toward center of disc.)

2. If you are formatting a floppy disc, install the floppy disc to be formatted in a disc drive slot.


4. HP 4971S prompts: *Select a volume to format.*

5. Softkeys are displayed for the volumes connected to your HP 4971S system. Press the softkey for the volume you want to format.

**WARNING**

If you have a Winchester disc drive with more than one volume on the hard disc, if you select any one of the volumes to format, all volumes on the hard disc are formatted.
6. HP 4971S displays volume number, the current logical volume name, and how many files are currently on the volume.

7. HP 4971S prompts: Do you want to proceed with the formatting?

8. Press <YES> softkey to format the volume and HP 4971S displays:
   
   Volume formatting in progress.

   Press <No> or <EXIT> softkey if you do not want to proceed.

9. After the volume is formatted,
   
   HP 4971S prompts: Volume name for #X : ______

   If the volume has been formatted previously and named, the old name is displayed in the prompt. If the volume is new, the name field is blank.

10. If you want the old name, press RETURN.

11. If you want a new name, enter the new name and press RETURN key.

   Volume names may be up to six keyboard characters. Leading spaces in volume names are deleted. Spaces between characters are replaced with an underscore (\_). Characters not valid for volume file names are:

   @   $   /   .   (period)

   #   =   :   CTRL-x (control characters)

12. After a volume is formatted,
   
   HP 4971S displays: Formatting successful.

   The name you give to a volume is displayed when you do a directory of the volume.

   DIRECTORY OF VOLUME : (volume name)

   VOLUME SIZE (BYTES): 630784 LARGEST AVAILABLE SPACE (BYTES): 21248

   FILE # NAME TYPE SEQUENCE DATE SAVED TIME SAVED SIZE (BYTES)

   ....  ....  ....  ........  ........  ........  ........

   <Disc Functions> Menu 18-26
Compressing A Volume

<Compress Volume> softkey lets you compress or compact the files stored in a volume.

The directory is checked for current files. Valid existing files are relocated to recover space previously occupied by deleted files.

After a volume is compressed, all free space is contiguous at the end of the compressed volume.

Compressing a volume lets you have access to all the free space on the volume. You now have the maximum space available displayed when you view the "LARGEST AVAILABLE SPACE (BYTES)" field of a volume directory list.
<Disc Functions> IN REMOTE MODE

When two protocol analyzers are connected for remote operation, the slave protocol analyzer, at the remote site, makes all the measurements on the Local Area Network (LAN) it is connected to and the slave also executes the disc function commands.

Selecting A Volume In Remote Mode

When a remote link is established and you press <Select Volume>, <Copy Files>, <Compress Volume>, etc. the display prompts you to choose either <Master> or <Slave>. Select the station that has the mass storage devices you want to use. Softkeys then display the choice of volumes available at the selected station.

Copy Functions In Remote

In remote mode, you can perform the following copy functions:

- Slave volume to slave volume
- Slave volume to master volume
- Master volume to slave volume
- Master volume to master volume

OPERATING EXCEPTIONS FOR DISC FUNCTIONS IN REMOTE MODE

Remote operation does not allow two primary functions normally available in the <Disc Functions> Menu. These functions are:

- Log-To-Disc
- Format volumes

Log-to-disc - If you try to use <Execute Program> and the program has a log-to-disc command, the command is ignored. The rest of the program executes normally.

Format volumes - During remote operation, you can not format volumes at either the master or the slave protocol analyzer. Volumes can be formatted only when a station is in local control.
<Examine Data> MENU

The <Examine Data> Menu lets you easily control the format of displayed network traffic for quicker recognition of frames that interest you.

This chapter includes:

- <Examine Data> Display
- <Examine Data> Softkey Selections
- <Examine Data> Softkey Descriptions

Finding Frames

Selecting A Frame Display Format

Selecting Frame Header Formats

Selecting Datafield Character Formats

Displaying Data In Filter Formats

Selecting Timestamp Measurements

Selecting Timers And Counters

- Displaying Frame Errors
In the default <Examine Data> display, messages are displayed in detailed format. The protocol analyzer displays a physical header with each frame to give additional information about the frame. In addition, an Ethernet header is displayed. The data field is displayed in a hex and ASCII 8 format.

Figure 19-1 shows an <Examine Data> default display for network messages. The numbers on the left side of the display are for explanation use and are not part of the display.

Line 1

Line 1 is the physical header included with each frame by the protocol analyzer. It contains the following details:

Frame number

The physical elements, which includes:

- Time Stamp
- Message length
- Filters matched
- Error indicator or frame status

Frame Number

The "#1" in line 1 indicates that this is the first message stored in the protocol analyzer memory. Following messages are counted in the sequence they were stored in the Receive Buffer.

The frame number is always shown in <Examine Data> displays.

The frame number is not shown while <Monitor Network> Menu is operated in <Nonstop Mode>.
<Examine Data> Display

**Time Stamp**

Mar 9 @ 6:10:34.55533" is the month, day, hour, minute, and second the message was stored in memory. The seconds are displayed in microseconds.

The default time stamp display mode is <Date/Time>. This references all frames stored to the time when each frame occurred on the network.

**Message Length**

The calculated length of the message, in bytes, is displayed in the "Len" Field of line 1.

The frame length is calculated by the protocol analyzer and includes all the information fields, which are: Destination Address, Source Address, Length (Length in Ethernet, Type in IEEE 802.3), and Data fields. Preamble and FCS Fields are not included in the message length.
<Examine Data> Display

Filters field is a display showing currently defined filters and if a filter match occurred when the frame was captured.

Filters 0.............
Indicates the first filter defined is matched by this message.

Filters 0123456789ABCDEF
Up to 16 filters can be defined using the <Edit Filters> function. This example indicates all 16 available filters are defined and have been matched by the current message.

Filters Ox.............
Indicates Filter_0 was defined and matched in a message. Filter_1 was defined but did not find a match.

No filter match is indicated by the "x" character.

Only filters 0 and 1 are defined. All the other filters that are undefined are indicated by the "." character.

The Filters field uses the filters defined when the data was captured. Because of this, if you edit an existing filter to no longer match a frame and again look at the same data in the Receive Buffer, the <Examine Data> display still indicates a match. If you delete a filter that matched a frame, that filter position is displayed as undefined.

If you create a new filter and return to examine the previously captured data, the <Examine Data> display shows an x to indicate the new filter exists. It does not show if a match occurred with the new filter.

To update the filters-matched field with frames already stored in the Receive Buffer, perform an <Execute Programs> with <Run From Buffer> selected.
Frame errors are discussed in more detail in the "Displaying Frame Errors" section later in this chapter.

"No Error" indicates the frame was stored in the Receive Buffer with no errors detected. Possible errors that can be detected are indicated by the error messages:

- Runt Frame
- Jabbering
- Misaligned
- Corrupt Data
- Bad FCS

The HP 4971S can also detect combinations of these possible frame errors. The possible error combinations are listed below:

- Runt-Bad FCS
- Runt-Alignment
- Jabr-Bad FCS
- Jabr-Alignment

**Line 2**

In default <Examine Data> Menu, the protocol analyzer defaults to the <Ethernet Header> mode and displays the following information in line 2:

- Destination Address
- Source Address
- Type

**Destination Address**

The Destination Address consists of six bytes that identify where the message is being sent. Destination addresses are displayed in hexadecimal.

The Destination Address field can be displayed as a functional node name by using the <Show Node Names> softkey.
**<Examine Data> Display**

**Source Address**

The Source Address consists of six bytes to identify where the message originated. Source Addresses are displayed in hexadecimal.

The Source Address field can be displayed as a functional node name by using the <Show Node Names> softkey.

**Type**

The Type Field is displayed as two hexadecimal bytes. Type: is used in the Ethernet protocol to indicate the higher level protocol being used. The contents displayed in the Type Field will be bytes 13 and 14 of the frame contents.

Line 2 can be changed to display the IEEE 802.3 header by pressing the <Select Format>, <Change Headers>, and <802.3 Header> softkeys. The IEEE 802.3 header changes the Type: Field to Length: Field. The Length: Field also displays the contents of bytes 13 and 14.

**Line 3**

In the default display, line 3 of the <Examine Data> Menu contains the first line of text or data for the frame. In addition, the byte position for the first character on the line is shown at the left side of the display.

**Byte position**

On line 3, the "15" identifies that the first byte on line 3 is the 15th byte in the frame. Following lines use this column to indicate the location of the first byte on each line in the frame.

**Data**

The power on, or default <Examine Data> mode, displays characters in the message in hexadecimal and ASCII formats. The frame data is first displayed in Hexadecimal with up to 17 bytes per line. Each line is then interpreted on the right side of the display in ASCII format.
Line 21

Line 21 displays status messages. Examples of status messages are:

- No next frame
- Empty buffer

Line 22

Line 22 displays error messages. See the appendix section for error message information.

Lines 23, 24

The softkey selections that may be used to control operation of the HP 4971S are displayed on lines 23 and 24.
*** Optional keyboards can be used to display other character codes. See appendix B.

** ASCII 7

<table>
<thead>
<tr>
<th>ASCII 7</th>
<th>ASCII 7</th>
<th>ASCII 7</th>
<th>ASCII 7</th>
<th>ASCII 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Par</td>
<td>Par = 0</td>
<td>Par = 1</td>
<td>Odd Par</td>
<td>Even Par</td>
</tr>
</tbody>
</table>

*** Filters

| Filter 0 | Filter 1 | .. | .. |

<Examine Data> Softkey Descriptions

The <Examine Data> softkeys are described in the following functional groups:

Finding Frames

<Next Frame> <Next Marked> <Search Buffer>

<Previous Frame> <Previous Marked> <Search Next>

<Scroll Frames> <Scroll Marked> <Define Search>

<Go To Frame #> <Mark/Unmark> <Datafield Pattern>
Selecting Frame Display Format

<Select Format> <Filter Format> <Show Node Name>
<Detailed Format> <Summary Format> <Show Hex Address>

Selecting Frame Header Format

<Change Headers> <Physical Header> <802.3 Header>
<Suppress Headers> <Ethernet Header> <802.2 Header>

Selecting Datafield Character Format

<Change Datafield> <Character Data> <Select Data Code>
<Suppress Data> <Hex/Char Data> <ASCII 7>
<Hex Data> <Hex/Char Data> <ASCII 8>
<EBCDIC>

Displaying Data in Filter Formats

<Use First Matched>
<Filter_0>

Selecting Timestamp Measurements

<Change Timestamp> <Time From Start> <Time From Trigger>
<Date/Time> <Time From Frame #> <Time between Frames>

Selecting Counters & Timers

<Counters & Timers>

<Examine Data> Menu 19-9
Finding Frames

You can use softkeys in the <Examine Data> Menu to quickly and easily move through frames stored in the Receive Buffer to locate specific frames of interest to you.

The following softkeys can be used to move through the stored frames:

- <Next Frame>
- <Previous Frame>
- <Scroll Frames>
- <Go to Frame #>
- <Next Marked>
- <Previous Marked>
- <Scroll Marked>
- <Go To Trigger>
- <Scroll Frames>
- <Mark/Unmark>
- <Search Buffer>
- <Search Next>
- <Search Prev>

Remember that in addition to the above softkeys for controlling frame display, you can use keys on the keyboard. These keys are discussed in the section "Editing With The Keyboard Keys", in Chapter 1.
FINDING FRAMES (cont.)

<Next Frame> softkey appears to move the displayed frames up one frame. What was the second frame being shown is now displayed at the top of the display. The next frame stored in the Receive Buffer memory is added to the bottom of the displayed frames.

If <Next Frame> softkey is pressed while the last frame in memory being displayed, status message, No next frame., is displayed above the softkey selections.

<Previous Frame> softkey appears to move the display down with a new frame added at the top. The new frame now seen at the top of the display is the frame in the Receive Buffer that precedes the previously displayed top frame.

If <Previous Frame> softkey is pressed while the first frame in memory is being displayed, status message, No previous frame., is displayed above the softkey selections.

<Scroll Frames> Press <Scroll Frames> to cause the protocol analyzer to start incrementing the display through the frames stored in the Receive Buffer.

Press <Stop Scrolling> or <EXIT> softkeys to end the scroll function, or, you can let the protocol analyzer automatically stop incrementing the display when the last frame in the Receive Buffer is displayed.

No reverse scroll function is available. You can use <Go To Frame #> softkey to quickly move to previous frames or hold down the PREV keyboard key.

<Go To Frame #> lets you place a particular frame at the top of the display.

Enter the frame number as an integer value such as; 3, 15, or 455. Non-integer entries will cause an error message to be displayed. Press the RETURN key to execute the command.

(continued)
FINDING FRAMES (cont.)

To quickly find and show the last frame in the Receive Buffer, enter a number you know is greater than the last frame number in the receive Buffer and press the RETURN key.

Go to what frame #? 999999

<Next Marked> lets you update the display with the next following frame identified by a "Mark" to be displayed at the top of the screen.

Frames can be marked manually by softkey selection as you scroll the frames or they can be marked by your program. Frames are marked to indicate a special filter condition or that they are of some particular interest to you.

Using marked frames provides a quick method to scroll through the memory buffer to find only frames of interest to you.

<Previous Marked> lets you update the display so that the closest previous frame identified with a "Mark" is displayed at the top of the screen.

<Scroll Marked> provides a method to get non-consecutive frames grouped together on the screen.

Only marked frames are displayed. Unmarked frames occurring between marked frames are not displayed.

After <Scroll Marked> function is selected, subsequent <Previous Marked> and <Next Marked> softkeys maintain this function of only displaying marked frames. Also, PREV/NEXT keyboard keys act like <Prev Marked> and <Next Marked> softkeys.
FINDING FRAMES (cont.)

<Go To Trigger>  causes the display to show the trigger frame identified in <Edit Programs> Menu for controlling the "Store" function:

<Starting With>
<Centered About>
<Ending With>

When one of these functions is used to control the "Store:" function, that trigger frame is displayed when the <Go To Trigger> softkey is pressed.

<Mark/Unmark>  This softkey toggles the mark condition either on or off. If no mark exists, the softkey marks the frame. If the frame is marked, press this softkey to remove the mark condition.

<Mark>  Puts a transparent mark on a single frame in the Receiver Buffer. When later examined in the buffer, marked frames can be selectively located and displayed.

The frame currently at the top of the display is marked when you press the <Mark Frame> softkey. The frame number field is changed to inverse video to indicate a marked frame.

<Unmark>  Removes the frame "Mark" from the frame currently at the top of the display.
FINDING FRAMES (cont.)

<Search Buffer> softkey lets you look through the buffer for a particular element(s) you have specified. Frame elements you may search for include:

- Destination Address
- Source Address
- Frames with errors
- Filters matched
- Data Field Patterns (up to 6 bytes)

<Search Next> causes the protocol analyzer to look for the next frame in the buffer that contains the search elements you have defined.

<Search Previous> causes the protocol analyzer to look for a frame stored previous to the currently displayed frame. The protocol analyzer looks for the search elements you have defined.

<Define Search> softkey lets you identify or define the different frame elements you want to look for in the buffer.

<Dest Address> lets you specify any message addressed to a specific node on the network.

Enter the Hex code for the Destination Address you want to search for. Press RETURN key to complete the entry.
<Define Search> (cont.)

<Source Address>
lets you specify any message addressed from a specific node on the network.

Enter the Hex code for the Source Address you want to search for. Press RETURN key to complete the entry.

<Filter Matched>
lets you see if a filter defined in the <Edit Filters> Menu can be matched to a frame stored in the receive buffer.

Press <Filter Matched> softkey and then press the softkey that identifies the filter you want to use the next time you search the buffer. Press <EXIT> softkey to complete the entry. Choose a softkey to search forward (next) or backward (previous) in the buffer.

>Error Frame>
lets you search the buffer for frames that have a frame error. Press <Error Frame> and choose the error type you want to search for from the displayed softkeys. The frame error choices are:

- No Error
- Bad FCS
- Misalign
- Runt
- Jabber
- Any Error

You can look for frames with a specific error, frames without any error, or only frames that have some type of error.

Types of frame errors are described at the end of this chapter in the section, "Displaying Frame Errors."
FINDING FRAMES (cont.)

<Datafield Pattern>
lets you search through the buffer for a frame with a specific data field pattern that starts at a byte offset you define.

Press <Datafield Pattern> softkey and enter the pattern you want. The data field entry must be in Hex code. You can enter up to 6 characters. Don't care characters (XX) may be used in any of the positions.

You must specify at what byte location in the frame you want to look for the characters. You can specify patterns starting from byte position 1.

Examples:

1A-6E-XX-XX-XX-XX at offset 13 Look for pattern 1A-6E in the TYPE/LENGTH field.

54-68-69-73-20-69 at offset 15 Look for pattern 54-68-69-73-20-69 starting at the first of the data field.

16-16-16-XX-XX-XX at offset 214 Look for pattern 16-16-16-XX-XX-XX starting at the 200th byte in the data field.
Selecting A Frame Display Format

The format used to display frames stored in the Receive Buffer can be changed by using softkey selections.

In addition, the entire group of counters and timers can be viewed on one display screen.

The softkeys used to change the frame display format and display counters, and timers include:

- <Select Format>
- <Detailed Format>
- <Summary Format>
- <Filter Format>
- <Show Node Names>
- <Show Hex Addresses>
- <Counters & Timers>
SELECTING FRAME DISPLAY FORMAT (cont.)

<Select Format> softkey provides another level of softkeys to let you group or display the frames in the following formats:

- Detailed format
- Summary Format
- Filter Format

<Detailed Format> is the default format for displaying frame contents. <Detailed Format> displays the headers you have selected along with the data field of the frame.

The default protocol for <Detailed Format> is Ethernet protocol. The default header display has <Physical Header> and <Ethernet Header> softkeys selected. The data field is displayed in combined <Hex and Char> format with <ASCII 8> character code.

An example of this softkey display is described in the previous pages under the "Default Display Description" heading.

<Summary Format> softkey lets you quickly get an overview of the messages received into the Receive Buffer. This display lets you view as many as eight messages at a time which enables you to easily recognize trends or patterns in the messages. The information displayed is:

- Frame number
- Calculated frame length
- Destination Address
- Filters matched
- Source Address
- Error indicators

<Examine Data> Menu 19-18
SELECTING A FRAME DISPLAY FORMAT (cont.)

<Summary Format> With this display, you can get an overview of what stations are doing the transmitting and what stations are being transmitted to.

<table>
<thead>
<tr>
<th>FRAME NUMBER</th>
<th>DESTINATION ADDRESS</th>
<th>SOURCE ADDRESS</th>
<th>FRAME LENGTH</th>
<th>FILTERS MATCHED</th>
<th>ERRORS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01·23·45·67·89·AB</td>
<td>FE·DC·BA·98·76·54</td>
<td>1267</td>
<td>0xxx.............</td>
<td>No error</td>
</tr>
<tr>
<td>2</td>
<td>08·00·09·FF·FF·FF</td>
<td>08·00·09·00·0A·08</td>
<td>342</td>
<td>01xx.............</td>
<td>No error</td>
</tr>
<tr>
<td>3</td>
<td>00·DD·00·0D·D8·00</td>
<td>08·00·09·00·0A·08</td>
<td>655</td>
<td>012x.............</td>
<td>No error</td>
</tr>
<tr>
<td>4</td>
<td>08·00·09·00·0A·08</td>
<td>08·00·09·FF·FF·FF</td>
<td>1400</td>
<td>0123.............</td>
<td>No error</td>
</tr>
<tr>
<td>5</td>
<td>01·23·45·67·89·AB</td>
<td>FE·DC·BA·98·76·54</td>
<td>67</td>
<td>0xxx.............</td>
<td>Bad FCS</td>
</tr>
<tr>
<td>6</td>
<td>01·23·45·67·89·AB</td>
<td>FE·DC·BA·98·76·54</td>
<td>67</td>
<td>0xxx.............</td>
<td>No error</td>
</tr>
<tr>
<td>7</td>
<td>print_server</td>
<td>CPU1</td>
<td>854</td>
<td>01xx.............</td>
<td>No error</td>
</tr>
<tr>
<td>8</td>
<td>mass_store</td>
<td>MAINCPU</td>
<td>1514</td>
<td>0123.............</td>
<td>No error</td>
</tr>
</tbody>
</table>

Figure 19-2. <Summary Format> Softkey Display

In the <Summary Format> display above, the Destination and Source Addresses are shown in hexadecimal format. If a node has been assigned a node name in the <Edit Nodelist> Menu, the assigned name is displayed. Frames #7 and #8 show the addresses displayed in functional node names which make it much easier to recognize address patterns in Destination and Source Addresses.
Frame lengths for the stored frames are displayed. The frame length field lets you recognize if only long frames are being transmitted or if any short frames occurred or if there is a mixture of long and short frames occurring.

The "FILTERS MATCHED" Field makes it is easy to see what filters are being matched. This field shows currently defined filters and if a filter match occurs. In programs using several filters to trap or store the frames into memory, this display makes it easy to see what filters have been matched in a group of captured frames.

The filter field function is described earlier in this chapter in the Default Display Description section.

Different types of frames errors can occur during transmission. Having all the frames error status listed in a column makes it convenient to scroll the frames to look for frame errors. Types of frame errors that can be displayed are described in "Default Display Description" in this section.
SELECTING FRAME DISPLAY FORMAT (cont.)

<Filter Format> displays the headers you have selected, the fields of the filter you select, followed by the frame’s data field.

The default filter format is the first filter matched. To select the filter for examining frames, press:

<Select Format>
<Filter Format>
<OTHER CHOICES>
<Change Filter> (Press filter softkey label)

Filter fields of the filter you select are displayed above the data field. The first three fields of each filter are not displayed again since they are always Address and Type/Length fields. The first three filter field contents can be seen by selecting Ethernet or IEEE 802.3 header softkeys.

<table>
<thead>
<tr>
<th>#1</th>
<th>Mar 9 @ 6:10:34:55533 Len 61 Filters 0123............. No error</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 Type 0A·0B</td>
</tr>
<tr>
<td>3</td>
<td>data·filter1 30·30·30·31 0001</td>
</tr>
<tr>
<td>4</td>
<td>15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D This is Frame Num</td>
</tr>
<tr>
<td>5</td>
<td>32 62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46 ber 0001's Data F</td>
</tr>
<tr>
<td>6</td>
<td>49 49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E field contents.</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

Figure 19-3. <Filter Format> Display.

In the example above, notice in line 1 that field "Filters: 0123............." indicates four filters have been defined and have been matched by frame #1.

The details of the first filter matched in the frame are displayed below the header. Line 3 shows the field defined in Filter 0.
SELECTING FRAME DISPLAY FORMAT (cont.)

<Filter Format> (cont.)

If the frame does not match any defined filter, message: "No filter matched" is displayed below the header lines.

The example below illustrates a frame with <Filter Format> selected. In addition, other display format softkeys are selected.

<Physical Header> displayed in line 1
<Ethernet Header> displayed in line 2
<802.2 Header> displayed in line 3
<Filter Format> displayed in lines 4-16

Figure 19-4. <Filter Format> With 13 Data Field filters.
SELECTING FRAME DISPLAY FORMAT (cont.)

<Filter Format>
(cont.)

The previous example shows 13 filter fields and 3 lines of the Data Field. Since <Edit Filters> Menu lets you define up to 29 filter fields in the Data Field, the Data Field contents may not be shown on the display. If 16 filter fields are defined, no line of data is displayed. To see past the 16th filter field and to see the Data Field, use the cursor keys to scroll the display.

A label is displayed for each defined filter field. In addition, the characters located in each filter field are displayed in Hex along with the equivalent character.

The equivalent character for the filter field is displayed in the last selection made between ASCII 7, ASCII 8, or EBCDIC.
SELECTING FRAME DISPLAY FORMAT (cont.)

In each of the frame display formats, the Destination and Source Addresses can be displayed in either hexadecimal or as a functional node name.

<Show Node Name> softkey displays any node address as a functional node name.

The node name must be defined in the <Edit Nodelist> Menu. This softkey is available under the <Setup 4971S> Menu.

If the node name is not defined, the name is displayed in hex.

An example of node names versus the Hexadecimal address is shown below:

<table>
<thead>
<tr>
<th>Hexadecimal Address</th>
<th>Node Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-AB-00-23-01-02</td>
<td>Print_Server1</td>
</tr>
<tr>
<td>66-CD-21-43-01-01</td>
<td>JohnB</td>
</tr>
<tr>
<td>08-AB-00-XX-XX-XX</td>
<td>all_printers</td>
</tr>
</tbody>
</table>

Notice that the node name can identify a device, the principal user at a node, or, by using a common prefix and don’t cares (xx-xx), it can group nodes with common prefixes.

<Show Hex Names> displays the node station as a six byte Hexadecimal address.
Selecting Frame Header Formats

Each frame is displayed by the protocol analyzer with up to three headers. The first header is a physical header created by the protocol analyzer. The second header is the IEEE 802.3 or Ethernet header. The third header is for IEEE 802.2 protocol.

The format used to display frame headers can be changed by softkeys.

Softkeys used to control frame header formats include:

  <Change Headers>
  <Suppress Headers>
  <Physical Header>
  <Ethernet Header>
  <802.3 Header>
  <802.2 Header>
FRAME HEADER FORMATS (cont.)

<Change Headers>  softkey presents a softkey selection that is used to control the header display.

<Suppress Headers>  With <Suppress Headers> softkey selected, all physical headers and protocol headers are removed from each frame in the display.

The example below shows a frame with all the headers removed. Lines 1 and 2 now contain the frame number and Data Field contents. The Destination Address, Source address, Length/Type, and Error fields are not displayed.

```
1  #1
2  15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D  This is Frame Num
3    32  62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46  ber 0001's Data F
4    49  49·45·4C·44·20·63·6F·6E·74·6E·74·2E                  ield content.
5
```

Figure 19-5. <Suppress Headers> Softkey Selection.
FRAME HEADER FORMATS (cont.)

<Physical Header> The physical header contains information generated by the HP 4971S about each frame stored in the Receive Buffer. Included in the physical header are:

- Time Stamp
- Calculated frame length
- Filters
- Errors

<table>
<thead>
<tr>
<th>#</th>
<th>Time Stamp</th>
<th>Calculated Length</th>
<th>Filters</th>
<th>Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mar 9 @ 6:10:34.55533 Len 61 Filters 0................. No error</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>15 54-68-69-73-20-69-73-20-46-72-61-6D-65-20-4E-75-60</td>
<td>This is Frame Num</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>49-45-4C-44-20-63-6F-6E-74-65-6E-74-2E</td>
<td>field content.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 19-6. <Physical Header> Softkey Selected.

With only <Physical Headers> header softkey selected, only the information added by the protocol analyzer is displayed. This header includes the physical description of the frame. Elements displayed are: Timestamp, calculated length of information fields, filters status, and error status.
SELECTING FRAME HEADER FORMATS (cont.)

<Ethernet Header>  The <Ethernet Header> softkey selects the Ethernet header for the display. This softkey is illustrated in figure 19-1. Ethernet displays use a "Type:" field for bytes 13 and 14.

Ethernet displays also include the Destination Address and Source Address fields.

<802.3 Header>  IEEE 802.3 header is similar to Ethernet header, however, IEEE 802.3 uses a "Length:" field for bytes 13 and 14.

<Ethernet Header> and <802.3 Header> softkeys toggle with each other. Selecting one cancels the other's display. Only one of these headers may be displayed at a time. Pressing the softkey that is active turns that function off and if the other header softkey is not pressed, neither header is displayed.

<table>
<thead>
<tr>
<th>#1</th>
<th>Destination 01·23·45·67·89·AB</th>
<th>Source FE·DC·BA·99·76·54</th>
<th>Length OA·OB</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>54·68·69·73·20·69·73·20·46·72·61·60·65·20·4E·75·6D</td>
<td>This is Frame Num</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46</td>
<td>ber 0001's Data F</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E</td>
<td>field content.</td>
<td></td>
</tr>
</tbody>
</table>

Figure 19-7. <802.3 Header> Softkey Selection.
 FRAME HEADER FORMATS (cont.)

<802.2 Header>  <802.2 Header> information is positioned in the first 3-4 bytes of the Data Field and contains the following information:

DSAP (Destination Service Access Point)
SSAP (Source Service Access Point)
Control

DSAP  Byte 15 in the Data Field is labeled Destination Service Access Point address. This address references a specific protocol used within the device identified by the Destination Address. The DSAP field is displayed in hex.

SSAP  Byte 16 in the Data Field is labeled Source Service Access Point address. Similar to DSAP, this address references a specific protocol used within the device identified by the Source Address. The SSAP field is displayed in hex.

Control  The Control field, as its name implies, is used to control the communications between the processes or applications contained at the Destination and Source addresses.

The Control field is also displayed in hex and may be either 1 or 2 bytes. The 2 least significant bits of byte 17 determine if the protocol analyzer will display 1 or 2 bytes in the Control field.

<table>
<thead>
<tr>
<th>Byte 17</th>
<th>Byte 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSB</td>
<td>MSB</td>
</tr>
<tr>
<td>LSB</td>
<td>LSB</td>
</tr>
<tr>
<td>xxxx</td>
<td>xxxx</td>
</tr>
<tr>
<td>xx</td>
<td>xx11</td>
</tr>
</tbody>
</table>

When the two least significant bits of byte 17 are 1’s, the protocol analyzer will display one byte for the Control Field. This determines whether the data field begins with byte 18 or 19.
FRAME HEADER FORMATS (cont.)

Control (cont.)

Examples of control field contents include:

- Connection requested
- Connection accepted
- Connection denied
- Connection busy

Confirmation of messages sent or received

The following example uses only the 802.2 header. Notice in the example below that the Control Field is two bytes and the Data Field starts at byte 19.

```
1 #1
2 19 20·69·73·20·46·72·61·6D·65·20·4E·75·6D·62·65·72·20
3 36 30·30·30·31·27·73·20·44·41·54·41·20·46·49·45·4C·44
4 53 20·63·6F·6E·74·65·6E·74·2E
5
```

Supress Physical Ethernet 802.3 802.2

Figure 19-8. <802.2 Header> Softkey Selection

<Examine Data> Menu  19-30
Selecting Datafield Character Formats

The information in the data fields can be presented in several formats. The data field can be suppressed from the display but is still available in the Receive Buffer. Also, the format of the data characters may be selected from a variety of choices.

The softkey choices for data fields include:

<Change Datafield>
Suppress Data>
Hex Data>
Character Data>
Hex/Char Data>
Select Data Code>
ASCII 7>
ASCII 8>
EBCDIC>
<Change Datafield> softkey changes the softkey selections to let you select different formats for characters in the data field.

<Suppress Data> The entire data field can be suppressed or deleted from the display by pressing the <Suppress Data> softkey. Whatever data field had been displayed is now removed. If physical header, frame header, and data fields had been displayed, pressing <Suppress Data> leaves only the physical header and frame header displayed.

In the example below, notice that only selected header information is displayed.

```
1 #1 Mar 9 @ 6:10:34.55533 Len 61 Filters 0.............. No error
2 Destination 01-23-45-67-89-AB Source FE-DC-BA-99-76-54 Type 00-53
3 DSAP 54 SSAP 68 Control 69-73
4 5 #2 Mar 9 @ 6:10:34.55533 Len 61 Filters 0.............. No error
6
```

Figure 19-9. <Suppress Data> Softkey Selected.
DATAFIELD CHARACTER FORMATS (cont.)

<Hex/Char Data>  In the default <Examine Data> Menu, the data field is displayed below the header fields in two formats. The data is displayed in Hexadecimal format on the left side of the line with the interpreted data displayed on the right side of the same line.

<Hex Data>  
<Character Data>  When <Character Data> or <Hex Data> softkeys are pressed, the data field is displayed only in that selected format. The equivalent data field is not displayed.

These character formats are convenient since longer lines can be used to display the Data Field contents. <Character Data> formats display 73 characters per line while <Hex Data> format displays 24 characters per line.

The example below shows the display with <Character Data> softkey selected. The data is presented only in the equivalent character format with no Hexadecimal equivalent display.

<table>
<thead>
<tr>
<th>#</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>#1 May 3 @12:21:03.24446 Len 167 Filters 1 ................ No error</td>
</tr>
<tr>
<td>2</td>
<td>Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 Length 00·53</td>
</tr>
<tr>
<td>3</td>
<td>15 This is an example with &lt;Character Data&gt; softkey selected. Notice that</td>
</tr>
<tr>
<td>4</td>
<td>88 no equivalent Hex characters are presented on the right side of the d</td>
</tr>
<tr>
<td>5</td>
<td>161 isplay.</td>
</tr>
</tbody>
</table>

Figure 19-10.  <Character Data> Display.
<Select Data Code> softkey lets you choose the character code. The choices are:

<ASCII 7>  
<ASCII 8>  
<EBCDIC>

The default display described in the section "<Examine Data> Display" at the first of this chapter is an example of the two column data format. The data is first presented in Hexadecimal code and then in the equivalent selected code of ASCII or EBCDIC. Seventeen characters are displayed in each line with either of these combined character protocols selected.

<ASCII 7>

ASCII 7 No Par
The parity bit is ignored.

ASCII 7 Par = 0
The parity bit is always 0.

ASCII 7 Par = 1
The parity bit is always 1

ASCII 7 Odd Par
The parity bit is set to always provide an odd number of bits in the byte.

ASCII 7 Even Par
The parity bit is set to always provide an even number of bits in the byte.
Displaying Data In Filter Formats

You can display frames in the format of filters you have defined in <Edit Filters> Menu. Use the following softkeys to select the filter used to display frames:

- <Select Format>
- <Filter Format>
- <OTHER CHOICES>
- <Change Filter>

<Change Filter> softkey displays softkey choices for the filters you have defined in <Edit Filters> Menu.

The default filter format is the first filter matched. To select the filter format, press any displayed softkey containing a filter name.

<Use first Matched>
If you have several filters defined, <Use first Matched> softkey displays a frame in the filter format of the first filter to be matched by that frame.

<Filter_0>
lets you manually change the frame display format to that of another filter even if the filter did not specifically match that data frame.

Softkeys are displayed for each of the filters defined in the <Edit Filters> Menu. You can display any frame in the format of a defined filter.

<Filter 1>

: 

: 

<Examine Data> Menu 19-35
Selecting Timestamp Measurements

The HP 4971S can perform measurements that reference the time when frames were received into the protocol analyzer. When each frame is received into the HP 4971S, each frame is tagged with the date and time. Measurements using this timestamp function can be made with 32 microsecond accuracy.

The timestamp softkey functions detect the start and stop points of frames. Timestamp softkey descriptions use the following conventions for start and stop points of frames:

**Start of Frame**
refers to the beginning of the Destination Address Field in a frame.

**End of Frame**
refers to the end of the FCS Field in a frame.

Examples of timing measurements that you can measure include:

What date/time did the message occur on the network?

How much time occurred from when the run is started to when each frame is received?

How much time occurred between two specific frames being received?

With some frame identified as a reference point, what is the time relationship of all frames received before or after the reference frame?
TIMESTAMP MEASUREMENTS (cont.)

The softkeys used to make timestamp measurements include:

- <Change Timestamp>
- <Date/Time>
- <Time from Start>
- <Time from Frame #>
- <Time from Trigger>
- <Time btwn Frames>

<Change Timestamp> softkey changes the softkey selection to display softkeys used for timestamp measurements.

The protocol analyzer causes the date and time of day to be transparently added to each frame as it is received. This timestamp enables the following measurements:

- <Date/Time>
- <Time from Start>
- <Time from Frame #>
- <Time from Trigger>
- <Time btwn Frames>
TIMESTAMP MEASUREMENTS (cont.)

<Date/Time>  is the default softkey for <Examine Data> Menu. It causes the timestamp field in each frame's physical header to display the date and time that each frame occurred on the network.

The timestamp displayed in the physical header is referenced to the date and time you enter via the <Set Date> and <Set Time> softkeys at power on.

The display format for <Date/Time> softkey is: month, day, hour, minute, second

Mar 9 @ 6:10:34.55533

In a free run or continuous store application, the timestamp functions for approximately 1.5 days. After 1.5 days of continuous storage, the protocol analyzer stops and displays the message:

** Timestamp Overflow **

A new run must be started in order to start the timestamp function again.

The clock is reset each time a run is started and is stopped when the run is stopped.

<Time from Start> causes the timestamp field in each frame's physical header to contain:

The elapsed time measured from the run start to when each frame was received.

Frames have an elapsed time entered in the field:

Elapsed 00:00:01.67543
TIMESTAMP MEASUREMENTS (cont.)

<Time From Frame #> prompts you to identify a particular frame number and the timestamp is set to zero for that frame time.

This softkey causes the timestamp field in each frame's physical header to display:

The elapsed time from the start of the reference frame to the start of the displayed frame.

Frames received before the reference frame have a (-) sign preceding the number to show negative time.

In the following example, frame #3 has been selected as the reference frame:

#1 Elapsed · 0:00:01.99978
#2 Elapsed · 0:00:00.99987
#3 Elapsed 0:00:00.00000
#4 Elapsed 0.00.00.87241

<Time From Trigger> lets a frame matching a filter or combination of filters be specified as a trigger reference point.

This softkey causes the timestamp field in each frame's physical header to display:

The elapsed time from the start of the trigger frame to the start of the displayed frame.
TIMESTAMP MEASUREMENTS (cont.)

<table>
<thead>
<tr>
<th>Time From Trigger</th>
<th>A trigger frame is the frame identified in &lt;Edit Programs&gt; to control the Store function:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt;Starting With&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;Centered About&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;Ending With&gt;</td>
</tr>
</tbody>
</table>

Only one of these functions can be used in each program. Whichever function is used, that frame is referenced to zero for <Time From Trigger> measurements.

<table>
<thead>
<tr>
<th>Time btwn Frames</th>
<th>causes the timestamp field in each frame’s physical header to display:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The elapsed time from the end of the previous frame to the start of the next frame.</td>
</tr>
<tr>
<td></td>
<td>The end of the previous frame is after the last byte of the FCS field.</td>
</tr>
<tr>
<td></td>
<td>In &lt;Time btwn Frames&gt; mode, the timestamp in the first frame contains the time from the start of the run to the start of the first frame.</td>
</tr>
</tbody>
</table>
Selecting Timers And Counters

In addition to displaying the contents of the captured frames, the <Examine Data> softkey lets you view the timers and counters available in programs you can create.

The <Timers & Counters> softkey displays the labels and contents of all 16 counters and all 16 timers. This display shows the contents of the counters and timers that existed when a program run was halted. To update or refresh the display, repeat a <Run From Network> or <Run From Buffer> function.

When names have been assigned to either the timers or counters in <Edit Programs> Menu, the assigned names are also displayed in the <Examine Data> Menu.

<table>
<thead>
<tr>
<th>COUNTERS</th>
<th></th>
<th>TIMERS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Counter_0 =</td>
<td>0</td>
<td>Timer_0 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_1 =</td>
<td>0</td>
<td>Timer_1 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_2 =</td>
<td>0</td>
<td>Timer_2 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_3 =</td>
<td>0</td>
<td>Timer_3 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_4 =</td>
<td>0</td>
<td>Timer_4 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_5 =</td>
<td>0</td>
<td>Timer_5 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_6 =</td>
<td>0</td>
<td>Timer_6 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_7 =</td>
<td>0</td>
<td>Timer_7 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_B =</td>
<td>0</td>
<td>Timer_B =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_9 =</td>
<td>0</td>
<td>Timer_9 =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_A =</td>
<td>0</td>
<td>Timer_A =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_C =</td>
<td>0</td>
<td>Timer_C =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_D =</td>
<td>0</td>
<td>Timer_D =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_E =</td>
<td>0</td>
<td>Timer_E =</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Counter_F =</td>
<td>0</td>
<td>Timer_F =</td>
<td>0.00 ms</td>
</tr>
</tbody>
</table>

Figure 19-11. <Timers & Counters> Menu Display.
Displaying Frame Errors

The HP 4971S LAN protocol analyzer displays several types of frame errors that may occur. This section reviews the IEEE 802.3 frame format and also describes the possible causes of frame errors that can be displayed.

IEEE 802.3 Frame Protocol

The IEEE 802.3 standard specifies a message frame as:

<table>
<thead>
<tr>
<th>Preamble</th>
<th>Dest Addr</th>
<th>Source Addr</th>
<th>Length/Type</th>
<th>Data Field</th>
<th>FCS</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>6</td>
<td>6</td>
<td>2</td>
<td>46</td>
<td></td>
</tr>
</tbody>
</table>

Min length is 64 bytes

Max Length is 1518 bytes

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 802.3 Length</td>
<td>IEEE 802.3 Length</td>
</tr>
<tr>
<td>6 Dest Addr</td>
<td>6</td>
</tr>
<tr>
<td>6 Source Addr</td>
<td>6</td>
</tr>
<tr>
<td>2 Length/Type</td>
<td>2</td>
</tr>
<tr>
<td>46 Data field</td>
<td>1500</td>
</tr>
<tr>
<td>4 FCS field</td>
<td>4</td>
</tr>
</tbody>
</table>

64 bytes 1518 bytes
DISPLAYING FRAME ERRORS (cont.)

IEEE 802.3 Preamble

IEEE 802.3 specifies that the Preamble have a 64 bit synchronization pattern of alternating 1’s and 0’s ending with two consecutive 1’s. The information immediately following the last synchronizing byte is grouped into the frame elements: Destination Address, Source Address Length/Type Field, Data Field, and FCS.

In actual practice, preamble length can vary between different network systems. The <Hardware Functions> Menu lets you choose different preamble lengths of 16, 32, 64, or 128 bits for HP 4971S transmissions.

Types Of Frame Errors

Several types of errors can be detected by the HP 4971S and displayed in the <Examine Data> Menu. Definitions and possible causes of frame errors are listed on the following pages.

Runt Frames
Jabber Frames
Misaligned Frames
Corrupt Data Frames
Bad CRC Frames
DISPLAYING FRAME ERRORS (cont.)

RUNT FRAMES

<table>
<thead>
<tr>
<th>Definition</th>
<th>A frame that is too short. It has less than the 60 bytes required by IEEE 802.3 for the Destination Address through Data fields.</th>
</tr>
</thead>
</table>

"Runt" frame label is displayed in the Error Field of the <Examine Data> Menu when frames have less than 60 bytes for Destination Address through Data fields.

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>1. Frame collisions can cause Runt Frames. Normally, frame collisions occur very early in the frame transmission, well before the 512 bits needed before the protocol analyzer can receive the frame.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. The transmitting station sent a Data Field with less than 46 bytes.</td>
</tr>
<tr>
<td></td>
<td>3. Runt frames can also be caused by late collisions either because a node is not transmitting according to IEEE 802.3 format or the network is physically too large.</td>
</tr>
</tbody>
</table>
JABBER FRAMES

Definition
A frame that is too long; it has more than 1514 bytes in the information fields; Destination Address through Data fields.

Possible Causes
1. The transmitting station is not transmitting within specs.
2. A MAU on the network has failed and is putting out garbage.
MISALIGNED FRAME

Definition
A frame that has a total number of bits in the frame that is not divisible by 8 and also has a FCS error.

The FCS error is usually caused by the uneven number of bits.

Possible Causes
1. Hardware impedance mismatch causes ringing on the network.
2. The transmitting station may have sent the extra bits.
CORRUPT DATA

Definition
Displayed when a possible error occurred in the message inside the protocol analyzer due to heavy network traffic conditions with frequent jabber frames occurring.

Possible Causes
1. Excessive number of jabber frames
2. Hardware failure in the HP 4971S.
   (Execute the Self-Test)
DISPLAYING FRAME ERRORS (cont.)

BAD FCS

Definition
Displayed when the FCS error check generated inside the HP 4971S does not match the FCS field transmitted by the Source Address.

Possible Causes
1. Ringing on end of message for exactly eight bits.
2. Frame disturbed during transmission.
3. The transmitter may be defective or have a bad MAU.
4. System noise due to improper grounding of network cable.
This chapter describes the softkeys used to control printer functions with the HP 4971S system.

This chapter includes:

- <Printer Functions> Softkey Selections
- Getting Top Of Forms
- Stopping The Printer
- Selecting The Printer
- Printing The Node List
- Printing Filters
- Printing Messages
- Printing Programs
- Printing Data
- Print The Screen
- <Printer Functions> In Remote Mode
<Printer Functions> Softkey Selections

The <Printer Functions> Menu lets you have printed copies of received frames, the protocol analyzer's setup configuration and the current screen contents.

You can print frames stored in the protocol analyzer's buffer memory. You are able to select and print only the frames that interest you.

You can also print the protocol analyzer setup configuration. The setup configuration includes:

- Node list
- Filters
- Messages
- Programs

Finally, you can "print the screen" which includes all the characters shown on the HP 4971S display.
Getting Top Of Forms

The HP 4971S is intended to work with the HP 2225A ThinkJet Printer.

The protocol analyzer controls the printer so that it prints 60 lines of text and then spaces 6 lines. If you position the top of the form correctly, you have 3 blank lines at the top of the form and 3 blank lines at the bottom of the form.

Position the form

You should set the top of the form to the fourth line on the page, to leave a top margin of 3 lines or 1/2 inch.

To set the top of the form to the fourth line:

Use the Line Feed (LF) button to position the paper so that the page perforation is just above the pinch rollers.

After the top of form is positioned, press the blue button on the control panel to reinitialize the printer.

Experiment with positioning the paper for several printouts to determine the correct position for your application.

The protocol analyzer does not sense the perforations on the forms; it continues to print 60 lines and space 6 lines. If you use the line feed button to advance the page, the text is not centered on the page. If you want to advance the page and maintain text centering, use the Form Feed (FF) button on the control panel.
Stopping The Printer

As each request for printed copies is being printed, the message Printing is displayed.

The print operation may take several minutes if long lists of frames, programs, filters, messages, or node lists are to be printed.

You can stop the printer if you decide the list being printed is not what you want or it will take too long to print. While the list is being printed, the softkey <Abort Operation> is displayed. Press <Abort Operation> to stop the print function.

**<Abort Operation>**

softkey stops the printing operation after the current file in the printer buffer is printed. The protocol analyzer displays the message:

    Printer operation aborted by the user.

The printer does not stop printing immediately after the <Abort Operation> softkey is pressed. Printing continues until current data stored in the printer buffer has been printed. The printer buffer can hold approximately one page of printed text.
Selecting The Printer

<Select Printer> softkey causes the protocol analyzer to establish its link with the printer. If the link is successful, the protocol analyzer displays:

Local Printer is selected and initialized.

If the link is not successful, the protocol analyzer displays:

THERE IS NO COMMUNICATION WITH THE PRINTER.

If this occurs, check the following:

1. Is the HP-IB cable connected?

2. Is the printer's HP-IB switch set to address 1?

   If the switch has to be changed to 1, cycle the printer power switch off and back on.

For information about <Select Printer> functions in Master/Slave operation, see <I/O Functions> chapter.
Printing The Node List

<Print Nodes>

causes the printer to output a listing of the nodes identified in the <Edit Nodes> Menu.

Up to 1000 nodes can be defined. Press <Print Nodes> softkey to begin printing the defined node list and display the message:

Printin.

Example of <Print Nodes>:

<table>
<thead>
<tr>
<th>NETWORK NAME : Network_0</th>
<th>Network TYPE : ETHERNET</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE # NODE NAME NODE ADDRESS BUS POSITION</td>
<td></td>
</tr>
<tr>
<td>---- --------------- ---------------</td>
<td></td>
</tr>
<tr>
<td>1 HP LAN Analyzer 08·00·09·XX·XX·XX 0</td>
<td></td>
</tr>
</tbody>
</table>

All the nodes defined in <Edit Nodes> Menu are printed.

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
Printing Filters

<Print Filters> causes the printer to print a listing of the filters defined in the <Setup 4971S>, <Define Filters> softkey menus.

If a filter has been defined in <Edit Filters> Menu, all the details of that filter are printed when <Print Filters> softkey is executed.

All of the 16 possible filters you create are printed.

Press <Print Filters> softkey to begin printing the filters list and display:

    Printing.

An example of <Print Filters> softkey is shown below:

<table>
<thead>
<tr>
<th>FILTER #0</th>
<th>Label: Filter_0</th>
<th>MINIMUM Frame Length = 51</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Frame Traits: REJECT Frame with GOOD FCS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MAXIMUM Frame length = 2022</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REJECT Frame with BAD FCS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REJECT MISALIGNED Frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REJECT RUNT Frame</td>
<td></td>
</tr>
<tr>
<td>BYTE</td>
<td>FIELD LABEL</td>
<td>FIELD DATA</td>
</tr>
<tr>
<td>---- -----</td>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>1      DESTINATION</td>
<td>XX·XX·XX·XX·XX·XX</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>7      SOURCE</td>
<td>XX·XX·XX·XX·XX·XX</td>
<td>Node Name: -- Not Defined --</td>
</tr>
<tr>
<td>13     TYPE</td>
<td>XX·XX</td>
<td></td>
</tr>
<tr>
<td>15     DATA</td>
<td>XX</td>
<td></td>
</tr>
</tbody>
</table>

The printer inserts a ~ symbol before and after characters declared as "Not" characters in your filter definition.

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
Printing Messages

<Print Messages> causes the messages created in <Edit Messages> Menu to be printed.

The protocol analyzer causes the printer to print all the messages you have created. Up to 16 user created messages are possible.

Press <Print Messages> softkey to begin printing and display the message:

Printing.

An example of <Print Messages> follows:

```
MESSAGE 0  FCS VALUE: Good  MESSAGE Label: MESSAGE_0
       FRAME Length: 60 Bytes

     BYTES     FIELD LABEL       HEX DATA
------------------ -------------------------------
  1....6  DESTINATION  00·00·00·00·00·00·00  Node Name: -- Not Defined --
  7....12  SOURCE      08·00·09·00·0A·44  Node Name: HP LAN Analyzer
 13....14  TYPE        00·00
 15....29  DATA              00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00·00
 30....44
```

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
Printing Programs

<Print Programs> softkey lets you print a selected program created in <Setup 4971S>, <Edit Programs> Menus. Up to five programs can be created in the <Edit Programs> Menu.

Press <Print Programs> softkey to display softkey choices for existing programs. Press a softkey for the program you want printed.

The example below shows the default Program_0 that is printed when you do not have a program of your own created:

Listing of program "Program_0"

Store: all frames
     until full

Log file: not used

Block 1:

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
Printing Data

<Print Data> softkey lets you get printouts of frames you have captured in the protocol analyzer's memory.

You do not have to print all frames in the protocol analyzer memory. In order to save time and print only the frames you want, the protocol analyzer provides softkeys to choose what frames you want printed.

Press <Print Data> softkey to display the following softkey choices for printing frames:

- <Range of Frames>
- <Single Frame>
- <Marked Frames>
- <All Frames>
- <Print the List>

Each frame chosen is printed in the format you currently have selected in the <Examine Data> Menu.

<Print Data> softkey displays the following table for choosing what frames to print:

FRAMES IN THE LIST (15 elements maximum) :

1.
2.
:
:
15.

You can select up to 15 combinations of; All Frames, Range of Frames, Marked Frames, and Single Frames to be printed. The same frame(s) may be printed in different groupings of frames.

After you have selected all of the combinations that you want, press <Print the List> softkey.
<Print Data> (cont.)

<Range of Frames>

lets you choose a range of consecutively numbered frames to be printed. Press this softkey to display:

FRAMES IN THE LIST (15 elements maximum):

1. RANGE OF FRAMES FROM # ___ TO #

Enter the first frame number.

From the keyboard, enter the first number of a range of frames you want printed. If you decide your range of frames entry is wrong, press CLEAR LINE or DELETE CHAR to clear the field. Enter the new number and press RETURN key to complete the entry. If you decide not to enter a range of frames, press <EXIT> softkey to delete that current element from the list.

The protocol analyzer displays: Enter last frame number. Again from the keyboard, enter the last number for the range of frames you want printed. Press RETURN key to complete the entry.

To quickly find the last frame number in the protocol analyzer's memory, enter 9999999 and press RETURN key. The protocol analyzer displays the last available frame.

You may enter up to 15 different ranges of frames to be printed.

After you have selected all the combinations that you want, press <Print the List> softkey to start printing and display: Printing.

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
<Single Frame>
softkey lets you print a single frame that is stored in the protocol analyzer's Receive Buffer.

Press <Single Frame> softkey to display:

FRAMES IN THE LIST (15 elements maximum):

1. Single Frame #1
2.
3.

Enter single frame number.

From the keyboard, enter the frame number of the single frame you want printed. If you decide the Single Frame entry is wrong, press CLEAR LINE or DELETE CHAR keys to clear the field. Enter a new number and press RETURN key to complete the entry.

Up to 15 separate frames can be printed using the <Single Frame> softkey selection.

After you have selected all the frame combinations you want, press <Print The List> to start the printing and also display: Printing.

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
<Print Data> (cont.)

<Marked Frames>

softkey lets you print only the frames you have marked in the protocol analyzer's memory.

In <Examine Data> Menu, you can manually mark frames that are of interest to you. Also, in <Edit Programs> Menu, you can create a program to mark particular frames as they are stored in the Receive Buffer.

Press the <Marked Frames> softkey to display:

FRAMES IN THE LIST ( 15 elements maximum) :
-------------------------------------------------
1. MARKED FRAMES
2.
:

Press <Print the List> softkey to begin printing marked frames in the Receive Buffer and display the message: Printing.

If you enter <Marked Frames> more than once, you repeat printing a marked frame list as many times as you entered the softkey.

If no frames have been marked in the Receive Buffer, the protocol analyzer returns to the <Print Data> Menu and displays the message:

NO MARKED FRAMES IN BUFFER.

Press <Abort Operation> softkey to stop printing marked frames before the complete list is printed. See <Abort Operation> description on page 20-4.
<Print Data> (cont.)

<All Frames>

softkey lets you print all frames currently stored in the protocol analyzer's memory. Press <All Frames> softkey to display:

FRAMES IN THE LIST (15 elements maximum):

1. ALL FRAMES
2. :

After you have selected all the frame combinations you want, press <Print The List> to start the printing and also display:

Press <Abort Operations> softkey to stop printing before the complete list is printed. See <Abort Operation> on page 20-4.

<Print The List>

softkey is the execute key for <Print Data>. Press <Print the List> softkey to begin printing whatever group of frames you have selected. The protocol analyzer prompts:

Would you like to print the timers and counters also?

YES  NO  EXIT

Press <YES> softkey if you want to print the data list and the timers and counters list.

Press <NO> softkey if you only want to print the data list.

Press <Abort Operation> softkey to stop printing before the complete list is printed. See <Abort Operation> description on page 20-4.
<EXIT> softkey lets you delete a current element you are defining in the list.

When the <Range of Frames> or <Single Frame> softkeys are currently selected, you can press <EXIT> to delete that element from the list and then make another softkey selection to add another frame combination to the list.

**WARNING**

If you press <EXIT> with no Range of Frames or Single Frame entry field currently active for entry, the protocol analyzer deletes the entire frame list.
Print The Screen

The HP 4971S has an additional important printer function. You can print the current screen display simply by pressing SHIFT and PRINT keys at the same time.

These keys can be used whenever you are in any menu except <Printer Functions>.

This function lets you conveniently print a hard copy of whatever function you are editing or frames you may be viewing at that moment.
<Printer Functions> In Remote Mode

When two protocol analyzers are used for remote operation and each location has a printer, you can get printouts at either the slave location or the master location.

Selecting The Printer In Remote Mode

After the remote link is established, use the following procedure to select the printer location.

1. Press <Select Printer> softkey.

2. HP 4971S prompts: Select the MASTER or SLAVE.

3. Press either the <MASTER> or <SLAVE> softkey for the printer location you want to use.

If a printer location is not specified, the system defaults to the slave printer when the remote link is established.

4. HP 4971S displays: _______ printer is selected.
This chapter describes the menus and softkeys used to display the hardware configuration of the HP 4971A and to test hardware circuitry in the HP 4971A instrument.

A self test is performed automatically at power on. The power-on self test is a subset of the self tests available in the <Test LAN Analyzer> Menu.

The <Test LAN Analyzer> softkey lets you run the more extensive self tests.

This chapter includes:

- HP 4971A Hardware Functions Display
- HP 4971A Hardware Functions Descriptions
- <Test LAN Analyzer> Self Tests
- Running The Self Tests
HP 4971A Hardware Functions Display

From the Top Level Menu, press the <Hardware Functions> softkey to display the menu shown below.

<table>
<thead>
<tr>
<th>LAN Address of this Analyzer:</th>
<th>08-00-09-00-1A-34</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory bytes available:</td>
<td>XXXXXX (varies with system usage)</td>
</tr>
<tr>
<td>LAN Receiver hardware:</td>
<td>Installed</td>
</tr>
<tr>
<td>LAN Transmitter hardware:</td>
<td>Installed</td>
</tr>
<tr>
<td>Dual Port RAM hardware:</td>
<td>Installed</td>
</tr>
<tr>
<td>Deep Trapmachine hardware:</td>
<td>Installed</td>
</tr>
<tr>
<td>Shallow Trapmachine hardware:</td>
<td>Installed</td>
</tr>
<tr>
<td>Runt Frame filter:</td>
<td>enabled</td>
</tr>
<tr>
<td>Receiver Buffer size:</td>
<td>1500 bytes</td>
</tr>
<tr>
<td>Transmitter preamble length:</td>
<td>64 bits</td>
</tr>
<tr>
<td>Execute Network File at power-on:</td>
<td>Yes</td>
</tr>
<tr>
<td>Network file name:</td>
<td>AUTOEX</td>
</tr>
<tr>
<td>Test LAN Analyzer</td>
<td>Enabled/Disabled (Normal)</td>
</tr>
</tbody>
</table>

Figure 21-1. <Hardware Functions> Menu.
HP 4971A Hardware Functions Description

LAN Address of this Analyzer:
This line displays the IEEE 802.3 address unique to your HP 4971S. This is the six byte address used in default Source and Destination Address fields of IEEE 802.3 and Ethernet protocols.

Memory bytes available:
shows how many bytes of RAM memory are available for use by the HP 4971S. This is the memory space used for protocol analyzer functions such as editing the node list, programs, filters, and messages. The available memory display is updated dynamically during operation of the analyzer.

LAN Receiver hardware:
LAN Transmitter hardware:
Dual Port RAM hardware:
Deep Trapmachine hardware:
Shallow Trapmachine hardware:
These are the hardware printed circuit boards that are used to perform the protocol analyzer functions of the HP 4971S. All of these boards must be installed for the protocol analyzer self test to pass and for the protocol analyzer to function.
Runt Frame filter: lets you choose the minimum frame length for the protocol analyzer to accept.

It is common for frames shorter than the IEEE 802.3 requirement to occur on the network due to collisions.

The HP 4971S can capture frames shorter than the IEEE 802.3 minimum length. You can choose between two minimum sizes of Runt frames to be captured. You can store frames with information fields as short as:

Approx. 52 bytes — with Runt Frame Filter: Enabled (38 bytes in the data field)

15 bytes — with Runt Frame Filter: Disabled (1 byte in the data field)

IEEE 802.3 specifies that the minimum frame length should be 64 bytes from Destination Address through the FCS Field (60 bytes in Dest. Addr., Source Addr., Type/Length, and Data Fields).

<table>
<thead>
<tr>
<th>Dest. Preamble</th>
<th>Source Addr</th>
<th>Length/Type</th>
<th>Data Field</th>
<th>FCS (CRC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>6</td>
<td>6</td>
<td>2</td>
<td>46-1500</td>
</tr>
</tbody>
</table>

<------IEEE 802.3 specifies minimum length as 64 bytes ------>

<------60 bytes (Data Field = 46 bytes) ------>

These fields are referred to as "Information Fields" in this manual.
Runt Frame Filter: (cont.)

**Enabled**

In default mode, the Runt frame filter is enabled. The protocol analyzer discards frames with less than approx. 52 bytes in the information fields (at least 38 bytes in the data field).

Very short frames can cause problems in HP 4971S hardware used to capture frames. In "Enabled" mode, the HP 4971S avoids the hardware problems by discarding the frames with less than 52 bytes in the information fields.

**Disabled**

The "Disabled" mode is provided for unique or specific applications when you need to capture and view very short frame fragments. You should return to the "Enabled" mode when you are finished with your special measurement. "Enabled" mode provides complete integrity for received data.

In "Disabled" mode, the protocol analyzer can store frames with as few as 15 bytes in the information fields (at least one byte in the Data Field).

**WARNING**

In "Disabled:" mode, hardware filters and data frames stored in the HP 4971S can be corrupted. Data frames can also be missed. Use "Runt Frame Filter: Enabled" mode for normal operation.

The error message, "CORRUPT DATA", is displayed in the <Examine Data> Menu if an error occurs in a frame while it is being received inside the analyzer. When short frames occur, HP 4971S filters start being loaded, however, if the frame is discarded, the filter is not reset until the next complete frame is received. Until the next complete frame is received, received data frames can be corrupted, frame fragments can be missed without an error message displayed.
Receive buffer size:

lets you select the length of buffer used to store frames received from the network.

480 bytes

The "480 bytes" mode is provided for unique or specific applications when you need to capture more than 655 frames in the HP 4971S receive buffer. We recommend you return to the "1500 bytes" mode when you are finished with your special measurement.

During normal, low traffic (Less than 10-20%) monitoring, if your network generally transmits shorter length frames, you can store more frames in memory by setting the buffer length to 480 bytes.

WARNING

When operated in "480 bytes" mode, data integrity problems can occur under high network loads. The following list shows the two possible conditions when data integrity problems can occur.

1. During heavy network loads, when frame lengths slightly greater than 480 bytes occur, an extra character may be added to the frame by the protocol analyzer. When this happens, the frame is marked as "CORRUPT DATA" in the <Examine Data> Menu.

2. When frames are received with minimum interframe spacing, (9.6 us), there is a slight possibility that one of the frames or both frames may be corrupted by the protocol analyzer. If a frame is corrupted, it is marked as "CORRUPT DATA".

1500 bytes

is the default length. Use this buffer size when you do not want to risk missing a frame in the protocol analyzer.

1500 byte buffer length lets all frames passing the runt frame filter be stored without the risk of corrupt buffers.
The number of frames that can be stored in the HP 4971S receive buffer depend on two conditions:

<table>
<thead>
<tr>
<th>STORE METHOD USED</th>
<th>RECEIVE BUFFER LENGTH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear Storage</td>
<td>480 byte buffer</td>
</tr>
<tr>
<td>Until Full</td>
<td>1500 byte buffer</td>
</tr>
<tr>
<td>Starting With</td>
<td></td>
</tr>
<tr>
<td>Circular Storage</td>
<td></td>
</tr>
<tr>
<td>Centered About</td>
<td></td>
</tr>
<tr>
<td>Ending With</td>
<td></td>
</tr>
<tr>
<td>Nonstop</td>
<td></td>
</tr>
</tbody>
</table>

### 480 BYTE BUFFER LENGTH

**LINEAR STORAGE**

1

- 2046 FRAMES MAX

**CIRCULAR STORAGE**

NEWEST FRAME

CIRCULAR OVERHEAD

1646 FRAMES MAX

OLDEST FRAME

### 1500 BYTE BUFFER LENGTH

**LINEAR STORAGE**

1

- 655 FRAMES MAX

**CIRCULAR STORAGE**

NEWEST FRAME

CIRCULAR OVERHEAD

515 FRAMES MAX

OLDEST FRAME

---

Figure 21-2. Receive Buffer Storage.
You can change the length of the preamble for messages transmitted by the HP 4971S. Using different preamble lengths lets you test receive functions of stations on your network. Choices for preamble length are:

- 16 bits
- 32 bits
- 64 bits (default)
- 128 bits

The HP 4971S can not receive frames with only 16 bits in the preamble.

Execute Network File at power-on:

lets you choose whether or not you want to automatically execute a network file when the protocol analyzer is turned on. You can create network files that automatically loads a program and menus to perform tests you specify.

See chapter, <Disc Functions> Menu, for more information about creating and saving network files.

Network file name:

lets you choose the network file that is to be automatically loaded at power on. A default network file name, AUTOEX (AUTO EXECute), is used by the HP 4971S.

If you want to automatically load a file name other than AUTOEX, enter the new file name and then press RETURN key to complete the entry.
<Test LAN Analyzer> Self Tests

A brief description of tests performed by the <Test LAN Analyzer> softkey is listed on the following pages. This section gives you an overview of the self tests performed on the HP 4971A instrument. A more detailed description is given in the HP 4971S Hardware Support Manual.

Hardware boards test status

The hardware list displayed for <Hardware Functions> Menu shows the status of boards after the power-on self test or <Test All Hardware> test is completed. If any board fails, the display indicates which board(s) failed.

<table>
<thead>
<tr>
<th>Hardware Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN receiver hardware</td>
<td>INSTALLED</td>
</tr>
<tr>
<td>LAN Transmitter hardware</td>
<td>INSTALLED</td>
</tr>
<tr>
<td>Dual Port RAM hardware</td>
<td>INSTALLED</td>
</tr>
<tr>
<td>Deep Trapmachine hardware</td>
<td>INSTALLED</td>
</tr>
<tr>
<td>Shallow Trapmachine hardware</td>
<td>INSTALLED</td>
</tr>
<tr>
<td></td>
<td>&lt;- FAILED HARDWARE TEST</td>
</tr>
</tbody>
</table>

Loss of stored messages and data.

After you select the <Test Hardware> softkey, a message is displayed to warn you that when the self test is performed, any setup menu information, and transmit and receive buffer data is lost. Internal memory is used during the hardware tests and any stored information is written over. The hardware tests give a high degree of assurance that the hardware of the protocol analyzer, the Access Unit Interface (AUI) cable, and the Media Access Unit (MAU) are working correctly.

When you run the <Test All Hardware> and <Network Loop Test> softkey tests, you have run a very extensive test of the protocol analyzer and its link to the local area network (LAN).
<Test All Hardware> softkey runs a self test without having to go through the power-on software loading routine. The <Test All Hardware> softkey tests the buffer memory more extensively than the power-on test.

Functions tested by this softkey include:

- LAN Receiver
- LAN Transmitter
- Dual Port RAM
- Deep Trap Machine
- Shallow Trap Machine
- Internal Loopback

After running the <Test All Hardware> self test, if your system is connected to a LAN, you may want to perform the <Network Loop Test> to also verify that the AUI cable, MAU, and the network are functioning.

<Network Loop Test> softkey causes the protocol analyzer to transmit two frames on the network.

The frames pass through the AUI cable, through the MAU, onto the network cable, and then back to the protocol analyzer.

If the received frames are the same as the transmitted frames, you have verified operation of the transmit/receive circuitry in the protocol analyzer, the AUI cable, the MAU and the fact that the network cable is functioning.

<Reset MAU> The protocol analyzer resets or initializes the MAU by disconnecting the MAU’s power for about one second.
Running the Self Tests

When you elect to run the self tests, the protocol analyzer displays status messages during the test and at the end of the test.

During the test.

During the test, the protocol analyzer displays:

\[ \text{Testing (test name).} \]

After the test.

Depending on whether the test passes or fails, the protocol analyzer displays one of the messages:

\[ \begin{align*}
\text{Pass} & \quad (\text{Name of hardware board: }) \ \text{INSTALLED} \\
\text{Failed} & \quad (\text{Name of hardware board: }) \ \text{INSTALLED} \leftarrow \text{FAILED HARDWARE TEST}
\end{align*} \]

If the test fails.

Refer to the HP 4971S Hardware Support Manual for trouble shooting information if any test fails or, contact your nearest HP Service Office.
This chapter describes the password features used to control access to HP 4971S Receiver and Transmitter functions.

This chapter includes:

- <Passwords> Softkey Selections
- Introduction
- Changing The Password
- Storing The Password
- Securing Receiver Or Transmitter Functions
- Unsecuring Receiver Or Transmitter Functions
- Passwords In Other Analyzer Menus
<Passwords> Menu 22-2

Passwords

Enter Rev Password
Secure Receiver
Enter Xmt Password
Secure Xmitter
Change Password
  New Rev Password
  New Xmt Password
  Store New Password
  EXIT

EXIT

WARNING

The <Passwords> feature works. There is no procedure to recover a forgotten password from the protocol analyzer. If you forget your password, you must reboot your system using the original software supplied with your protocol analyzer.

When a password is saved to the Configuration File, no procedure exists to recover the password from the file.

You should keep a copy of the original software (without passwords) in a secure place. Store passwords only on working copies of your system software. Another suggestion is to record your password on paper and store the paper in a secure location.
Introduction

<Password> Menu lets you disable or block certain features of the HP 4971S. Two primary functions of the protocol analyzer that are disabled by passwords are:

1. Displaying the data field portion of captured frames.
2. Sending messages from the protocol analyzer.

In the <Passwords> Menu, you can suppress displaying the data field portion of captured frames. IEEE 802.3/Ethernet headers as well as the HP 4971S physical headers containing frame length and error information can be viewed for network trouble shooting. With the password feature enabled, only authorized operators may view confidential messages.

<Passwords> can prevent the HP 4971S from transmitting messages onto the network. Only authorized operators may send frames with the password function enabled.

NULL Password

In default mode, that is, no user password has yet been entered, the Receiver and Transmitter passwords are both NULL passwords, (all <BLANK> characters).

The NULL password lets you have full access to reading frame data fields and sending messages on the network.

Secured Operation

To secure (disable) either the Receive or Transmit functions, you must define and enter a password into the protocol analyzer.

You can use different passwords to secure the Transmit and Receive functions separately, or, if the Receive and Transmit passwords are the same, your password needs to be entered only once.

Saving A Password

A password can be saved to the Configuration File to cause the protocol analyzer to power up in a secured mode each time the power is cycled to ON.
Using passwords involves the operations:

1. Changing a password.
2. Storing a password.
3. Securing the receiver and/or the transmitter functions.
4. Unsecuring the receiver and/or transmitter functions.

Each of these operations are discussed on the following pages.

You should practice using the password softkeys until you are sure you understand the password menu. Use a single character such as "1" or "A" for the password entry. As you change or edit the passwords, increment the character to the next value "2" or "B".

If you forget the password or get confused, it is much quicker and easier to enter single characters until you find the password.

When you are comfortable with the procedures for passwords, then enter longer and more complex passwords (up to eight keyboard characters).
Changing The Password

In default mode, the Receiver and Transmitter passwords are both NULL (all <SPACE> characters). To secure the Receiver and/or Transmitter functions, use the <Change Password> softkey.

If another password has been entered, the <Change Password> menu also lets you revoke the previous password and enter a new password.

<Change Password> This softkey presents a display to let you enter new passwords. The new password can replace the NULL password or, it can replace a previously defined password.

Press <Change Password> softkey to display:

Enter Rcv Secure Enter Xmt Secure Change EXIT
Password Receiver Password Xmitter Password

New Rcv New Xmt Store New EXIT
Password Password Password

<Enter New Rcv Password> opens the protocol analyzer to accept a new password for Receiver functions.

<Enter New Xmt Password> opens the protocol analyzer to accept a new password for Transmitter functions.
PROCEDURE TO CHANGE PASSWORDS

1. From the <Passwords> Menu, press <Change Password> softkey.

2. Which password do you want to change? Choose one of the following.

   Press <New Rcv Password> to change the Receiver password.

   Press <New Xmt Password> to change the Transmitter password.

3. A. Current password is NULL

   a. 4971S prompts: Enter your NEW password. (0..8 characters)

   b. Enter up to 8 keyboard characters and press the RETURN key.

   c. 4971S prompts: Please verify your new password by retyping it.

   d. Enter the new password again and press the RETURN key.

   e. 4971S displays: Secured (Enter password for access)

      Password changed

B. Current password is not NULL

   a. 4971S prompts: Enter your CURRENT password. (0..8 characters)

   b. Enter your current password and press the RETURN key.

   If you enter the wrong password, the HP 4971S prompts:

      INCORRECT PASSWORD

   After you correctly enter the CURRENT password,

   4971S prompts: Enter your NEW password. (0..8 characters)
c. Enter up to 8 keyboard characters and press the RETURN key.

d. 4971S prompts: Please verify your new password by retyping it.

e. Enter the new password again and press the RETURN key.

f. 4971S displays: Password changed
Storing The Password

After a password is changed, you can use the new password to secure Receiver and Transmitter functions temporarily or until the power is turned off.

In order to automatically restore the same password when the power is turned on again, you must store or save the password to the Configuration File, CNFG.

<Store New Password>

overwrites the new password over the current password on the Configuration File, CNFG.

The Configuration File is located on the LANCOD system disc. When you store the password, the protocol analyzer looks for the LANCOD disc. The analyzer prompts you to install LANCOD if it is not found.

In systems using only the HP 9122D Dual Disc Drive, you must install the LANCOD disc in a disc drive slot. In systems with system software loaded on a Winchester disc drive, the analyzer finds the LANCOD volume on the hard disc. If two LANCOD volumes are found, the analyzer stores the password on the volume with the lowest unit number. Floppy disc volumes always have a lower number than hard disc volumes.

<Store New Password> overwrites a new password over a previously defined password without disturbing any other elements on the configuration file.

WARNING

If you define a new password and use the <Save Config.> softkey, you overwrite the entire configuration file not just the old password.

Use <Store New Password> when you want to change only the password on the configuration file.
Securing Receiver Or Transmitter Functions

You can cause the Receiver and/or Transmitter function to become secured by changing to a new password.

Also, you can use the current password and secure the Receiver and/or Transmitter functions with the softkeys <Secure Receiver> and <Secure Transmitter>.

**<Secure Receiver>**

This softkey lets you disable the Receiver function. You cannot view data fields in any frames received from the network.

To unsecure or enable the Receiver function, you must press the <Enter Rcv Password> softkey and enter the current password or change the password with <Change Password> softkey.

**<Secure Xmitter>**

This softkey lets you disable the Transmitter function. You cannot transmit frames from the protocol analyzer onto the network.

To unsecure or enable the Transmitter function, you must press the <Enter Xmt Password> softkey and enter the current password or change the password with <Change Password> softkey.
Unsecuring Receiver Or Transmitter Functions

There are two methods to unsecure or remove a password from the Receiver or Transmitter functions while you are in the <Passwords> Menu.

1. Change an existing password to a new name by using the <Change Password> softkey. See the section "Changing The Password" in this chapter.

2. Use the <Enter Rcv Password> or <Enter Xmt Password> softkeys to enter the current password.

<Enter Rcv Password>
Press this softkey and then enter the current Receiver password. Press the RETURN key.

If you correctly enter the password, the HP 4971S displays:

Unsecured (Password has been entered)

<Enter Xmt Password>
Press this softkey and then enter the current Transmitter password. Press the RETURN key.

If you correctly entered the password, the HP 4971S displays:

Unsecured (Password has been entered)
Passwords In Other Analyzer Menus

If a password is used to secure Receive or Transmit functions, the following analyzer menus display an error message when you try to view a frame's data field or send a message.

/Edit Filters> Menu
/Edit Messages> Menu
/Edit Programs> Menu
/Examine Data> Menu
/Printer Functions> Menu

Receiver Functions

When a Receiver password is active, the data field portion of received frames is not displayed in any analyzer menu. Only the physical header generated by the analyzer and the IEEE 802.3/Ethernet headers can be displayed.

The data field information for each frame is in the protocol analyzer's receive buffer. To view the data fields, you must unsecure the Receiver function password.

Transmitter Functions

In <Execute Programs> Menu, when a Transmitter password is active and a <Send Message> command occurs, no message is sent.

An error message is displayed to alert you that the protocol analyzer can not send messages until the Transmitter function password is unsecured.
This chapter describes how to set the date and time for your protocol analyzer.

At power up, or any time the power to the HP 4971A system has been interrupted, the date and time should be set. It is important to set date and time so that disc functions and time measurement functions that reference the time are accurate.

This chapter includes:

- Setting The Date
- Setting the Time
Setting The Date

PROCEDURE:

1. From the Top Level Menu, press the <OTHER CHOICES> softkey to display softkeys for setting the date and time.

2. Press <Set Date> softkey.

Entry format

The date entry must follow the format:

day month year (separate each entry with a space)
(use three letters for month)

For example:

15 jan 87 = January 15, 1987

Entry values

The values you can enter for the day and year must be within the range listed below:

years = => 0 days = => 1
<= 99 <= 31

3. Press the RETURN key to complete the entry.
Setting The Time

PROCEDURE:

1. From the Top Level Menu, press the <Set Time> softkey.

Entry format

2. The time entry must follow the format:

   hour:minute:second
   (separate each entry with a colon :)
   (use 24 hour entry to denote AM and PM)

For example:

   9:30:00 = 9:30 AM
   21:30:00 = 9:30 PM

Entry values

The values you enter for the hours, minutes, and seconds must be within the ranges listed below:

   hours = => 0
          <= 23

   minutes = => 0
            <= 59

   seconds = => 0
             <= 59

3. Press the RETURN key to complete the entry.
INDEX

This index references both volumes of the HP 4971S Operating Manual.

Volume I contains chapters 1 through 8, Appendices A-D and a glossary
Volume II contains chapters 9 through 23
10BASE2 6-21, 6-22
10BASE5 6-14, 6-22
1500 byte buffer 21-6
480 byte buffer 21-6

<802.2 Format> 12-18
<802.2 Header> 19-29
<802.3 Format> 12-17
<802.3 Header> 19-28
802.3 Frame Protocol 6-17

<Abort Operation> 20-4
Accessories for the HP 4971A 2-12
Accessories for the HP 4971S 2-9
Accessory boards, locations 4-32
Access Unit Interface (AUI) 6-14

Active softkeys 1-10
<Add Filter> 12-10
<Add Message> 13-4
Address, HP 4971S LAN address 21-3
Address switches, memory boards 4-34
<All Frames> 14-7, 18-13

Altitude 2-7, 3-2
<And> 14-43
<And Frame Traits> 14-14, 14-44
<And Then> 14-31
<Append Nodes> 18-15

ARROW-DOWN key 1-11
ARROW-HOME key 1-11
ARROW-LEFT key 1-11
ARROW-RIGHT key 1-12
ARROW-UP key 1-12

<ASCII 7> 12-16, 13-6, 19-34
<ASCII 8/Roman 8> 12-16, 19-34
ASCII code tables Appendix B

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Assigning A Printer  |  20-5
Assigning The Mass Storage Device:  |  15-13

<table>
<thead>
<tr>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing up system software</td>
</tr>
<tr>
<td>BACKSPACE key</td>
</tr>
<tr>
<td>Bad FCS</td>
</tr>
<tr>
<td>Baseband</td>
</tr>
<tr>
<td>Baud Rate:</td>
</tr>
<tr>
<td>&lt;Beep&gt;</td>
</tr>
<tr>
<td>&lt;Binary LSB Left&gt;</td>
</tr>
<tr>
<td>&lt;Binary LSB Right&gt;</td>
</tr>
<tr>
<td>&lt;Bin LSB Left&gt;</td>
</tr>
<tr>
<td>&lt;Bin LSB Right&gt;</td>
</tr>
<tr>
<td>Bits/Character:</td>
</tr>
<tr>
<td>&lt;Block 1&gt;</td>
</tr>
<tr>
<td>Block structure</td>
</tr>
<tr>
<td>Buffer Memory</td>
</tr>
<tr>
<td>Bus position</td>
</tr>
<tr>
<td>Bus Topology</td>
</tr>
<tr>
<td>Byte position in &lt;Examine Data&gt; Menu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Capture Slave&gt;</td>
</tr>
<tr>
<td>Carrier Sense</td>
</tr>
<tr>
<td>&lt;Centered About&gt;</td>
</tr>
<tr>
<td>&lt;Change Datafield&gt;</td>
</tr>
<tr>
<td>&lt;Change Filter&gt;</td>
</tr>
<tr>
<td>&lt;Change Headers&gt;</td>
</tr>
<tr>
<td>&lt;Change Password&gt;</td>
</tr>
<tr>
<td>&lt;Change Timestamp&gt;</td>
</tr>
<tr>
<td>&lt;Character Data&gt;</td>
</tr>
<tr>
<td>Character entry</td>
</tr>
<tr>
<td>CLEAR LINE key</td>
</tr>
<tr>
<td>Coaxial Cable</td>
</tr>
</tbody>
</table>

*Volume I contains chapters 1 through 8, appendices A-D and a glossary.*

*Volume II contains chapters 9 through 23.*

*Index  I- 3*
DDCMP Timeout
<Define Search> 19-14
<Delete Block> 14-39
<Delete Bytes> 12-15, 13-5
DELETE CHAR key 1-12

<Delete Field> 6-15
<Delete File> 18-7
<Delete Filter> 12-10
DELETE LINE key 1-12
<Delete Message> 13-4

<Delete Node> 11-7
<Delete Program> 14-5
Destination Address, IEEE 802.3 6-18, 19-5
<Detailed Format> 19-18
Disabled hand shaking 15-6

Disc Designations 18-3
Disc Drive Numbers 4-25, 4-27, 4-29
Disc drives available 5-3
Disc file syntax 18-22
Disc File Type 18-23

<Disc Functions> Menu 18-1
Disc Number or Name 5-18
Disc Sequence Number 18-23
Discs Supplied With System 18-4
<Display> 14-27

<Display Frame> 14-32, 14-50
Display, installation 4-16
DSAP 19-29

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23
Index 1-5
E 19-34
EBCDIC code table Appendix B
E 13-6
EBCDIC Entry> 12-16
E Edit All Fields> 12-12

E Edit Config> 15-4
E Edit Datafield> 13-5
E Edit Filters> 12-1, 12-9, 14-43
Editing programs 14-24
Editing With Keyboard Keys 1-11
Edit Message example 13-12
E Edit Messages> 13-1
E Edit Modem Str> 15-15
E Edit New Program?> 14-4

E Edit Nodelist> 11-1
adding stations to list 11-5
deleting stations from list 11-7
searching for a node 11-9
sorting the node list 11-8
E Edit Programs>

Edit Which Program? 14-4
E Else If> 14-41
E Else When> 14-41, 14-48
E Enable I/O> 15-19

Encoded DDCMP: 15-8, 15-11
E End Edit> 14-14, 14-31, 14-41
E Ending With> 14-12
End of Frame 19-36
E Enter New Rcv Password> 22-5
E Enter New Xmit Password> 22-5
E Enter Node Name> 12-11, 13-4
E Enter Rcv Password> 22-10
E Enter Xmit Password> 22-10

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index I-6
Environment, operating 3-2
>Error Frame> 19-15
Error, I/O 15-20
Error Messages Appendix A
<Ethernet> 11-4
<Ethernet Format> 12-17
Ethernet, frame 6-20
<Ethernet Header> 19-20

<Examine Data> 19-1
Examine Data Display 19-2
  Byte Position 19-6
  Data 19-6
  Destination Address 19-5
  Error 19-5
  Filters 19-4
  Frame Number 19-2
  Message Length 19-3
  Source Address 19-7
  Time Stamp 19-3
  Type 19-7

<Execute Program> 16-1
<EXIT> 20-15

FCS, Bad, Good 12-21
FCS, selecting an FCS value 13-12
FCS Field, IEEE 802.3 6-19
Files, name syntax 18-22
File space available 18-5
File type 18-6
Filter examples 12-24
<table>
<thead>
<tr>
<th>Filter Format</th>
<th>19-21</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter, introduction</td>
<td>7-6, 12-2</td>
</tr>
<tr>
<td>Filter length</td>
<td>12-22</td>
</tr>
<tr>
<td>Filter Matched</td>
<td>19-15</td>
</tr>
<tr>
<td>Find Block</td>
<td>14-38</td>
</tr>
<tr>
<td>Finding Frames</td>
<td>19-10</td>
</tr>
<tr>
<td>Followed By</td>
<td>14-36</td>
</tr>
<tr>
<td>Format As Filter #</td>
<td>13-9</td>
</tr>
<tr>
<td>Format Volume</td>
<td>18-25</td>
</tr>
<tr>
<td>Formatting (Initializing) a Floppy Disc</td>
<td>5-17, 18-25</td>
</tr>
<tr>
<td>Formatting (Initializing) a hard disc</td>
<td>5-9, 5-13, 5-15</td>
</tr>
<tr>
<td>Formatting volumes</td>
<td>18-25</td>
</tr>
<tr>
<td>Frame Acquisition vs Display Speed</td>
<td>16-2</td>
</tr>
<tr>
<td>Frame Counter</td>
<td>14-29, 14-46</td>
</tr>
<tr>
<td>Frame Errors</td>
<td>19-42</td>
</tr>
<tr>
<td>Frame filter, Runt</td>
<td>21-4</td>
</tr>
<tr>
<td>Frame Matches</td>
<td>14-43</td>
</tr>
<tr>
<td>Frame match operation precedence</td>
<td>14-44</td>
</tr>
<tr>
<td>Frame Number</td>
<td>17-9, 19-2</td>
</tr>
<tr>
<td>Frames Matching</td>
<td>14-7</td>
</tr>
<tr>
<td>Fuses</td>
<td>4-6</td>
</tr>
<tr>
<td>Go To Block</td>
<td>14-32</td>
</tr>
<tr>
<td>Go To Byte</td>
<td>13-7</td>
</tr>
<tr>
<td>Go To Frame #</td>
<td>19-11</td>
</tr>
<tr>
<td>Go To Trigger</td>
<td>19-13</td>
</tr>
<tr>
<td>HARDSC (#13)</td>
<td>5-10</td>
</tr>
<tr>
<td>&lt;HARDWARE FUNCTIONS&gt; MENU</td>
<td>21-1</td>
</tr>
<tr>
<td>Hardware Handshake:</td>
<td>15-6</td>
</tr>
<tr>
<td>Hex</td>
<td>11-10</td>
</tr>
<tr>
<td>Hex Data</td>
<td>19-33</td>
</tr>
<tr>
<td>Hex/Char Data</td>
<td>19-33</td>
</tr>
<tr>
<td>Hex Entry</td>
<td>12-16</td>
</tr>
<tr>
<td>HP-IB Cables, installation</td>
<td>4-20</td>
</tr>
<tr>
<td>HP-IB Cables, part numbers</td>
<td>8-3</td>
</tr>
<tr>
<td>Humidity</td>
<td>2-7, 3-2</td>
</tr>
</tbody>
</table>

Volume I contains chapters 1 through 8, appendix A-D and a glossary.
Volume II contains chapters 9 through 23.
Index I-8
<table>
<thead>
<tr>
<th>Subject</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 802.3 Frame</td>
<td>6-17, 19-42</td>
</tr>
<tr>
<td>If commands</td>
<td>14-25</td>
</tr>
<tr>
<td>&lt;If Counter&gt;</td>
<td>14-32, 14-40</td>
</tr>
<tr>
<td>&lt;Increment Counter&gt;</td>
<td>14-31</td>
</tr>
<tr>
<td>Initializing (formatting) floppy disc</td>
<td>5-17, 18-25</td>
</tr>
<tr>
<td>Initializing (formatting) hard disc</td>
<td>5-9, 5-13, 5-15</td>
</tr>
<tr>
<td>&lt;Insert Block&gt;</td>
<td>14-39</td>
</tr>
<tr>
<td>&lt;Insert Bytes&gt;</td>
<td>12-15, 13-5</td>
</tr>
<tr>
<td>INSERT CHAR key</td>
<td>1-12</td>
</tr>
<tr>
<td>&lt;Insert Field&gt;</td>
<td>12-14</td>
</tr>
<tr>
<td>INSERT LINE key</td>
<td>1-12</td>
</tr>
<tr>
<td>&lt;Insert Node&gt;</td>
<td>11-5</td>
</tr>
<tr>
<td>I/O Functions</td>
<td>15-1</td>
</tr>
<tr>
<td>I/O Run Time Errors</td>
<td>15-28</td>
</tr>
<tr>
<td>I/O Status Messages</td>
<td>15-20</td>
</tr>
<tr>
<td>Jabber Frames</td>
<td>19-5, 19-45</td>
</tr>
<tr>
<td>Keyboard, installation</td>
<td>4-14</td>
</tr>
<tr>
<td>Keyboard keys</td>
<td>1-11</td>
</tr>
<tr>
<td>LAN (Local Area Network), introduction</td>
<td>6-1</td>
</tr>
<tr>
<td>LAN terms</td>
<td>Glossary</td>
</tr>
<tr>
<td>LANCOD</td>
<td>5-3, 18-3</td>
</tr>
<tr>
<td>LANSYS</td>
<td>5-3, 18-3</td>
</tr>
<tr>
<td>Largest space available</td>
<td>18-5</td>
</tr>
<tr>
<td>Length Field, IEEE 802.3</td>
<td>6-18</td>
</tr>
<tr>
<td>Line voltage select switches</td>
<td>4-4</td>
</tr>
<tr>
<td>&lt;List Directory&gt;</td>
<td>18-5</td>
</tr>
<tr>
<td>&lt;Load File&gt;</td>
<td>18-15</td>
</tr>
<tr>
<td>Loading The System Software</td>
<td>5-5, 5-7</td>
</tr>
<tr>
<td>Manual conventions</td>
<td>1-8, 1-16</td>
</tr>
<tr>
<td>&lt;Mark&gt;</td>
<td>19-13</td>
</tr>
<tr>
<td>&lt;Mark Frame&gt;</td>
<td>14-33</td>
</tr>
</tbody>
</table>

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index I-9
Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index 1-10
Node List
Node list, adding stations to the list
Node name
Node number
<No Frames>
<Nonstop>
<Nonstop Mode>

<Not>
'<Not' Byte>
NULL password
Numeric entry

Options for the HP 4971A
<Or>
<Overwrite Nodes>

Parity Bit:
>Passwords> Menu
Peripherals for the HP 4971S
<Physical Header>
Power cords

Power Requirements
Preamble, IEEE 802.3
Preamble length
Preventative maintenance
<Previous Frame>
<Previous Marked>
PREV key

<P>rint Data>
<P>rinter Functions>
Getting Top Of Forms
Stopping The Printer
<P>rint Filters>
<P>rint Messages
<P>rint Nodes
<P>rint Programs

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index 1-11
<Print The List> 20-14
Print The Screen 20-16

Product Description, HP 4971S 2-2
Product Information 2-1

Programming examples 14-54
Programming with softkeys 14-24
Program structure 14-24
Protocol 15-8
Protocol Buffer Size: 15-9
Protocol timeout: 15-9
<Purge Node List> 11-7

Range of Frames 18-12, 20-11
Receive buffer size: 21-6
Received Based Detection 6-16
Receive LED 16-8, 17-6
Remote disc functions 18-28
Remote printer functions 20-17
Remote protocol: 15-8
<Rename Counters & Timers> 14-39
<Rename Programs> 14-5
<Repeated ___ Times> 14-35

Repeating Displays 17-9
Repeating keys 1-15
Replacement Parts 8-3
<Reset> 14-36
<Reset MAU> 21-10
RETURN key 1-14

<Re-write Existing> 18-9, 18-14
<Run From Buffer> 16-4
Run from Log-data disc file 16-5
<Run From Network> 16-3
Running Programs 14-24
Runt Frame Filter: 21-4
Runt Frames 12-21, 19-6, 19-44

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index 1-12
Sequence Number 18-16, 18-22, 18-23
Service support: hardware, software 2-14
Setting the Date and Time 5-22, 23-1
<Set Date> 5-22, 23-2

<Set Time> 5-23, 23-3
<Setup Analyzer> 10-1
>Show Hex Address> 12-11, 13-4
>Show Hex Name> 19-24
>Show Node Name> 12-11, 13-4, 19-24

Simulate Function 7-16
<Singie Frame> 18-12, 20-12
Site Preparation 3-1
Softkey conventions 1-8
Softkey descriptions 1-4
Softkey Levels 1-4, 1-9
Softkey programming 14-24
Softkey selections 1-4

Soft LED indicators 16-8, 17-6
Software Handshake: 15-7
Software, loading into the system 5-5, 5-7
Software, system 5-3, 5-5, 5-7

<Sort By Address> 11-8
<Sort By Bus Pos'n> 11-8
<Sort By Name> 11-8
<Sort Nodes> 11-8

Volume I contains chapters 1 through 8, appendices A·D and a glossary.
Volume II contains chapters 9 through 23.
Index I-14
<Source Address> 19-15
Source Address, IEEE 802.3 6-18, 19-6
Spaces in entry fields 1-16
Specifications, HP 4971S Operating 2-3
Specifications, physical 2-6
SSAP field (IEEE 802.2) 19-29

<Start> 14-27
<Start Display> 17-4
<Starting With> 14-10
<Start Monitor> 17-4
Start of Frame 19-36

<Stop> 14-30
Stop Bits: 15-5
Stop Display 14-51
<Stop Display> 17-4
<Stop Monitor> 17-5
Store: command 14-6
<Store New Password> 22-8
<Summary Format> 19-18
<Suppress Data> 19-32
<Suppress Headers> 19-26

System Software
Backing up system software 5-17
Loading system software 5-5, 5-7
Software supplied with the HP 4971S 5-3

TAB key 1-14
Temperature 2-7, 3-2
Terminal Emulator 15-29
<Test> 14-30

<Test All Hardware> 21-10
<Test LAN Analyzer> 21-9

Volume I contains chapters 1 through 8, appendices A-D and a glossary.
Volume II contains chapters 9 through 23.
Index I-15
Volume I contains chapters 1 through 8, appendices A-D and a glossary.

Volume II contains chapters 9 through 23.

Index 1-16